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Chapter 1. Introduction
IBM® OpenPages® GRC Platform is an integrated governance, risk, and compliance platform that enables
companies to manage risk and regulatory challenges across the enterprise.

Audience

The IBM OpenPages GRC Installation and Deployment Guide provides instructions for installing and
deploying the OpenPages GRC Platform application.

Please read the following important information regarding IBM OpenPages GRC documentation

IBM maintains one set of documentation serving both cloud and on premise IBM OpenPages GRC
deployments. The IBM OpenPages documentation describes certain features and functions which may
not be available in OpenPages GRC on Cloud. For example, OpenPages GRC on Cloud does not include
integration with IBM Business Process Manager and certain administrative functions.

If you have any questions about the functionality available in the product version that you are using,
please contact IBM OpenPages Support via the IBM Support Community.

Finding information

To find product documentation on the web, including all translated documentation, access IBM
Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited
vision, to use information technology products. OpenPages GRC documentation has accessibility features.
PDF documents are supplemental and include no added accessibility features.

Installation locations
The installation directory is the location of product artifacts after a package, product, or component is
installed. The following table lists the conventions that are used to refer to the installation location of
installed components and products:

Important: Directory locations that contain spaces are not supported. IBM OpenPages GRC Platform or
any software that is used by it must not be installed into a directory with spaces. For example, do not
install database server, database client, or application server software into the Program Files
directory.

Table 1: Variable notations for installation directories

Directory Description

<installation_server_home> The directory where the IBM OpenPages GRC Platform installation server
is installed.

For example:

• On Windows: c:\IBM\OPInstall\OP_<version>_Installer
• On AIX® and Linux: /home/opuser/IBM/OPInstall/
OP_<version>_Installer

https://www.ibm.com/mysupport
http://www.ibm.com/support/knowledgecenter
http://www.ibm.com/support/knowledgecenter


Table 1: Variable notations for installation directories (continued)

Directory Description

<agent_home> The directory where the IBM OpenPages GRC Platform installation agent
is installed on a remote server.

For example:

• On Windows: c:\IBM\OPAgent
• On AIX and Linux: /home/opuser/IBM/OPAgent

<OP_HOME> The directory where OpenPages GRC Platform is installed.

For example:

• On Windows: c:\OpenPages
• On AIX and Linux: /opt/OpenPages

<ORACLE_HOME> The installation location of the Oracle database server.

For example:

• On Windows: C:\app\Administrator\product\12.1\client_1
• On AIX and Linux: /home/oracle/app/oracle/product/12.1/
client_1

<DB2_HOME> The installation location of the IBM DB2® software.

For example:

• On Windows: C:/IBM/SQLLIB
• On AIX and Linux: /home/db2inst1/sqllib

<WAS_HOME> The installation location of IBM WebSphere® Application Server.

For example:

• On Windows: C:\IBM\WebSphere\AppServer
• On AIX and Linux: /opt/IBM/WebSphere/AppServer

<COGNOS_HOME> The installation location of Cognos Analytics.

For example:

• On Windows: C:\IBM\cognos\analytics
• On AIX and Linux: /usr/IBM/cognos/analytics

<JAVA_HOME> The installation location of your Java™ Runtime Environment (JRE) or
your IBM Java Software Development Kit (SDK).

SDK example on an application server where IBM WebSphere is
installed:

• On Windows: C:\IBM\WebSphere\AppServer\Java\8.0
• On AIX and Linux: /opt/IBM/WebSphere/AppServer/Java/8.0

JRE example on a reporting server where Cognos Analytics is installed:

• On Windows: C:\<COGNOS_HOME>\jre
• On AIX and Linux: /<COGNOS_HOME>/jre

2   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide



Table 1: Variable notations for installation directories (continued)

Directory Description

<CC_HOME> The installation location of OpenPages GRC Platform CommandCenter.

For example:

• On Windows: C:\OpenPages\CommandCenter
• On AIX and Linux: /opt/OpenPages/CommandCenter

<SEARCH_HOME> The installation location of global search.

The <SEARCH_HOME> directory contains the opsearchtools.jar,
Apache Solr, and other global search files. The global search indexing
directory is also stored in the <SEARCH_HOME> directory.

For example:

• On Windows: c:\OpenPages\OPSearch
• On AIX and Linux: /opt/OpenPages/OPSearch

In the installation app, you specify the <SEARCH_HOME> directory in the
Search Home Directory field on the Search Server card.

Changes to the installation process
If you installed previous versions of IBM OpenPages GRC Platform, you will notice many differences in
version 7.4 and later. The installation process has changed to make it easier to install and upgrade IBM
OpenPages GRC Platform.

Phases of the installation process

In version 7.4 and later, the installation process is divided into three phases:

• Validation: After you enter the details for your deployment, you validate them. The installation server
checks your deployment for any issues that need to be resolved before you continue with the
installation. The installation server also installs and starts agents on the remote servers that are in your
deployment.

• Installation: During this phase, the installation server stages the assets onto the servers in your
deployment.

• Configuration: During this phase, the installation server sets up and configures the OpenPages
components.

You complete each phase before continuing to the next phase.

Upgrade process changes

In previous versions, upgrades were done in-place, onto your existing OpenPages environment. In version
7.4 and later, an upgrade begins with a fresh installation. You then upgrade the database and migrate
files.

When you do the fresh installation, you can use your existing hardware, but the software must be installed
into new directories. You cannot install on top of your existing OpenPages directory structures.

When you upgrade the database, you can choose to upgrade the database on your existing database
server or use a new database server.
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New installation server component

In version 7.4 and later, the installation server replaces the IBM OpenPages Administrative Console. The
installation server automates many tasks that were done manually in previous versions. The installation
server also provides more validation, more flexibility in configuring your deployment, and improved error
logging.

You can install and upgrade multiple environments with a single installation server. You can install the
installation server on a separate computer or on a server in an OpenPages environment. In addition, you
do not need to install IBM Installation Manager to install the installation server. The installation server
includes its own installer.

The installation server provides a web application, called the installation app, which you can use to install
and upgrade OpenPages. You can also install and upgrade in silent mode. The installation app replaces
the OpenPages Administrative Console user interface.

Figure 1: Installation server

Tip: You can log out and close the installation app during the Install and Configure processes. The
processes continue to run. When you log in to the installation app again, the app shows the status of your
deployment.

Agents

In previous versions, you needed to install OPAdminConsoleRemote on each server in your deployment.
In version 7.4 and later, the installation server installs the agent software and starts the agents on remote
servers automatically. The agent software is not needed on the database server.

To install the agents on remote servers, you must have access to an account on the remote server. The
account must have the necessary permissions to install and run software on the remote server. Or, you
can install the agents manually on remote servers.

Deployment Manager

In version 7.4 and later, the IBM WebSphere deployment manager for OpenPages is a separate
component. You can install the deployment manager on its own computer or on the same computer as an
application server.

Ports

In previous versions, default ports were used. In version 7.4 and later, you can set custom port numbers
for IBM WebSphere, Cognos Analytics, and other components when you configure your deployment.
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Shared cell deployments

In version 7.4 and later, you can deploy OpenPages into an existing IBM WebSphere cell.

Rollback operations

In previous versions, if a failure occurred during an operation, the entire process failed. In version 7.4 and
later, you can use the Rollback option for each server to roll back the operation that caused the error. This
feature enables you to resolve issues more quickly and resume the installation from the point of failure.

Migrating files during an upgrade

In version 7.4 and later, you can choose the files and directories that you want to migrate when you
upgrade OpenPages.

Redesigned database scripts

The database scripts that are used to install and upgrade the OpenPages database have been redesigned.
The redesigned scripts provide the following enhancements:

• The database installation and upgrade scripts incorporate more pre- and post-validation checks than in
previous versions.

• The scripts now separate DBA and non-DBA tasks.

When you install the database, you now have the following options:

– You can use the OpenPages installation app to create the database objects. The user who installs
OpenPages must provide DBA credentials.

– A database administrator can run the scripts that require DBA privileges, and then another user can
use the OpenPages installation app to complete the installation.

– You can create all of the objects required for the database manually before you install OpenPages. A
database administrator must run the scripts that require DBA privileges. A schema user can run the
other scripts.

When you upgrade the database, a database administrator runs the scripts that require DBA privileges.
A user who is not a database administrator can run the scripts that do not require DBA privileges.

• Oracle Transparent Data Encryption is now supported.
• You can customize the schema name (Oracle) and table space names (Oracle and IBM DB2) when you

create the OpenPages database.
• You no longer need to run the sysdba-xa-views-wrapper.sql script. The sydba-create-xa-
views.sql and sysdba-xa-grants.sql scripts are also no longer used.

Validation

In version 7.4 and later, additional validation is done before you install OpenPages. The installation server
validates each server in your deployment before the installation process begins.

The additional validation prevents possible deployment failures caused by configuration issues, unmet
prerequisites, and insufficient permissions. The additional validation enables you to identify and resolve
issues up-front, which can save you time and effort.
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For example, the installation server checks if ports are occupied. If a port is occupied, you can fix the
issue before you install OpenPages. In previous versions, the ports were not validated. If a port was
occupied, the deployment would fail.

Validation messages are displayed on server cards. When you click the card, an error icon is displayed
next to the field where the error occurs.

Figure 2: Example of error notifications – three fields are empty on the application server card

Log files and reports

The installation server provides more logging and exception handling.

• You can validate your deployment before you begin the installation process.
• You can download the validation results in a report to see the details.
• When the installation server encounters an exception, the error is displayed in the user interface. You

can download the log file.
• You can view log files for each phase of the installation process as well as for each server in your

deployment.

The following image shows an example of a pre-installation validation report. The page about
Application Server1 is displayed. No errors were found. Two warnings indicate that values are below
the recommended values. Warnings do not need to be fixed before you install OpenPages.
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Figure 3: Example of a validation report showing results for an application server

IBM Java 8 is provided with Cognos Analytics

In previous versions, you needed to install Java on each reporting server in your deployment. Cognos
Analytics V11 includes IBM Java 8.

IBM HTTP Server for Cognos Analytics

If you use IBM HTTP Server to load balance the reporting servers, note that the configuration method has
changed. See the Cognos Analytics documentation for details.

Oracle database alias

If you use the same Oracle database instance for OpenPages and Cognos®, use the same database alias
for both OpenPages and Cognos.

When you configure the database connection information, you can choose to use either the SID or the
Service Name.
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IBM Business Process Manager integration

In version 7.3, the integration of IBM Business Process Manager with OpenPages was done manually by
running a script. In version 7.4 and later, you can still do the integration manually, but you also have the
option to use the installation server to do the integration.
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Chapter 2. What's new?
New and changed features affect the installation and configuration of IBM OpenPages GRC Platform. Use
this information to help you plan your upgrade and deployment strategies and the training requirements
for your users.

For information about all new features for this release, see the IBM OpenPages GRC New Features Guide.

For an up-to-date list of environments that are supported by OpenPages GRC Platform, see the IBM
Software Product Compatibility Reports (http://www.ibm.com/support/docview.wss?uid=swg27039467).

New features in version 7.4.0
The new features in IBM OpenPages GRC Platform version 7.4.0 are described in the following sections.

Software versions

For details about supported software, see IBM OpenPages GRC Platform Supported Environments.

Table 2: Changes to supported software versions

Software Conformance changes

Linux Red Hat Enterprise Linux (RHEL) 6.6 (and higher
minor releases and updates) is now supported in
addition to RHEL 7.0.

RHEL 6.5 is no longer supported.

AIX AIX 6.1 is no longer supported. AIX 7.1 or higher is
supported.

IBM WebSphere Application Server Network
Deployment

IBM Websphere 9.0.0.3 (or higher fix packs) is now
supported.

IBM Websphere 8.5.5.x is no longer supported.

IBM DB2 DB2 ESE 11.1.1.1 (or higher editions/fix packs) is
supported in addition to DB2 ESE 11.1.0.0.

Oracle Oracle 11g is no longer supported. Oracle SE
12.1.0.2 and later fix packs is supported.

IBM Java SDK/JRE Version 8.0.4.1 and later fix packs is supported.
Java 1.7 is no longer supported.

Microsoft Internet Explorer Internet Explorer 11 in native mode is supported.
Internet Explorer 9 and 10 and Internet Explorer
compatibility mode are no longer supported.

The Force Internet Explorer Compatibility Mode
registry setting has been removed and is
disregarded during upgrade.

Google Chrome is also supported.

http://www.ibm.com/support/docview.wss?uid=swg27039467
http://www.ibm.com/support/docview.wss?uid=swg27039467
http://www.ibm.com/support/docview.wss?uid=swg27039467


Table 2: Changes to supported software versions (continued)

Software Conformance changes

IBM Cognos 11.0.7 Interim Fix 1001 (and higher 11.0.x
continuous releases) is now supported.

IBM Cognos Business Intelligence 10.2.2.x is no
longer supported.

Fujitsu Fujitsu Interstage BPM is no longer supported.

Administration and serviceability enhancements

For an overview of the changes to the installation process, including the new installation server, see
“Changes to the installation process” on page 3.

Table 3: Administration and serviceability enhancements

For new information about... See this topic...

The new installation app makes it easier to install
IBM OpenPages GRC Platform.

Chapter 5, “OpenPages installation server and
app,” on page 33

The installation process has been redesigned. Chapter 6, “Install IBM OpenPages GRC Platform,”
on page 45

The upgrade process has been redesigned. Chapter 7, “Upgrade IBM OpenPages GRC
Platform,” on page 167

Shared cell deployments “Considerations for shared cell deployments” on
page 124

Oracle Transparent Data Encryption is now
supported.

For new installations of IBM OpenPages GRC
Platform, see “Oracle Transparent Data Encryption
(TDE) for fresh installations” on page 114.

For upgrades, see “Oracle Transparent Data
Encryption (TDE) for upgrade customers” on page
238.

The SQL for security rules has changed. In certain security rules, the product was
improperly extending or restricting access to users
when the conditions of the security rule were met
by data in past reporting periods, even when the
user was interacting with data in the current
reporting period. This issue was addressed by a fix
to the security rules SQL that had this problem.
When the fix is applied, security rule conditions are
evaluated against data in the correct reporting
period only.

See “Updating security rules” on page 185.
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New features in version 7.3.0.2
The new features in IBM OpenPages GRC Platform, version 7.3.0.2, are described in the following
sections.

Integration with IBM Regulatory Compliance Analytics

You can import data from IBM Regulatory Compliance Analytics into IBM OpenPages GRC Platform. To
enable this functionality, you need to do some post-installation tasks.

For more information, see Chapter 17, “IBM Regulatory Compliance Analytics,” on page 307.

New features in version 7.3.0.1
The new features in IBM OpenPages GRC Platform, version 7.3.0.1, are described in the following
sections.

IBM OpenPages Vendor Risk Management solution loader

The IBM OpenPages Vendor Risk Management solution loader enables customers who upgraded from a
fresh 7.2 installation to version 7.3.0.1 to load the objects, relationships, and profiles to use the IBM
OpenPages Vendor Risk Management solution.

If you had a fresh installation of IBM OpenPages GRC Platform version 7.2 with solutions and then
upgraded to version 7.3.0.1 or later, use the solutions loader to install IBM OpenPages Vendor Risk
Management. You must have the 7.2 solutions schema in your environment. You must also have licensed
IBM OpenPages Vendor Risk Management.

UCF connector integration

Use IBM OpenPages GRC SDI Connector for UCF Common Controls Hub to import data from UCF
Common Controls Hub into IBM OpenPages GRC Platform.

For more information, see Chapter 14, “IBM OpenPages GRC SDI Connector for UCF Common Controls
Hub,” on page 275.

New features in version 7.3.0
New features affect the installation and configuration of IBM OpenPages GRC Platform.

Collect and view logs

The new LogCollector tool provides a command-line interface that you can use to collect log files and
diagnostic data from the IBM OpenPages GRC Platform environment.

With the LogCollector tool, you can collect log and diagnostic files from the IBM OpenPages GRC Platform
environment and from the IBM OpenPages GRC Platform database.

For more information, see “Collect log files and diagnostic data” on page 342.

Administrative Console application interface runs on Linux

You can now run the IBM OpenPages GRC Platform Administrative Console application interface on Linux
systems. For more information, see “Setting up the installation server on Linux or AIX” on page 34.
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Software versions

OpenPages GRC Platform now supports Red Hat Enterprise Linux (RHEL) 7.0 (and higher minor releases
and updates). Red Hat Enterprise Linux (RHEL) 6.5 (and higher minor releases and updates) is also
supported.

OpenPages GRC Platform requires new versions of some software. If you are upgrading or migrating, you
must update your environment to use these versions:

• IBM WebSphere Application Server 8.5.5.9
• If you are using IBM DB2, version 11.1 is required. IBM DB2 version 10.5 is no longer supported.
• If you are using IBM DB2, IBM Cognos Business Intelligence (BI) version 10.2.2.6 or later is required.

Integration with IBM Business Process Manager

The integration of IBM OpenPages GRC Platform with IBM Business Process Manager gives you access to
an enhanced level of GRC process automation. IBM Business Process Manager is a leading industry
process automation system that is both scalable and highly configurable.

For information about how to integrate IBM Business Process Manager with IBM OpenPages GRC
Platform, see the IBM OpenPages GRC - Business Process Manager Installation Guide.

New features in version 7.2.0.4
The new features in IBM OpenPages GRC Platform, version 7.2.0.4, are described in the following
sections.

Collect and view logs

The new LogCollector tool provides a command-line interface that you can use to collect log files and
diagnostic data from the IBM OpenPages GRC Platform environment.

With the LogCollector tool, you can collect log and diagnostic files from the IBM OpenPages GRC Platform
environment and from the IBM OpenPagesdatabase.

For more information, see “Collect log files and diagnostic data” on page 342.

New features in version 7.2.0.3
The new features in IBM OpenPages GRC Platform, version 7.2.0.3, are described in the following
sections.

Changes to DB2 conformance

Version 7.2.0.3 introduces support for IBM DB2 version 11.1. IBM DB2 10.5.0.5 special_33521 is also
supported.

For more information, see supported software environments (http://www.ibm.com/support/docview.wss?
uid=swg27039467).

For information about upgrading to IBM DB2 version 11.1, see „Upgrade IBM DB2” auf Seite 58.
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New features in version 7.2.0.2
The new features in IBM OpenPages GRC Platform, version 7.2.0.2, are described in the following
sections.

OpenPages Loss Event Entry

You can use the new optional, chargeable component, IBM OpenPages Loss Event Entry, to enable users
across an organization to quickly create loss events. It is easy to use and task focused for users with no
experience with OpenPages.

For more information, see Chapter 16, “Loss Event Entry,” on page 295.

New features in version 7.2.0.1
The new features in IBM OpenPages GRC Platform, version 7.2.0.1, are described in the following
sections.

Approval app

The approval app is an optional feature that leverages the power of IBM OpenPages GRC Platform and
provides an easy-to-use interface for quickly taking action on a review, approval, or attestation request
with confidence and full knowledge of the context surrounding the request. The approval app works with
objects that are set up for the configurable lifecycle.

For more information, see Chapter 15, “Approval app,” on page 281.

New features in version 7.2.0
New features affect the installation and configuration of IBM OpenPages GRC Platform.

Software versions

Support for the Oracle 12.1.0.2 database server and database client is now supported in addition to the
existing supported versions.

Microsoft Internet Explorer version 11 is now provided, in addition to the existing supported versions.

Google Chrome is now a supported web browser.

OpenPages GRC Platform requires new versions of some software. If you are upgrading or migrating, you
must update your environment to use these versions:

• IBM Runtime Environment for Java 1.7.3
• IBM WebSphere Application Server Network Deployment 8.5.5.5
• IBM Cognos Business Intelligence (BI) version 10.2.2.1

IBM WebSphere Liberty Profile 8.5.5.6 is now installed with OpenPages CommandCenter instead of
Apache Tomcat. Tomcat is no longer supported.

Two versions of Dojo are now installed when you deploy OpenPages. Dojo 1.8.4 is required for
visualization reports and Dojo 1.10.4 is used in the OpenPages application.

Search server

Global search is an optional component that you can install so users can search easily for objects across
the entire application. The search server that you install for global search is deployed as part of the
OpenPages GRC Platform application from the Administrative Console.

For more information, see “Search server” on page 19.
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IBM QRadar integration

IBM QRadar® integration is an optional project that you can install to import offenses from QRadar to
OpenPages GRC Platform as incidents.

For more information, see Chapter 13, “QRadar integration,” on page 271.

SAML V2.0 single sign-on

You can now configure IBM OpenPages GRC Platform to use SAML V2.0 for single sign-on without the
need for custom code and without involvement from IBM Services.

Changed features in version 7.2.0
The following topics describe features that have changed since the last release of IBM OpenPages GRC
Platform.

New objects added to profiles

After you upgrade or migrate, new object types are added to the master profiles.

• The Questionnaire subcomponent includes new object types - Questionnaire Template, Questionnaire
Assessment, Section Template, SubSection Template, Question Template.

• A new subcomponent, Assessment Program, is added. It includes a new object type - Program.
• The Regulatory Library subcomponent includes a new object type - Regulation Initiative.

For more information, see the IBM OpenPages GRC Platform Solutions Guide.

Changes to solutions trigger files

After you upgrade or migrate, the following files are updated:

• Standard solutions classes are removed from the openpages-ext.jar file.
• A new file is deployed, openpages-solutions.jar, that contains the standard solutions classes.

When you add custom triggers, do not include the class files the openpages-solutions.jar file. If you
already added custom trigger class files to openpages-solutions.jar for the previous release, you
can back up the class file before you upgrade, and restore it manually.

New features in version 7.1.0.1
The following topics describe the new features for this release.

Support for Oracle 12.1.0.2 database server

Support for the Oracle 12.1.0.2 database server is now provided in addition to the existing supported
versions.

For more information, see “Oracle 12.1.0.2 database server considerations” on page 75.

New features in version 7.1.0
The following topics describe the new features for this release.

Use IBM Installation Manager to install OpenPages GRC Platform solutions

You now use IBM Installation Manager to install, update, and uninstall IBM OpenPages GRC Platform
solutions.
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Changed features in version 7.1.0
The following topics describe features that have changed since the last release.

IBM JRE for OpenPages GRC Platform is included with the Administrative Console

When you install the IBM OpenPages GRC Platform Administrative Console, IBM Runtime Environment for
Java for OpenPages GRC Platform is now installed as well. It is no longer necessary to install Java as a
separate component.

REST API security or IBM WebSphere Application Server global security must be enabled

IBM WebSphere Application Server global security is now enabled by default on the application servers
when you first install IBM OpenPages GRC Platform.

If you enabled REST API security or WebSphere Application Server global security before upgrading or
migrating OpenPages GRC Platform, no further action is required.

If you did not enable REST API security or IBM WebSphere Application Server global security before
upgrading or migrating, you must enable REST API security manually.

Migrating OpenPages GRC Platform

The process for migrating from a previous version of IBM OpenPages GRC Platform has changed.

Increased support for concurrent users

IBM OpenPages GRC Platform now supports up to 1000 concurrent users on a single node.

Default folder for adding new child objects

If you upgrade or migrate from IBM OpenPages GRC Platform 7.0, when you create a new object, the
system uses the default folder setting to determine in which folder to create child objects.

In previous releases, when the parent_entity folder was set as the default folder, child objects were
added to the next level parent folder.

In this release, when the parent_entity is set as the default folder, new child objects are added to the
parent_entity folder.

Check the value of this setting after upgrading or migrating to ensure that it is correctly set for your
requirements.

For more information, see the IBM OpenPages GRC Platform Administrator's Guide.

New features in version 7.0.0
The following topics describe the new features for this release.

Use IBM Installation Manager to install the OpenPages GRC Platform Administrative
Console

Use IBM Installation Manager to install, update, and uninstall the IBM OpenPages GRC Platform
Administrative Console. Use the Administrative Console to install, configure, and deploy OpenPages
components to WebSphere Application Server.

You can run the Administrative Console application interface on computers that are running either
Microsoft Windows or Linux operating systems. To run the Administrative Console application interface on
Linux, you must perform some additional steps. To use the Administrative Console on AIX operating
systems, you must use it in silent mode.
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Topology-driven deployments in the IBM OpenPages GRC Platform Administrative
Console

The IBM OpenPages GRC Platform Administrative Console provides a topological view of your
deployments. You can manage the topology by adding components, such as more application servers to
an existing OpenPages GRC Platform deployment.

New deployment wizards in the OpenPages GRC Platform Administrative Console
The IBM OpenPages GRC Platform Administrative Console has changed and now provides new
deployment wizards for managing your deployments.

Wizards allow you to create new deployments and upgrade or migrate existing deployments. You can also
extend existing OpenPages GRC Platform deployments, such as by adding servers to the deployment.

Embedded guidance for the Next Steps panel in the OpenPages GRC Platform
Administrative Console

The Next Steps panel displays the status of your IBM OpenPages GRC Platform deployment, and also
provides help for completing the next steps in the deployment.

Validation of software prerequisites
The IBM OpenPages GRC Platform Administrative Console provides validation of your software
prerequisites, such as installed versions of your database server, database client, WebSphere Application
Server, and IBM Cognos Business Intelligence software.

If the software does not meet the minimum requirements, you must update the software before you can
proceed with the installation.

Changed features in version 7.0.0
The following topics describe features that have changed since the last release.

Supported software environments
Ensure that you review the software environments that are supported by IBM OpenPages GRC Platform
version 7.0. New versions and end of support for various environments can affect your upgrade strategy.

You can review the supported environments by using the IBM Software Product Compatibility Reports
(http://www.ibm.com/support/docview.wss?uid=swg27039467).

Silent installations require a deployment properties file
Before you run a silent installation, you must create a deploy.properties file, which defines your
installation, and identify a deployment folder.

You can create the deploy.properties file and the deployment folder from the IBM OpenPages GRC
Platform installation app.

Interactive Object Manager loading and status monitoring
Use the Config > OM Load tab in the IBM OpenPages GRC Platform Administrative Console to view the
status, load, and reload Object Manager schema data to your OpenPages database.

IBM Cognos BI Software Development Kit installation no longer required
The IBM OpenPages GRC Platform reporting server no longer requires the IBM Cognos Business
Intelligence (BI) Software Development Kit.
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Chapter 3. OpenPages GRC Platform overview
You use IBM OpenPages GRC Platform to manage risk and regulatory challenges across the enterprise.
OpenPages GRC Platform provides core services and components that span risk and compliance domains.
These components include operational risk, policy and compliance, financial controls management, IT
governance, internal audit, regulatory compliance management, and model risk governance.

The following diagram shows the architectural components for OpenPages GRC Platform applications.
The platform contains the database and key services such as the security framework and reporting
framework, and document management. The solutions are configurations that work with the platform.

Figure 4: OpenPages GRC Platform components

OpenPages GRC Platform components
IBM OpenPages GRC Platform consists of the following components:

• An installation server, which is used to install IBM OpenPages GRC Platform.
• A database server for hosting the OpenPages GRC Platform repository.
• One or more application servers for hosting the OpenPages GRC Platform application.
• One or more reporting servers for hosting Cognos Analytics and OpenPages GRC Platform

CommandCenter.
• Up to one search server (optional) for hosting the OpenPages GRC Platform global search component.
• Up to one workflow server (optional) for IBM Business Process Manager.

After installation, users can access OpenPages GRC Platform from a separate client computer.



Installation server
The IBM OpenPages GRC Platform installation server is required to install and upgrade IBM OpenPages
GRC Platform. You can also use it to apply fix packs and interim fixes. The installation server includes a
web interface, called the installation app.

The installation server uses installation agents to install components on remote servers, except the
database server. The installation server pushes the agent software to the remote servers and starts the
agents automatically. For each remote server, you must provide the credentials of a local user who can
install and run software on the remote server.

You can set up the installation server on one of the servers in your OpenPages environment or on a
separate computer.

Figure 5: Installation server

Database server
A database server is required to host the IBM OpenPages GRC Platform repository. The repository is a
central source for metadata management, versioned application data, and access control.

To install the IBM OpenPages GRC Platform application, you must create an OpenPages database
schema, a set of database users, and table spaces.

You can automatically create and configure these components during the OpenPages installation.
Alternatively, you can create them manually before you install OpenPages.

You can use an IBM DB2 database or an Oracle database for the OpenPages repository.

Application server
An application server is required to host the IBM OpenPages GRC Platform application.

The IBM OpenPages GRC Platform application server runs the application solutions, and includes the
definition and administration of business metadata, UI views, user profiles, and user authorization.

You must install IBM WebSphere Application Server before you install OpenPages GRC Platform.

You can install the IBM WebSphere deployment manager for IBM OpenPages GRC Platform on a separate
computer or on the same computer as the application server.

You can also add horizontal and vertical cluster members for the application server.

The admin application server is the main application server for your deployment and is referred to as
appserver1.

All secondary application servers are known as non-admin application servers.
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Reporting server
A reporting server is required to host Cognos Analytics and OpenPages GRC Platform CommandCenter.

Cognos Analytics

Cognos Analytics provides executive dashboards and reports that are designed to accelerate the review
and approval of governance, risk, and compliance management (GRCM) information throughout the
enterprise. Business users can browse through complex information easily by clicking dashboard
elements to drill down through detailed reports.

Cognos Analytics includes a content store, which is a relational database. The content store contains data,
such as report specifications, published models, and the packages that contain them. The content store
also contains connection information for data sources.

If you install more than one reporting server with OpenPages GRC Platform, you only need one IBM
Cognos content store database for all servers. The main server is known as the active reporting server,
and all secondary servers are known as standby reporting servers.

For more information on active and standby servers, see the IBM Cognos Analytics Installation and
Configuration Guide.

OpenPages GRC Platform CommandCenter

OpenPages GRC Platform CommandCenter provides the integration between OpenPages and Cognos
Analytics so that you can create and run reports.

It installs the OpenPages Reporting Framework Generator and the OpenPages security provider, creates
the OpenPages data sources, and imports the report packages that are supplied with OpenPages.

Search server
OpenPages GRC Platform supports a single search server in the enterprise configuration.

The search server is required to host the OpenPages GRC Platform global search component. Global
search is an optional component that you can install so users can search easily for objects across the
entire application.

For best performance, install the search server on a separate computer.

Workflow server
You can integrate IBM Business Process Manager with your IBM OpenPages GRC Platform deployment by
adding workflow server.

The workflow server is an optional component.

For more information, see the IBM OpenPages GRC - Business Process Manager Installation Guide.

Server topology and installation configurations
Before you install IBM OpenPages GRC Platform, plan the server topology. The number of computers you
use depends on the expected user loads.

A mix of client and server operating systems are supported. For example, you can install OpenPages GRC
Platform application servers on a Windows operating system and install the OpenPages database on Linux
or AIX operating systems. You can also install the OpenPages application servers on Linux or AIX and
install the OpenPages database on Windows.

Use the following guidelines to plan your server topology.
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Very light loads for proof of concept testing and demos

If you want to install OpenPages to see new features or to develop a proof of concept, you can use Docker
to install OpenPages. For more information, see Appendix B, “Install OpenPages by using Docker,” on
page 325.

Light loads

For light user loads, you can use one application server, one reporting server, a server for the deployment
manager, and a database server.

If you are installing a search server, install it on a separate computer.

This topology is typical in a testing or staging environment.

Figure 6: Topology for test environments or light user loads

If you want to integrate IBM Business Process Manager with IBM OpenPages GRC Platform, use a
separate computer for IBM Business Process Manager.
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Figure 7: Topology for light user loads with a workflow server for IBM BPM

Moderate to high loads

For moderate to high loads, set up a clustered OpenPages GRC Platform environment. By adding vertical
or horizontal cluster members to the environment, you can increase scalability. Scaling requires that you
use a load balancer to distribute the incoming client requests.

You can scale application servers horizontally or vertically by adding cluster members. You can also scale
the reporting server by adding horizontal cluster members.

You can install the deployment manager on the same computer as the primary application server
(appserver1). Or, for added scalability, you can install the deployment manager on a separate computer.

If you are installing a search server, install it on a separate computer.

The following diagram shows an example of using horizontal cluster members for the application server
and for the reporting server. A load balancer distributes incoming requests to horizontal cluster members.
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Figure 8: Topology for moderate to high user loads

If you are installing a workflow server, install it on a separate computer.
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Figure 9: New medium load diagram with BPM

Clustered environments
A clustered environment consists of multiple IBM OpenPages GRC Platform application servers (known as
cluster members) running simultaneously to provide increased scalability.

You can set up a vertical cluster with multiple cluster members running on a single computer. You can also
set up a horizontal cluster with multiple cluster members running on different computers.

When you set up a clustered environment, load balancing is required to distribute incoming client
requests across the members. This configuration allows the IBM OpenPages GRC Platform application to
scale as the number of concurrent users increases.

You can also scale the reporting server horizontally by installing additional reporting servers. You must
configure additional Cognos dispatchers to ensure that the incoming requests are distributed across
multiple servers.
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Configure clustered environments
To accommodate increased user loads, you can scale the application servers and reporting servers in your
IBM OpenPages GRC Platform environment.

Scaling application servers

You can scale application servers horizontally or vertically by adding cluster members to the OpenPages
environment. A cluster member consists of an instance of the OpenPages application server. Each
member runs on a different port.

When you scale, load balancing is required to distribute the incoming requests across the members.

For more information on adding horizontal and vertical cluster members to the OpenPages environment,
see the IBM OpenPages GRC Administrator's Guide.

Scaling the reporting server

You can scale the reporting server horizontally by installing more reporting servers. You must configure
the additional Cognos dispatchers to ensure that the incoming requests are distributed across the
multiple servers.

Creating a clustered environment

The process to create a clustered OpenPages environment is summarized here:

1. Install and configure the admin application server, each application server, and the reporting server as
a stand-alone system.

If you are using more than one reporting server, ensure that you stop all standby reporting servers
when you install the active reporting server.

2. Configure each system for load balancing.

Set up the load balancer on the OpenPages application server or on an external system.

You can deploy a hardware or software load balancer. The load balancer must support session affinity
and port-based URL routing.

24   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide



Chapter 4. Installation prerequisites
Ensure that you have installed the prerequisite software and hardware before you install IBM OpenPages
GRC Platform.

Software prerequisites
To ensure that your product works properly, apply all minimum required operating system patches, and
use only the supported versions of third-party software. Review the prerequisite software before installing
IBM OpenPages GRC Platform.

You can review the supported prerequisite software by using the IBM Software Product Compatibility
Reports (www.ibm.com/support/docview.wss?uid=swg27039467).

Prerequisite software for all servers
Before you install IBM OpenPages GRC Platform, ensure that the prerequisite software is installed on
each server in your environment.

The following table lists the third-party software that must be installed on each computer you are using
for the database server, all application servers, reporting servers, and the search server.

For more information, see IBM OpenPages GRC Platform Supported Environments (http://
www-01.ibm.com/support/docview.wss?uid=swg27039467).

Table 4: Software prerequisites for all Windows computers

Requirement Specification

Operating system Microsoft Windows Server 2012 Standard Edition

Microsoft Windows Server 2012 R2 Standard
Edition

Web browser Microsoft Internet Explorer 11, Native mode

Google Chrome 46 or later

File compression utility For example, WinZip or 7-Zip

PDF reader Adobe Acrobat

Table 5: Software prerequisites for all AIX or Linux computers

Requirement Specification

Operating system Linux:

• Red Hat Enterprise Linux (RHEL) Server 6.6
• Red Hat Enterprise Linux (RHEL) Server 7.x

AIX 7.1

File compression utility For example, GNU compression utility (gtar)

http://www.ibm.com/support/docview.wss?uid=swg27039467
http://www.ibm.com/support/docview.wss?uid=swg27039467
http://www-01.ibm.com/support/docview.wss?uid=swg27039467


Note: If you are using Red Hat Enterprise Linux 7.2, note the following known issue https://
access.redhat.com/solutions/2062273. To fix the issue, edit the /etc/systemd/logind.conf file, set
RemoveIPC=no, and then restart the corresponding service or reboot.

Prerequisite software for the installation server
The following table provides the software requirements for the installation server.

You can install the installation server on a separate computer or on a computer in your IBM OpenPages
GRC Platform environment, such as the admin application server.

After you install the installation server, you can use the OpenPages installation app to create and manage
deployments. For more information, see Chapter 5, “OpenPages installation server and app,” on page
33.

Table 6: Software prerequisites for the installation server computer

Requirement Specification

IBM Runtime Environment for Java 8 IBM Java JRE 8.0_64

IBM JRE is available on the IBM OpenPages GRC
Platform installation media.

Install the IBM Runtime Environment for Java (IBM
JRE) and set up the system environment variables
for Java on the installation server computer before
you install the installation app.

Windows PowerShell If you are using Microsoft Windows, then Windows
PowerShell version 4.0 or later is required.

Libraries required for AIX If you are using AIX, ensure that you have the
following libraries:

• libgcc-4.8.5-5.aix7.1.ppc.rpm
• libstdc++-4.8.5-5.aix7.1.ppc.rpm

Note: Do not install versions later than 4.8.x. Later
versions of the libraries are not compatible with
the installation server.

Prerequisite software for the database server
You must install the required software on the database server, including any fix packs, patches, or other
service updates.

For more information, see Supported Software Environments (http://www.ibm.com/support/docview.wss?
uid=swg27039467).
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Table 7: Supported database server software

Database server software Version

IBM DB2 11.1.0.x or 11.1.1.x

If you are installing the database server on a
Microsoft Windows operating system, ensure that
the C:\ drive contains a minimum of 8GB free disk
space for temporary files that are created during
the installation.

If you are installing the database server on a Linux
operating system, ensure that the temp directory
contains sufficient free disk space for log files that
are created during the installation.

Oracle 12.1.0.2 and later fix packs

If you use field level encryption for long string
fields, you need to apply an Oracle patch to fix an
Oracle issue.

For more information about using Oracle 12.1.0.2,
see “Upgrading the Oracle database server to
12.1.0.2” on page 76 and “Oracle 12.1.0.2
database server considerations” on page 75.

Prerequisite software for application servers
Ensure that you install the prerequisite software on all application servers and the deployment manager.

The following table lists the software requirements for application servers.

Table 8: Software prerequisites for application server computers

Requirement Specification

Application server IBM WebSphere Application Server Network
Deployment 9.0.0.3 and all fix packs, and IBM
WebSphere SDK Java Technology Edition 8.

All servers across a cluster must have the same
WebSphere version.

The OpenPages GRC Platform installation requires
that the application server software is installed to a
path with no spaces.
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Table 8: Software prerequisites for application server computers (continued)

Requirement Specification

Database client software IBM DB2 or Oracle database client software.

If the database server is on a separate computer,
install the database client software on each
OpenPages application server in your deployment.

For DB2, ensure that you use the same version for
the database client software and database server
software. Apply all required patches, interim fixes,
or services to both the database server and the
database client software.

For Oracle, ensure that you use version 12.1.0.2 or
a later fix pack.

If you are using the same computer for the
application server and reporting server, and you
want to install Oracle 12.1.0.2, you must install the
32-bit version.

IBM Installation Manager (IIM) IIM is used to install IBM WebSphere Application
Server

IBM WebSphere Application Server requires IIM
1.8.7 or later.

IIM is also used to deploy IBM OpenPages Loss
Event Entry and IBM OpenPages GRC SDI
Connector for UCF Common Controls Hub.

Prerequisite software for reporting servers
The following table provides the software requirements for reporting servers.

Table 9: Software prerequisites for reporting server computers

Requirement Specification

Reporting server Cognos Analytics V11.0.7 Interim Fix 1001 or later
fix packs.

For information about the software prerequisites
for Cognos Analytics, see the IBM Cognos Analytics
Installation and Configuration Guide.

If you are using Linux 7.x, update pam.x86_64 and
then install pam.i686. For example, run yum
install pam.x86_64 and then run yum
install pam.i686.

Web server One of the following web servers:

• Apache HTTP Server 2.2 or later
• IBM HTTP Server 8.5.5 or later
• Microsoft IIS 8.0 and later fix packs (Windows

only)
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Table 9: Software prerequisites for reporting server computers (continued)

Requirement Specification

Database client software IBM DB2 or Oracle database client software.

If the database server is on a separate computer,
install the database client software on each
reporting server in your deployment.

For DB2, ensure that you use the same version for
the database client software and database server
software. Apply all required patches, interim fixes,
or services to both the database server and the
database client software.

For Oracle, ensure that you use version 12.1.0.2 or
a later fix pack.

The 32-bit Oracle database client is required by
the reporting server. If you are using the same
computer for the application server and reporting
server, you must install the 32-bit version.

Prerequisite software for the search server
The following table provides the software requirements for the search server.

The search server must be installed on a different computer from the IBM OpenPages GRC Platform
application server.

Table 10: Software prerequisites for the search server computer

Requirement Specification

IBM Runtime Environment for Java8 IBM Java JRE 8.0_64

IBM JRE is available on the IBM OpenPages GRC
Platform installation media.

Install the IBM Runtime Environment for Java (IBM
JRE) and set up the system environment variables
for Java on the search server computer before you
install global search.

If you are using AIX on the search server, bash is required.

Prerequisite software for the workflow server
The following table provides the software requirements for the workflow server.
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Table 11: Software prerequisites for the workflow computer

Requirement Specification

IBM Business Process Manager IBM Business Process Manager 8.5.7 and later fix
packs

For more information, see IBM Business Process
Manager Standard detailed system requirements.

Note: If you already have IBM Business Process
Manager installed, you can use your existing
installation.

Prerequisite software for OpenPages GRC Platform client computers
Ensure that prerequisite software is installed on all computers that access IBM OpenPages GRC Platform.

The following table lists the software requirements for client computers.

Table 12: Software prerequisites for client computers

Requirement Specification

Web browser Microsoft Internet Explorer version 11 running in
Native view.

Google Chrome 46 or later.

PDF reader For example, Adobe Reader.

Optional: Microsoft Excel Microsoft Excel 2010 or 2013.

Required for some reporting functions.

Optional: Microsoft .NET Framework Required on client computers where IBM Cognos
for Microsoft Office products are installed. For
more information, see the Cognos documentation.

Hardware prerequisites
To ensure that your product works properly, you must have hardware that is correctly sized for your IBM
OpenPages GRC Platform deployment. Review the hardware prerequisites before installing the
deployment.

IBM OpenPages GRC Platform has recommended and required minimum values per server for disk space
and recommended minimum values for CPU and RAM. During the installation process, the actual capacity
of the servers in your deployment is checked. A warning is issued if a server does not have the
recommended capacity for CPU, RAM, or disk space. An error is issued if a server does not have the
required minimum capacity for disk space. Errors must be addressed for the installation process to
continue.
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VMWare configuration requirements on Windows computers
The VMWare performance on a virtualized system is comparable to hardware. You can use the hardware
guidelines for the database server, application server, reporting server, or search server for sizing VM
requirements.

Cloning of IBM OpenPages GRC Platform application server VMs is not supported.
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Chapter 5. OpenPages installation server and app
Use the IBM OpenPages GRC Platform installation server to install and upgrade OpenPages. You can also
use it to apply fix packs and interim fixes. The installation server includes a web interface, called the
installation app. The installation app is installed when you install the OpenPages installation server.

You can set up the installation server on one of the servers in your OpenPages environment or on a
separate computer.

For example, you can set up the installation server on the admin application server, and then log in to the
installation app from your laptop.

Or, you can set up the installation server on your laptop, and log in to the app from your laptop.

Important: If you use Windows servers in your deployment, set up the OpenPages installation server on a
Windows computer.

The installation server uses installation agents to install components on remote servers. The installation
server pushes the agent software to the remote servers and starts the agents automatically. Or, you can
install the agent software manually on remote servers, if you prefer.

Installation on different operating systems
You can use different operating systems in your IBM OpenPages GRC Platform deployment.

If your deployment includes servers that are running on Microsoft Windows, install the IBM OpenPages
GRC Platform installation server on a Windows computer.

For example, if your deployment uses application servers and reporting servers that are running on Linux
and a search server that is running on Windows, install the installation server onto a Windows computer.

If the servers in your deployment are running on Linux or AIX, you can install the IBM OpenPages GRC
Platform installation server on a Linux, AIX, or Windows computer.

Supported shells for UNIX installations

You can run the installation server on the Bourne shell (/bin/sh), Bourne Again Shell, (/bin/bash),
C-Shell (/bin/csh), or Korn Shell (/bin/ksh).

Setting up the installation server on Windows
You can set up the installation server on a server in your deployment or on a separate computer. Use a
computer that can communicate with the servers in your OpenPages environment.

After you set up the installation server, you can use the OpenPages installation app to create and manage
deployments.

Before you begin
The computer where you set up the installation server must meet the following requirements:

• IBM Java 8 is installed.
• Java is included in the PATH system environment variable.

You might also want a PDF reader application on the computer. When you install or upgrade OpenPages,
you can download validation reports in PDF format.

Procedure

1. Log on to the computer as an administrator.



2. Do one of the following steps:

• Update the antivirus policy on the installation server computer to allow Node.js.
• Disable antivirus software on the installation server computer. You can re-enable it after you install

the installation server.
3. Create a new directory.

For example, C:\IBM\OPInstall.
4. Locate the installation files.

The files are stored in \OP_<version>_Non_Embedded\OP_<version>_Installer .
5. Copy the \OP_<version>_installer directory to the directory that you created.
6. Change directory to <installation_server_home>\OP_<version>_installer\install
\Windows.

7. Open a command prompt as an administrator.
8. Run the installation script.

You can use the /p parameter to set the password for the initial installation app user, called admin. If
you exclude the parameter, the install.bat script prompts you for the password.

Syntax:

install.bat –acceptLicense [/p:password]

Note: You can also use an optional /s parameter to stop the installer from starting automatically
after the install.bat file completes.

9. If you did not use the /p parameter, type a password and then press Enter.
10. After the installation completes, re-enable the antivirus software on the installation server.

Do this step if you disabled the antivirus software in step “2” on page 34.

Results

The OpenPages installation server is installed and started. You can now log in. For the user name, type
admin. For the password, type the password that you set when you ran the install.bat script. See
“Logging in to the installation app” on page 37.

Setting up the installation server on Linux or AIX
You can set up the installation server on a server in your deployment or on a separate computer. Use a
computer that can communicate with the servers in your OpenPages environment.

After you set up the installation server, you can use the OpenPages installation app to create and manage
deployments.

Important: If you use Windows servers in your deployment, set up the OpenPages installation server on a
Windows computer. See “Setting up the installation server on Windows” on page 33.

Before you begin
The computer where you set up the installation server must meet the following requirements:

• IBM Java 8 is installed.
• Java is included in the PATH system environment variable.
• JAVA_HOME is set.

You might also want a PDF reader application on the computer. When you install or upgrade OpenPages,
you can download validation reports in PDF format.
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About this task

This video demonstrates how to set up the installation server: https://youtu.be/ojQgmgQI5Qs.

Procedure

1. Log on to the computer as an administrator.
2. Do one of the following steps:

• Update the antivirus policy on the installation server computer to allow Node.js.
• Disable antivirus software on the installation server computer. You can re-enable it after you install

the installation server.
3. Create a directory.

For example, /home/opuser/IBM/OPInstall.
4. Locate the installation files.

The files are stored in /OP_<version>_Non_Embedded/OP_<version>_Installer.
5. Copy the OP_<version>_Installer directory to the directory that you created.
6. Change directory to /home/opuser/IBM/OPInstall/OP_<version>_Installer/install/
Linux. Or, if you are using AIX, go to /home/opuser/IBM/OPInstall/
OP_<version>_Installer/install/AIX

7. Grant the +rwx permission to the user on the installation server directory, subdirectories, and scripts.
8. Open a shell and run the setup script.

You can use the -p parameter to set the password for the initial installation app user, called admin. If
you exclude the parameter, the install.sh script prompts you for the password.

Syntax:

./install.sh –-acceptLicense [-p:password]

Note: You can also use an optional -s parameter to stop the installer from starting automatically
after the install.sh file completes.

9. If you did not use the -p parameter, type a password and then press Enter.
10. Close the shell window.
11. After the installation completes, re-enable the antivirus software on the installation server.

Do this step if you disabled the antivirus software in step “2” on page 35.

Results

The OpenPages installation server is installed and started. You can now log in. For the user name, type
admin. For the password, type the password that you set when you ran the install.sh script. See
“Logging in to the installation app” on page 37.

Installing agents manually
The installation server can automatically install the agent software on remote servers. But you can install
the agent software manually, if you prefer.

Before you begin

The computer where you install the agent software must meet the following requirements:

• IBM Java 8 is installed.
• Java is included in the PATH system environment variable.

OpenPages installation server and app  35

https://youtu.be/ojQgmgQI5Qs


About this task

When you specify the deployment properties for a remote server, you are asked to provide the user name
and password of an administrator account on the remote server. The installation server uses these
credentials to install the agent software on the remote server. However, your organization might have
policies that restrict the use of administrator credentials. In this case, you can install the agent software
manually before you install IBM OpenPages GRC Platform.

The overall process involves the following steps:

1. Install the agent software manually and start the agent on each remote server, except the database
server. The agent software is not needed on the database server.

2. In the installation app, enter the deployment properties for the remote servers.

• Enable the Remote Deploy option.
• Use Agent for the Local User Name and Local User Password.

Note: If the real local account uses Agent for the user name or password, use different text for the
Local User Name and Local User Password.

• In the Agent Directory field, type the full path to the directory on the remote server where you
installed the agent software. This directory is the <agent_home> directory.

Procedure

1. Log on to the remote server as an administrator.
2. Do one of the following steps:

• Update the antivirus policy on the remote server to allow Node.js.
• Disable antivirus software on the remote server. You can re-enable it after you install the agent

software.
3. Create a directory.

For example:

• Windows: C:\IBM\OPAgent
• Linux or AIX: /home/opuser/IBM/OPAgent

This directory will be the <agent_home> directory for the remote server.
4. Copy the agent installation software to the remote server.

a) Locate the following file on the installation server: <installation_server_home>/op-
installer-agent.zip.

b) Copy op-installer-agent.zip to the <agent_home> directory that you created on the
remote server.

c) Extract the op-installer-agent.zip file into the <agent_home> directory.
5. Open a shell or command window. If you are using Windows, open the command window as an

administrator.
6. Go to the <agent_home>/install/<OS> directory.
7. Run the following script to install the agent software:

• Windows:

install.bat -acceptLicense

• Linux or AIX:

chmod 755 install.sh
./install.sh -acceptLicense

8. When the script completes, close the shell or command window.
9. Start the agent.
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See “Starting the installation agent manually” on page 41.
10. Repeat these steps on each remote server, except the database server.

What to do next

When you fill in the server properties, do the following:

• Enable the Remote Deploy option.
• In the Agent Directory field, type the full path to the <agent_home> directory on the remote server.
• Update the Local User Name and Local User Password fields. Use Agent for the Local User Name and

Local User Password.

Logging in to the installation app
Use the installation app to create a new deployment or to work with an existing deployment.

Before you begin
The installation server must be running.

Procedure

1. Open Google Chrome or Microsoft Internet Explorer.
2. Go to https://<host>:<port_number>.

• Replace <host> with the name of the computer where you set up the installation server.
• Replace <port_number> with the port number of the installation server. The default port number is

8443.

For example, https://appserver1.mycompany.com:8443

If you are running the installation server on your local computer, go to https://localhost:8443
3. Enter your credentials.
4. Review and accept the terms and conditions.
5. Click Login.

Adding users
You can set up additional user accounts to access the IBM OpenPages GRC Platform installation app.

About this task

You add users by editing the <install_server_home>/src/db/jsonDB.json file.

Create a backup of the jsonDB.json file before you begin.

When you save the file and restart the installation server, the passwords in the file are encrypted.

This video demonstrates how to add users and update user passwords:

https://youtu.be/0RGTvjrb02s

Procedure

1. Log out of the IBM OpenPages GRC Platform installation app.
2. Stop the installation server.

For more information, see “Stopping the installation server” on page 40.
3. Open the <install_server_home>/src/db/jsonDB.json file in a text editor.

OpenPages installation server and app  37

https://youtu.be/0RGTvjrb02s


4. Use the following code as a guide to help you to add user accounts.

{
  "token": [],
  "user": [
    {
      "name": "admin",
      "password": "{AES}QiTCrj1RuBgvLvKHm32JoQ==",
      "id": "101",
      "encrypted": true
    },
    {
      "name": "<new_user>",
      "password": "<new_user_password>",
      "id": "102"
    },
    {
      "name": "<new_user>",
      "password": "<new_user_password>",
      "id": "103"
    }
  ]
}

Note the following requirements:

• Each user name must be unique.
• Each user account must have a unique ID.

The last block (with ID 103 in this example) does not end with a comma.
5. Save the file and close it.
6. Start the installation server.

On Windows:

a. Go to the <installation_server_home> directory. For example c:\74Installer
\OP_<version>_Installer.

b. Right-click the startup.bat file and click Run As Administrator

On Linux or AIX:

a. Open a shell and go to the <installation_server_home> directory, for example /home/
opuser/74Installer/OP_<version>_Installer.

b. Run the following command:

./startup.sh

Results
The user accounts are added and the passwords in the jsonDB.json file are encrypted.

Changing passwords
You can change the passwords of the installation app user accounts.

About this task

You change passwords by editing the <install_server_home>/src/db/jsonDB.json file.

Create a back up of the jsonDB.json file before you begin.

When you save the file and restart the installation server, the passwords in the file are encrypted.

Procedure

1. Log out of the IBM OpenPages GRC Platform installation app.
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2. Stop the installation server.
For more information, see “Stopping the installation server” on page 40.

3. Open the <install_server_home>/src/db/jsonDB.json file in a text editor.
4. Locate the user whose password you want to change, for example admin2.

{
  "token": [],
  "user": [
    {
      "name": "admin",
      "password": "{AES}QiTCrj1RuBgvLvKHm32JoQ==",
      "id": "101",
      "encrypted": true
    },
    {
      "name": "admin2",
      "password": "{AES}QiTCrj1RuBgvLvKHm32JoQ==",
      "id": "102",
      "encrypted": true
    },
    {
      "name": "admin3",
      "password": "{AES}IAHJQUu_MiqdcX2LtugZcA==",
      "id": "103",
      "encrypted": true
    }
  ]
}

5. Delete the encrypted password and then type a new password.
6. Delete the comma after the id value.
7. Delete the "encrypted": true line.

The result is:

{
  "token": [],
  "user": [
    {
      "name": "admin",
      "password": "{AES}QiTCrj1RuBgvLvKHm32JoQ==",
      "id": "101",
      "encrypted": true
    },
    {
      "name": "admin2",
      "password": "<new_password>",
      "id": "102"
    },
    {
      "name": "admin3",
      "password": "{AES}IAHJQUu_MiqdcX2LtugZcA==",
      "id": "103",
      "encrypted": true
    }
  ]
}

8. Save the file and close it.
9. Start the installation server.

On Windows:

a. Go to the <installation_server_home> directory. For example c:\74Installer
\OP_<version>_Installer.

b. Right-click the startup.bat file and click Run As Administrator

On Linux or AIX:

a. Open a shell and go to the <installation_server_home> directory, for example /home/
opuser/74Installer/OP_<version>_Installer.
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b. Run the following command:

./startup.sh

Results
The passwords are changed and they are encrypted in the jsonDB.json file.

Starting the installation server
If you stop the IBM OpenPages GRC Platform installation server you can restart it.

Procedure

1. Log on to the computer where you set up the installation server.
2. Start the installation server.

On Windows:

a. Go to the <installation_server_home> directory. For example c:\74Installer
\OP_<version>_Installer.

b. Right-click the startup.bat file and click Run As Administrator

On Linux or AIX:

a. Open a shell and go to the <installation_server_home> directory, for example /home/
opuser/74Installer/OP_<version>_Installer.

b. Run the following command:

./startup.sh

Results

The installation server is running. You can now log in to the installation app. See “Logging in to the
installation app” on page 37.

Stopping the installation server
You can stop the IBM OpenPages GRC Platform installation server.

Procedure

1. Log on to the computer where you set up the installation server.
2. Stop the installation server.

On Windows:

• Stop the ibmopenpagesgrcplatforminstaller<version>.exe service.
• Or, go to the <installation_server_home> directory, open a command prompt as an

administrator, and run the following command:

npm run stop

On Linux or AIX:

a. Open a shell and go to the <installation_server_home> directory, for example /home/
opuser/IBM/OPInstall/OP_<version>_Installer.
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b. Run the following command:

npm run stop

Results

The installation server is stopped. To restart it, see “Starting the installation server” on page 40.

Starting the installation agent manually
You can start the agent on a remote server manually.

About this task

When you specify the deployment properties for a remote server, you are asked to provide the user name
and password of an administrator account on the remote server. The installation server uses these
credentials to start and stop the agent software on the remote server. If you install the agent software
manually and you use Agent for the remote server login credentials, you need to start and stop the agent
manually. You cannot use the installation app to start or stop the agent.

You might also choose to start and stop agents manually if you prefer to use the command line.

Procedure

1. Log on to the remote server as the user who installed the agent software.

Alternatively, you can log in as any user who has full permissions on the agent directories and who can
run Node.js.

2. Start the installation agent.

On Windows:

a. Go to the <agent_home>\install\Windows directory.
b. Open a command prompt as an administrator.
c. Run the following command:

startup.bat

On Linux or AIX:

a. Open a shell and go to the <agent_home>/install/<OS> directory.
b. Run the following command:

./startup.sh

Results

The installation agent is running.

Stopping the installation agent manually
You can stop the agent on a remote server manually.

About this task

When you specify the deployment properties for a remote server, you are asked to provide the user name
and password of an administrator account on the remote server. The installation server uses these
credentials to start and stop the agent software on the remote server. If you install the agent software
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manually and you use Agent for the remote server login credentials, you need to start and stop the agent
manually. You cannot use the installation app to start or stop the agent.

You might also choose to start and stop agents manually if you prefer to use the command line.

Procedure

1. Log on to the remote server as the user who installed the agent software.

Alternatively, you can log in as any user who has full permissions on the agent directories and who can
run Node.js.

2. Stop the installation agent.

• Windows: Stop the ibmopenpagesgrcplatforminstaller<version>.exe service. Or, open a
command prompt as an administrator, go to the <agent_home> directory, and run the following
command:

npm run stop

• Linux or AIX: Go to the <agent_home> directory and run the following command:

npm run stop

Results

The installation agent is stopped.

Changing the port number of the installation server
You can change the port number of the IBM OpenPages GRC Platform installation server. This task is
optional.

Procedure

1. Log on to the computer where you set up the installation server.
2. If the installation server is running, stop it.

On Windows:

• Stop the ibmopenpagesgrcplatforminstaller<version>.exe service.
• Or, go to the <installation_server_home> directory, open a command prompt as an

administrator, and run the following command:

npm run stop

On Linux or AIX:

a. Open a shell and go to the <installation_server_home> directory, for example /home/
opuser/IBM/OPInstall/OP_<version>_Installer.

b. Run the following command:

npm run stop

3. Create a .env file to set the port number.
a) Create a new file and add the following line:

INSTALLER_PORT=<port_number>

Example:

INSTALLER_PORT=9091

42   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide



b) Save the file in the <installation_server_home> directory. Name the file .env.

Example: <installation_server_home>/.env
4. Start the installation server.

On Windows:

a. Go to the <installation_server_home> directory. For example c:\74Installer
\OP_<version>_Installer.

b. Right-click the startup.bat file and click Run As Administrator

On Linux or AIX:

a. Open a shell and go to the <installation_server_home> directory, for example /home/
opuser/74Installer/OP_<version>_Installer.

b. Run the following command:

./startup.sh

Results

The port number of the installation server is updated. Use the new port number when you log into the
installation app: https://<host>:<port_number>.
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Chapter 6. Install IBM OpenPages GRC Platform
You can use the installation app to install IBM OpenPages GRC Platform.

For videos about how to install OpenPages, see the IBM Industry Platforms Support and Documentation
channel.

Installation process overview
Installing OpenPages GRC Platform requires the following steps.

• Install the OpenPages installation app. See Chapter 5, “OpenPages installation server and app,” on page
33.

• Set up the servers that you want to use in your deployment and install the prerequisite software. See
“Preparing your system for installation” on page 46.

• Decide how you want to create the database. You can use the OpenPages installation app to install the
database or you can use scripts to do some or all of the database installation steps. If you are using IBM
DB2 , see “OpenPages database object creation for DB2” on page 103. If you are using Oracle, see
“OpenPages database schema creation for Oracle” on page 110.

• Install OpenPages. You can use the installation app or you can do a silent installation.

The following tasks are required:

– “Configuring the database server (DB2)” on page 125 or “Configuring the database server (Oracle)”
on page 127

– “Configuring the deployment manager” on page 129
– “Configuring application servers” on page 131
– “Configuring reporting servers” on page 133

The following tasks are optional:

– “Configuring a search server” on page 134
– “Workflow server configuration” on page 135

• Do the post-installation tasks. See “Post installation tasks” on page 135.

https://www.youtube.com/channel/UCc8wk4zAveqojk0Qi9O6pOw/featured


Figure 10: Installation process overview

Preparing your system for installation
Before you install IBM OpenPages GRC Platform, prepare the servers that you are going to use in your
deployment.

Checklist if you are using existing hardware
Do the following steps if you are installing OpenPages on existing hardware where you have an older
version of OpenPages installed.

1. Stop all servers (OpenPages, Cognos, and global search).
2. Back up the existing OpenPages environment. For more information, see “Backing up your source

environment” on page 174.
3. Use new directory paths for the new installation.
4. If you are using Microsoft Windows:

• For Cognos Analytics to start, ensure that <JAVA_HOME> is set to Java 8 before you start the Cognos
servers.

• If Cognos fails to start and the error, Bad Major Version, is issued, Cognos did not pick up the change
to <JAVA_HOME>.
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You must set the Java 8 location as the <JAVA_HOME> variable in the ibmcognos_location/
bin64/bootstrap_wlp_<OS>.xml file.

<param>-java_home=C:\IBM\WebSphere9\AppServer\java\8.0\jre</param>

This known issue can occur only on a Windows server where IBM WebSphere and Cognos reside on
the same server.

Checklist for Windows servers
Do the following tasks on each Microsoft Windows server before you install IBM OpenPages GRC
Platform:

• Make sure that the clocks are synchronized across the application servers, database server, reporting
servers, search server, and the deployment manager server.

• Enable Data Execution Prevention (DEP). See “Enabling Data Execution Prevention for essential
Windows programs and services” on page 47.

Do the following additional tasks on all servers except the database server:

• Create the OpenPages installation user and add the user to the power users or admin group. See “Users
and groups for installations on Windows” on page 47.

Enabling Data Execution Prevention for essential Windows programs and services
By default, Windows Server uses settings that are designed to prevent an application from running
unauthorized programs. These settings can interfere with the IBM OpenPages GRC Platform installation.
Configure Data Execution Prevention (DEP) before starting the installation to prevent any issues.

Procedure

1. Log on to the server.
2. Open Windows Explorer.
3. Right-click This PC and click Properties.
4. Click Advanced System Settings.
5. On the Advanced tab, under the Performance heading, click Settings.
6. In the Performance Options window, click the Data Execution Prevention tab, and then select Turn

on DEP for essential Windows programs and services only.
7. Click OK and then restart your system to enable the change.
8. Repeat these steps for each Windows server in the installation.

What to do next

When the installation of all software is complete, you can disable the setting.

Users and groups for installations on Windows
To install and configure IBM OpenPages GRC Platform on a Windows operating system, you must set up
an OpenPages installation user that is a member of the power user or administrator group.

In this guide, the OpenPages installation user is called opuser.

Important: The password for this user cannot contain spaces or special characters.

Checklist for Linux and AIX servers
Do the following tasks on each Linux or AIX server before you install IBM OpenPages GRC Platform:

• Make sure that the clocks are synchronized across the application servers, database server, reporting
servers, search server, and the deployment manager server.

• Set the file descriptor limit for OpenPages users.
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– If you are using Linux, see “Setting the file descriptor limit for OpenPages GRC Platform users on
Linux ” on page 48.

– If you are using AIX, see “Setting the file descriptor limit for OpenPages GRC Platform users on AIX ”
on page 49.

Do the following additional tasks on all application servers (admin and non-admin), the deployment
manager server, reporting servers (active and standby), and the search server:

• If you are using Linux, check the operating system limits that are set on the server. See “Check
operating system limits on Linux” on page 50.

Do the following additional task on all application servers (admin and non-admin) and the search server:

• Create the users and groups for installing OpenPages. See “Users and user groups for installation on
AIX and Linux” on page 50

• Create the OpenPages installation directory and give the OpenPages installation user access. See
“Creating the installation directories for AIX or Linux” on page 51.

Setting the file descriptor limit for OpenPages GRC Platform users on Linux
You must set the soft and hard limits for the file descriptor and update system files to allocate sufficient
resources to the IBM OpenPages GRC Platform users. You must complete this task on all Linux operating
system servers in your environment.

Procedure

1. Log on to the application server as the root user.
2. Verify that the /etc/pam.d/system-auth file contains the correct settings by typing the following

commands:

• cat /etc/pam.d/system-auth | grep session | grep pam_unix.so

The system response: session required pam_unix.so
• cat /etc/pam.d/system-auth | grep session | grep pam_limits.so

The system response: session required pam_limits.so

Both commands must return a session line.
3. To determine the current value of the fs.file-max property that is set in the /etc/sysctl.conf file,

type the following command:

cat /etc/sysctl.conf | grep fs.file-max

• If the fs.file-max setting does not exist, add it to the /etc/sysctl.conf file by typing the
following commands:

echo "# Added to increase system open files" >> /etc/sysctl.conf
echo "fs.file-max=500000" >> /etc/sysctl.conf

• If the fs.file-max setting exists, but it is set to less than 500000, change the fs.file-max setting to
500000.

4. Change the file descriptor limits in the /etc/security/limits.conf file by adding the following
text to the end of the file before the #End of file text.

*  soft nofile 100000

*  hard nofile 200000

*  soft stack 10240

5. To determine the startup limits for the number of processors, type the following command:

ls /etc/security/limits.d/90-nproc.conf

• If this 90-nproc.conf file exists, then modify the number of processes to 4096.
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• If the file does not exist, add the following lines to the end of the /etc/security/limits.conf
file:

* soft nproc    4096
* hard nproc    5120

The soft limit provides a specific limit that can be exceeded, for a short period, up to the system
hard limit.

6. Restart the system and then verify the settings that you changed by typing the following command:

ulimit -a

Setting the file descriptor limit for OpenPages GRC Platform users on AIX
You must set the soft and hard limits for the file descriptor and update system files to allocate sufficient
resources to the IBM OpenPages GRC Platform users. You must complete this task on all AIX operating
system servers in your environment.

Procedure

1. Log on to the operating system as root user.
2. Open the /etc/security/limits file.
3. Add the following lines to the end of the file:

opuser:
fsize = -1 
nofiles =-1

4. To set the maximum number of processes for non-root users, open a shell and type the following
command:

 chdev -l sys0 -a maxuproc='16384'

5. Restart the operating system.

Optional: Changing the TEMP directory for AIX installations
By default, the /tmp directory is configured as the TEMP directory. For AIX installations, you can change
the TEMP directory by adding variables to the .profile of the user who is installing the product.

Procedure

1. On the IBM OpenPages GRC Platform application servers, ensure that the /tmp directory on the
database server is set to a minimum size of 4 GB.

2. Log on to the application server as the OpenPages installation user.

The user has non-root privileges.
3. Use the following commands to change the TEMP directory:

export IATEMPDIR=temp_directory

export TEMP=temp_directory

export TMP=temp_directory

export TMPDIR=temp_directory

export TEMPDIR=temp_directory

For example, use the following commands:

export IATEMPDIR=/opt/temp

export TEMP=/opt/temp

export TMP=/opt/temp

export TMPDIR=/opt/temp
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export TEMPDIR=/opt/temp

Check operating system limits on Linux
If your application server, reporting server, or search server is running Red Hat Enterprise Linux, check the
operating system limits that are configured on the server.

You can run the ulimit -a command to check the limits. Update the limits, if needed, to use the
following minimum values:

core file size                (blocks, -c) 10485760
data seg size                 (kbytes, -d) unlimited
scheduling priority           (-e) 0
file size                     (blocks, -f) unlimited
pending signals               (-i) 63407
max locked memory             (kbytes, -l) 65536
max memory size               (kbytes, -m) unlimited
open files                    (-n) 100000
pipe size                     (512 bytes, -p) 8
POSIX message queues          (bytes, -q) 819200
real-time priority            (-r) 0
stack size                    (kbytes, -s) unlimited
cpu time                      (seconds, -t) unlimited
max user processes            (-u) 127457
virtual memory                (kbytes, -v) unlimited
file locks                    (-x) unlimited

If you change any values, restart the server.

Users and user groups for installation on AIX and Linux
To install IBM WebSphere Application Server and IBM OpenPages GRC Platform on a UNIX operating
system, you must create the required users and groups.

Tip: For simplicity, you can use the root user to install IBM WebSphere Application Server, then change
the owner of the IBM WebSphere directory to the same account as the OpenPages installation user.

If you prefer, you can create two separate users:

• One user to install IBM WebSphere Application Server.
• One user to install IBM OpenPages GRC Platform.

Both users must belong to the same primary group. If you create separate users, after the installation,
you must change the permissions on the installation directories and files. The group members must have
read, write, and execute permissions (775) on the files and directories.

Example: Create an AIX or Linux operating system group named opgroup. This group contains the user
that starts IBM WebSphere and the user that owns the OpenPages application server files. Install IBM
WebSphere and the OpenPages application. Ensure that the installation files and directories are writable
for the owner and that the owners are members of the same group (chmod 775 command).

Before you begin
If you are using an IBM DB2 database, see Creating group and user IDs for a DB2 database installation
(Linux and UNIX) (http://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/
com.ibm.db2.luw.qb.server.doc/doc/t0006742.html).

Procedure

1. Log on to the application server as root and open a shell.
2. To install IBM WebSphere Application Server, create a user, such as wasuser.

useradd -m wasuser
3. To create a group, such as opgroup, enter the following command:

• On AIX operating systems:

mkgroup -A opgroup
• On Linux operating systems:
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groupadd opgroup
4. Do one of the following steps:

• If you created an opgroup group, add the opuser and wasuser users to the primary group
(opgroup group).

useradd -G opgroup opuser

useradd -G opgroup wasuser
• If the same user account installs both IBM WebSphere Application Server and the OpenPages

application server, create a user, such as opuser.

useradd -m opuser
5. Change the password for the OpenPages installation user by using the following command:

passwd opuser
6. Change the password for the IBM WebSphere Application Server installation user by using the

following command:

passwd wasuser
7. On AIX and Linux operating systems, grant read, write, and execute permissions to the home directory

of the OpenPages installation user.

chmod 755 /home/opuser

For local installations on Linux operating systems, the OpenPages installation user is the user who runs
the OpenPages installation program.

For remote installations on AIX and Linux operating systems, the OpenPages installation user is the
user who connects to the remote server.

What to do next
After you install IBM WebSphere Application Server and OpenPages application server, ensure that
installation directories and files have write permission for the group.

Creating the installation directories for AIX or Linux
You must create the installation directories for OpenPages GRC Platform and change the ownership of
these directories to the OpenPages installation user. Do this task if you are installing OpenPages GRC
Platform on a UNIX operating system.

Procedure

1. Log on to the application server computer as the root user.
2. If the installation directory for OpenPages does not exist, create it by typing the following command.

Restriction: Ensure that the directory to which you install OpenPages contains only ASCII characters
in the path name.

mkdir -p <directory>

Example:

mkdir -p /OpenPages
3. Change the ownership of the directory to the OpenPages installation user.

Tip: For simplicity, you can use the root user to install IBM WebSphere Application Server, then change
the owner of the IBM WebSphere directory to the same account as the OpenPages installation user.

chown -R opuser /OpenPages
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Checklist for application servers
Do these tasks on each application server before you install IBM OpenPages GRC Platform:

• Check that all of the required ports are available. See “Port assignments ” on page 102.
• Set the DB2_HOME or ORACLE_HOME environment variable.
• If you are using Microsoft Windows, set the TMP and TEMP environment variables to a location that is

accessible by all users. For example, use C:\TEMP instead of C:\Users\ADMINI~1\AppData\Local
\Temp. See “Changing the Temp directory for Windows application servers” on page 52.

• If you are using a horizontal cluster for the application servers, do the following tasks:

– Set up the load balancer.
– If you are using Microsoft Windows application servers, configure a domain account. See “Configuring

OpenPages GRC Platform applications to use a domain account on Windows operating systems” on
page 139

– If you are using Linux or AIX application servers, configure file permissions. See “Configuring file
share permissions on AIX or Linux operating systems” on page 139

• Install IBM Installation Manager (IIM is used to install IBM WebSphere Application Server). See
“Installing IBM Installation Manager” on page 54.

• Install IBM WebSphere Application Server and the IBM Java JRE that is supplied with IBM WebSphere
Application Server. See “Installing IBM WebSphere Application Server Network Deployment” on page
54.

• Set the JAVA_HOME environment variable to point to the IBM Java JRE that is supplied with IBM
WebSphere Application Server.

• If the database server is on a separate computer:

– If you are using IBM DB2, see “DB2 database client installations” on page 73.
– If you are using Oracle, see “Oracle database client installations” on page 83.

Do these additional tasks on the admin application server (AppServer1):

• Configure the hosts file. See “Configuring the hosts file” on page 53.

Changing the Temp directory for Windows application servers
You can change the location of the Temp directory by changing environment variables in the system
properties.

About this task

By default, the TEMP and TMP environment variables are set to a hidden user folder location. The folder
location is typically %USERPROFILE%\AppData\Local\Temp. You can change the location of the
directory by changing the TEMP and TMP environment variables in the system properties.

If you use more than one administrator level user account to install IBM OpenPages GRC Platform, install
fix packs, or perform upgrades, do the steps in this topic to avoid potential privilege violations that can
occur during a deployment.

Procedure

1. Ensure that the TEMP directory that you want to use is set to at least 8 GB on each application server.
2. Log on to application server as the OpenPages administrator.
3. Right-click This PC and click Properties.
4. Click Advanced System Settings and then click Environment Variables.
5. Select the TEMP variable and click Edit.
TEMP and TMP might be defined as system variables or user variables, depending on how your system
is set up.

6. In the Variable value box, type the new folder location and click OK.
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For example, type c:\temp.
7. Repeat the steps to change the folder location for the TMP variable.
8. Click OK.

Configuring the hosts file
You must ensure that the computer that you use to deploy IBM OpenPages GRC Platform can connect to
each computer on which you install the database server, application servers, reporting servers, and
search server. You must also ensure that each server in your deployment can successfully ping and
perform a trace route to and from each of the other servers.

Procedure

1. Log on to the admin application server as the admin user.
2. Edit the hosts file:

• For UNIX, go to the /etc directory and open the hosts file in a text editor.
• For Windows, open the C:\Windows\System32\drivers\etc\hosts file.

3. Add the IP address and name of each OpenPages application server, reporting server, search server,
and database server.

4. Save and close the hosts file.
5. Repeat these steps for each OpenPages application server, reporting server, search server, and

database server.

IBM WebSphere Application Server installations
IBM WebSphere Application Server must be installed and running on each computer where you plan to
install the IBM OpenPages GRC Platform application server.

Moving from IBM WebSphere Application Server 8.5.5.x

If you have a previous version of OpenPages GRC Platform with IBM WebSphere Application Server
version 8.5.5.x, you must do a new installation of 9.0.0.x.

Tip: You do not need to uninstall WebSphere 8.5.5. WebSphere supports the installation of multiple
versions on a server. For more information, see the WebSphere documentation.

Installation restrictions

Review the following restrictions before you install IBM WebSphere Application Server.

Supported WebSphere Application Server software environments
Ensure that you are using a supported version of IBM WebSphere Application Server. The OpenPages
GRC Platform installation program verifies the version. For more information about supported
software environments, see Review the IBM OpenPages GRC Platform supported software
environments and other system requirements.

Note: IBM product fixes and updates are available from IBM Fix Central (www.ibm.com/support/
fixcentral/).

Installation path cannot contain spaces

The installation path for IBM WebSphere Application Server must not contain spaces. The default
location is <path>/WebSphere/AppServer.

For Windows installations, if IBM WebSphere Application Server is installed in a directory with spaces,
you can enter the short file name convention. For example, for C:\Program Files\IBM
\WebSphere\AppServer, enter C:\PROGRA~1\IBM\WebSphere\AppServer.
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Installing IBM Installation Manager
You use IBM Installation Manager to install IBM WebSphere Application Server, Cognos Analytics, and
some other components, such as IBM OpenPages Loss Event Entry. Install IBM Installation Manager on
each application server and reporting server.

Ensure you install the 64-bit version of IBM Installation Manager.

If an older version of IBM Installation Manager is installed, install to a new directory. For more information
about this requirement, see Update to Installation Manager 1.8 is blocked when its data location is within
its install location (http://www.ibm.com/support/docview.wss?uid=swg21692402).

For more information about IBM Installation Manager, see the Installation Manager documentation
(http://www.ibm.com/support/knowledgecenter/SSDV2W/im_family_welcome.html).

Procedure

1. Download IBM Installation Manager from Passport Advantage®.
2. Complete the following steps.

a) On Microsoft Windows, double-click install.exe.
b) On AIX or Linux, in a terminal window, enter ./install.

3. Follow the steps to install IBM Installation Manager.

Installing IBM WebSphere Application Server Network Deployment
Use IBM Installation Manager to install IBM WebSphere Application Server and fix packs.

For horizontal cluster configurations, install IBM WebSphere on the admin application server and all non-
admin application servers. You must install the same version of IBM WebSphere on each application
server.

For more information, see the IBM WebSphere documentation on IBM Knowledge Center.

Restriction: Do not install into a directory that contains spaces or non-ASCII characters.

Procedure

1. Start IBM Installation Manager.
For information about installing IBM Installation Manager, see “Installing IBM Installation Manager”
on page 54.

2. Click File > Preferences, and then click Repositories.
3. Click Add repository.
4. Enter the path to the IBM WebSphere installation files, and click OK.

If you provided an HTTPS or restricted FTP repository location, then you are prompted to enter a user
ID and password. The new or changed repository location is listed. If the repository is not accessible, a
red x is displayed in the Accessible column.

5. Click Add repository.
6. Enter the path to the IBM SDK Java 8 files, and click OK.
7. In IBM Installation Manager, click Install.
8. Select the IBM WebSphere installation package, then click Next. Follow the steps in IBM Installation

Manager to complete the installation.
9. When the installation process is complete, select whether to create a profile and then click Finish. For

OpenPages admin and non-admin application servers, select None.
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Configuring the application server
Configure the IBM OpenPages GRC Platform application servers to avoid time-outs and other issues.

Procedure

1. Open a browser window and log on to the IBM WebSphere Integrated Solutions Console as a server
administrator.

The default URL is http://<server_name>:<port>/ibm/console.
2. In the Integrated Solutions Console:

a) Expand Servers > Server Types
b) Click WebSphere Application Server.

3. On the Application servers page, click the name of the application server you want to configure.
4. On the Application servers | OpenPages-server-name page, click the Configuration tab.
5. Under the Web Container heading, click Session Management.
6. On the Session Management page:

a) Set the Maximum in-memory session count to 3000.
b) Click Apply.

7. On the Application servers | Configuration tab, under the Java and Process Management | Process
definition heading, click Java Virtual Machine.

8. On the Java Virtual Machine page:
a) Set the Initial heap size to 1024 MB.
b) Set the Maximum heap size to 3072 MB.
c) Update the Generic JVM arguments:

• Change the GC policy to -Xgcpolicy:gencon
• Change the Nursery size to -Xmn768m
• Change the -Xgcpolicy:gencon -Xmn350m -Xdisableexplicitgc to -Xthr:noAdaptSpin -

Xgcpolicy:gencon -Xmn768m -Xdisableexplicitgc.
d) Click Apply.

9. On the Application servers | Configuration tab, under the Thread Pools heading, click Web
Container.

10. On the Web Container page:
a) Set the Minimum size to 50.
b) Set the Maximum size to 500.
c) Click Apply.

11. In the Integrated Solutions Console:
a) Expand Resources | JDBC
b) Click Data Sources .
c) In the Data sources pane, click the CWTxDataSourceXA application server.
d) Click Connection pool properties.
e) On the Configuration tab, set the Maximum connections to 750.
f) Click Apply.

12. Repeat these steps on each application server.

If you are using a horizontal cluster, do these steps on each horizontal cluster member.

If you are using a vertical cluster, do these steps on each vertical cluster member.
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Checklist for the deployment manager server
If you are installing the deployment manager on a separate computer, do these tasks on the deployment
manager server before you install IBM OpenPages GRC Platform:

• Check that all of the required ports are available. See “Port assignments ” on page 102.
• Set the DB2_HOME or ORACLE_HOME environment variable.
• Install IBM Installation Manager (IIM is used to install IBM WebSphere Application Server). See

“Installing IBM Installation Manager” on page 54.
• Install IBM WebSphere Application Server and the IBM Java JRE that is supplied with IBM WebSphere

Application Server. See “Installing IBM WebSphere Application Server Network Deployment” on page
54.

The deployment manager must use a version of IBM WebSphere Application Server that is equal to or
greater than the version of IBM WebSphere Application Server that is installed on the application
servers. For example, if IBM WebSphere Application Server version 9.0.0.4 is installed on the
application server, the deployment manager must use 9.0.0.4 or a later fix pack. If possible, use the
same version on the deployment manager and application servers.

• Set the JAVA_HOME environment variable to point to the IBM Java JRE that is supplied with IBM
WebSphere Application Server.

• If the database server is on a separate computer:

– If you are using IBM DB2, see “DB2 database client installations” on page 73.
– If you are using Oracle, see “Oracle database client installations” on page 83.

Checklist for the database server (DB2)
If you use an IBM DB2 database server, do these tasks before you install IBM OpenPages GRC Platform:

• Check that all of the required ports are available. See “Port assignments ” on page 102.
• Install IBM DB2. Include the DB2 Text Search component. See “IBM DB2 database server installations”

on page 57.
• Copy the encryption function for OpenPages to the database server. See “Copying the encryption

function for OpenPages to the DB2 server” on page 58.
• Set up operating system users and groups (instance owner, DAS user, OP installation user. See

“Operating system user accounts for IBM DB2 databases” on page 71.
• Set up the schema owners (the OpenPages database user and the Cognos content store user) See

“Database schema owners” on page 72.
• Check that the database user passwords have not expired.
• Prepare a database instance for OpenPages. See “Preparing the database instances for OpenPages on

DB2” on page 69.
• Create the OpenPages database. See “Creating the OpenPages database on IBM DB2” on page 65.
• You must create a separate database for Cognos Analytics.

If the database server is on a separate computer, do one of the following tasks:

• If you are using IBM DB2, see “DB2 database client installations” on page 73.
• If you are using Oracle, “Oracle database client installations” on page 83.

IBM DB2 database server and client setup for OpenPages GRC Platform
Before you install OpenPages GRC Platform, you must complete these tasks if you are installing IBM DB2:

• Install and configure IBM DB2 on the database server.
• Prepare a DB2 database instance for the OpenPages database.
• Create the OpenPages database.
• Install the DB2 database client software on each OpenPages application server and reporting server.
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• Verify the connection between the database server and the application and reporting servers.
• Create the OpenPages database objects.

This step is optional. You can use scripts to create some or all of the database objects. Or, you can use
the OpenPages installation program to create them.

Restriction: You must use two separate databases - one for the Cognos Analytics content store and one
for the IBM OpenPages GRC Platform database.

IBM DB2 database server installations
You can use an IBM DB2 database for the IBM OpenPages GRC Platform repository.

Check the specific requirements for your system before you install IBM DB2 products.

For more information about IBM OpenPages GRC Platform supported software, see “Software
prerequisites” on page 25.

For more information about DB2 system requirements, see the DB2 for Linux, UNIX, and Windows system
requirements web page.

To use DB2 for the OpenPages database, complete following tasks:

• Install the DB2 database server using a custom installation to include the DB2 Text Search component.

The database server that hosts the OpenPages database must have the required server software
installed. DB2 must be installed before you install any required fix packs.

For more information about database server versions, see “Prerequisite software for the database
server” on page 26.

For more information about the DB2 Text Search component, see “The DB2 Text Search component ” on
page 57.

Restriction: IBM OpenPages GRC Platform does not support installation of DB2 software in directories
that contain spaces. To use DB2 software that is installed in a directory with spaces, you can enter the
short file name convention in the OpenPages installation app. For example, for C:\Program Files
\IBM\DB2\SQLLIB, use C:\PROGRA~1\IBM\DB2\SQLLIB.

• Set up the required users and groups. See “Operating system user accounts for IBM DB2 databases” on
page 71.

• Prepare the database instance. See Prepare the IBM DB2 database instance for OpenPages.
• Create the database. See “Creating the OpenPages database on IBM DB2” on page 65.

Note: For information about how to upgrade DB2, see “Upgrading IBM DB2 (Windows)” on page 58 or
“Upgrading IBM DB2 (Linux or AIX)” on page 60.

The DB2 Text Search component
The IBM DB2 Text Search component is required by the IBM OpenPages GRC Platform installation. When
you install the IBM DB2 database server, select the custom installation type and the IBM DB2 Text Search
component.

For more information, see Installing DB2 Accessories Suite for DB2 Text Search in the DB2
documentation.

If the DB2 database server is already installed on the database server computer, use the DB2 setup
program to add the DB2 Text Search function to your existing DB2 installation.

To determine whether the DB2 Text Search component is installed, run the db2ts command to start or
stop the component. If the command fails, the component is not installed. For more information about
running the command, see the DB2 search commands in the DB2 documentation.
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Copying the encryption function for OpenPages to the DB2 server
If you are doing a fresh installation or if you are upgrading and using a new computer for the database
server, you must manually copy the encryption function for IBM OpenPages GRC Platform to the IBM DB2
server.

Procedure

1. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS /bin/<PLATFORM> directory.

2. Copy the files to the following directories:

• <DB2_HOME>/FUNCTION
• <DB2_HOME>/FUNCTION/unfenced

Upgrade IBM DB2
Before you upgrade IBM OpenPages GRC Platform, upgrade IBM DB2 to version 11.1.

Upgrading IBM DB2 (Windows)
You must upgrade to a supported version of IBM DB2 before you upgrade your IBM OpenPages GRC
Platform environment.

This task provides the basic steps for upgrading IBM DB2. For more information about this process, see
the IBM DB2 Knowledge Center.

Procedure

1. Stop all OpenPages application servers.
For more information, see “Stopping application servers in a Windows environment” on page 260.

2. Stop the global search services.
For more information, see “Stopping the global search services by using a script” on page 258 and
“Stopping the global search services” on page 259.

3. Stop all IBM Cognos services.
For more information, see “Starting and stopping the Cognos services” on page 264.

4. Complete the DB2 pre-upgrade tasks for both the OpenPages database and the Cognos content
store. For more information, see Pre-upgrade tasks for DB2 servers.

If you get warnings about the discontinued SYSFUN.ASCII1 function, you can ignore them.
5. Drop the DB2 Text Search index and disable DB2 Text Search.

For more information, see “Dropping the DB2 Text Search index and disabling DB2 Text Search” on
page 64.

6. Check the value of the application heap size for the Cognos database.
a) Open the DB2 command line processor (CLP).
b) Run the following command as the database instance owner. Replace <cognosdb> with the name

of your Cognos database.

db2 get db cfg for <cognosdb> | findstr APPLHEAPSZ

c) If the value is less then 4096 then increase it to a minimum of 4096.

Open the DB2 command line processor (CLP) and run the following command as the database
instance owner. Replace <cognosdb> with the name of your Cognos database.

db2 update db cfg for <cognosdb> using applheapsz 4096

7. Back up the OpenPages database and the Cognos content store.
8. Run the IBM DB2 installation program.

58   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide

http://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.qb.server.doc/doc/c0060076.html
http://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.qb.upgrade.doc/doc/t0050541.html


The installation program installs DB2 and upgrades the existing database instances. For more
information, see Upgrading a DB2 server (Windows).
a) Click Install a Product.
b) For the Product, choose Workgroup, Enterprise and Advanced Editions. Click Work with

Existing.
c) Select the installation that you want to upgrade.
d) Select the Custom option.
e) Accept the default values for the response file settings.
f) Expand Server Support and select DB2 Text Search for installation.
g) Accept the default settings on each page of the wizard until you are prompted for the db2admin

credentials.
h) Enter the domain and password for the db2admin user.
i) Accept the default settings on the remaining pages of the wizard. Click Finish.

When the installation process completes, check the log files.
9. Upgrade your OpenPages database.

For more information, see Upgrading databases.

For example, start the DB2 command line processor (CLP) and run the following commands:

set db2instance=db2inst1
db2start 
db2 upgrade database opx user opuser using password

10. Upgrade your Cognos content store database.
For more information, see Upgrading databases.

For example, start the DB2 command line processor (CLP) and run the following commands:

set db2instance=db2inst2 
db2start 
db2 upgrade database cognosdb user db2admin using password

11. Revalidate objects, rebind packages, and redeploy the Java routines for OpenPages in the OpenPages
database.
a) Start the DB2 command line processor (CLP).
b) Run the following command:

set db2instance=db2inst1

c) Go to the \OP_<version>_Non_Embedded\OP_<version>_Configuration\Database
\DB2\INSTALL_SCRIPTS directory.

For example:

cd C:\OP\OpenPages\DB2\INSTALL_SCRIPTS

d) Revalidate the database objects.

For example:

clpplus -nw opuser/password@localhost:50000/opx 
  @sql-wrapper revalidate.sql revalidate.log opuser 

e) Rebind the packages.

For example:

db2rbind opx -l opbind.log all 
  -u db2admin -p password -r any

f) Redeploy the Java routines for OpenPages.
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For example:

manageOPJavaRoutines.bat opx opuser password remove opdb2udf.jar

manageOPJavaRoutines.bat opx opuser password 
  install opdb2udf.jar

12. Revalidate objects and rebind packages in the Cognos content store.
a) Start the DB2 command line processor (CLP).
b) Run the following command:

set db2instance=db2inst2

c) Revalidate the database objects.

For example:

db2 connect to cognosdb user db2admin using password
db2 "call sysproc.admin_revalidate_db_objects()"

d) Rebind packages in the Cognos database.

For example:

db2rbind cognosdb -l cogbind.log -u db2admin -p password

13. Apply the IBM DB2 license.
a) Extract the quick start activation file for IBM DB2.
b) Start the DB2 command line processor (CLP).
c) Go to the directory where the license file, db2ese_u.lic, is stored.
d) Run the following command:

db2licm –a db2ese_u.lic

14. Start all IBM OpenPages GRC Platform services.
15. Configure and enable DB2 Text Search, create the index, and schedule a job to synchronize the index.

For more information, see "Utilities for filtering on long string field content in a DB2 database" in the
IBM OpenPages GRC Administrator's Guide.

Upgrading IBM DB2 (Linux or AIX)
You must upgrade to a supported version of IBM DB2 before you upgrade your IBM OpenPages GRC
Platform environment.

This task provides the basic steps for upgrading IBM DB2. For more information about this process, see
the IBM DB2 Knowledge Center.

Procedure

1. Stop all OpenPages application servers.
For more information, see “Stopping all application servers in AIX and Linux using a script” on page
261.

2. Stop the global search services.
For more information, see “Stopping the global search services by using a script” on page 258 or
“Stopping the global search services” on page 259.

3. Stop all IBM Cognos services.
For more information, see “Starting and stopping the Cognos services” on page 264.

4. Mount the IBM DB2 installation media or extract the downloaded installation package onto your file
system.
a) Log in as the instance owner.
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b) Create a new directory. Do not create it under /sqllib.
c) Extract the installation package to the directory that you created.

5. Check that your system meets the installation prerequisites.
For more information, see db2prereqcheck - Check installation prerequisites.
a) Go to the DB2 V11.1 installation directory.

cd server_ese_u

b) As the root or sudo user, check the installation requirements.

./db2prereqcheck –i -v 11.1.0.0

If successful, you see the message DBT3533I The db2prereqcheck utility has
confirmed that all installation prerequisites were met.

c) Review the log file.
6. Complete the DB2 pre-upgrade tasks for both the OpenPages database and the Cognos database. For

more information, see Pre-upgrade tasks for DB2 servers.

If you get warnings about the discontinued SYSFUN.ASCII1 function, you can ignore them.
7. Check the value of the application heap size for the Cognos database.

a) Run the following command as the database instance owner. Replace <cognosdb> with the name
of your Cognos database.

db2 get db cfg for <cognosdb> | grep -i APPLHEAPSZ

b) If the value is less then 4096 then increase it to a minimum of 4096.

Run the following command as the database instance owner. Replace <cognosdb> with the name
of your Cognos database.

db2 update db cfg for <cognosdb> using applheapsz 4096

8. Drop the DB2 Text Search index and disable DB2 Text Search.
For more information, see “Dropping the DB2 Text Search index and disabling DB2 Text Search” on
page 64.

9. Back up the OpenPages database and the Cognos database.
10. Run the IBM DB2 installation program to upgrade IBM DB2

For more information, see Upgrading DB2 server (Linux and UNIX).
a) Log on to the database server as the root user and run the db2setup command.

cd <Installation Home>/servers_ese_u
./db2setup

b) Click Install a Product and New Install.
c) For the Product, choose Workgroup, Enterprise and Advanced Editions.
d) Select the Custom option.
e) Clear the Create an instance check box.
f) Expand Server Support and select DB2 Text Search for installation.
g) Accept the default settings on the remaining pages of the wizard.
h) When the installation process completes, review the log files.
i) Click Finish.

11. Upgrade your OpenPages database instance.
Perform this step as the root user
For more information, see Upgrading Version 10.5 or DB2 Version 10.1 instances.
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a) Stop all DB2 version 10.5 services.
b) Edit the /etc/services file and remove any existing entry for the DB2text service.
c) Upgrade the OpenPages database instance.

For example:

cd /opt/ibm/db2/V11.1/instance
./db2iupgrade -u db2fenc1 -j "TEXT_SEARCH,db2j_db2inst1,55000" db2inst1

d) View the log file, for example /tmp/db2iupgrade.log.20620. Verify that the upgrade was
successful. Look for the message DBI1070I Program db2iupgrade completed
successfully.

12. Upgrade your Cognos database instance.
Perform this step as the root user
For more information, see Upgrading Version 10.5 or DB2 Version 10.1 instances.

Note: Perform this step after the OpenPages database instance upgrade completes successfully.

a) Upgrade the Cognos database instance.

For example:

cd /opt/ibm/db2/V11.1/instance
./db2iupgrade -u db2fenc1 db2inst2

b) View the log file, for example /tmp/db2iupgrade.log.18463. Verify that the upgrade was
successful. Look for the message DBI1070I Program db2iupgrade completed
successfully.

13. Check the installation level for both instances.
For more information, see db2level - Show DB2 service level command.

For each instance, run the db2level command as the instance owner.

For each instance, look for a return value of DB2 v11.1.0.0.
14. If you are using DB2 Administration Server (DAS), upgrade the service.

For more information, see Upgrading the DB2 Administration Server (DAS).

For example:

cd /opt/ibm/db2/V11.1/instance
./dasmigr

The value DBI1070I Program dasmigr completed successfully indicates success.
15. Upgrade your OpenPages database.

Perform this step as a user with SYSADM authority.
For more information, see Upgrading databases.

For example:

db2start 
db2 upgrade database opx user opuser using password

16. Upgrade your Cognos database instance.
Perform this step as a user with SYSADM authority.
For more information, see Upgrading databases.

For example:

db2start 
db2 upgrade database cognosdb user db2inst2 using password

17. Configure and enable DB2 Text Search, create the index, and schedule a job to synchronize the index.
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For more information, see "Utilities for filtering on long string field content in a DB2 database" in the
IBM OpenPages GRC Administrator's Guide.

18. Revalidate objects, rebind packages, and redeploy the Java routines for OpenPages in the OpenPages
database.
Perform these steps as the instance owner for the OpenPages database.
a) Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/
Database/DB2/INSTALL_SCRIPTS directory.

For example:

cd /home/opuser/OP/OpenPages/DB2/INSTALL_SCRIPTS

b) Revalidate the database objects.

For example:

clpplus -nw opuser/password@localhost:50000/opx 
  @sql-wrapper revalidate.sql revalidate.log opuser 

c) Rebind the packages.

For example:

db2rbind opx -l opbind.log all 
  -u db2admin -p password -r any

d) Redeploy the Java routines for OpenPages.

For example:

./manageOPJavaRoutines.sh opx openpage password 
   remove /home/db2inst1/sqllib/function/jar/OPENPAGE 
./manageOPJavaRoutines.sh OPX openpage password 
   install /home/opuser/OP/OpenPages/DB2/INSTALL_SCRIPTS/opdb2udf.jar
ls -lrt /home/db2inst1/sqllib/function/jar/OPENPAGE

19. Revalidate objects and rebind packages in the Cognos database.
Perform these steps as the instance owner for the Cognos database.
a) Revalidate the database objects.

For example:

db2 connect to cognosdb user db2admin using password
db2 "call sysproc.admin_revalidate_db_objects()"

b) Rebind packages in the Cognos database.

For example:

db2rbind cognosdb -l cogbind.log -u db2inst2 -p password

20. Optional: Back up the databases.

• For the OpenPages database, run the following commands as the instance owner for the
OpenPages database:

mkdir db2v11bu
cd db2v11bu
db2 backup database opx to .

• For the Cognos database, run the following commands as the instance owner for the Cognos
database:

mkdir db2v11bu
cd db2v11bu
db2 backup database cognosdb to .

21. Apply the IBM DB2 license.
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For more information, see db2licm - License management tool command.
a) Extract the quick start activation file for IBM DB2.

b) Run the db2licm command.

For example:

db2licm -a /home/db2inst1/ese_u/db2/license/db2ese_u.lic

c) Verify the license by running the db2licm -l command.
22. Start all IBM OpenPages GRC Platform services.
23. Verify that DB2 Text Search is running.

db2connect to <openpages_database_name> user <openpages_database_user> 
  using <database_user_password>
db2 "select count(*) from <openpages_database_user>.propertyvals_clob 
  where contains(CLOB_VALUE, 'RPS') = 1"

Dropping the DB2 Text Search index and disabling DB2 Text Search
If DB2 Text Search is enabled in your source environment, drop the text search indexes, disable the text
search service, remove the DB2 administrative task to update the indexes, and disable DB2 Text Search.
Do this procedure before you back up the OpenPages database.

Procedure

1. Log on to a system as the OpenPages installation user, for example opuser.

You can use any system with access to CLPPlus that can connect to the OpenPages GRC Platform
database server.

2. Drop the DB2 Text Search index.
a) Go to the <OP_HOME>/aurora/bin/full-text-index directory.
b) Open a command or shell window and run the following command:

clpplus -nw @sql-wrapper CustomIndexing_Step5_IndexDrop.sql 
  <LOG_FILE_NAME> <DB2_SERVER_NAME> <DB2_PORT_NUMBER> <DATABASE_NAME> 
  <OP_DB_USER> <OP_DB_PASSWORD> <FORCE_DROP_INDEX>

For example

clpplus -nw @sql-wrapper CustomIndexing_Step5_IndexDrop.sql 
   CustomIndexing_Step5_IndexDrop.log localhost 50000 OPX OPENPAGE 
   password Y

Note: For more information about the script, see "Drop a long string index" in the IBM OpenPages
GRC Administrator's Guide.

3. Run the following command to determine if DB2 Text Search is enabled.

select * from all_tables where table_schema = 'SYSIBMTS';

If the command returns any data, DB2 Text Search is enabled. Continue with the next step to disable
DB2 Text Search.

4. Log on to the OpenPages database as the db2inst1 user.

db2 connect to opx user opuser using password

5. Run the following command to disable DB2 Text Search.
For more information, see SYSTS_DISABLE procedure - Disable current database for text search.

db2 "call sysproc.systs_disable('','en_US',?)"
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Alternatively, use these commands.

db2 GRANT SYSTS_ADM TO db2inst1 
db2 grant SYSTS_MGR to db2inst1
db2 connect reset 
db2ts start for text
export DB2DBDFT=OPX
db2ts DISABLE DATABASE FOR TEXT

6. Remove the DB2 administrative task to update the indexes
For more information, see the following topic in the DB2 documentation: Removing a task from the
administrative task scheduler (https://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/
com.ibm.db2.luw.admin.gui.doc/doc/t0054384.html).

Copy Java routine class files to the DB2 server
If you are using a new instance for the OpenPages database, copy the Java routine class files for IBM
OpenPages GRC Platform to the IBM DB2 server before you create the reporting schema.

Perform this task after you have upgraded your database server to IBM DB2 version 11.1.

1. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

2. Copy the following files to the DB2_HOME/FUNCTION directory:

• opconvert.class
• regexp.class

For example, on Microsoft Windows operating systems, the <DB2_HOME>\FUNCTION directory is
<install_path>\ibm\SQLLIB\FUNCTION.

On AIX or Linux operating systems, the default location is /home/<db2_instance_owner>/
sqllib/FUNCTION.

Creating the OpenPages database on IBM DB2
IBM OpenPages GRC Platform requires an OpenPages database. You must create the database before you
install IBM OpenPages GRC Platform.

Procedure

1. Log on to the DB2 database server computer as the DB2 database instance owner.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

3. Verify that you have write permission on the sql-wrapper.sql file. If not, switch users or change the
permission on the file by using the chmod command.

4. Edit the sql-wrapper.sql file to ensure that the variables are set correctly for your environment and
save the changes.

• On Windows operating systems, if required, modify the following properties to suit your
environment:

define opx_base_currency_iso_code='USD'
define opx_dflt_stor_srv_root='c:\OpenPages\openpages-storage'
define opx_op_admin_name='OpenPagesAdministrator'
define opx_op_admin_pwd='OpenPagesAdministrator'
define sqllib_dir='C:\IBM\SQLLIB'

• On AIX or Linux operating systems, if required, modify the following properties to suit your
environment.

define opx_base_currency_iso_code='USD'
define opx_dflt_stor_srv_root='opt/openpages-storage/'
define opx_op_admin_name='OpenPagesAdministrator'
define opx_op_admin_pwd='OpenPagesAdministrator'
define sqllib_dir='home/db2inst1/sqllib'
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5. On Linux or AIX, verify that you have execute permission on the create-opx-db-srv.sh script.
6. On Windows, start the DB2 command line processor (CLP). Click All Programs > IBM DB2 > IBM DB2

DB2COPY1 > DB2 Command Window - Administrator.
7. To create the database for OpenPages, run the create-opx-db-srv.sh|.bat script from the

command line.

Use the following table to replace the variables in the command-line options with values that are
suitable for your environment.

Table 13: Options for the create-opx-db-srv.sh|.bat script

Variable Description

database_name The name of the OpenPages database

Note: If you are upgrading OpenPages, use the
name from your previous OpenPages
environment. DB2 does not support restoring to a
database with a different name.

path The location of the database on the server

catalog_path The location of the database alias on the local
server

On Windows operating systems, the
<catalog_path> is the drive letter (C: or E:). On
Linux or AIX operating systems, <catalog_path>
is the absolute path (/home/db2inst1)

• On Windows, type the following command:

create-opx-db-srv.bat <database_name> <path> 
   <catalog_path>

Example: A database named OPX is created. The database and database alias are on the D: drive.

create-opx-db-srv.bat OPX D: D:

• On AIX or Linux, type the following command:

./create-opx-db-srv.sh <database_name> <path>
   <catalog_path> 

Example: A database named OPX is created. The database and database alias are in the /home/
db2dinst1 directory.

./create-opx-db-srv.sh OPX /home/db2inst1 /home/db2inst1 

8. If the database server is on a Windows operating system and the OpenPages installation user is not
the DB2 database instance owner, run the following script:

clpplus -nw <username>/<password>@<hostname>:
   <port>/<database_name> 
   @sql-wrapper dba-grant.sql dba-grant.log <instance_owner_username>>

• username is the user name of the OpenPages installation user (the user that is logged in to the
system).

• password is the password of the OpenPages installation user.
• instance_owner_username is the DB2 database instance owner (the user who creates the database

instance).
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If the OpenPages installation user is the same as the DB2 database instance owner, no action is
required.

The script explicitly grants control on the SYSTOOLS schema objects to the DB2 database instance
owner.

9. If the database server is on a Windows computer, the OpenPages installation user is not the DB2
database instance owner, and the DB2 database instance owner is not the DB2 administration server
(DAS) user, then run the following script:

clpplus -nw <username>/<password>@<hostname>:
   <port>/<database-name> 
   @sql-wrapper dba-grant.sql dba-grant.log <das_user_name>

• username is the user name of the OpenPages installation user (the user that is logged in to the
system).

• password is the password of the OpenPages installation user.
• das_user_name is the DB2 Administration server (DAS) user account.

The script explicitly grants control on the SYSTOOLS schema objects to the DAS user.

What to do next

Create the database objects. You can use the OpenPages installation program or you can create the
schema by using scripts. See “OpenPages database object creation for DB2” on page 103.

Running the database creation scripts from the OpenPages application server computer
If your IBM OpenPages GRC Platform application server is not on the same computer as your database
server, you can also run the database scripts remotely.

Before you begin

Ensure that your environment meets these prerequisites:

__ • The DB2 client software is installed on the application server, see “DB2 database client installations”
on page 73

__ • The DB2 database server is running
__ • A database instance for the OpenPages database has been created
__ • Oracle compatibility mode is enabled
__ • You have updated the database manager configuration for the OpenPages database instance
__ • You have copied the Java routine class files and encryption files to the DB2 server from the

OpenPages installation files.
__ • DB2 text search is enabled and configured

Procedure

1. Log on to the OpenPages GRC Platform application server computer as the DB2 administrator.
2. On Windows, start the DB2 command line processor (CLP). Click All Programs > IBM DB2 > IBM DB2

DB2COPY1 > DB2 Command Window - Administrator
3. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

4. To catalog the node, run the following script:

• On AIX or Linux operating systems:

./db2-catalog-node.sh <node_name> <hostname> <port>
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• On Windows operating systems:

db2-catalog-node.bat <node_name> <hostname> <port>

Table 14: Command-line variables for the db2-catalog-node.sh|.bat script

Variable name Description

node_name The node name of the database partition server.

The node name represents a local nickname that
you can set for the computer that contains the
database you want to catalog.

hostname The host name or the IP address of the node
where the target database is installed.

port The port that the database server uses.

The default port is 50000.

Example: On AIX or Linux operating systems:

./db2-catalog-node.sh OPNode OPAdmin 50000 

On Windows operating systems:

db2-catalog-node.bat OPNode OPAdmin 50000 

5. To create the database for OpenPages, run the create-opx-db-clt script.

Replace the variables with your system values:

• database_name is the name of the OpenPages database.
• path is the location on which to create the database on the server.
• catalog_path is the location of the database alias on the local computer.
• node_name is the cataloged node name.
• instance_owner_usrname is the user name of the DB2 account that owns the instance on the remote

computer.
• instance_owner_password is the password for the account that owns the database instance.

• On AIX or Linux operating systems, type the following command:

./create-opx-db-clt.sh <database_name> <path> 
   <catalog_path>  

Example: Create a remote database on a Linux operating system from an AIX-based computer. The
DB2 database instance owner on the remote computer is db2inst1

./create-opx-db-clt.sh OPdb7 /usr /usr  
   OPNode db2inst1 Db2_1234 

• On Windows operating systems, type the following command:

create-opx-db-clt.bat <database_name> 
   <path> <catalog_path> 
   <node_name> <instance_owner_username> 
   <instance_owner_password>
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Example: Create a remote database on AIX or Linux operating systems from a Windows-based
computer. The DB2 database instance owner on the remote computer is db2inst1.

create-opx-db-clt.bat OPdb7 /usr /usr
   OPNode db2inst1 Db2_1234 

6. If the database server is on a Windows operating system and the OpenPages installation user is not
the DB2 database instance owner, run the following script:

clpplus -nw <username>/<password>@<hostname>:
   <port>/<database_name> 
   @sql-wrapper dba-grant.sql dba-grant.log <instance_owner_username>>

• username is the user name of the OpenPages installation user (the user that is logged in to the
system).

• password is the password of the OpenPages installation user.
• instance_owner_username is the DB2 database instance owner (the user who creates the database

instance).

If the OpenPages installation user is the same as the DB2 database instance owner, no action is
required.

The script explicitly grants control on the SYSTOOLS schema objects to the DB2 database instance
owner.

7. If the database server is on a Windows computer, the OpenPages installation user is not the DB2
database instance owner, and the DB2 database instance owner is not the DB2 administration server
(DAS) user, then run the following script:

clpplus -nw <username>/<password>@<hostname>:
   <port>/<database-name> 
   @sql-wrapper dba-grant.sql dba-grant.log <das_user_name>

• username is the user name of the OpenPages installation user (the user that is logged in to the
system).

• password is the password of the OpenPages installation user.
• das_user_name is the DB2 Administration server (DAS) user account.

The script explicitly grants control on the SYSTOOLS schema objects to the DAS user.

Preparing the database instances for OpenPages on DB2
You must prepare the IBM DB2 database instances that are used for the IBM OpenPages GRC Platform
databases.

Before you begin

For more information about IBM OpenPages GRC Platform supported software, see “Software
prerequisites” on page 25.

Tip: To verify the current version and service level of IBM DB2, use the db2level command.

About this task

To prepare the database instances, you must:

__ • Run the enable-ora-compatibility script to enable Oracle compatibility mode for the DB2
database instance that is used for the OpenPages schema.

Important: Oracle compatibility mode must not be enabled on the DB2 database instance that is
used for the Cognos Analytics content store or on the database instance that is used for IBM Business
Process Manager.

__ • Run the opx-dbm-cfg script to update the database manager configuration for the OpenPages
database instance.
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__ • Copy the Java routine class files to the DB2 database server installation location from the OpenPages
installation files.

__ • Enable and configure DB2 text search.

For more information, see the IBM OpenPages GRC Platform Administrator's Guide.

Procedure

1. Log on to the DB2 database server as the DB2 instance owner.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

3. On Linux and AIX, ensure that the DB2 instance owner has execute permission on the scripts in the
INSTALL_SCRIPTS directory.

• If the DB2 instance owner owns the directory, type the following command:

chmod -R 755 /<path>/INSTALL_SCRIPTS
• If the DB2 instance owner belongs to the same group as the user who owns the directory, type the

following command:

chmod -R 775 /<path>/INSTALL_SCRIPTS
• If the DB2 instance owner is part of other groups, type the following command:

chmod -R 777 /<path>/INSTALL_SCRIPTS
4. Edit the sql-wrapper.sql file to ensure that the variables are set correctly for your environment and

save the changes.

• On Windows operating systems, if required, modify the following properties to suit your
environment:

define opx_base_currency_iso_code='USD'
define opx_dflt_stor_srv_root='c:\OpenPages\openpages-storage'
define opx_op_admin_name='OpenPagesAdministrator'
define opx_op_admin_pwd='OpenPagesAdministrator'
define sqllib_dir='C:\IBM\SQLLIB'

• On AIX or Linux operating systems, if required, modify the following properties to suit your
environment.

define opx_base_currency_iso_code='USD'
define opx_dflt_stor_srv_root='opt/openpages-storage/'
define opx_op_admin_name='OpenPagesAdministrator'
define opx_op_admin_pwd='OpenPagesAdministrator'
define sqllib_dir='home/db2inst1/sqllib'

5. Enable Oracle compatibility mode on the OpenPages database instance.

• On Windows, open a command window and type db2cmd to start the DB2 command line processor
(CLP). Then, type enable-ora-compatibility.bat.

• On AIX or Linux, type ./enable-ora-compatibility.sh.

Note: If you have multiple instances of the DB2 server, ensure that you choose the DB2COPY of the
OpenPages database instance.

Restriction: DB2 compatibility features are enabled at the database instance level and cannot be
disabled. Keep the selected compatibility level for the life of the OpenPages database.

To confirm that Oracle compatibility mode is set, type db2set -all. Verify that one of the listed
profile variables is DB2_COMPATIBILITY_VECTOR=ORA.

6. Update the database manager configuration for the OpenPages database instance.

• On Windows, open a command window and type db2cmd to start the DB2 command line processor
(CLP). Then, type opx-dbm-cfg.bat.

• On AIX or Linux, type ./opx-dbm-cfg.sh.
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7. Copy the Java routine class files for OpenPages to the DB2 server.
a) Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

b) Copy the following files to the <DB2_HOME>\FUNCTION directory:

• opconvert.class
• regexp.class

For example, on Windows, the <DB2_HOME>\FUNCTION directory is <install_path>\ibm
\SQLLIB\FUNCTION.

On AIX or Linux, the default location is /home/<db2_instance_owner>/sqllib/FUNCTION.
8. Enable and configure text search. For more information, see DB2 Text Search (http://www.ibm.com/

support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.admin.ts.doc/doc/c0051296.html).
9. Copy the encryption function for OpenPages to the DB2 server.

a) Go to the/OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS /bin/<PLATFORM> directory.

b) Copy the files to the following directories:

• <DB2_HOME>\FUNCTION
• <DB2_HOME>\FUNCTION\unfenced

What to do next

You can create the database instance for OpenPages.

Operating system user accounts for IBM DB2 databases
Operating system user accounts affect the procedures that are used to create the IBM OpenPages GRC
Platform repository and Cognos Analytics content store.

Restriction: You must use two separate databases - one for the Cognos Analytics content store and one
for the IBM OpenPages GRC Platform database.

DB2 instance owner
This user controls all DB2 processes and owns all file systems and devices that are used by the
databases within the database instance.
For Windows operating systems, the default user is db2admin.
For Linux and AIX operating systems, the default user is db2inst1.

The user account for the DB2 instance owner is created as a prerequisite step to installing DB2
software and instance.

DB2 administration server (DAS) user
The user ID for the DB2 administration server user.
For Windows operating systems, the default user is db2admin.
For Linux and AIX operating systems, the default user is dasusr1.

Important: To simplify user administration, when you install the DB2 database, ensure that you
assign the DB2 instance owner as the DAS user.

OpenPages installation user
This user installs OpenPages GRC Platform. The user account can create the OpenPages database
automatically by using the OpenPages installation program or manually by running scripts.

Restriction: On Windows, if the OpenPages installation user is not the same as the DB2 instance
owner, the OpenPages installation user must run the dba-grant.sql script. The script explicitly
grants control on SYSTOOLS schema objects to the DB2 database instance owner.

For information on manually running the script, see “Creating the OpenPages database on IBM DB2”
on page 65.
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Database schema owners

The following distinct database user accounts must exist before you install OpenPages GRC Platform and
Cognos Analytics:

• OpenPages database user account.
• Cognos Analytics content store user account

On Linux and AIX operating systems, the user names for the OpenPages database user account must not
be the same as the group name. For example, opuser:opuser is not allowed.

DB2 guidelines for creating users

Important: The user accounts must match the schema names on which they operate.

Follow the DB2 guidelines for creating user names (http://www.ibm.com/support/knowledgecenter/
SSEPGG_11.1.0/com.ibm.db2.luw.admin.dbobj.doc/doc/c0007248.html).

For more information about passwords for your DB2 user accounts, see the IBM DB2 documentation
(http://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/
com.ibm.swg.im.dbclient.install.doc/doc/c0060749.html)

Users and groups for application servers on Linux or AIX that use DB2 databases
To install the DB2 database client, IBM WebSphere Application Server , and the IBM OpenPages GRC
Platform application, you must create two users and one group. You can create a separate user and group
to install IBM WebSphere Application Server.

To install the DB2 database client, create and configure the required users and groups as specified in the
following table.

Table 15: Required users and groups for application servers

User Assign to Groups Permissions Reason

db2user The group is
assigned during the
installation of the
DB2 client.

Read, write, execute
permission to the DB2 client
installation directory.

Required by DB2 database client
installation program.

wasuser IBM WebSphere
Application Server
installation.

Read, write, execute
permission to the IBM
WebSphere Application
Server installation directory.

You can create a non-root user to
install the IBM WebSphere
Application Server software. You can
create a separate user or use opuser.

If the wasuser and opuser are
separate users, they must belong to
the same primary group.
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Table 15: Required users and groups for application servers (continued)

User Assign to Groups Permissions Reason

opuser Read, write, execute
permission to the following
directories:

• DB2 database client
installation directory.

• IBM WebSphere
Application Server
installation directory.

• Java SDK or JRE
installation directory.

• Cognos Analytics
installation directory.

The user account that installs
OpenPages GRC Platform.

DB2 database client installations
Install an IBM DB2 database client so that the IBM OpenPages GRC Platform application servers and
reporting servers can connect to the DB2 database server.

Use the following checklist to guide you through the required setup:

__ • Install the DB2 client software.

Use the DB2 Setup wizard to install the IBM Data Server Client. For information, see the DB2
documentation:

– Installing DB2 database servers using the DB2 Setup wizard (Windows)
– Installing DB2 servers using the DB2 Setup wizard (Linux and UNIX)

__ • Create a DB2 database client instance on the client computer (AIX and Linux only).
__ • Configure the DB2 client and server connection.
__ • Test the connection between the database server and the client.

For information about the installation methods for IBM data server clients in AIX and Linux environments,
see Installing IBM data server clients (Linux and UNIX).

Creating and configuring a DB2 client instance in AIX and Linux environments
If you are using Linux or AIX application servers or reporting servers, create a DB2 client instance on the
application server and reporting server computers.

In Windows environments, the client instance is created by default when the client software is installed.

For more information, see db2icrt - Create instance command.

Procedure

1. Log on to the application server computer as a root user.
2. Go to the <DB2DIR>/instance/ directory.

<DB2DIR> is installation location of the DB2 client software.

• On AIX operating systems, the default DB2 installation directory is /opt/IBM/db2/version/
instance.

• On Linux operating systems, the default installation directory is /opt/ibm/db2/version/
instance.

3. To create an instance for a client, run the following command:

db2icrt -s client <instname>
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The -s option is used when you create an instance other than the default instance that is associated
with the installed product from which you run the db2icrt command.

<instname> is the user name of the instance owner.

Example: db2icrt -s client db2inst2

The default location of the DB2 instance /home/db2inst2/sqllib.
4. Log on to the reporting server computer as a root user, and repeat steps 2 and 3.

Testing the connection between the DB2 client and server
If the IBM OpenPages GRC Platform application server is not on the same computer as the database
server, test the connection. Ensure that you can connect to the IBM DB2 server from the OpenPages
application server computer.

Before you begin

You must have System Administrative (SYSADM) or System Controller (SYSCTRL) authority. Otherwise,
ensure that the catalog_noauth option is set to ON. You cannot use root authority when you catalog a
node.

Procedure

1. Log on to the OpenPages application server as a DB2 user.
2. If you are using Microsoft Windows, start the DB2 command line processor.

From the command prompt, type db2cmd, or from the Start menu, click All Programs > DB2COPY1 >
Command Window - Administrator.

3. Test the connection from the client to the database.
a) To verify that the node was created, issue the following command to list the contents of the node

directory:

db2 list node directory show detail

A list of the nodes that you created is displayed.

Node Directory

 Number of entries in the directory = 1

Node 1 entry:

 Node name                      = OPNode_Name
 Comment                        =
 Directory entry type           = LDAP
 Protocol                       = TCPIP
 Hostname                       = database_server_name
 Service name                   = 50000

b) To list the database directory, run the following command:

db2 list database directory

A list of the databases is displayed.
c) To connect to the remote database from the client, type the following command

db2 => connect to <database_alias> user <userid>   

Example: connect to opdb user opuser

If the connection is successful, a message similar to the following message is displayed:

Database Connection Information

Database server = DB2 version

SQL authorization ID = opuser
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Local database alias = opdb

Checklist for the database server (Oracle)
If you use an Oracle database server, do these tasks before you install IBM OpenPages GRC Platform:

• Check that all of the required ports are available. See “Port assignments ” on page 102.
• If the database server is running on Linux or AIX, set up the operating system users and groups for

Oracle (oinstall, dba, oracle). See “Creating users and groups on the Oracle database server for
Linux operating systems” on page 79.

• Install Oracle. See “Oracle database server installations” on page 75.
• Review the list of Oracle package dependencies.

To function correctly, the OpenPages Oracle packages must have access to some standard Oracle
objects. If you are using a standard Oracle deployment, access to these objects is granted by default.

Some environments, however, might restrict the default Oracle access model and remove public access
from some of the objects. Review the list of package dependencies to ensure access is granted. See
“Oracle package dependencies” on page 77.

• Add a listener for the OpenPages database. See “Adding an Oracle listener for the OpenPages GRC
Platform database” on page 80.

• Create a database instance for OpenPages. See “Creating an Oracle database instance for the
OpenPages GRC Platform database” on page 80.

• Add a net service name for each server in your OpenPages deployment. See “Add a local net service
name for the OpenPages GRC Platform database” on page 81.

• Set environment variables. See “Setting the Oracle environment variables for the database server” on
page 81.

Oracle database server and client setup for OpenPages GRC Platform installations
Install and configure database server software to use with IBM OpenPages GRC Platform.

Install the database client software (Oracle Admin client) on all OpenPages application servers, the
deployment manager server, and on all reporting servers.

Oracle database server installations
IBM OpenPages GRC Platform requires a database server. Use the installation instructions from the
vendor to install the Oracle database server on the OpenPages database server. After you install Oracle
database, some configuration is required.

Restriction: Do not install Oracle database server or Oracle client software into a directory that contains
spaces.

Important: The password for database users (such as SYSTEM, SYS, DBSNMP, SYSMAN) cannot contain
spaces or special characters due to database requirements and conflicts with OpenPages scripts.

After installing the Oracle database server, you must install Oracle client software on all application server
computers.

Oracle 12.1.0.2 database server considerations
If you have installed the 64-bit Oracle 12.1.0.2 database server, and you want to install the 32-bit Oracle
12.1.0.2 client on the same computer, some manual configuration might be required.

For more information, see “Install the 32-bit Oracle 12.1.0.2 client and 64-bit Oracle 12.1.0.2 database
server on the same computer” on page 354.
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Upgrading the Oracle database server to 12.1.0.2
If you are upgrading from an existing installation of OpenPages GRC Platform with Oracle 11.2.0.4 to
OpenPages GRC Platform with Oracle 12.1.0.2, you must complete the following steps to upgrade the
Oracle database server.

Procedure

1. Perform the pre-upgrade steps.
a) Stop all OpenPages application servers, Oracle database servers, and Cognos servers.

For more information, see Chapter 11, “Starting and stopping servers,” on page 253.
b) Back up the existing OpenPages environment by using the OPBackup and OPCCBackup utilities.

For more information, see “Backing up the OpenPages database (Oracle)” on page 215.

If you prefer, you can back up only the databases, by using the Oracle backup tool.
c) Update the Oracle path in the environment variables on the Oracle server.

If the Oracle 11.2.0.4 database client is running on the same computer as the Oracle server, ensure
that you note the Oracle 11.2.0.4 client path information because it is required in step 5b.

On Microsoft Windows, for example, if Oracle 11.2.0.4 is installed in C:\app\ product
\11.2.0\dbhome_1, change the path to C:\app\product\12.1.0\dbhome_1

On UNIX, if Oracle 11.2.0.4 is installed in /home/oracle/app/oracle/product/11.2/
dbhome_1, change the path to /home/oracle/app/oracle/product/12.1/dbhome_1

2. Upgrade the Oracle database server from version 11.2.0.4 to version 12.1.0.2.
a) Run the Oracle 12.1.0.2 installation wizard.

Accept the default options on all pages, except for the pages described here.

For full information, see the Oracle documentation.
b) On the Select Installation Option page, select Upgrade an existing database.
c) For Windows only:

1) On the Oracle Home User page, select Use Windows Built-in Account.
2) On the Specify Installation Location page, ensure the Oracle base and Software location

show the same path that you specified in step 1c.

For UNIX only, follow these steps on the Perform Prerequisite Checks page if errors are shown:

1) Select Fix & Check Again, and follow the instructions.
2) Run the following command as a root user to increase the swap size:

dd if=/dev/zero of=/tmp/swap1 bs=1M count=512     
mkswap /tmp/swap1
swapon /tmp/swap1

Where count is the size to increase.

When the errors are fixed, you can continue with the installation.
3. Update the Oracle listener details from the Oracle Net Configuration Assistant wizard.

On the Listener Configuration, Listener Name page, update the Listener name to the name specified
in the listener.ora file of the Oracle 11.2.0.4 installation.

Tip: You can find the value of the listener.ora from your Oracle 11.2.0.4 server environment. For
example, C:\app\OPDB\product\11.2.0\dbhome_1\NETWORK\ADMIN

4. Migrate the data from the Database Upgrade Assistant.
a) On the Select Database page, ensure the Target Oracle Home and Source Oracle Home values are

correct.
5. Perform the post upgrade steps.
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a) Stop the Oracle 11.2.0.4 listener service and change the startup type to manual.

This step is required if your system restarts after the Oracle server upgrade is complete.
b) Revert to the original Oracle 11.2.0.4 path in the environment variables that you updated in step 1c.

This step is required only if the Oracle 11.2.0.4 database client is running on the same computer as
the updated Oracle server.

c) Start the Oracle 12.1.0.2 listener service.

Oracle package dependencies
To function correctly, the IBM OpenPages GRC Platform Oracle packages must have access to some
standard Oracle objects.

In a standard Oracle deployment, database users can access the objects listed in the following tables.
Some customer environments might restrict the default Oracle access model and remove public access
from some of these objects. To use the OpenPages GRC Platform application, users require access to all
objects in the tables. Verify that access to these objects has not been revoked before you install
OpenPages.

The following tables list the standard Oracle objects to which the OpenPages application requires access.
The tables show the base object, the object name, and the public synonym for the Oracle database
objects.

Table 16: Base objects for the package object type

Base Object Object Name Public Synonym

SYS.DBMS_LOB DBMS_LOB PUBLIC.DBMS_LOB

SYS.DBMS_LOCK DBMS_LOCK PUBLIC.DBMS_LOCK

SYS.DBMS_JOB DBMS_JOB PUBLIC.DBMS_JOB

SYS.DBMS_OUTPUT DBMS_OUTPUT PUBLIC.DBMS
_OUTPUT

SYS.DBMS_RANDOM DBMS_RANDOM PUBLIC.DBMS
_RANDOM

SYS.DBMS_SESSION DBMS_SESSION PUBLIC.DBMS
_SESSION

SYS.DBMS_SNAPSHOT DBMS_MVIEW PUBLIC.DBMS
_MVIEW

SYS.DBMS_SQL DBMS_SQL PUBLIC.DBMS_SQL

SYS.DBMS_STANDARD DBMS_STANDARD PUBLIC.DBMS_
STANDARD

SYS.DBMS_STATS DBMS_STATS PUBLIC.DBMS
_STATS

SYS.DBMS_UTILITY DBMS_UTILITY PUBLIC.DBMS
_UTILITY

SYS.ODCICONST ODCICONST PUBLIC.ODCICONST

SYS.PLITBLM PLITBLM PUBLIC.PLITBLM

SYS.STANDARD STANDARD N/A

SYS.UTL_I18N UTL_I18N PUBLIC.UTL_I18N
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Table 17: Base objects for the view object type

Base Object Object Name Public Synonym

SYS.ALL.PROCEDURES ALL_PROCEDURES PUBLIC.ALL
_PROCEDURES

SYS.ALL_TAB_PRIVS ALL_TAB_PRIVS PUBLIC.ALL
_TAB_PRIVS

SYS.NLS_SESSION_
PARAMETERS

NLS_SESSION
_PARAMETERS

PUBLIC.NLS
_SESSION
_PARAMETERS

SYS.PRODUCT_COMPONENT_
VERSION

PRODUCT_COMPONENT
_VERSION

PUBLIC.PRODUCT_
COMPONENT
_VERSION

SYS.USER_CONS_COLUMNS USER_CONS_COLUMNS PUBLIC.USER
_CONS_
COLUMNS

SYS.USER_CONSTRAINTS USER_CONSTRAINTS PUBLIC.USER_
CONSTRAINTS

SYS.USER_DB_LINKS USER_DB_LINKS PUBLIC.USER
_DB_LINKS

SYS.USER_IND_COLUMNS USER_IND_COLUMNS PUBLIC.USER_IND_
COLUMNS

SYS.USER_INDEXES USER_INDEXES PUBLIC.USER
_INDEXES

SYS.USER_OBJECTS USER_OBJECTS PUBLIC.USER
_OBJECTS

SYS.USER_SEGMENTS USER_SEGMENTS PUBLIC.USER
_SEGMENTS

SYS.USER_SEQUENCES USER_SEQUENCES PUBLIC.USER_
SEQUENCES

SYS.USER_SOURCE USER_SOURCE PUBLIC.USER
_SOURCE

SYS.USER_TAB_COLS USER_TAB_COLS PUBLIC.USER
_TAB_COLS

SYS.USER_TAB_COLUMNS USER_TAB_COLUMNS PUBLIC.USER_TAB_
COLUMNS

SYS.USER_TABLES USER_TABLES PUBLIC.USER
_TABLES

SYS.USER_TABLESPACES USER_TABLESPACES PUBLIC.USER_
TABLESPACES

SYS.USER_TRIGGERS USER_TRIGGERS PUBLIC.USER
_TRIGGERS

Users also require access to all synonyms. If any public synonyms are removed from a default Oracle
deployment, you must create a private synonym to the object in the OpenPages GRC Platform application
user schema.
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Follow these steps to grant explicit permission to an object:

1. Log on to a computer with SQL*Plus and access to the database server.
2. From the command line, log on to SQL*Plus:

sqlplus sys/<password>@<tns_alias> as sysdba

3. At the SQL prompt, type the following command for the objects listed in Table 16 on page 77:

grant execute on <object_name> to public;

Type the following command for the objects listed in Table 17 on page 78:

grant select on <object_name> to public;

Each package object requires the EXECUTE permission. All other objects require the SELECT permission.

Creating users and groups on the Oracle database server for Linux operating systems
For Linux installations, create and configure the oinstall and dba groups and the oracle user on the
server that hosts the Oracle database.

The users and groups must be created and configured by a user with SYSADMIN privileges and access to
root.

For more information, see the Oracle documentation.

If you are installing a cluster environment, you must create these users on the cluster administrator
server and on each cluster member.

About this task

Use the following table to help you create the required users and user groups for the database server.

Table 18: Required users and groups for Oracle database servers

User Assign to Groups Permissions Reason

oracle oinstall; dba

oinstall is the
primary group for
this user.

Read, write, execute
permission to the Oracle
Admin client installation
directory.

Required by Oracle database
installation program.

Important: The password for this
user cannot contain spaces or
special characters due to conflicts
with OpenPages scripts.

Procedure

1. Log on to the database server as root.
2. Create the groups: oinstall and dba.

a) Open a Linux shell .
b) Type the following command:

groupadd oinstall

This group is the primary group for the oracle user. This group is the inventory group.

Note: The Oracle database requires this name.
c) Type the following command:

groupadd dba
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Note: The Oracle database requires this name.
3. Create a user that is called oracle, assign the initial login group (oinstall), and add the user to the
dba group.
a) Go to the /usr/sbin/ directory
b) Type the following command:

/usr/sbin/useradd -m -g oinstall -G dba oracle

4. Change the password for the oracle user by using the following command:

passwd oracle

5. At the New Password prompt, enter a new password.

Adding an Oracle listener for the OpenPages GRC Platform database
You must manually add an Oracle database listener for the IBM OpenPages GRC Platform database.

Procedure

1. Log on to your database server as a user with administrative privileges.
2. Start the Net Configuration Assistant.

a) Open a Command Prompt window as a user with Administrative privileges.
b) Go to the <ORACLE_HOME>/bin directory.
c) To start the Net Configuration Assistant, type the following command: netca.

3. Accept the default options on all pages, except for the pages described here. For full information, see
the Oracle documentation.
a) On the Listener Configuration, Listener Name page, ensure the listener name that you specify is

unique in the current Oracle Home
b) On the TCP/IP Protocol page, choose a port.

Creating an Oracle database instance for the OpenPages GRC Platform database
You must create an Oracle database instance for OpenPages GRC Platform to use.

Note: OpenPages GRC Platform supports non-CDB databases only.

Procedure

1. Log on to your Oracle database server as a user with administrative privileges.
2. Start the Database Configuration Assistant.

a) Open a command prompt window as a user with administrative privileges.
b) Go to the <ORACLE_HOME>/bin directory.
c) To start the Database Configuration Assistant, type the following command: dbca.

3. Accept the default options on all pages, except for the pages described here. For full information, see
the Oracle documentation.

4. On the Initialization Parameters page, change the following settings.
a) On the Memory tab, click Custom and then set the following options:

• Memory Management to Automatic Shared Memory Management.
• SGA Size field to 1024.
• PGA Size field to 768.

b) On the Sizing tab, set the following options:

• Block Size to 8192.
• Processes to 250.
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c) On the Character Sets tab, select Use Unicode (AL32UTF8) and set the National Character Set
option to AL16UTF16 - Unicode UTF-16 Universal character set.

You must create your database with the AL32UTF8 character set.

Add a local net service name for the OpenPages GRC Platform database
The database client uses a net service name to connect to the IBM OpenPages GRC Platform repository.

You must add a net service name, with the appropriate host, port, and service name details, for each
server in the OpenPages GRC Platform deployment.

For more information on creating a net service name, see the Oracle documentation.

Setting the Oracle environment variables for the database server
After you install the Oracle database server, you must set the Oracle environment variables on the
OpenPages database server computer.

The following table lists the environment variables required for AIX and Linux operating systems. If you
are using Microsoft Windows, you need to set only the ORACLE_HOME environment variable.

Table 19: Oracle environment variables

Environment variables Description

ORACLE_SID Specifies the database service name.

Restriction: The SID is case-sensitive in AIX and Linux environments.

ORACLE_HOME Specifies the installation location or top-level directory structure for the
database installation.

NLS_LANG Specifies the database character set that is configured during the database
installation. The default value is AMERICAN_AMERICA.AL32UTF8

Note: To display non-English characters for Japanese locales, set the
variable to the following value:
NLS_LANG=JAPANESE_JAPAN.JA16SJISTILDE

TNS_ADMIN Specifies the location of the tnsnames.ora file. The default location is the
<ORACLE_HOME>/network/admin directory.

On Windows:

1. Log on to the database server as a user with administrative privileges.
2. Right-click My Computer > Properties.
3. Click Advanced system settings > Environment Variables.
4. In the System Variables pane, click New.
5. Add the ORACLE_HOME variable, then click OK.

For example: ORACLE_HOME=C:\app\Administrator\product\12.1.0\dbhome_1
6. Select the PATH variable in the System Variables pane, and click Edit.
7. In the Edit System Variable box, add the path to ORACLE_HOME at the start of the PATH variable.

%ORACLE_HOME%\bin

By default, the PATH variable already includes the path %ORACLE_HOME%\bin after you install the
Oracle database server software.

8. Click OK twice to exit.
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On UNIX:

1. Log on to the database server as the user who installed the Oracle database server.
2. Open the user profile, and set the ORACLE_SID, NLS_LANG, ORACLE_HOME, and TNS_ADMIN

variables.

Important: Use the syntax and delimiters that are appropriate for the shell that you are using.

For example:

export ORACLE_SID=OP
export NLS_LANG=AMERICAN_AMERICA.AL32UTF8
export ORACLE_HOME=/home/oracle/app/oracle/product/12.1.0/dbhome_1
export TNS_ADMIN=$ORACLE_HOME/network/admin

3. Append the location of ORACLE_HOME/bin to the PATH environment variable.

For example:

export PATH=$ORACLE_HOME/bin:$PATH

4. Refresh the profile.

For example, on Linux, open a shell and run the following command:

./home/oracle/.bash_profile

On AIX, open a shell and run the following command:

./home/oracle/.profile

Increasing the Oracle connection limit
In clustered environments, you must increase the number of users who can connect to the database
instance.

Procedure

1. Log on to the database server as a user with administrative privileges.
2. To start the Oracle Enterprise Manager console, open a web browser and type https://
<oracle_server_name>:<port>/em

If you are using Oracle 12.1.0.2, the default port number is 5500.
3. Log on to the Oracle Enterprise Manager console by using the following syntax: sys/
<password>@sysdba.
a) For the User Name, enter sys.
b) Enter the password for the sys user.
c) From the Connect As list, select SYSDBA.

4. On the Oracle Enterprise Manager home page, click the Server tab.
5. Under Database Configuration, click Initialization Parameters.
6. On the Initialization Parameters page, click the SPFile tab.
7. Locate the Processes parameter.

If necessary, use the search function by entering Processes in the Name field and then clicking Go.
8. Enter a value in the Processes field.

In a clustered environment, for best performance allocate sufficient processes for each IBM
OpenPages GRC Platform application instance and each corresponding Cognos instance.

For a two-node OpenPages GRC Platform environment, use the following settings:
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OpenPages
Configure 75 processes for each OpenPages instance.

CommandCenter
Configure 80 processes for each OpenPages CommandCenter instance.

Database processing usage
Configure 60 processes for database connection processing and background processes.
By default, this setting is 250 processes and 280 sessions for a two-node OpenPages
environment. If you have two or more application servers, increase the number of processes.

9. Click Apply.

You are prompted to restart the server.
10. To restart the server, select Immediate.

Starting and stopping the Oracle database server in a Windows environment
Use Windows services to start or stop the Oracle database instance.

Procedure

1. Log on to the database server as a user with administrative privileges.
2. Click Start > All Programs > Administrative Tools > Services.
3. Start the Oracle database listener service, which connects the user to the Oracle database instance
4. To start the Oracle database instance, right-click the service name (OracleServiceSID) and select

Start.

Oracle database client installations
You install the Oracle database client on each IBM OpenPages GRC Platform application server so that it
can connect to the Oracle database server remotely and administer the OpenPages database.

If the Oracle database server is installed on the same computer as the application server, the Oracle
Admin client is not required.

The 32-bit Oracle database client is required by the reporting server. If you are using the same computer
for the application server and reporting server, you must install the 32-bit version.

Review the following tasks before you install the Oracle Admin client software:

• “Setting the ORACLE_HOME environment variable on the OpenPages application servers” on page 85.
• “Testing the connection to the OpenPages database from the Oracle database client” on page 86.

For information on installing the Oracle Admin client software, see the Oracle documentation.

Creating users and groups for application servers on UNIX that use Oracle databases
To install the Oracle Admin client, IBM WebSphere Application Server, and the IBM OpenPages GRC
Platform application, you must create two users and one group on AIX and Linux operating systems. You
can create a separate user and group to install IBM WebSphere Application Server.

About this task

To install the Oracle Admin client, create and configure the oinstall group and the oracle user on the
server that hosts the OpenPages application.
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Table 20: Required users and groups for application servers (Linux and AIX)

User Assign to Groups Permissions Reason

oracle oinstall

The primary group
for the oracle user.

Read, write, execute
permission to the Oracle
Admin client installation
directory.

Required by Oracle Admin client
installation program.

For information on creating standard
Oracle users and user groups, see
the Oracle documentation.

wasuser IBM WebSphere
Application
Serverinstallation

Read, write, execute
permission to the
WebSphere Application
Server installation directory.

You can create a non-root user to
install the IBM WebSphere
Application Server software. You can
create a separate user and group or
use the opuser user.

opuser oinstall Read, write, execute
permission to the following
directories:

• <OP_HOME>/tmp
directory.

• Oracle Admin client
installation directory and
<ORACLE_HOME>
directory.

• IBM WebSphere
Application Server
installation directory.

• Java SDK or JRE
installation directory.

• Cognos Analytics
installation directory.

User must include
<ORACLE_HOME>/bin in
the path to run SQL*Plus
commands.

Required by the OpenPages
installation.

Procedure

1. Log on to the application server as the root user and open a shell.
2. To create a group called oinstall, enter the following command:

AIX:

mkgroup oinstall

Linux:

groupadd oinstall 

Restriction: The Oracle Admin Client installer requires that this group is named oinstall.
3. To create the oracle user and assign the user to the oinstall group, go to the /usr/sbin/

directory and enter the following command:

/usr/sbin/useradd -m -g oinstall oracle

Restriction: The Oracle Admin Client installer requires that this user is named oracle.
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4. Use the following command to change the password for the oracle user:

passwd oracle

5. Enter a new password at the New Password prompt.
6. To install the OpenPages application, opuser must exist.

If this user does not already exist, create the user:

useradd -m -g oinstall <name>

If the user already exists, assign it to the oinstall group:

a. Obtain the groups to which opuser belongs by using the id opuser command.
b. Add the oinstall group to its supplementary groups:

usermod -G group1,group2,...,oinstall opuser

Example:

Run the command id opuser.

The output from the command window shows that opuser is assigned to the groups opgroup and
staff:

uid=210(opuser) gid=206(opgroup) groups=1(staff)

Run the command usermod -G staff,oinstall opuser

Run the command id opuser to verify whether opuser has been assigned to the oinstall group
successfully.

The output from the command window shows that opuser is assigned to the groups staff and
oinstall:

7. If you created a new opuser in the previous step, change the password by using the following
command:

passwd <name>

Restriction: The password cannot contain spaces or special characters.
8. At the New Password prompt, enter a new password.
9. Grant read, write, and execute permissions for opuser to the ORACLE_HOME directory. Run the

following command by using SQL*Plus:

chmod -R 775 /home/oracle

10. Grant read, write and execute permissions for opuser to the IBM WebSphere Application Server
installation directory, the Java SDK or IBM JRE installation directory, and the Cognos Analytics
installation directory.

Setting the ORACLE_HOME environment variable on the OpenPages application servers
Set up the ORACLE_HOME environment variable to point to the directory where the Oracle database client
software is installed. Set the variable on the admin application server and each non-admin application
server.

Procedure

1. Log on to the application server.

On Microsoft Windows, log on as a user with administrative privileges and full access to the local
server drives.

For UNIX, log in as a non-root user, such as the opuser user that you created for the IBM
OpenPages GRC Platform installation.
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2. Set the ORACLE_HOME environment variable to point to the Oracle Admin Client installation directory.

On Windows:

a. Right-click My Computer > Properties.
b. Click Advanced system settings > Environment Variables.
c. Click New in the System Variables panel.
d. Add the ORACLE_HOME variable to the New System Variable box, then click OK.

For example: ORACLE_HOME=C:\app\Administrator\product\12.1.0\client_1
e. Select the PATH variable in the System Variables panel, and click Edit.
f. In the Edit System Variable box, add the path to ORACLE_HOME at the start of the PATH variable.

%ORACLE_HOME%\bin

By default, the PATH variable already includes the path <ORACLE_HOME>\bin after you install the
Oracle client software.

g. Click OK twice to exit.

On UNIX, add the ORACLE_HOME variable to the profile.

• On Linux, the profile is /home/<user>/.bash_profile
• On AIX, the profile is /home/<user>/.profile

Where <user> is the person who logs in to the operating system and creates the OpenPages
installation.

For example:

export ORACLE_HOME=/home/oracle/app/oracle/product/12.1.0/client_1

3. Append the location of <ORACLE_HOME>/bin to the PATH environment variable.

For example:

export PATH=$ORACLE_HOME/bin:$PATH

4. Refresh the profile.

For example, on Linux, open a shell and run the following command:

. /home/opuser/.bash_profile

On AIX, open a shell and run the following command:

. /home/opuser/.profile

Testing the connection to the OpenPages database from the Oracle database client
Test whether the SQL*Net connect string can connect to the IBM OpenPages GRC Platform database on
the Oracle database server from the Oracle database client.

Procedure

1. Copy the file <ORACLE_HOME>/network/admin/tnsnames.ora from the Oracle database server
operating system to the <ORACLE_HOME>/network/admin Oracle database client directory.

Ensure that the OpenPages installation user has read, write and execute permissions on the
tnsnames.ora file in the Oracle database client operating system.

2. Log on to the Oracle database client as an OpenPages installation user.
3. Edit the file <ORACLE_HOME>/network/admin/tnsnames.ora, and update the Host value to the

host name or IP address of the Oracle database server.
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4. To test the connection to the OpenPages database on the database server, type the following
command:

sqlplus <username>/<password>@<service_name>

For example, sqlplus system/openpages@op

The system connects you to an Oracle database instance.
5. To exit SQL*Plus, type exit.

Configuring IBM OpenPages GRC Platform to work on a single computer with an Oracle database
For test and development environments, you can install IBM OpenPages GRC Platform, the Oracle
database, the 32-bit Oracle Admin Client, and Cognos Analytics on a single computer. However, some
configuration is required.

About this task

You can install IBM OpenPages GRC Platform on a single computer for pre-deployment testing or proof of
concept demonstrations. For single computer installations, ensure that the correct Oracle Admin Client is
used by each software component.

If you install IBM OpenPages GRC Platform on a single server, you must install two versions of Oracle
Admin Client. Both the 32-bit and 64-bit versions are required. The OpenPages application requires the
64-bit Oracle Admin Client and the Cognos Analytics software requires the 32-bit Oracle Admin Client.

Ensure that IBM OpenPages GRC Platform has already been installed before performing these steps.

Procedure

1. Log on to the Cognos server as a user with administrative privileges.
2. Ensure that the ORACLE_HOME environment variable points to the 32-bit Oracle Admin Client.
3. Edit the PATH variable to add %ORACLE_HOME%\bin.
4. If set, remove the TNS_ADMIN variable.
5. From the command line, go to the <CC_HOME>/framework/conf directory.
6. Open the framework.properties file in a text editor and ensure that the oracle.client.path property

contains the location of the 32-bit Oracle Admin client bin directory.
7. Save and close the file.

Note: If the server is Windows, ensure that the PATH system environment variable contains the path to
the Oracle server and not the Oracle client to avoid issues that can occur on server restarts.

8. Restart the IBMOpenPagesFrameworkModelGenerator service.

Testing the connections to the database server and the OpenPages GRC Platform database
Test whether the SQL*Net connect string can connect to the database listener by using the TNSPING
utility in the <ORACLE_HOME>/bin directory. The TNSPING utility tests whether the listener is available.
It does not test whether the databases behind the listener are working.

To test that the IBM OpenPages GRC Platform database is created, use SQL*Plus to log on to the
OpenPages Oracle database schema.

Procedure

1. To test whether you can log on to Oracle Enterprise Manager, the web-based interface that is used to
administer an Oracle database, type the following command:

https://<oracle_server_name>:<port>/em

If you are using Oracle 12.1.0.2 or a later fix pack, the default port number is 5500.
2. To test whether a SQL*Net connect string can connect to the listener, type the following command:

tnsping <database_instance_name>
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The utility requests acknowledgment that the service name is valid and that the listener is configured
to handle requests for that service name.

If the configuration is correct, a message is displayed that shows the return time.

If the configuration is not correct, the utility returns an error message. Ensure that you use the correct
service name and that the listener is started on the server computer.

3. To test that the OpenPages database is created, type the following command:

sqlplus <username>/<password>@<service_name>

For example, sqlplus system/openpages@op

The system connects you to an Oracle database instance.
4. To exit SQL*Plus, type exit.

Checklist for reporting servers
Do the following tasks on each reporting server (active and standby) before you install IBM OpenPages
GRC Platform:

• Check that all of the required ports are available. See “Port assignments ” on page 102.
• If you are using Linux or AIX, give the OpenPages installation user (opuser) read, write, and execute

permissions to the following directories:

– Java SDK or JRE installation directory
– Cognos Analytics installation directory

• If you are using a horizontal cluster for the reporting servers, set up the load balancer.
• If the database server is on a separate computer, install the database client software (32-bit version) on

each reporting server and test the connection.

– If you are using IBM DB2, see “DB2 database client installations” on page 73.
– If you are using Oracle, see “Oracle database client installations” on page 83.

• Install and configure a web server. See “Web server configuration options for Cognos Analytics” on page
92.

• If you are using Linux or AIX, ensure that you have the 32-bit and 64-bit libraries required by Cognos.
• Install Cognos Analytics, 32-bit version. See “Installing Cognos Analytics” on page 90.

– Optional: Include the Cognos Framework Manager when you install Cognos Analytics.
• Copy the JDBC driver to the reporting servers.
• Configure the connection to the content store.

– If you are using IBM DB2, see “Configuring a connection to the content store (DB2)” on page 93.
– If you are using Oracle, see “Configuring a connection to the content store (Oracle)” on page 94.

• Start Cognos services. See “Saving your settings and starting the IBM Cognos services” on page 96.
• Prepare the server for IBM OpenPages CommandCenter.

– If you are using IBM DB2 for the Cognos database, enable a connection between CommandCenter
and the database servers. See “Enabling the connection to a DB2 database from the OpenPages
CommandCenter computer” on page 97.

– If you are using Oracle for the Cognos database, do the following tasks:

- Set environment variables for CommandCenter on each reporting server.
- Test the connection to the OpenPages database on the database server.
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Installing IBM Installation Manager
You use IBM Installation Manager to install IBM WebSphere Application Server, Cognos Analytics, and
some other components, such as IBM OpenPages Loss Event Entry. Install IBM Installation Manager on
each application server and reporting server.

Ensure you install the 64-bit version of IBM Installation Manager.

If an older version of IBM Installation Manager is installed, install to a new directory. For more information
about this requirement, see Update to Installation Manager 1.8 is blocked when its data location is within
its install location (http://www.ibm.com/support/docview.wss?uid=swg21692402).

For more information about IBM Installation Manager, see the Installation Manager documentation
(http://www.ibm.com/support/knowledgecenter/SSDV2W/im_family_welcome.html).

Procedure

1. Download IBM Installation Manager from Passport Advantage.
2. Complete the following steps.

a) On Microsoft Windows, double-click install.exe.
b) On AIX or Linux, in a terminal window, enter ./install.

3. Follow the steps to install IBM Installation Manager.

Cognos Analytics installations
Cognos Analytics and OpenPages CommandCenter must be installed on the reporting server.

For more information about IBM OpenPages GRC Platform supported software, see “Software
prerequisites” on page 25.

Reporting server distribution options

For light user loads, with fewer than 50 concurrent users, Cognos Analytics and OpenPages
CommandCenter can be installed on the same computer as the OpenPages application server.

For heavier user loads, install Cognos Analytics and CommandCenter on a different computer than the
OpenPages application servers. OpenPages GRC Platform operates at peak performance when the
database server, application server, and the reporting server are installed on separate computers.

Requirements for installing Cognos Analytics in a Linux environment

Cognos Analytics requires specific Linux packages.

For more information, see the Software Product Compatibility Report for Cognos Analytics.

Requirements for running multiple instances of Cognos Analytics on the same computer

If you want to install multiple instances of Cognos Analytics on the same computer, you must change the
configuration to ensure that the instances do not share port numbers or other resources. For more
information, see Configuration settings that are the same for multiple versions on the same server in the
IBM Cognos Knowledge Center.

Database server requirements for OpenPages GRC Platform and Cognos Analytics

If you are using an IBM DB2 database server, you must use two separate databases - one for the IBM
Cognos content store, and a second one for the IBM OpenPages GRC Platform database.

If you are using an Oracle database server, for best performance, use separate databases for the content
store and IBM OpenPages GRC Platform database.
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Installing Cognos Analytics
Before you install IBM OpenPages GRC Platform components, ensure that Cognos Analytics is installed
and running on your reporting server computer.

For more information, see the IBM Cognos Analytics Installation and Configuration Guide in IBM
Knowledge Center (https://www.ibm.com/support/knowledgecenter/SSEP7J_11.0.0/).

Before you begin

Review the following notes:

Java

In previous versions, you needed to install Java from the IBM OpenPages GRC Platform installation
media. This step is no longer required. IBM Runtime Environment for Java is provided with Cognos
Analytics.

On all operating systems, if the Cognos Analytics installation program does not find Java 8 in the PATH
environment variable, the installer automatically points to the Java that is provided with Cognos
Analytics. The location is <COGNOS_HOME>/jre.

Important: If you want to use your own Java, ensure that it meets the Java requirements for Cognos.
For more information, see the Cognos documentation.

Oracle

If you use Oracle and the OpenPages database is installed on a separate computer than the Cognos
Analytics server, ensure that a 32-bit database client is installed on the Cognos Analytics server.

Restriction: Do not install the database client software into a directory with spaces.

If you are using an Oracle database on the same computer as Cognos Analytics, you must update your
environment variables so that the IBM Cognos service uses the 32-bit Oracle libraries, and the Oracle
server uses the 64-bit libraries.

IBM DB2

If you are using IBM DB2, install the 64-bit database client, which also includes the 32-bit client
software.

Linux
Ensure that the dependent 32-bit and 64-bit libraries are installed.

To create the user variables for the IBM Cognos service, do the following tasks:

• Create a user variable that is named ORACLE_HOME and set its value to the 32-bit Oracle Admin client
home.

For example, on Microsoft Windows operating systems, set the ORACLE_HOME user variable to
C:\oracle\product\12.1\client_1.

• Create a user variable that is named PATH, or append to an existing one, and include the 32-bit Oracle
Admin client home.

For example, on Windows, set the PATH user variable to %ORACLE_HOME%\bin;%PATH%.
• Add <ORACLE_HOME>/lib to the system libraries variable.

Table 21: Oracle Admin client path environment variables for Cognos installations

Operating
system Environment variable Example

Linux LD_LIBRARY_PATH LD_LIBRARY_PATH=$ORACLE_HOME/
lib:$LD_LIBRARY_PATH

AIX LIBPATH LIBPATH=$ORACLE_HOME/lib:$LIBPATH
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The 64-bit IBM DB2 database installation includes libraries for both 32-bit and 64-bit systems. Use the
following table to add the path to the DB2 32-bit server libraries.

Table 22: IBM DB2 path environment variables for Cognos installations

Operating
system Environment variable Example

Linux LD_LIBRARY_PATH LD_LIBRARY_PATH=$DB2DIR/
lib32:$LD_LIBRARY_PATH

AIX LIBPATH LIBPATH=$DB2DIR/lib32:$LIBPATH

Procedure

1. Optional: If you have an earlier version of Cognos, back up the content store.
2. Ensure that a web server is installed.

For more information, see “Prerequisite software for reporting servers” on page 28.
3. On the reporting server, install Cognos Analytics.

a) Install Cognos Analytics.

Restriction: Install Cognos Analytics into a directory that contains only ASCII characters in the
path name. Do not install Cognos Analytics into a directory that contains spaces.

For information about installing Cognos Analytics, see the following topics in the Cognos
documentation:

• Installing server components on Windows operating systems
• Installing on UNIX or Linux operating systems

b) Install Framework Manager.

Framework Manager is not required in production environments. Framework Manager is the
modeling tool for creating and managing business-related metadata.

Restriction: If you need Framework Manager in your development environment, you must install
the 64-bit IBM Cognos server and the 32-bit Framework Manager to different directories. The
default installation locations for 32 and 64-bit IBM Cognos components are different. For more
information about installing Framework Manager, see Install and configure IBM Cognos Framework
Manager in the IBM Cognos documentation.

4. Copy the JDBC database driver to the <COGNOS_HOME>/drivers directory.

• If the content store is an Oracle database, copy the ojdbc7.jar file from the Oracle installation.
• If the content store is a DB2 database, copy the db2jcc4.jar and db2jcc_license_cu.jar

files from the IBM DB2 installation.
5. Append the <COGNOS_HOME>/bin64 directory to the library path environment variable.

• On Linux operating systems, update the LD_LIBRARY_PATH environment variable.

Example: export LD_LIBRARY_PATH=/opt/ibm/cognos/analytics/
bin64:$LD_LIBRARY_PATH

• On AIX operating systems, update the LIBPATH environment variable.

Example: LIBPATH=/opt/ibm/cognos/analytics/bin64:$LIBPATH
6. Append the <COGNOS_HOME>/bin64 directory to the PATH environment variable.

Example: export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/opt/ibm/cognos/analytics/
bin64

7. Verify that JAVA_HOME is set in the system environment variables.
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Set JAVA_HOME to <COGNOS_HOME>/jre/bin

Do this step on each reporting server in your deployment (active and standby).

If the reporting server is installed on the same computer as the application server, you can skip this
step.

8. If you are using an Oracle database on the same computer as Cognos Analytics, update the IBM
Cognos service settings to the user account for which you created the user variables for the 32-bit
Oracle libraries.

a) Open the Microsoft Windows Services page.
b) Right-click the IBM Cognos service, select Properties, and click the Log On tab.
c) Select This Account, and select the user account for which you created the user variables for the

32-bit Oracle libraries.

Web server configuration options for Cognos Analytics
You must configure your web server before users can connect to the Cognos Analytics portal.

For more information, see the following topics in the Cognos Analyticsdocumentation:

• Configure Cognos Analytics with your web server (https://www.ibm.com/support/knowledgecenter/en/
SSEP7J_11.0.0/com.ibm.swg.ba.cognos.inst_cr_winux.doc/c_configureawebserver_single.html)

• Configure Apache HTTP Server or IBM HTTP Server (https://www.ibm.com/support/
knowledgecenter/en/SSEP7J_11.0.0/com.ibm.swg.ba.cognos.inst_cr_winux.doc/
c_config_web_server_intro.html)

The configuration for these web servers has changed in Cognos Analytics V11.0. See the following topic
for an example of the configuration: “Configuring Apache Web Server or IBM HTTP Server” on page 92

• Configuring IIS in Cognos Analytics 11.0.4+ (https://www.ibm.com/support/knowledgecenter/en/
SSEP7J_11.0.0/com.ibm.swg.ba.cognos.inst_cr_winux.doc/t_gateway_iis.html)

If you are using Microsoft Internet Information Services (IIS) on Windows, see the following technote
for information about how to use a script to do the configuration.

Consider the following guidelines:

• Use compiled gateways for production systems

For production systems, you can improve performance by changing the gateway from the default CGI
gateway.

• Use CGI gateways

You can use the CGI gateway on IBM HTTP Server, Apache Web Server, or Microsoft Internet
Information Services (IIS) Server. Cognos Analytics is configured to use the CGI gateway by default.

• Configure WebDAV to view and browse images

To view and browse images in the Cognos Analytics, configure Web Distributed Authoring and
Versioning (WebDAV) on your web server. Report authors can browse for images to include in reports in
a way that is similar to browsing a file system.

Configuring Apache Web Server or IBM HTTP Server
You must configure the Cognos Analytics gateway on your web server.

Procedure

1. Log on to the web server as a user with administrative privileges.
2. From the command prompt, go to the <Webserver_installation>/conf/ directory.
3. Make a backup copy of the httpd.conf file and rename the file to: httpd.conf.original.
4. Open the httpd.conf file in a text editor.
5. Configure the virtual directories by adding the following lines to the end of the httpd.conf file.
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For example, on UNIX:

LoadModule headers_module modules/mod_headers.so
LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_http_module modules/mod_proxy_http.so

<Location /ibmcognos/bi>
RequestHeader set X-BI-PATH /ibmcognos/bi/v1
ProxyPass http://op-server.com:9300/bi
ProxyPassReverse http://op-server.com:9300/bi
ProxyPassReverseCookieDomain . ibm.com
</Location>

ScriptAlias /ibmcognos/cgi-bin /home/opuser/IBM/cognos/analytics/cgi-bin
<Directory /home/opuser/IBM/cognos/analytics/cgi-bin>
AllowOverride FileInfo
Options FollowSymLinks
Order Allow,Deny
Allow from All
</Directory>

Alias /ibmcognos/help /home/opuser/IBM/cognos/analytics/webcontent/documentation
<Directory /home/opuser/IBM/cognos/analytics/webcontent/documentation>
AllowOverride FileInfo
Options FollowSymLinks
Order Allow,Deny
Allow from All
</Directory>

Alias /ibmcognos /home/opuser/IBM/cognos/analytics/webcontent
<Directory /home/opuser/IBM/cognos/analytics/webcontent>
AllowOverride FileInfo
Options FollowSymLinks
Order Allow,Deny
Allow from All
</Directory>

Note: Ensure that you define the /ibmcognos/cgi-bin alias before the /ibmcognos alias.
6. Save and close the file.
7. Restart the web server.

Configuring a connection to the content store (DB2)
After you install Cognos Analytics, configure a connection to the content store database.

Important: The content store database must be in a separate database instance than the IBM OpenPages
GRC Platform database. Oracle compatibility mode must not be enabled for the IBM DB2 database
instance that is used for the content store.

Before you begin

Ensure that you copied the following files from the <DB2_HOME>/sqllib/java directory to the
<COGNOS_HOME>/drivers directory:

• db2jcc4.jar
• db2jcc_license_cu.jar

Procedure

1. Log on to the reporting server as a user with administrator privileges.

Note: For Windows installations, the user must belong to the DB2ADMINS group. For Linux or AIX
installations, the user must belong to the db2iadm group.

2. Start Cognos Configuration.

• On Windows computers, from the Start menu, click All Programs > IBM Cognos Analytics > IBM
Cognos Configuration.

• On Linux or AIX, go to the <COGNOS_HOME>/bin64 directory, type ./cogconfig.sh, and press
Enter.

3. In Cognos Configuration, configure the database connection to the content store.

Install IBM OpenPages GRC Platform  93



a) In the Explorer pane, under Data Access > Content Manager,, click Content Store.
b) In the Database server and port number field, enter the name of the computer and the port

number on which DB2 is running.

localhost:50000 is the default setting. 50000 is the default port number that is used by DB2.
Replace localhost with the DB2 server name. If you are using a different port number, replace
the default port with the port that you are using.

c) Click the Value field next to the User ID and password property, click the edit icon, and type the
appropriate values for the Cognos user that you created for the content store database, and click
OK.

d) In the Properties window, for the Database name property, type the name for your content store
database.

Restriction: Do not use a name longer than eight characters and use only letters, numbers,
underscores, and hyphens in the name.

4. Right-click Content Store, and click Generate DDL.
5. In the message box, click Details to record the location of the DDL file that is generated.

The createDb.sql file is created in the <COGNOS_HOME>/configuration/schemas/
content/db2 directory.

6. To save your settings in Cognos Configuration, click File > Save.
7. To run the script that creates the database, log in to the database server as a user who has

permissions to create a database.
a) For Windows installations, at the command prompt, type db2cmd.
b) From the command line, type db2 -tvf createDb.sql.
c) On Windows computers, close the CLP.

8. In Cognos Configuration, in the Explorer pane, right-click the content store database connection and
click Test.

Configuring a connection to the content store (Oracle)
After you install Cognos Analytics, configure a connection to the content store database.

Before you begin
Ensure that you copied the ojdbc7.jar file from the <ORACLE_HOME>/jdbc/lib directory on the
database server to the <COGNOS_HOME>/drivers directory on the reporting server.

Procedure

1. Log on to the reporting server computer where Cognos Analytics is installed.
2. Go to the <OP_version>_Non_Embedded/<OP_version>_Configuration/Database/ORACLE/
COGNOS directory.

3. Log on to the Oracle database as SYS using the following command:

sqlplus <sys>/<password>@<SID> as sysdba

For example:

sqlplus sys/mypassword@OP as sysdba

4. At the SQL*Plus prompt, run the following command to create the user and password for the content
store database:

@cognosdbcreate.sql <cognos_user> <cognos_password>
     <oracle_data_home> <tablespace_name> <log_file>
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Table 23: Parameter descriptions for the cognosdbcreate.sql script for Oracle databases

Script parameters Description

cognos_user Specifies the new user name for the content store database

cognos_password Specifies the password for the cognos_user

oracle_data_home Specifies the location of the Oracle data home directory for the
content store database instance.

On Windows operating systems: <ORACLE_BASE>\oradata\<SID>

tablespace_name Specifies the name of the exported table space.

log_file Specifies the file name and location of the log file to create.

For example:

@cognosdbcreate.sql cognos mypassword
    /home/oracle/app/oracle/oradata/<SID> cognos_ts cognosdbcreate.log

5. Exit SQL*Plus.
6. Start Cognos Configuration.

• On Windows computers, from the Start menu, click All Programs > IBM Cognos Analytics > IBM
Cognos Configuration.

• On Linux or AIX, go to the <COGNOS_HOME>/bin64 directory, type ./cogconfig.sh, and press
Enter.

7. In Cognos Configuration, configure the database connection to the content store.
a) In the Explorer pane, under Data Access > Content Manager, right-click Content Store > Delete.
b) Right-click Content Manager > New Resource > Database.
c) In the New Database window, for the Name field, enter a descriptive name for the connection.

Note: The name is not required to match the database identifier.
d) For the Type, select Oracle Database (Advanced) for Oracle RAC databases, or Oracle Database if

you are not using an Oracle RAC database.
e) Click OK.
f) In the Explorer panel, select the new connection, and in the Properties panel, use the following

tables to enter the property settings.

Table 24: Content store property settings for Oracle database

Property name Property value

Database server and port number The name of the database server and the
listener port that is used for the database
instance.
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Table 24: Content store property settings for Oracle database (continued)

Property name Property value

User ID and Password Click the value field and then click the pencil
icon.

In the Value - User ID and password field,
enter the appropriate values for the user and
password for the content store database you
created in step 4.

If you used the IBM OpenPages GRC Platform
Installer for Cognos, the default user is cognos.

Service name Enter the SID for the database instance.

Table 25: Content store property settings for Oracle database (Advanced) (Oracle RAC database)

Property name Property value

Database server and port number The name of the database server and the listener port
that is used for the database instance.

User ID and Password Click the value field and then click the pencil icon.

In the Value - User ID and password field, enter the
appropriate values for the content store database you
created in step 4.

If you used the OpenPages GRC Platform Installer for
Cognos, the default user is cognos.

Database specifier Enter a database specifier string in the following
format with no carriage returns:

(description=(address=
(host=<server_name>)
(protocol=tcp)(port=<port>)
(connect_data(service_name=
<service_name>)))

8. To test that the database connection to the content store database is successful, in the Explorer pane,
right-click the content store database connection and click Test.

Saving your settings and starting the IBM Cognos services
You must save your configuration settings and start the IBM Cognos services.

Procedure

1. Start Cognos Configuration.

• On Windows computers, from the Start menu, click All Programs > IBM Cognos Analytics > IBM
Cognos Configuration.

• On Linux or AIX, go to the <COGNOS_HOME>/bin64 directory, type ./cogconfig.sh, and press
Enter.

2. Ensure that the name under IBM Cognos services is IBM Cognos, the default value.

Important: On Microsoft Windows operating systems, IBM OpenPages GRC Platform requires IBM
Cognos as the service name.

3. Under Local Configuration, click Environment.
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4. Ensure that you use the default port number for the values such as Dispatcher URIs for gateway,
External dispatcher URI, Internal dispatcher URI, Dispatcher URIs for external applications, and
Content Manager URIs. The default port number is 9300.

Important: Changing the default port number also changes the IBM Cognos service name.
5. In IBM Cognos Configuration, click File > Save to save your configuration settings.

You must save the configuration settings, even if you have not changed any of the values.
6. Click Actions > Start.

It might take a few minutes for the IBM Cognos service to start.

If you receive a warning during the Testing the mail server connection process, click OK and
Continue to continue starting the services. A mail server connection is not required.

Warning: If you chose to upgrade your content store database by creating a backup and
restoring it, you are prompted to upgrade your reports. Do not select the option to upgrade your
reporting content. Upgrade your reports later by using the New Report Upgrade wizard in IBM
Cognos Administration.

Enabling the connection to a DB2 database from the OpenPages CommandCenter computer
Cataloging a TCP/IP node adds an entry to the Data Server Client node directory that describes the
remote node. This entry specifies the chosen alias, the host name or IP address, and the service name (or
the port number) that the client uses to access the remote host.

Before a client application can access a remote database, the database must be cataloged on the client.
When you create a database, the database is automatically cataloged on the server with a database alias.
The database alias is the same as the database name, unless a different database alias is specified.

Important: If the application server and database server are on the same computer, you can ensure that
the Cognos installation user has access to the IBM OpenPages GRC Platform data source by cataloging
the OpenPages repository node and database.

Before you begin

Ensure that IBM DB2 client software is installed on the reporting server.

Procedure

1. Log on to the reporting server with a valid DB2 user ID.
2. If you are using Microsoft Windows, start the DB2 command line processor. Open a command prompt

and run db2cmd.
3. Catalog the node by entering the following commands in the command line processor:

db2 catalog tcpip node <node_name> remote <hostname|ip_address> 
   server <service_name|port_number>
db2 terminate

Example:

db2 catalog tcpip node OPNODE remote mycomputer.domain.com server 50000
db2 terminate

4. Catalog the database by entering the following commands in the command line processor:

db2 catalog database <database_name> as <database_alias>
  at node <node_name> [ authentication <auth_value> ]

Example:

db2 catalog database OPX at node OPNODE authentication server
db2 terminate
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5. To list the node directory, type the following command:

db2 list node directory show detail

6. To list the database directory, type the following command:

db2 list database directory

Setting database environment variables for the reporting server on AIX and Linux operating systems
If you use an Oracle database for the IBM OpenPages GRC Platform repository, you must set some system
environment variables on the reporting server.

Procedure

1. Log on to the reporting server as an OpenPages installation user with administrative privileges.
2. To determine the version of Java that is in the PATH variable, run the following command:

java -version

If you get the following error, Java is not in the PATH variable.
Command not found

3. Set the following environment variables.

Table 26: Environment variable settings on the reporting server on Linux or AIX operating systems

Environment variable Example settings

JAVA_HOME Specifies the installation location of your Java Runtime
Environment (JRE).

For example /usr/IBM/cognos/analytics/jre

COGNOS_HOME Specifies the installation location of Cognos Analytics.

For example /usr/IBM/cognos/analytics

4. Append JAVA_HOME to the PATH variable.

Example: PATH=$JAVA_HOME/bin:$PATH
5. If you use Oracle for the OpenPages database, set the following environment variables.

Table 27: Oracle database environment variable settings on the reporting server on Linux or AIX
operating systems

Environment variable Example settings

ORACLE_HOME The default location is /home/oracle/app/oracle/
product/<Oracle_version>/client_1

If you installed the OpenPages application and Cognos on the
same server, enter the location of the 32-bit Oracle Admin
Client.

TNS_ADMIN Specifies the location of the tnsnames.ora file.

The default location is $ORACLE_HOME/network/admin
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Table 27: Oracle database environment variable settings on the reporting server on Linux or AIX
operating systems (continued)

Environment variable Example settings

NLS_LANG Specifies the database character set configured during the
database installation. By default, set to
AMERICAN_AMERICA.AL32UTF8

Important: To display non-English characters for Japanese
locales, set NLS_LANG=JAPANESE_JAPAN.JA16SJISTILDE

6. Append ORACLE_HOME to the PATH variable.

Example: PATH=$ORACLE_HOME/bin:$PATH
7. Refresh the profile.

Setting database environment variables for reporting servers on Windows operating systems
You must set some system environment variables on the reporting server.

Procedure

1. Log on to the reporting server as a user with administrative privileges.
2. Set the following environment variables in the user profile.

Table 28: Environment variable settings on the reporting server on Windows operating systems

Environment variable Setting

JAVA_HOME Specifies the installation location of your Java Runtime
Environment (JRE).

COGNOS_HOME Specifies the location of the Cognos Analytics directory.
C:\IBM\cognos\analytics

3. Append JAVA_HOME to the PATH environment variable.

Example: Add %JAVA_HOME%/bin to the PATH environment variable.
4. If you are using an Oracle database for the OpenPages database, set the following environment

variables.

Table 29: Oracle environment variable settings on the reporting server on Windows operating systems

Environment variable Setting

ORACLE_HOME The default location is a subdirectory of ORACLE_BASE, such
as ORACLE_BASE=C:\app\product\<Oracle_version>
\client_1

If you installed the OpenPages application and Cognos
Analytics on the same server, enter the location of the 32-bit
Oracle Admin Client.

Example: ORACLE_HOME=C:\app\product
\<Oracle_version>\client_32bit

TNS_ADMIN Specifies the location of the tnsnames.ora file.

The default location is <ORACLE_HOME>\network\admin
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Table 29: Oracle environment variable settings on the reporting server on Windows operating systems
(continued)

Environment variable Setting

NLS_LANG Specifies the database character set configured during the
database installation. The default value is
AMERICAN_AMERICA.AL32UTF8

Note: To display non-English characters for Japanese locales,
set the NLS_LANG property:
NLS_LANG=JAPANESE_JAPAN.JA16SJISTILDE

5. Append ORACLE_HOME to the PATH environment variable.

Example: Add %ORACLE_HOME%/bin to the PATH environment variable.

Testing the connection to the OpenPages database from the Oracle database client
Test whether the SQL*Net connect string can connect to the IBM OpenPages GRC Platform database on
the Oracle database server from the Oracle database client.

Procedure

1. Copy the file <ORACLE_HOME>/network/admin/tnsnames.ora from the Oracle database server
operating system to the <ORACLE_HOME>/network/admin Oracle database client directory.

Ensure that the OpenPages installation user has read, write and execute permissions on the
tnsnames.ora file in the Oracle database client operating system.

2. Log on to the Oracle database client as an OpenPages installation user.
3. Edit the file <ORACLE_HOME>/network/admin/tnsnames.ora, and update the Host value to the

host name or IP address of the Oracle database server.
4. To test the connection to the OpenPages database on the database server, type the following

command:

sqlplus <username>/<password>@<service_name>

For example, sqlplus system/openpages@op

The system connects you to an Oracle database instance.
5. To exit SQL*Plus, type exit.

Checklist for the search server
If you want to use global search, you need a search server. Do the following tasks on the search server
before you install IBM OpenPages GRC Platform:

• Check that all of the required ports are available. See “Port assignments ” on page 102.
• Install IBM Java 8. See “Getting a copy of the IBM Runtime Environment for Java for the search server”

on page 100.

Getting a copy of the IBM Runtime Environment for Java for the search server
Before you install a search server, install IBM Runtime Environment for Java (IBM JRE) and set up the
system environment variables for Java on the search server computer.

About this task

You can install the search server on a computer that is using a different operating system from the
OpenPages application servers. The version of Java on the search server must be a version of Java that is
supported by IBM OpenPages GRC Platform.
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Procedure

1. Get a copy of IBM Runtime Environment for Java (IBM JRE) from the IBM OpenPages GRC Platform
installation media.

• If you are installing the search server on a computer that is running Microsoft Windows, copy
\OP_<version>_Non_Embedded\IBM_Java\WIN64\java_8.0_64 to the search server.

• If you are installing the search server on a computer that is running Linux, copy /
OP_<version>_Non_Embedded/IBM_Java/Linux64/java_8.0_64 to the search server.

• If you are installing the search server on a computer that is running AIX, copy /
OP_<version>_Non_Embedded/IBM_Java/AIX64/java_8.0_64 to the search server.

2. Copy IBM JRE to the local hard disk of the search server.

You can copy IBM JRE to any directory on the search server.

For example:

• Windows operating systems: Copy IBM JRE to the root of the C drive under C:\IBM.
• Linux or AIX operating systems: Copy IBM JRE to /opt/IBM/.

3. For Linux or AIX operating systems, grant read, write, and execute permissions on Java to the
OpenPages installation user (opuser).

Run the following command:

chmod -R +x /opt/IBM/java_8.0_64

4. Set the system environment variables for Java.

Windows operating systems:

a) Click Start. Right-click Computer, click Properties, and then click Advanced system settings.
b) Click Environment Variables.
c) Under System variables, click New.
d) Type JAVA_HOME in the Variable name field.
e) Type C:\IBM\java_8.0_64\jre in the Variable value field.
f) Click OK.
g) Under System variables, select the Path variable, and then click Edit.
h) Type %JAVA_HOME%\bin; at the beginning of the list of paths in the Variable value field.
i) Click OK.

Linux or AIX operating systems:
a) Based on the UNIX shell that you are using and the account under which the search server will run,

edit the .profile or .bashrc file.
b) Ensure that JAVA_HOME is set to /opt/IBM/java_8.0_64/jre.
c) Ensure that PATH includes $JAVA_HOME/bin as the first item.

Note: On AIX, Linux and Windows operating systems, start a new command prompt or shell window to
see the changes to the environment variables.

5. Verify the version of Java that is on the search server.

Run the java -version command. The result should be similar to the following sample:

java version "1.8.0"
Java(TM) SE Runtime Environment (build pxa6480sr4fp1-20170215_01(SR4 FP1))
IBM J9 VM (build 2.8, JRE 1.8.0 Linux amd64-64 Compressed References 20170209_336038 (JIT 
enabled, AOT enabled)
J9VM - R28_20170209_0201_B336038
JIT  - tr.r14.java.green_20170125_131456
GC   - R28_20170209_0201_B336038_CMPRSS
J9CL - 20170209_336038)
JCL - 20170215_01 based on Oracle jdk8u121-b13
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Port assignments
Both dedicated ports and ports that are dynamically assigned for each installation are used for the IBM
OpenPages GRC Platform installation. These default ports can be changed after installation.

You can change some port settings during the installation. You can also change the default port settings
after installation. For information about changing the ports after installation, see the IBM OpenPages GRC
Administrator's Guide.

Default ports

The following table lists the default ports.

Table 30: Default fixed port assignments

Description Ports

OpenPages installation server 8443

OpenPages installation agent 8443

OpenPages database instance (Oracle) 1521

OpenPages database instance (IBM DB2) 50000

OpenPages deployment manager 9060

OpenPages deployment manager (SSL) 9043

OpenPages application URL 10108

OpenPages application URL (SSL) 10111

OpenPages deployment manager SOAP port 8879

Cognos Analytics gateway (as configured for your web server) 80

Framework Generator port 8080

Cognos Analytics dispatcher URI 9300

Search server (used for indexing and searching OpenPages data) 8983

Search server (used to administer global search) 8985

On Windows computers, additional OpenPages installations increment the port numbers by two.

Files containing port numbers

After installation, you can view the OpenPages port assignments by using the IBM WebSphere
Administrative Console.

The following tables list property files on the OpenPages admin application server that contain port
numbers for other components.
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Table 31: Files that contain port numbers

Port File name Parameter Name

Oracle database instance port <ORACLE_HOME>/NETWORK/
  ADMIN/tnsnames.ora

N/A

Framework Generator port <OP_HOME>/aurora/conf/
  aurora.properties

cognos.framework.refresh.ser
vlet

Cognos Analytics server port <OP_HOME>/aurora/conf/
  aurora.properties

cognos.server

Cognos Analytics Dispatcher URI <OP_HOME>/aurora/conf/
  aurora.properties

cognos.computation.server

Dynamically assigned ports

Port numbers for IBM OpenPages GRC Platform servers that are not listed, such as OpenPages non-admin
application servers, are assigned dynamically during the installation.

OpenPages application non-admin server port numbers start at 9080 and increment by 1 for each
additional server in the installation.

After installation, you can view all port assignments by using the IBM WebSphere Administrative Console.

Create the database schema objects
Before you install IBM OpenPages GRC Platform, decide how you want to create the OpenPages database.

OpenPages database object creation for DB2
Before you install IBM OpenPages GRC Platform, decide how you want to create the OpenPages database
objects.

You have the following options:

• You can use the OpenPages installation program to create the database objects. If you choose this
option, you need to provide DBA credentials when you install OpenPages.

• You can ask a database administrator to do the steps that require DBA privileges, and then use the
OpenPages installation program to complete the database setup. Use this option if your organization's
security policies require the separation of DBA and non-DBA tasks. Also, use this option if your database
administrator wants to customize the table space names, the schema name, or make other
customizations.

• You can create all of the objects required for the database manually by using scripts. Use this option if
you want to customize the table space names or if you want to run custom scripts.

The initial install of a DB2 database always assumes LFS for the OpenPages storage type. If you want to
use UNC, you must first install with LFS and then use the update storage script to change to UNC.
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Preparing the files for your database administrator
Your database administrator needs a set of scripts to create the database objects. You need to prepare
the files and send them to your DBA with instructions on how to run the scripts.

Do this procedure if your organization's security policies require the separation of DBA and non-DBA
tasks.

About this task

The sql-wrapper.sql file contains information that is used by the database scripts. You need to enter
the values for your environment, such as the name of the database instance for OpenPages.

When you install OpenPages, use the same values that you set in the sql-wrapper.sql file.

Procedure

1. Log on to the DB2 database server computer as a user with administrative privileges.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

3. Verify that you have write permission on the sql-wrapper.sql file. If not, change the permission on
the file by using the chmod command.

4. Edit the sql-wrapper.sql file.

Restriction: Change only the parameters that are described in this step.

These parameters are used by the scripts that your DBA will run.

Table 32: Parameters in the sql-wrapper.sql file for DB2 databases

Property Description

opx_instance_owner The database instance owner for OpenPages.

The user you specify must have both DBADM and
SECADM privileges

If your database administrator is going to run the
DBA scripts for you, then you can leave this value
empty when you run the non-DBA scripts.

opx_db2_server_name The database server name

opx_db2_port_number The database port number, for example 50000

opx_db2_db_name The name of the OpenPages database.

opx_db_owner The schema owner of the OpenPages database.

opx_dflt_stor_srv_root The path to the OpenPages storage directory.

Example:

define opx_dflt_stor_srv_root='/home/
opuser/OP/OpenPages/openpages-storage'

opx_op_admin_name The OpenPages administrator user name

opx_op_admin_pwd The OpenPages administrator password

5. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

6. Collect the following files and send them to your DBA.

• sql-wrapper.sql
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• create-opx-schema-owner.sql
• create-opx-tablespaces.sql
• dba-grant.sql
• no-op.sql
• op-database-dba-install.bat/.sh
• op-database-dba-install.sql

Also, send your DBA the instructions to run the DBA script: “Running the steps that require DBA
privileges” on page 105

Note: If you have DBA privileges and you plan to run the DBA scripts, you can skip this step.

Running the steps that require DBA privileges
You can run a script to do the database object creation steps that require DBA privileges. Do this
procedure if you do not want to enter DBA credentials when you install OpenPages or if your
organization's security policies require the separation of DBA and non-DBA tasks.

Before you begin

• The DB2 database server is running
• A database instance for the OpenPages database is created
• The sql-wrapper.sql is configured for your environment

About this task

Run the following script: op-database-dba-install.sh|.bat. The script uses the parameters in the
sql-wrapper.sql file.

The op-database-dba-install.sh|.bat calls the following scripts:

• op-database-dba-install.sql: Runs the DBA steps. This script calls the other scripts in this list.
• create-opx-tablespaces.sql: Creates the OpenPages table spaces.
• dba-grant.sql: Grants privileges to the DBA user.
• create-opx-schema-owner.sql: Creates the OpenPages schema owner and grants the user access

to the OpenPages table spaces.
• no-op.sql: This script is empty. Edit this script if you want to run any custom scripts at the end of the

DBA setup process. See “Custom table space names” on page 106.

You can do the following configurations:

• You can specify custom names for table spaces
• You can specify a custom SQL script to run

Procedure

1. Log on to the DB2 database server computer as the DB2 database administrator (DBA).
2. Locate the scripts that are required.

If you are a database administrator, get the scripts from your OpenPages team.

Or, you can get the scripts from the /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/DB2/INSTALL_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.

The user that you specify for the opx_instance_owner parameter must have both DBADM and
SECADM privileges.

If you want to customize the table space names, see “Custom table space names” on page 106.
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Note: Do not modify the parameters in the section that is used only for upgrades.
5. On Windows, start the DB2 command line processor (CLP). Click All Programs > IBM DB2 > IBM DB2

DB2COPY1 > DB2 Command Window - Administrator
6. Run the op-database-dba-install.sh|.bat script from the command line.

On Windows:

op-database-dba-install.bat <dba_password>

On Linux or AIX:

./op-database-dba-install.sh <dba_password>

7. Verify that the return code is 0, indicating success.

You can also check the log file, op-dba-install-<timestamp>.log.

What to do next
You can use the OpenPages installation program to complete the database setup. Or you can complete
the database setup manually by using scripts.

Custom table space names
You can customize the table spaces in the OpenPages database. These procedures are intended for
database administrators.

To customize the table space names, edit the following properties in the sql-wrapper.sql file:

define opx_dflt_data_ts='AURORA'
define opx_dflt_indx_ts='INDX'
define opx_dflt_temp_data_ts='AURORA_NL'
define opx_dflt_temp_indx_ts='AURORA_NLI'
define opx_dflt_dedi_temp_ts='AURORA_TEMP'
define opx_dflt_snp_ts='AURORA_SNP'
define opx_dflt_clob_data_ts='AURORA_CLOB_DATA'
define opx_dflt_domain_indx_ts='AURORA_DOMAIN_INDX'

Give the new table space names to the user who will install OpenPages. The table space names must be
provided during the installation process.

Preparing to run the non-DBA database scripts
Edit the sql-wrapper.sql file to specify the values for your environment.

This procedure is optional. Instead of running scripts, you can complete the database setup when you
install OpenPages.

About this task

The sql-wrapper.sql file contains information that is used by the database scripts. You need to enter
the values for your environment, such as the name of the database instance for OpenPages.

When you install OpenPages, use the same values that you set in the sql-wrapper.sql file.

Procedure

1. Log on to the DB2 database server computer as the DB2 database administrator (DBA).
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

3. Verify that you have write permission on the sql-wrapper.sql file. If not, change the permission on
the file by using the chmod command.

4. Edit the sql-wrapper.sql file to ensure that the variables are set correctly for your environment.

Edit the following parameters, if needed:
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Table 33: Parameters in the sql-wrapper.sql file for DB2 databases

Property Description

opx_instance_owner The database instance owner for OpenPages.

opx_db2_server_name The database server name

opx_db2_port_number The database port number, for example 50000

opx_db2_db_name The name of the OpenPages database.

opx_db_owner The schema owner of the OpenPages database.

opx_dflt_stor_srv_root The path to the OpenPages storage directory.

Example:

define opx_dflt_stor_srv_root='/home/
opuser/OP/OpenPages/openpages-storage'

opx_op_admin_name The OpenPages administrator user name

opx_op_admin_pwd The OpenPages administrator password

opx_base_currency_iso_code The base currency

For example, if you use Euros as your base
currency, change the default ISO currency code
from USD to EUR.

define opx_base_currency_iso_code='EUR'

5. If you want to load custom data during the database setup process, see “Loading custom data (DB2
and Oracle)” on page 107.

Loading custom data (DB2 and Oracle)
If you want to load custom data during the database setup process, edit the sql-wrapper.sql file to
specify the scripts to run.

About this task

You can use the custom_environment_script and custom_data_load_script parameters to
configure a custom scripts.

Use the custom_environment_script parameter to set environment values. The script that you
specify is called each time that the sql-wrapper.sql script is called.

Use the custom_data_load_script parameter to load custom data. The script that you specify is
called by the op-database-product-install.sh|.bat script. The custom data load is done as the
last step in the op-database-product-install.sh|.bat script.

Procedure

1. Open the sql-wrapper.sql file.
2. If you are using IBM DB2, verify that the sqllib_dir path is correct. If you are running the custom

scripts from a computer other than the database server, update the path.
3. Edit the following parameters:

define custom_environment_script=no-op.sql
define custom_data_load_script=no-op.sql

Replace no-op.sql with the script that you want to run.
4. Place your custom scripts in the same directory as the sql-wrapper.sql file.

Install IBM OpenPages GRC Platform  107



Running the steps that do not require DBA privileges
You can complete the database setup manually by using scripts. Do this procedure after a database
administrator has run the DBA scripts.

This procedure is optional. Instead of running scripts, you can complete the database setup when you
install OpenPages.

Before you begin
Ensure that the following conditions are met:

• The DB2 database server is running.
• A database instance for the OpenPages database is created.
• The database setup steps that require DBA privileges are complete.
• The sql-wrapper.sql file is configured for your environment.

About this task

You need to run the following scripts:

• op-validate-dba-install.sh|.bat: Validates that the DBA steps completed successfully.
• op-database-product-install.sh|.bat: Performs the database creation tasks that do not

require DBA privileges.
• op-validate-product-install.sh|.bat: Validates that the database setup steps completed

successfully.

These scripts use the parameters that are specified in the sql-wrapper.sql script.

Procedure

1. Log on to the DB2 database server computer as the DB2 database administrator (DBA).
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

3. Verify that you have execute permission on the scripts in the INSTALL_SCRIPTS directory.
4. On Windows, start the DB2 command line processor (CLP). Click All Programs > IBM DB2 > IBM DB2

DB2COPY1 > DB2 Command Window - Administrator
5. Run the op-validate-dba-install.sh|.bat script from the command line.

The script verifies that the DBA setup steps are complete.

On Linux or AIX:

./op-validate-dba-install.sh <opuser_password>

On Windows:

op-validate-dba-install.bat <opuser_password>

Replace <opuser_password> with the password of the OpenPages database user.
6. Verify that the return code is 0, indicating success.
7. Run the op-database-product-install.sh|.bat script from the command line.

On Linux or AIX:

./op-database-product-install.sh <opuser_password>

On Windows:

op-database-product-install.bat <opuser_password>

Replace <opuser_password> with the password of the OpenPages database user.
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8. Verify that the return code is 0, indicating success.

You can also view the log file, op-database-product-install-<timestamp>.log.
9. Run the op-validate-product-install.sh|.bat script from the command line.

The script verifies that the setup steps are complete.

On Linux or AIX:

./op-validate-product-install.sh <opuser_password>

On Windows:

op-validate-product-install.bat <opuser_password>

Replace <opuser_password> with the password of the OpenPages database user.
10. Verify that the return code is 0, indicating success.

You can also view the log file, validate-product-install-<timestamp>.log.
11. Remove the passwords from the sql-wrapper.sql file for security purposes.

Troubleshooting DB2 database object creation
If you encounter problems when you run the scripts to create the database objects, you can run scripts to
drop the objects and then try again.

You have two choices:

• You can drop the database objects that were created when you ran the non-DBA script (op-database-
product-install.sh|.bat). See “Dropping non-DBA database objects in a DB2 database” on page
109.

• You can drop all of the OpenPages database objects. This option drops the database objects created by
op-database-dba-install.sh|.bat and op-database-product-install.sh|.bat. See
“Dropping all OpenPages objects in a DB2 database” on page 110.

Dropping non-DBA database objects in a DB2 database
You can run the AuroraDbDelete.sql script to drop the database objects that the op-database-
product-install.sh|.bat script created.

Procedure

1. Log on to the IBM DB2 database server as a user with administrative privileges.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

3. Verify that you have execute permission on the files in the INSTALL_SCRIPTS directory. If not, change
the permission on the file by using the chmod command.

4. On Windows, start the DB2 command line processor (CLP). Click All Programs > IBM DB2 > IBM DB2
DB2COPY1 > DB2 Command Window - Administrator

5. Run the AuroraDbDelete.sql script from the command line.

@AuroraDbDelete.sql

What to do next
Run the op-database-product-install.sh|.bat script again. See “Running the steps that do not
require DBA privileges” on page 108.

If you encounter problems again, you can drop all of the OpenPages database objects. See “Dropping all
OpenPages objects in a DB2 database” on page 110.
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Dropping all OpenPages objects in a DB2 database
You can run the init-db-cleanup.sql script to drop the database objects. The script drops the
objects that the op-database-dba-install.sh|.bat and op-database-product-
install.sh|.bat scripts created.

About this task
The init-db-cleanup.sh|.bat script drops the database objects and removes the OpenPages table
spaces.

You must have DBA privileges to run the script.

Procedure

1. Log on to the IBM DB2 database server as a user with administrative privileges.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

3. Verify that you have execute permission on the files in the INSTALL_SCRIPTS directory. If not, change
the permission on the file by using the chmod command.

4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.
5. On Windows, start the DB2 command line processor (CLP). Click All Programs > IBM DB2 > IBM DB2

DB2COPY1 > DB2 Command Window - Administrator
6. Run the init-db-cleanup.sh|.bat script.

On Linux or AIX:

./init-db-cleanup.sh <dba_password>

On Windows:

init-db-cleanup.bat <dba_password>

What to do next
Run the database object creation scripts in a clean database environment. See “OpenPages database
object creation for DB2” on page 103.

OpenPages database schema creation for Oracle
Before you install IBM OpenPages GRC Platform, decide how you want to create the OpenPages database.

You have the following options:

• You can use the OpenPages installation program to create the database schema. If you choose this
option, you need to provide DBA credentials when you install OpenPages.

• You can ask a database administrator to do the steps that require DBA privileges, and then use the
OpenPages installation program to complete the database setup. Use this option if your organization's
security policies require the separation of DBA and non-DBA tasks. Also, use this option if your database
administrator wants to customize the table space names, the schema name, or make other
customizations.

• You can create all of the objects required for the database manually by using scripts. Use this option if
you want to do any of the following configurations:

– Customize the table space names or the schema name
– Customize the table space data file locations
– Use Oracle Transparent Data Encryption (TDE)
– Run custom scripts

The initial install of an Oracle database always assumes LFS for the OpenPages storage type. If you want
to use UNC, you must first install with LFS and then use the update storage script to change to UNC.
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This video demonstrates how to create the database schema by using scripts:

https://youtu.be/0WGVOxWqQH4

Preparing the files for your database administrator
Your database administrator needs a set of scripts to create the database schema. You need to prepare
the files and send them to your DBA with instructions on how to run the scripts.

Do this procedure if your organization's security policies require the separation of DBA and non-DBA
tasks.

About this task

The sql-wrapper.sql file contains information that is used by the database scripts. You need to enter
the values for your environment, such as the name of the database instance for OpenPages.

When you install OpenPages, use the same values that you set in the sql-wrapper.sql file.

Procedure

1. Log on to the Oracle database server computer as a user with administrative privileges.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

3. Verify that you have write permission on the sql-wrapper.sql file. If not, change the permission on
the file by using the chmod command.

4. Edit the sql-wrapper.sql file.

Restriction: Change only the parameters that are described in this step.

These parameters are used by the scripts that your DBA will run.

Table 34: Parameters in the sql-wrapper.sql file for Oracle databases

Property Description

opx_datafile_storage_dir Defines the physical locations of the datafiles
that are associated with the tablespaces that are
created. This should be set to a value that is
appropriate for your environment

opx_dflt_sid The TNS alias of the Oracle database for
OpenPages.

opx_db_owner The database owner, also the name of the
schema

opx_op_admin_name The OpenPages administrator user name

opx_op_admin_pwd The OpenPages administrator password

opx_dflt_stor_srv_root The path to the OpenPages storage directory.

Example:

define opx_dflt_stor_srv_root='/home/
opuser/
OP/OpenPages/openpages-storage'

5. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

6. Collect the following files and send them to your DBA.

• sql-wrapper.sql
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• create-opx-directory.sql
• create-opx-schema-owner.sql
• create-opx-tablespaces.sql
• install-oracle-text.sql
• no-op.sql
• op-database-dba-install.sh|.bat
• op-database-dba-install.sql
• uniform-grants.sql

Also, send your DBA the instructions to run the DBA script: “Running the steps that require DBA
privileges” on page 112.

Note: If you have DBA privileges and you plan to run the DBA scripts, you can skip this step.

Running the steps that require DBA privileges
You can run a script to do the database schema creation steps that require DBA privileges. Do this
procedure if you do not want to enter DBA credentials when you install OpenPages or if your
organization's security policies require the separation of DBA and non-DBA tasks.

Before you begin

• The Oracle database server is running
• A database instance for the OpenPages database is created
• The sql-wrapper.sql file is configured for your environment

About this task

Run the following script: op-database-dba-install.sh|.bat. The script uses the properties that are
defined in the sql-wrapper.sql file.

The op-database-dba-install.sh|.bat calls the following scripts:

• op-database-dba-install.sql: Runs the DBA steps. This script calls the other scripts that are in
this list.

• create-opx-directory.sql: Sets the location of the data pump directory to use for OpenPages.
• create-opx-tablespaces.sql: Creates the OpenPages table spaces. Edit this file to enable Oracle

TDE or to customize the table space data file names and locations.
• create-opx-schema-owner.sql: Creates the OpenPages schema owner and grants the user access

to the OpenPages table spaces.
• uniform-grants.sql: Grants privileges to the schema owner.
• install-oracle-text.sql: Enables Oracle Text Search.
• no-op.sql: This script is empty. Edit this script if you want to run any custom scripts at the end of the

DBA setup process.

You can do the following configurations:

• You can specify a custom name for the OpenPages schema
• You can specify custom names for the table spaces
• You can specify custom data file names and locations for the table spaces
• You can enable or disable Oracle Text
• You can specify a custom SQL script to run

Procedure

1. Log on to the Oracle database server computer as the Oracle database administrator (DBA).
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2. Locate the scripts that are required.

If you are a database administrator, get the scripts from your OpenPages team.

Or, you can get the scripts from the /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/INSTALL_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.

• Enter the DBA user name in the opx_oracle_dba_user parameter. The user that you specify must
have SYSDBA privileges.

For example:

define opx_oracle_dba_user='SYS'

• If you want to customize the table space names, see “Table space names and other customizations”
on page 113.

• If you want to use custom locations for the table space data files, see “Customize table space data
file locations” on page 114.

• If you use Oracle Automatic Storage Management (ASM), see “Changing the database script when
you use Oracle ASM” on page 114.

• If you want to use Oracle TDE, see “Oracle Transparent Data Encryption (TDE) for fresh installations”
on page 114.

Note: Do not modify the parameters in the section that is used only for upgrades.
5. Run the op-database-dba-install.sh|.bat script from the command line.

On Windows:

op-database-dba-install.bat <dba_password> 
   <op_schema_owner_password>

On Linux or AIX:

./op-database-dba-install.sh <dba_password> 
   <op_schema_owner_password>

6. Verify that the return code is 0, indicating success.

You can also check the log file, op-database-dba-install-<timestamp>.log.

What to do next

You can use the OpenPages installation program to complete the database setup. Or you can complete
the database setup manually by using scripts.

Table space names and other customizations
You can customize the table spaces in the OpenPages database. These procedures are intended for
database administrators.

To customize the table space names, edit the following properties in the sql-wrapper.sql file:

define opx_dflt_data_ts='AURORA'
define opx_dflt_indx_ts='INDX'
define opx_dflt_temp_data_ts='AURORA_NL'
define opx_dflt_temp_indx_ts='AURORA_NLI'
define opx_dflt_dedi_temp_ts='AURORA_TEMP'
define opx_dflt_snp_ts='AURORA_SNP'
define opx_dflt_clob_data_ts='AURORA_CLOB_DATA'
define opx_dflt_domain_indx_ts='AURORA_DOMAIN_INDX'

Give the new table space names to the user who will install OpenPages. The table space names must be
provided during the installation process.
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Note: If you complete both the DBA and non-DBA setup steps by using scripts, the table space names do
not need to be provided when you install the OpenPages.

You can also customize the data file path for each table space. See “Customize table space data file
locations” on page 114.

Customize table space data file locations
You can customize the data file location of the OpenPages table spaces.

Procedure

1. Log on to the Oracle database server as the user who installed Oracle.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

3. Open the create-opx-tablespaces.sql script in a text editor.
4. Replace the &&3 parameter with the full path to the data file.

For example, suppose that you want to customize the location of the opx_dflt_data_ts data file:

SELECT lower('&&opx_dflt_data_ts') lcase_name FROM dual;
create tablespace &&opx_dflt_data_ts datafile '&&3/&v_lcase_name..dbf' 
size 512 M reuse autoextend on next 128 M maxsize 1024 M &&encrypt_var;

Replace &&3 with the full path:

SELECT lower('&&opx_dflt_data_ts') lcase_name FROM dual;
create tablespace &&opx_dflt_data_ts datafile '/u01/oradata/OP/&v_lcase_name..dbf' 
size 512 M reuse autoextend on next 128 M maxsize 1024 M &&encrypt_var;

Note: Do not modify the &v_lcase_name..dbf parameter. The table space name is read from the
sql-wrapper.sql file.

Changing the database script when you use Oracle ASM
If you use Oracle Automatic Storage Management (ASM), you must modify some scripted values. You
must update the create-opx-tablespaces.sql script before you run the op-database-dba-
install.sh|.bat script.

Procedure

1. Log on to the Oracle database server as the user who installed Oracle.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

3. Open the create-opx-tablespaces.sql script in a text editor.
4. As appropriate for your environment, replace the '&&3/&v_lcase_name..dbf' parameter with the

name of a disk group.

For example, if you want to use a disk group called DATA to store the opx_dflt_data_ts table
space, use the following syntax:

create tablespace &&opx_dflt_data_ts datafile ‘+DATA’ size 512 M 
   reuse autoextend on next 128 M maxsize 1024 M &&encrypt_var;

5. Save and close the file.

Oracle Transparent Data Encryption (TDE) for fresh installations
You can use Oracle Transparent Data Encryption (TDE) to encrypt the OpenPages and Cognos table
spaces in the OpenPages database.

This task is optional.

Note: This task is for new installations only. If you are upgrading, see “Oracle Transparent Data
Encryption (TDE) for upgrade customers” on page 238.
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IBM OpenPages GRC Platform supports the ability to implement TDE, but TDE is an Oracle feature. You
need to be familiar with data encryption of Oracle databases and you need to configure and maintain TDE.
If you have questions about TDE, refer to the Oracle documentation.

Restriction: OpenPages supports Oracle TDE only for table spaces. Column-based TDE is not supported.

To implement Oracle TDE, you need to complete two main tasks:

1. Configure a key store. Do this step before you install Cognos and OpenPages.

Your database administrator needs to create a key store. The steps and requirements for key stores
are determined by Oracle. IBM is not responsible for the configuration or maintenance of the key store.

Note: A table space can be encrypted only when it is initially created. You cannot alter an existing table
space to enable encryption.

2. Encrypt the Cognos and OpenPages table spaces that support encryption.

To install OpenPages with Oracle TDE, you need to do some manual configuration tasks. Review and
ensure that you understand these manual steps before you install OpenPages with Oracle TDE.

Note: Oracle does not support encryption on system, undo, or temporary table spaces.

For more information about TDE, refer to the Oracle documentation, such as the Oracle Database
Advance Security Guide (https://docs.oracle.com/database/121/ASOAG/toc.htm).

Prerequisites and process overview
Ensure that your environment meets prerequisites for Oracle TDE and review the configuration process.

Note: These instructions are specific to Oracle version 12.1.0.2.

Ensure that your environment meets the following prerequisites:

1. The Oracle database that you are going to use for OpenPages is already created.
2. IBM OpenPages GRC Platform is not installed.
3. Cognos Analytics is not installed.
4. The Oracle instance is open and accepting connections.
5. The database compatibility parameter is set to at least 11.2.0.0 or higher.

Complete the following process to configure TDE:

1. Configure a software key store. Refer to the Oracle documentation: Configuring Transparent Data
Encryption

2. Encrypt the OpenPages table spaces that support encryption:

a. Verify the value of the database compatible parameter.
b. Enable Oracle TDE for Cognos table space.
c. Enable Oracle TDE for OpenPages table spaces.
d. Create the Cognos database user and table space.
e. Run the DBA step of the OpenPages database installation.
f. Verify that the table spaces are encrypted.

g. Complete the installation of OpenPages and Cognos

Encrypting OpenPages and Cognos table spaces
You can encrypt the OpenPages and Cognos table spaces by using Oracle TDE.

About this task

Do this procedure after you set up the key store and before you install IBM OpenPages GRC Platform and
Cognos Analytics.
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Procedure

1. Log on to the OpenPages database instance as the instance owner.
2. Start SQL*Plus.
3. Verify that the database compatible parameter is set to 11.2.0.0 or later.

select value from GV$SYSTEM_PARAMETER where name = 'compatible';

4. To encrypt the Cognos table spaces, modify the cognosdbcreate.sql file.

The cognosdbcreate.sql file is located in the following directory:
OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/ORACLE/COGNOS

a) Open the cognosdbcreate.sql file in a text editor.
b) Locate the Oracle Transparent Data Encryption section.
c) Comment out the define encrypt_var='' line.
d) Uncomment the line for the encryption algorithm that you are using for the table spaces.

For example, if you are using AES128:

--define encrypt_var=''
--define encrypt_var='ENCRYPTION USING ''3DES168'' DEFAULT STORAGE(ENCRYPT)'
define encrypt_var='ENCRYPTION USING ''AES128'' DEFAULT STORAGE(ENCRYPT)'
--define encrypt_var='ENCRYPTION USING ''AES192'' DEFAULT STORAGE(ENCRYPT)'
--define encrypt_var='ENCRYPTION USING ''AES256'' DEFAULT STORAGE(ENCRYPT)'

5. To encrypt the OpenPages table spaces, modify the create-opx-tablespaces.sql file.

The create-opx-tablespaces.sql file is located in the following directory:
OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/ORACLE/
INSTALL_SCRIPTS

a) Open the create-opx-tablespaces.sql file in a text editor.
b) Locate the Oracle Transparent Data Encryption section.
c) Comment out the define encrypt_var='' line.
d) Uncomment the line for the encryption algorithm that you are using for the table spaces.

For example, if you are using AES128:

--define encrypt_var=''
--define encrypt_var='ENCRYPTION USING ''3DES168'' DEFAULT STORAGE(ENCRYPT)'
define encrypt_var='ENCRYPTION USING ''AES128'' DEFAULT STORAGE(ENCRYPT)'
--define encrypt_var='ENCRYPTION USING ''AES192'' DEFAULT STORAGE(ENCRYPT)'
--define encrypt_var='ENCRYPTION USING ''AES256'' DEFAULT STORAGE(ENCRYPT)'

6. Run the op-database-dba-install.sh/bat script . For more information, see “Running the
steps that require DBA privileges” on page 112.

7. Install Cognos Analytics.
For more information, see “Installing Cognos Analytics” on page 90.

8. Run the cognosdbcreate.sql script.
For more information, see “Configuring a connection to the content store (Oracle)” on page 94.

9. Install IBM OpenPages GRC Platform.
10. Verify that the table spaces are encrypted.

Log in to the OpenPages database as a DBA user and run the following command:

select tablespace_name, encrypted, status from dba_tablespaces;

Verify that the output is similar to the following text:

TABLESPACE_NAME                ENC STATUS
------------------------------ --- ---------
SYSTEM                         NO  ONLINE
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SYSAUX                         NO  ONLINE
UNDOTBS1                       NO  ONLINE
TEMP                           NO  ONLINE
USERS                          NO  ONLINE
AURORA                         YES ONLINE
INDX                           YES ONLINE
AURORA_SNP                     YES ONLINE
AURORA_TEMP                    NO  ONLINE
AURORA_NL                      YES ONLINE
AURORA_NLI                     YES ONLINE
AURORA_CLOB_DATA               YES ONLINE
AURORA_DOMAIN_INDX             YES ONLINE
COGNOS                         YES ONLINE

14 rows selected.

Preparing to run the non-DBA database scripts
Edit the sql-wrapper.sql file to specify the values for your environment.

This procedure is optional. Instead of running scripts, you can complete the database setup when you
install OpenPages.

About this task

The sql-wrapper.sql file contains information that is used by the database scripts. You need to enter
the values for your environment, such as the name of the database instance for OpenPages.

When you install OpenPages, use the same values that you set in the sql-wrapper.sql file.

Procedure

1. Log on to the Oracle database server computer as the Oracle database administrator (DBA).
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

3. Verify that you have write permission on the sql-wrapper.sql file. If not, change the permission on
the file by using the chmod command.

4. Edit the sql-wrapper.sql file to ensure that the variables are set correctly for your environment.

Table 35: Parameters in the sql-wrapper.sql file for Oracle databases

Property Description

opx_dflt_sid The TNS alias of the Oracle database for
OpenPages.

opx_db_owner The database owner, also the name of the
schema

opx_op_admin_name The OpenPages administrator user name

opx_op_admin_pwd The OpenPages administrator password

opx_base_currency_iso_code The base currency

For example, if you use Euros as your base
currency, change the default ISO currency code
from USD to EUR.

define opx_base_currency_iso_code='EUR'
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Table 35: Parameters in the sql-wrapper.sql file for Oracle databases (continued)

Property Description

opx_dflt_stor_srv_root The path to the OpenPages storage directory.

Example:

define opx_dflt_stor_srv_root='/home/
opuser/
OP/OpenPages/openpages-storage'

5. To enable or disable Oracle Text, modify the flag_install_oracle_text property.

For example, to enable Oracle Text, type Y.

define flag_install_oracle_text='Y'

6. If you want to load custom data during the database setup process, see “Loading custom data (DB2
and Oracle)” on page 107.

Loading custom data (DB2 and Oracle)
If you want to load custom data during the database setup process, edit the sql-wrapper.sql file to
specify the scripts to run.

About this task

You can use the custom_environment_script and custom_data_load_script parameters to
configure a custom scripts.

Use the custom_environment_script parameter to set environment values. The script that you
specify is called each time that the sql-wrapper.sql script is called.

Use the custom_data_load_script parameter to load custom data. The script that you specify is
called by the op-database-product-install.sh|.bat script. The custom data load is done as the
last step in the op-database-product-install.sh|.bat script.

Procedure

1. Open the sql-wrapper.sql file.
2. If you are using IBM DB2, verify that the sqllib_dir path is correct. If you are running the custom

scripts from a computer other than the database server, update the path.
3. Edit the following parameters:

define custom_environment_script=no-op.sql
define custom_data_load_script=no-op.sql

Replace no-op.sql with the script that you want to run.
4. Place your custom scripts in the same directory as the sql-wrapper.sql file.

Running the steps that do not require DBA privileges
You can complete the database setup manually by using scripts. Do this procedure after the DBA steps
are complete.

This procedure is optional. Instead of running scripts, you can complete the database setup when you
install OpenPages.

Before you begin

• The Oracle database server is running
• A database instance for the OpenPages database is created
• The database setup steps that require DBA privileges are complete
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• The sql-wrapper.sql file is configured for your environment

About this task

You need to run three scripts:

• op-validate-dba-install.sh|.bat: Validates that the DBA steps completed successfully
• op-database-product-install.sh|.bat: Performs the database creation tasks that do not

require DBA privileges
• op-validate-product-install.sh|.bat: Validates that the steps completed successfully

Procedure

1. Log on to the Oracle database server as the OpenPages application user, opuser.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

3. Verify that you have execute permission on the files in the INSTALL_SCRIPTS directory. If not, change
the permission on the file by using the chmod command.

4. Verify that the DBA portion of the database setup completed successfully.

On Windows, open a command prompt by using the Run as Administrator option. Run the following
scripts:

op-validate-dba-install.bat <op_schema_owner_password>

On Linux or AIX:

./op-validate-dba-install.sh <op_schema_owner_password>

You can view the log file: op-validate-dba-install-<timestamp>.log.
5. Run the following script to set up the Oracle database instance.

On Windows, open a command prompt by using the Run as Administrator option. Run the following
script:

op-database-product-install.bat <op_schema_owner_password>

On Linux or AIX:

./op-database-product-install.sh <op_schema_owner_password>

The op-database-product-install.sh|.bat script performs the installation steps that do not
require DBA privileges.

6. Run the following scripts to verify the product installation on the Oracle database instance.

On Windows, open a command prompt by using the Run as Administrator option. Run the following
scripts:

op-validate-product-install.bat <op_schema_owner_password>

On Linux or AIX:

./op-validate-product-install.sh <op_schema_owner_password>

The op-validate-product-install.sh|.bat script verifies that the installation steps completed
successfully.

7. Remove the passwords from the sql-wrapper.sql file for security purposes.
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Troubleshooting Oracle schema creation
If you encounter problems when you run the scripts to create the Oracle database schema, you can run
scripts to drop the schema and then try again.

You have two choices:

• You can drop the database objects that were created when you ran the non-DBA script (op-database-
product-install.sh|.bat). See “Dropping non-DBA objects in an Oracle database” on page 120.

• You can drop the full schema. This option drops the database objects created by op-database-dba-
install.sh|bat and op-database-product-install.sh|.bat. See “Dropping the full schema
in an Oracle database” on page 120.

Dropping non-DBA objects in an Oracle database
You can run the AuroraDbDelete.sql script to drop the database objects that the op-database-
product-install.sh|.bat script created.

Procedure

1. Log on to the Oracle database server as a user with administrative privileges.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

3. Verify that you have execute permission on the files in the INSTALL_SCRIPTS directory. If not, change
the permission on the file by using the chmod command.

4. Log on to SQL*Plus as the OpenPages database user.
5. Use the spool command to create a log file.

spool <log_file directory>/<log_file name>

Ensure that you have write permission on the <log_file directory>.

Example:

spool /tmp/AuroraDbDelete.log

6. Run the AuroraDbDelete.sql script.

@AuroraDbDelete.sql

What to do next
Run the op-database-product-install.sh|.bat script again. See “Running the steps that do not
require DBA privileges” on page 118.

If you encounter problems again, you can drop the full schema. See “Dropping the full schema in an
Oracle database” on page 120.

Dropping the full schema in an Oracle database
You can run the init-db-cleanup.sql script to drop the OpenPages database schema. The script
drops the objects that the op-database-dba-install.sh|.bat and op-database-product-
install.sh|.bat scripts created.

About this task
The init-db-cleanup.sql script drops the schema and removes the OpenPages table spaces.

Procedure

1. Log on to the Oracle database server as a user with administrative privileges.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.
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3. Verify that you have execute permission on the files in the INSTALL_SCRIPTS directory. If not, change
the permission on the file by using the chmod command.

4. Log on to SQL*Plus as the OpenPages database user
5. Run the init-db-cleanup.sql script.

Syntax:

sqlplus /nolog @sql-wrapper init-db-cleanup.sql <log_file> 
   <oracle_tns_alias> <sysdba_user> <sysdba_password>
   <op_user>

Table 36: Parameters of the init-db-cleanup.sql script for Oracle databases

Parameter Description

<log_file> Optional: The path and name of a log file

<oracle_tns_alias> The TNS alias of the Oracle database instance

<sysdba_user> A user with SYSDBA privileges

<sysdba_password> The password of the SYSDBA user

<op_user> The OpenPages schema owner

For example:

sqlplus /nolog @sql-wrapper.sql init-db-cleanup.sql 
   log_file.txt OP system openpages openpages

What to do next
Run the database schema creation scripts in a clean database environment. See “OpenPages database
schema creation for Oracle” on page 110.

Creating a deployment
Create a deployment to install IBM OpenPages GRC Platform. You can create a deployment from scratch
or you can import deployment properties from a file.

If you are upgrading, you create a new deployment as part of the upgrade process. For more information,
see Chapter 7, “Upgrade IBM OpenPages GRC Platform,” on page 167.

Before you begin

• Before you create a deployment, plan your server topology and prepare each server for the installation.
• Ensure that the installation server can communicate with all of the servers in your deployment.
• On each remote server in your deployment, do one of the following steps:

– Update the antivirus policy on the remote server to allow Node.js.
– Disable antivirus software on the remote server. You can re-enable it after you complete the

installation of IBM OpenPages GRC Platform.

About this task

Tip: You can save your work at any time and return to your deployment later to complete the installation.

This video demonstrates how to manage and create deployments:

https://youtu.be/L2yGvDjsZWE
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For more videos, see the IBM Industry Platforms Support and Documentation channel.

Procedure

1. Log in to the IBM OpenPages GRC Platform installation app.
See “Logging in to the installation app” on page 37.

2. Create a deployment.
You can create a deployment from scratch or you can load values from an existing deployment.

• To create a deployment from scratch, click Create New. Type a name for the deployment, and then
click Create.

Note: The deployment name is used to create directories. Do not use spaces or special characters
in the deployment name.

Figure 11: Create a new deployment
• To load values from a deployment, click Import/Upload. Type a name for the new deployment.

Drag a deploy.properties file onto the window or click Browse to select a file. Click Upload.

Note: If you are upgrading, you can use a topology.xml file from your previous version of IBM
OpenPages GRC Platform.

Figure 12: Import a deployment
3. Choose the type of deployment that you want to install.

• Standalone Deployment: Select this option if you want to create a new cell for OpenPages. The
installation process creates a new cell and deployment manager in IBM WebSphere before
installing OpenPages. See this video about standalone deployments.

• Shared Cell Deployment: Select this option if you already have a cell and deployment manager in
your environment and you want to use them for OpenPages. The installation process deploys
OpenPages into the cell that you specify.

If you select this option, global security must be enabled on the shared cell before you install IBM
OpenPages GRC Platform. For more information, see “Considerations for shared cell deployments”
on page 124.
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For both types of deployments adding two horizontal clusters in one VM is not supported.

Figure 13: Selecting the deployment type
4. Optional: If you want to install IBM OpenPages solutions, enable the Install Solutions check box.
5. Set up the database server.

See “Configuring the database server (DB2)” on page 125 or “Configuring the database server
(Oracle)” on page 127.

6. Set up the deployment manager.
See “Configuring the deployment manager” on page 129.

7. Set up the application servers.
See “Configuring application servers” on page 131.

8. Set up the reporting servers.
See “Configuring reporting servers” on page 133.

9. Optional: Set up the search server.
See “Configuring a search server” on page 134.

10. Optional: Set up the IBM Business Process Manager workflow server.

Important: Before you set up a workflow server, see the IBM OpenPages GRC - Business Process
Manager Installation Guide. You need to do some pre-installation tasks and some post-installation
tasks.

If you are upgrading and you used IBM Business Process Manager in your previous version of
OpenPages, see the IBM OpenPages GRC - Business Process Manager Installation Guide for
information about how to update the integration.

11. Click Validate to save and validate the deployment.

During the validation process, the installation app installs the agent software on the remote servers,
starts the agents, validates the deployment properties, and verifies that the prerequisites for the
installation are complete.

For example, the following image shows an application server card after validation is complete The
Agent On icon is green, indicating that the agent is installed and running on the remote server.
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Figure 14: Agent software is running on Application Server1

You can download a validation report. Click the link at the top of the page.

Figure 15: Click to download a validation report

The validation reports are also stored in the <installation_server_home>/src/deployment/
<deployment-name>/validation directory.

Fix any errors and review the warnings. Click Save, and then click Validate. When the Install button
is available, you can continue. If fixing issues requires an update to the environment variables on any
servers, you must restart the installer server/agent on that server before re-validating.

12. Click Install.
The installation server stages the assets onto the servers in your deployment.

Tip: You can log out and close the browser window. The Install process continues to run. When you
log in to the installation app again, the app shows the status of your deployment. You can also close
the browser window during the Configure process.

13. Click Configure.
The installation server sets up and configures the IBM OpenPages GRC Platform components.

14. Review the log files.
For more information, see “Log files” on page 341.

15. If you disabled the antivirus software on remote servers, re-enable the antivirus software.
16. Optional: Download the deployment properties so that you can use the properties file for future

installations.

Click , and then click Download Properties. If you are using Internet Explorer, click Save or Save
As.

Considerations for shared cell deployments
Before you create a shared cell deployment, review the prerequisites and important considerations for
shared cell deployments.

Ensure that your environment meets these prerequisites:

• Enable Global Security on the cell before you install OpenPages.

The preinstallation validation process will fail if Global Security is not enabled.

In a standalone deployment, the installation server creates a cell with Global Security enabled. In a
shared cell deployment, however, you must enable Global Security in the cell that you want to use for
OpenPages.
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• Make sure that none of the profile directories for the cell, deployment manager, or other profiles fall
under any of the directories that you are using to install OpenPages, such as <OP_HOME>, <CC_HOME>,
and so on.

If your profiles are in the OpenPages installation directories, the profiles might be deleted when you
install OpenPages.

• Note that OpenPages cannot be deployed into the same cell as IBM Business Process Manager, if a
workflow server is included in your deployment.

• The software prerequisites for shared cell deployments are the same as the prerequisites for
standalone deployments.

Also, keep the following considerations in mind:

• The deployment manager will be stopped and started multiple times during the OpenPages installation.
• The startAllServers/stopAllServers scripts that are in <OP_HOME>/bin will not start or stop

the deployment manager in shared-cell deployments, even if the deployment manager is on the same
host as an application server.

• The installer does not create Microsoft Windows services for the deployment manager.

When you install OpenPages, the installation server configures the cell for OpenPages.

This video demonstrates how to manage and create deployments:

https://youtu.be/N2JavLP-mc4

Configuring the database server (DB2)
You can use an IBM DB2 database server in your IBM OpenPages GRC Platform deployment.

About this task

Complete all of the fields on the Database Server card. You might need some information from your
database administrator to complete the card.

Determine if the OpenPages database schema is installed.

• If the database schema is not yet installed, you can use the OpenPages installation app to install it. For
the Install Database option, click Full Database. You must provide DBA credentials to install the
database schema.

• If your database administrator completed only the database schema installation steps that require DBA
privileges, use the OpenPages installation app to complete the installation. For the Install Database
option, click Only Non-DBA.

• If your database administrator has already installed the database schema, you do not need to install the
database. For the Install Database option, click Already Installed.

If your database administrator installed the database schema or completed the DBA installation steps,
determine if your database administrator customized the table space names.

• If the table space names are customized, deselect the Use Default Database option. Type the custom
table space names in the table space fields.

• If the table space names are not customized, enable the Use Default Database option.

If the database is not already installed or if your database uses custom table space names, you need the
values from the sql-wrapper.sql file to complete the Database Server card.

Procedure

1. Click the Database Server card in the left pane.
2. Type a Nickname for the server.

The name is displayed on the server card.
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3. Type the Host Name of the server. Use the fully qualified domain name (FDQN).
4. Select the Operating System of the server.
5. Click Install Database and choose one of the following options:

• Full Database: Click this option if the database is not installed yet. The installation app will
complete both the DBA and non-DBA portions of the database installation.

• Only Non-DBA: Click this option if your database administrator completed the DBA portion of the
database installation. The installation app will complete the database installation.

• Already Installed: Click this option if the database is already installed.
6. If your database uses custom table space names, disable the Use Default Database option.

Ensure that you know the custom names. You need to enter them in a later step.
7. For the Database Vendor, select DB2.
8. Type the port number of the IBM DB2 database server in the Database Port field.
9. Type the name of the OpenPages database instance in the Alias field.

In the sql-wrapper.sql file, the Alias is specified by the opx_db2_db_name parameter.
10. If you chose to install the full database, type the DBA Username and the DBA Password.

The user that you specify must have both DBADM and SECADM privileges.

You need to provide the DBA credentials if you selected Full Database for the Install Database
option.

In the sql-wrapper.sql file, the DBA Username is specified by the opx_instance_owner
parameter.

11. Type the credentials of the OpenPages schema owner in the OP Database Username and OP
Database Password fields.

In the sql-wrapper.sql file, the OP Database Username is specified by the opx_db_owner
parameter.

12. Select the default currency to use in the OpenPages database.
You need to select the Base Currency if you selected Full Database or Only Non-DBA for the Install
Database option.

In the sql-wrapper.sql file, the Base Currency is specified by the
opx_base_currency_iso_code parameter.

13. If your database uses custom table space names, complete the table space name fields.
You need to provide the table space names if the Use Default Database option is disabled.

In the sql-wrapper.sql file, the table space names are specified by the opx_dflt_*_ts
parameters.

14. If you want to use the rollback feature for this server, enable the Rollback on failure option.

When Rollback on failure is enabled and an error occurs, the operation that caused the failure is
rolled back. You can then fix the error and continue with the installation. The installation process
resumes at the operation that was rolled back.

For example, if an error occurs during the Install process, fix the error and then click Install to
continue.

15. Click Save.
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Configuring the database server (Oracle)
You can use an Oracle database server in your IBM OpenPages GRC Platform deployment.

About this task

Complete all of the fields on the Database Server card. You might need some information from your
database administrator to complete the card.

Determine if the OpenPages database schema is installed.

• If the database schema is not yet installed, you can use the OpenPages installation app to install it. For
the Install Database option, click Full Database. You must provide DBA credentials to install the
database schema.

• If your database administrator completed only the database schema installation steps that require DBA
privileges, use the OpenPages installation app to complete the installation. For the Install Database
option, click Only Non-DBA.

• If your database administrator has already installed the database schema, you do not need to install the
database. For the Install Database option, click Already Installed.

If your database administrator installed the database schema or completed the DBA installation steps,
determine if your database administrator customized the table space names.

• If the table space names are customized, deselect the Use Default Database option. Type the custom
table space names in the table space fields.

• If the table space names are not customized, enable the Use Default Database option.

If the database is not already installed or if your database uses custom table space names, you need the
values from the sql-wrapper.sql file to complete the Database Server card.

Procedure

1. Click the Database Server card in the left pane.
2. Type a Nickname for the server.

The name is displayed on the server card.
3. Type the Host Name of the server. Use the fully qualified domain name (FQDN).
4. Select the Operating System of the server.
5. Click Install Database and choose one of the following options:

• Full Database: Click this option if the database schema is not installed yet. The installation app will
complete both the DBA and non-DBA portions of the database schema installation.

• Only Non-DBA: Click this option if your database administrator completed the DBA portion of the
database schema installation. The installation app will complete the database schema installation.

• Already Installed: Click this option if the database schema is already installed.
6. If your database uses custom table space names, disable the Use Default Database option.

Ensure that you know the custom names. You need to enter them in a later step.
7. For the Database Vendor, select Oracle.
8. Type the port number of the Oracle database server in the Database Port field.
9. Complete the identification information that will be used to build the JDBC connection string for the

OpenPages database.

• To use the system identifier, click SID and type the system identifier in the Identifier field.
• To use the service name, click Service Name and type the name in the Identifier field.

10. Type the name of the OpenPages database alias in the Alias field. In the sql-wrapper.sql file, the
Alias is specified by the opx_dflt_sid parameter.

11. If you chose to install the full database, type the DBA Username and the DBA Password.
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The user that you specify must have SYSDBA privileges.

You need to provide the DBA credentials if you selected Full Database for the Install Database
option.

In the sql-wrapper.sql file, the DBA Username is specified by the opx_oracle_dba_user
parameter.

12. Type the credentials of the OpenPages schema owner in the OP Database Username and OP
Database Password fields.

In the sql-wrapper.sql file, the OP Database Username is specified by the opx_db_owner
parameter.

13. Select the default currency to use in the OpenPages database.
You need to select the Base Currency if you selected Full Database or Only Non-DBA for the Install
Database option.

In the sql-wrapper.sql file, the Base Currency is specified by the
opx_base_currency_iso_code parameter.

14. If your database uses custom table space names, complete the table space name fields.
You need to provide the table space names if the Use Default Database option is disabled.

In the sql-wrapper.sql file, the table space names are specified by the opx_dflt_*_ts
parameters.

15. Type the path to the data home directory for the OpenPages database in the Oracle Data Home
Directory field.

You need to provide the data home directory path if you selected Full Database for the Install
Database option.

For example: /home/oracle/app/oradata/OP
16. Type the Oracle Cognos JDBC Username and the Oracle Cognos JDBC Password.
17. Type the TNS alias of the Cognos database in the Oracle Cognos DB Alias field.

Note: If you are using the same database instance for Cognos and OpenPages, you must use the
same alias as the OpenPages database.

18. If you want to use Oracle Text, enable the Oracle Enable Text Search option.

When the Oracle Text feature is enabled, you can filter based on the contents of fields with long string
data types.

In the sql-wrapper.sql file, the Oracle Enable Text Search option is specified by the
flag_install_oracle_text parameter.

19. If you want to skip the database memory configuration checks during the installation, enable the
Oracle Skip DB Memory Check option.
Your database administrator might ask you to disabled the memory checks. For more information,
see “Memory validation step fails for an Oracle database” on page 364.

20. If you want to use the rollback feature for this server, enable the Rollback on failure option.

When Rollback on failure is enabled and an error occurs, the operation that caused the failure is
rolled back. You can then fix the error and continue with the installation. The installation process
resumes at the operation that was rolled back.

For example, if an error occurs during the Install process, fix the error and then click Install to
continue.

21. Optional: Click Save.
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Configuring the deployment manager
You must configure a deployment manager for IBM OpenPages GRC Platform. The deployment manager is
the controller for OpenPages application servers.

About this task

The deployment manager is responsible for managing the nodes and application servers in the
OpenPages cluster in IBM WebSphere.

The deployment manager can be installed on the same computer as any of the application servers.
Alternatively, you can install the deployment manager on a separate computer. Use this option if your
organization requires high availability.

The deployment manager and all of the application servers in your deployment must use the same
operating system.

Procedure

1. Click the Deployment Manager card in the left pane.
2. Type a Nickname for the server.

The name is displayed on the server card.
3. Type the Host Name of the server. Use the fully qualified domain name (FQDN).
4. Select the Operating System of the server.

The operating system that you select also sets the operating system for application servers.
5. If the server is on a different physical machine than the installation server, enable the Remote

Deploy option.

The agent software is installed on the remote server automatically.

Complete the following fields:

• Agent Port: Type the port number for the agent software to use.

Note: If the host name is the same in any two cards, port synchronization will only work if you
complete the host information before completing the Agent Port field. Ensure that the port number
is the same in any two cards where the host name is the same. If the port number is not the same in
both cards, you will encounter exceptions during the validation phase where agents are installed
automatically on target systems.

• SSH Port (Linux/AIX only): Type the Secure Shell (SSH) port number of the remote server.
• Local User Name and Local User Password: Type the credentials of the OpenPages installation

user on the remote server. The account is used to install the agent software on the remote server.
You can specify a local account that is on the remote server or a service account, for example
<domain>/<user name>.

Note: If you installed the agent manually, use Agent for the Local User Name and Local User
Password.

• Agent Directory: Type the absolute path to the directory on the remote server where you want the
agent software installed.

Note: If you are using Microsoft Windows, the maximum length of the path is 25 characters.
6. If you selected the Install Solutions option, configure the metrics for solutions.

• Module Assessment Method: Select the risk assessment method.
• Total Likelihood Count: The Total Likelihood Count identifies the scale of inherent and residual risk

likelihood. Select the maximum value for the scale.
• Total Impact Count: The Total Impact Count identifies the scale of inherent and residual risk

impact. Select the maximum value for the scale.
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The count that you specify determines the number of choices available for inherent and residual
impact and likelihood fields in risk objects. For example, if Total Impact Count is set to 4, then the
available choices for Inherent Impact, Residual Impact, Audit Inherent Impact, and Audit Residual
Impact are: 1, 2, 3, 4.

You can modify these settings at a later time. Total Likelihood Count is called YMAX in the registry
settings and Total Impact Count is called XMAX.

7. Configure IBM WebSphere.

• WAS Home Directory: Type the absolute path of the IBM WebSphere installation directory.
• WAS Admin Username and WAS Admin Password: Type the credentials of the IBM WebSphere

administrator. If you are creating a standalone deployment, the installation process uses the values
you provide in these fields. If you are deploying OpenPages into a shared cell, the values for these
properties have already been set and you need to provide them in these fields.

8. Type the absolute path of the directory to use for the OpenPages profile in the DMGR Profile
Directory field.

If you are creating a standalone deployment, the installation process uses the value you provide in
this field. If you are deploying OpenPages into a shared cell, a value for this property has already
been set and you need to provide it in this field.

9. Type the SOAP port for the OpenPages deployment manager in the DMGR SOAP Port field.

If you are creating a standalone deployment, the installation process uses the value you provide in
this field. If you are deploying OpenPages into a shared cell, a value for this property has already
been set and you need to provide it in this field.

10. Type the absolute path of the OpenPages home directory in the OP Home Directory field.
11. Type the absolute path of the OpenPages storage directory in the Storage Directory field.

If the database installation is not complete and is being completed by the installation app, you must
provide an LFS path for the storage directory. It can be updated to a UNC path after the installation is
complete.

If the database installation is already complete, you can put either an LFS path or a UNC path,
depending on which storage type is in place at this point in the installation. The selected storage type
must match the current storage type that is defined in the database. For more information, see
“Updating the location of the openpages-storage directory (DB2)” on page 141 or “Updating the
location of the openpages-storage directory (Oracle)” on page 143.

12. Type the name of the IBM WebSphere profile that you want to create for OpenPages in the OP DMGR
Profile Name field.

Note: The profile name is used to create directories. Do not use spaces or special characters in the
name.

If you are creating a standalone deployment, the installation process uses the value you provide in
this field. If you are deploying OpenPages into a shared cell, a value for this property has already
been set and you need to provide it in this field.

13. Type the name of the IBM WebSphere cell for OpenPages in the OP Cell Name field.

If you are creating a standalone deployment, the installation process uses the value you provide in
this field. If you are deploying OpenPages into a shared cell, a value for this property has already
been set and you need to provide it in this field.

14. Type the name of the IBM WebSphere cluster for OpenPages in the OP Cluster Name field.
15. Type the name of the IBM WebSphere node for the deployment manager in the OP Dmgr Node Name

field.

If you are creating a standalone deployment, the installation process uses the value you provide in
this field. If you are deploying OpenPages into a shared cell, a value for this property has already
been set and you need to provide it in this field.
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16. Type the OpenPages super administrator credentials in the OP Admin Username and OP Admin
Password fields.
For more information, see “Super Administrator” on page 131.

17. Type the absolute path of the database client home directory in the DB Client Directory field.
18. Type the absolute path of the Java Home Directory on the server.

The Java Home Directory is where the IBM Java JRE that is supplied with IBM WebSphere
Application Server is installed. The path that you enter must match the path in the JAVA_HOME
system environment variable on the server.

19. If you want to use the rollback feature for this server, enable the Rollback on failure option.

When Rollback on failure is enabled and an error occurs, the operation that caused the failure is
rolled back. You can then fix the error and continue with the installation. The installation process
resumes at the operation that was rolled back.

For example, if an error occurs during the Install process, fix the error and then click Install to
continue.

20. Optional: Click Save.

Super Administrator
IBM OpenPages GRC Platform uses the concept of a Super Administrator account. You set up the Super
Administrator as part of the installation. The account has complete access to all objects, folders, role
templates, and groups in the OpenPages system.

In a new installation, the Super Administrator is the only user in the system. You can change the login user
name and password during or after installation.

In the OpenPages documentation, the Super Administrator account is called
OpenPagesAdministrator.

Do not use the following user names, which are reserved by OpenPages:

• OPSystem
• OpenPages
• OpenPagesApplicationUsers
• OPAdministrators

If you change the login information by using the IBM OpenPages GRC Platform application after
installation, you must also manually update the CommandCenter Framework Generator property file. For
more information, see the IBM OpenPages GRC Administrator's Guide.

Configuring application servers
You can use one or more application servers in your IBM OpenPages GRC Platform deployment.

About this task

You can scale the application server by adding horizontal or vertical cluster members.

• To add horizontal cluster members, add an Application Server card for each cluster member.
• To add vertical cluster members, use the OP Vertical Cluster Number field to specify the number of

cluster members.

You must configure a load balancer to distribute the incoming requests across the cluster members.

For more information, see “Configure clustered environments” on page 24.

Procedure

1. Click the Application Server1 card in the left pane.
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Application Server1 is the admin application server.
2. Type a Nickname for the server.

The name is displayed on the server card.
3. Type the Host Name of the server. Use the fully qualified domain name (FQDN).
4. If the server is on a different physical machine than the installation server, enable the Remote

Deploy option.

The agent software is installed on the remote server automatically.

Complete the following fields:

• Agent Port: Type the port number for the agent software to use.

Note: If the host name is the same in any two cards, port synchronization will only work if you
complete the host information before completing the Agent Port field. Ensure that the port number
is the same in any two cards where the host name is the same. If the port number is not the same in
both cards, you will encounter exceptions during the validation phase where agents are installed
automatically on target systems.

• SSH Port (Linux/AIX only): Type the Secure Shell (SSH) port number of the remote server.
• Local User Name and Local User Password: Type the credentials of the OpenPages installation

user on the remote server. The account is used to install the agent software on the remote server.
You can specify a local account that is on the remote server or a service account, for example
<domain>/<user name>.

Note: If you installed the agent manually, use Agent for the Local User Name and Local User
Password.

• Agent Directory: Type the absolute path to the directory on the remote server where you want the
agent software installed.

Note: If you are using Microsoft Windows, the maximum length of the path is 25 characters.
5. Type the absolute path of the IBM WebSphere installation directory in the WAS Home Directory field.
6. Type a name for the node in the OP Node Name field.
7. Type a name for the application server in the OP Server Name field.
8. Type the starting port number for OpenPages services in the OP Cluster Start Port field.

The field defines the start of a contiguous range of 20 port numbers from the starting port that can be
used for OpenPages services that run on the application server.

9. If you want to add vertical cluster members to the server, type a number greater than 1 in the OP
Vertical Cluster Number field.

10. Type the absolute path of the directory to use for the OPBackup and OPRestore utilities in the OP
Backup Restore Directory field.

11. Type the absolute path of the database client home directory in the DB Client Directory field.
12. Type the absolute path of the Java Home Directory on the server.

The Java Home Directory is where the IBM Java JRE that is supplied with IBM WebSphere
Application Server is installed. The path that you enter must match the path in the JAVA_HOME
system environment variable on the server.

13. If you want to use the rollback feature for this server, enable the Rollback on failure option.

When Rollback on failure is enabled and an error occurs, the operation that caused the failure is
rolled back. You can then fix the error and continue with the installation. The installation process
resumes at the operation that was rolled back.

For example, if an error occurs during the Install process, fix the error and then click Install to
continue.

14. Optional: Click Save.
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Configuring reporting servers
You can use one or more reporting servers in your IBM OpenPages GRC Platform deployment.

About this task

You can scale the reporting server by adding horizontal members. To add horizontal cluster members, add
a Reporting Server card for each cluster member.

You must configure additional Cognos dispatchers to ensure that the incoming requests are distributed
across the reporting servers.

For more information, see “Configure clustered environments” on page 24.

Procedure

1. Click the Report Server1 card in the left pane.
2. Type a Nickname for the server.

The name is displayed on the server card.
3. Type the Host Name of the server. Use the fully qualified domain name (FQDN).
4. Select the Operating System of the server.
5. If the server is on a different physical machine than the installation server, enable the Remote

Deploy option.

The agent software is installed on the remote server automatically.

Complete the following fields:

• Agent Port: Type the port number for the agent software to use.

Note: If the host name is the same in any two cards, port synchronization will only work if you
complete the host information before completing the Agent Port field. Ensure that the port number
is the same in any two cards where the host name is the same. If the port number is not the same in
both cards, you will encounter exceptions during the validation phase where agents are installed
automatically on target systems.

• SSH Port (Linux/AIX only): Type the Secure Shell (SSH) port number of the remote server.
• Local User Name and Local User Password: Type the credentials of the OpenPages installation

user on the remote server. The account is used to install the agent software on the remote server.
You can specify a local account that is on the remote server or a service account, for example
<domain>/<user name>.

Note: If you installed the agent manually, use Agent for the Local User Name and Local User
Password.

• Agent Directory: Type the absolute path to the directory on the remote server where you want the
agent software installed.

Note: If you are using Microsoft Windows, the maximum length of the path is 25 characters.
6. Type the absolute path of the Cognos Home Directory.
7. Type the Cognos Port and Cognos Dispatcher Port
8. Type the Cognos application URL context root in the URL Context Root field.
9. Type the Cognos Framework Manager port in the Framework Port field.

10. Type the Framework Output Directory property.
11. Type the absolute path of the directory on the reporting server where you want to install IBM

OpenPages CommandCenter in the Command Center Home Directory.
12. Type the absolute path of the directory to use for the OPCCBackup and OPCCRestore utilities in the

Command Center Backup Directory field.
13. Type the absolute path of the database client home directory in the DB Client Directory field.
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14. Type the absolute path of the Java Home Directory on the reporting server.

If you are using the IBM Java that is supplied with Cognos, the Java Home Directory is where the
Cognos IBM Java is installed.

The path that you enter must match the path in the JAVA_HOME system environment variable on the
reporting server.

15. If you want to use the rollback feature for this server, enable the Rollback on failure option.

When Rollback on failure is enabled and an error occurs, the operation that caused the failure is
rolled back. You can then fix the error and continue with the installation. The installation process
resumes at the operation that was rolled back.

For example, if an error occurs during the Install process, fix the error and then click Install to
continue.

16. Optional: Click Save.

Configuring a search server
You can use one search server in your IBM OpenPages GRC Platform deployment. The search server is
optional. Configure a search server if you want to use global search.

Procedure

1. Click the server list, select Global Search Server, and then click . Click Continue to confirm.
A Global Search card is added in the left pane.

2. Type a Nickname for the server.
The name is displayed on the server card.

3. Type the Host Name of the server. Use the fully qualified domain name (FQDN).
4. Select the Operating System of the server.
5. If the server is on a different physical machine than the installation server, enable the Remote

Deploy option.

The agent software is installed on the remote server automatically.

Complete the following fields:

• Agent Port: Type the port number for the agent software to use.

Note: If the host name is the same in any two cards, port synchronization will only work if you
complete the host information before completing the Agent Port field. Ensure that the port number
is the same in any two cards where the host name is the same. If the port number is not the same in
both cards, you will encounter exceptions during the validation phase where agents are installed
automatically on target systems.

• SSH Port (Linux/AIX only): Type the Secure Shell (SSH) port number of the remote server.
• Local User Name and Local User Password: Type the credentials of the OpenPages installation

user on the remote server. The account is used to install the agent software on the remote server.
You can specify a local account that is on the remote server or a service account, for example
<domain>/<user name>.

Note: If you installed the agent manually, use Agent for the Local User Name and Local User
Password.

• Agent Directory: Type the absolute path to the directory on the remote server where you want the
agent software installed.

Note: If you are using Microsoft Windows, the maximum length of the path is 25 characters.
6. Type the absolute path of the directory where you want to install global search in the Search Home

Directory field.
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The directory that you specify is the SEARCH_HOME directory for your deployment. The
opsearchtools.jar file, Apache Solr, and other global search files are installed in this directory.
The global search indexing directory is also stored under the Search Home Directory.

7. Select a language from the Search Language list.
The language that you select is used by the search server for indexing.

8. Type the absolute path of the Java Home Directory on the server.

The Java Home Directory is where the IBM Java JRE that is supplied with IBM WebSphere
Application Server is installed. The path that you enter must match the path in the JAVA_HOME
system environment variable on the server.

9. If you want to use the rollback feature for this server, enable the Rollback on failure option.

When Rollback on failure is enabled and an error occurs, the operation that caused the failure is
rolled back. You can then fix the error and continue with the installation. The installation process
resumes at the operation that was rolled back.

For example, if an error occurs during the Install process, fix the error and then click Install to
continue.

10. Optional: Click Save.

Workflow server configuration
You can integrate IBM Business Process Manager with IBM OpenPages GRC Platform. You need to do
some pre-installation tasks before you add a workflow server to your deployment.

See the IBM OpenPages GRC - Business Process Manager Installation Guide before you add a Workflow
Server card.

The guide describes how to prepare for the integration, how to complete the Workflow Server card, and
what postinstallation tasks you need to do. The guide also describes how you set up the integration
manually by running a script.

If you are upgrading and you used IBM Business Process Manager in your previous version of OpenPages,
see the IBM OpenPages GRC - Business Process Manager Installation Guide for information about how to
update the integration.

Post installation tasks
After you install IBM OpenPages GRC Platform, you must perform some post installation tasks.

You can also modify the installation environment to improve performance, enhance security, or change
default settings. For example, you can tune the application servers or configure LDAP.

As part of the post installation tasks, you can configure OpenPages GRC Platform to use Secure Sockets
Layer (SSL) to ensure that all data passed between the application server and a browser remains private.

For information about SSL configurations and about addition configurations, such as adding a member to
a cluster or changing port numbers, see the IBM OpenPages GRC Administrator's Guide.

After you complete the installation, consider backing up your environment by running OPBackup and
OPCCBackup.
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OpenPages GRC Platform CommandCenter post-installation tasks
After you install IBM OpenPages CommandCenter on the reporting servers, some post installation tasks
are required. You must update the CommandCenter configuration files to ensure that OpenPages
components can communicate with each other.

Copying the IBM Global Security Kit files to the DB2 server installations on Windows operating
systems
On Windows operating systems, you must copy the 32-bit version of the IBM Global Security Kit (GSK)
files to the DB2 server instance location. You must copy the files before you generate the reporting
framework.

Procedure

1. Log on to the database server computer.
2. Go to the <DB2_HOME>\bin directory for the IBM OpenPages GRC Platform database instance and

create a folder named icc.
3. Copy the contents of the C:\Program Files (x86)\IBM\gsk8\lib directory to the <DB2_HOME>
\bin\icc directory.

Updating IBM WebSphere Application Server Liberty for the Framework Model Generator
You can update the IBM WebSphere Application Server Liberty profile for the IBM OpenPages GRC
Platform Framework Model Generator. Update WebSphere Liberty after you install, upgrade, or migrate
IBM OpenPages GRC Platform.

Before you begin

Ensure that JAVA_HOME is defined.

About this task

You can update WebSphere Liberty by using IBM Installation Manager. Open IBM WebSphere and click
the link to download and install updates. For more information, see Installing Liberty on distributed
operating systems by using the GUI on IBM Knowledge Center

Alternatively, you can download the update and install it manually.

Procedure

1. Log on to the active reporting server as a user with administrative privileges.
2. Go to the Framework Model Generator home page, http://<server name>:<server port>
3. Click the link to download WebSphere Application Server Liberty Runtime. Save the .zip file to a

temporary directory.
4. Back up your current WebSphere Liberty installation.

a) Stop the Framework Model Generator. For more information, see “Starting and stopping the
OpenPages GRC Platform Framework Model Generator service on Windows” on page 265 or
“ Starting and stopping the OpenPages GRC Platform Framework Model Generator service on AIX or
Linux” on page 265.

b) Go to the <CommandCenter_Home> directory.
c) Rename the wlp directory to wlp_backup.

5. Install the new version of WebSphere Liberty.
a) Extract the downloaded .zip file to the temporary directory on the active reporting server.
b) Copy the wlp directory from the temporary directory to the <CommandCenter_Home> directory.

6. Configure WebSphere Liberty.
a) Go to the <CommandCenter_Home>/wlp_backup/bin directory and copy the script file server

or server.bat to the <CommandCenter_Home>/wlp/bin directory
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b) If you are using Windows, copy the Windows services files prunsrv.exe and
openpages_wlp_svc_setup.bat from <CommandCenter_Home>/wlp_backup/bin to
<CommandCenter_Home>/wlp/bin.

c) Copy the IBMOpenPagesFrameworkModelGenerator directory from
<CommandCenter_Home>/wlp_backup/usr/servers to
<CommandCenter_Home>/wlp/usr/servers.

7. Start the Framework Model Generator. For more information, see “Starting and stopping the
OpenPages GRC Platform Framework Model Generator service on Windows” on page 265 or “ Starting
and stopping the OpenPages GRC Platform Framework Model Generator service on AIX or Linux” on
page 265.

Creating the reporting schema and framework
To see the default IBM OpenPages GRC Platform reports, you must create a reporting schema and update
the reporting framework.

Before you begin
If you are using clustered environments, ensure you have configured them before you create the reporting
schema and framework. For more information, see “Configure clustered environments” on page 24.

Procedure

1. In a web browser, open the OpenPages GRC Platform application:

http://openpages_server:port/openpages
2. Log on to the application as a user with administrative privileges.
3. For System Admin Mode, switch from Disabled to Enabled.

4. From the menu bar, click Administration and select Reporting Schema.
5. Click Create.
6. After the create operation finishes, click System Admin Mode to switch from Enabled to Disabled.
7. From the menu bar, click Administration > Reporting Framework > Generation.
8. On the Reporting Framework Operations page, click Update.
9. In the Reporting Framework Generation window, under Framework Generation, select the

Framework Model and Labels and other options you want for the relational data model.

10. Click Submit.
11. To view the progress of the update, click Refresh.

The Percent Complete column on the Reporting Framework Operations table updates the
percentage of completion.

Results

Updating the reporting framework process takes approximately 30 minutes or longer.

OpenPages GRC Platform CommandCenter portal security
After installation, you can restrict which user groups are allowed to modify reports. To grant IBM
OpenPages GRC Platform CommandCenter administrative rights, create a group in the OpenPages
application or use an existing group, such as OPAdministrators. This is optional.

To restrict user access to administrative functions within the Cognos Analytics portal, use IBM Cognos
Administration. To prevent users from deleting, changing, or saving reports, restrict access to the
OpenPages reports that are in Public Folders. You can also restrict users from running reporting tools,
such as Cognos Analytics - Reporting, or from modifying reports.

For more information, see the IBM OpenPages GRC Administrator's Guide.
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Creating an open session command block for the OpenPages GRC Platform data source
For IBM OpenPages GRC Platform to work, you must create an open session command block for the
OpenPages data source.

Procedure

1. In the Internet Explorer browser, type the following URL:

http://cognos_server_name/ibmcognos
2. Open IBM Cognos Administration:

a) If the Cognos Welcome page is displayed, click Administer IBM Cognos Content.
b) If the IBM Cognos Connection is displayed, click Launch > IBM Cognos Administration.

3. On the Configuration tab, click Data Source Connections.
4. Click More next to OpenPages DataSource.
5. Click Set properties.
6. Select the Connection tab.
7. Next to the Open session commands, click Set.
8. In the XML database commands box, copy the following text:

<commandBlock>
<commands>
<sqlCommand>
<sql>begin OP_SESSION_MGR.SET_ACTOR_ID_PRIVATE (#$account.parameters.openPagesUserId#);
OP_CRYPT_MGR.SET_ENCRYPTION_PARAMS (#$account.parameters.openPagesEncryptKey#,
   #$account.parameters.openPagesEncryptAlgorithm#,
   #$account.parameters.openPagesEncryptPrefix#);
end;
</sql>
</sqlCommand>
</commands>
</commandBlock>

9. Click OK to save your changes.

Loading the Cognos Analytics dashboard integration after installing
After you install OpenPages, you must load a mandatory integration configuration so that you can use
Cognos Analytics dashboards within OpenPages.

Procedure

1. Copy the CommandCenter-integration-op-config.xml and CommandCenter-integration-
op-file-content.zip files from the IBM OpenPages GRC Platform installation media to the
administrative application server.
The files are located in the /OP_<version>_Non_Embedded/OP_<version>_Configuration/
loader-data/commandcenter directory.

2. Open a command line.

If you are using Microsoft Windows , open a command prompt with the Run as Administrator option.
3. Go to the <OP_HOME>/bin directory.
4. Run the following command to load the files.

Replace <loader-file-path> with the location of the CommandCenter-integration-op-
config.xml and CommandCenter-integration-op-file-content.zip files.

ObjectManager.cmd|sh l c <OpenPages Administrator user> 
   <OpenPages Administrator password> <loader-file-path> 
   CommandCenter-integration

5. If you encounter any errors, review the log file, OP_HOME/bin/logs/ObjectManager.log.
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Configuring OpenPages GRC Platform applications to use a domain account on Windows
operating systems

In a clustered environment, the IBM OpenPages GRC Platform application services access a file share.
The account that starts the services must have permissions to the file share.

Configuring the OpenPages applications to use a domain account must be done for new installations and
upgrades.

About this task

By default, on Windows operating systems, services run under the LocalSystem account. This account
cannot access a shared drive on another computer. In a horizontal cluster, configure the OpenPages
application services on all application servers to run under a domain account that has access to the
shared drive.

For IBM WebSphere Application Server, the following OpenPages application services must have
permissions to the file share:

• IBMWAS<version>Service - <OpenPages-dmgr-name>
• IBMWAS<version>Service - <OpenPages-node-name>
• IBMWAS<version>Service - <OpenPages-node-server-name>Server<#>

For the OpenPages installer, the following application service must have permissions to the file share:

• ibmopenpagesgrcplatforminstaller<version>.exe

Procedure

1. Log on to each application server as a user with administrative privileges.
2. Open the Services control panel.
3. Stop each of the OpenPages services.

a) Right-click the service name, and select Properties from the menu.
b) In the Properties window, click the Log On tab.
c) Select This account.
d) Type a domain, account name, and password for at least one user who has access to the shared

drive.
e) Click OK to continue.

Configuring file share permissions on AIX or Linux operating systems
For clustered IBM OpenPages GRC Platform environments that run on AIX or Linux operating systems,
configure the same user name and password on all systems. File share permissions are the same on all
systems. If you are using a network file share (NFS), ensure that users have read and write access to the
file share.

Sharing a network OpenPages GRC Platform storage directory on AIX or Linux operating
systems

When you install IBM OpenPages GRC Platform, you specify the Storage Directory location on the
Deployment Manager card. The storage location is a directory where attached files and forms that are
associated with OpenPages objects are stored.

If you pointed to a location on the local computer and you are using a horizontal cluster for the application
servers, you must change the pointer to a shared network storage location.

After you share the directory, use the update-storage script to update the database with the shared
network location.
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Procedure

1. Mount the storage directory on the admin application server to the non-admin server.
a) Log on to the OpenPages admin application server as the root user or a user that belongs to the

System group, and open a shell.
b) Go to the /etc directory, and open the hosts file in a text editor.
c) Add the IP address and name of each OpenPages horizontal cluster member.
d) Save and close the hosts file.
e) Create a file with the name exports in the /etc directory.

Important: Ensure that you have full rights to the local installation directory.
f) Open the exports file in a text editor and add the full path to the storage directory followed by
*(insecure,rw,async,no_root_squash).

/opt/OpenPages/openpages-storage *(insecure,rw,async,no_root_squash)

g) Export all file systems that are named in /etc/exports directory by using the following
command:

exportfs -a

The exportfs command maintains the current table of exported file systems for NFS in
the /var/lib/nfs/etc file.

h) Restart the NFS server.

On AIX operating systems, use the following commands:

stopsrc -g nfs
 startsrc -g nfs

On Linux operating systems, use the following command:

service nfs restart

The NFS server processes requests from the NFS clients.
i) Use the following command to check that the openpages-storage directory is exported and

ready for mounting:

showmount -e

Ensure that the openpages-storage directory is listed.
2. Mount the storage directory from the admin application server on the horizontal cluster member.

a) Log on to the OpenPages horizontal cluster member as the root user or a user that belongs to the
System group.

b) Open a shell as a user with administrative privileges.
c) Go to the /etc directory.
d) Open the hosts file in a text editor and add the IP address and name of each OpenPages horizontal

cluster member.
e) Save and close the hosts file.
f) Run the following command to mount the storage directory:

mount nfsservername mountpoint

• nfsservername is the name of the OpenPages admin application server and the location of the
openpages-storage directory on the admin server.

• mountpoint is the name and path of the openpages-storage directory on the horizontal cluster
member.
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Example:

mount aix61-1-5.openpages.com:/usr/OpenPages/openpages-storage 
/usr/OpenPages/openpages-storage

3. Update the location of the openpages-storage directory in the database.

• DB2: “Updating the location of the openpages-storage directory (DB2)” on page 141
• Oracle: “Updating the location of the openpages-storage directory (Oracle)” on page 143

Sharing a network OpenPages GRC Platform storage directory on Windows operating
systems

When you install IBM OpenPages GRC Platform, you specify the Storage Directory location on the
Deployment Manager card. The storage location is a directory where attached files and forms that are
associated with OpenPages objects are stored.

If you pointed to a location on the local computer and you are using a horizontal cluster for the application
servers, you must change the pointer to a shared network storage location. Ensure that all cluster
members can access the directory. If you are using a search server, ensure that the search server can also
access the shared network location.

After you share the directory, use the update-storage script to update the database with shared
network location.

Updating the location of the openpages-storage directory (DB2)
In the database, update the location of the openpages-storage directory.

If you are using Microsoft Windows, you can also use this procedure to change the storage type from LFS
to UNC.

Before you begin
Stop the IBM OpenPages GRC Platform services if they are running.

Procedure

1. Log on to the target environment as a user with administrative permissions. You can use any system
with access to CLPPlus that can connect to the database server.

2. Open a command or shell window.
3. Locate the update-storage.sql script.

The script is stored in the following directories. You can use the script in either location.

• /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory

• /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
UPGRADE_SCRIPTS

4. Run the update-storage.sql script to update the openpages-storage directory location in the
database:

clpplus -nw <op_db_user>/<op_db_password>@<database_host>:
   <database_port>/<database_name> @sql-wrapper update-storage <log_file> 
   <database_host> <database_port> <database_name> <op_db_user> 
   <op_db_password> <storage_type> <storage_server_name> <host_name> 
   <os_type> <path_or_UNC_name>
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Table 37: Parameters in the update-storage.sql script (DB2)

Parameter Description

<op_db_user> OpenPages user name for accessing the OpenPages database.

<op_db_password> The OpenPages password for accessing the OpenPages database.

<database_host> Name of the DB2 server host machine that contains the OpenPages
database.

<database_port> Port number of the DB2 database instance that is installed on the
database server. For DB2, the default port is 50000.

<database_name> Name of the OpenPages database.

<log_file> The name of the log file that the script creates and writes information
to.

<storage_type> The type of file storage to be used. Valid values are as follows:

• LFS (local file system)
• UNC (Universal Naming Convention) - for Windows only.

Note: After you move from LFS to UNC, you cannot go back to using
LFS.

<storage_server_name> The name of the storage server.

<host_name> The host name of the machine.

<os_type> The type of operating system. Valid values are as follows:

• Windows
• Unix

<path_or_UNC_name> The file path or UNC of the storage location. If the path contains
backslashes, wrap the path in single quotation marks.

Examples

• LFS

Windows

clpplus -nw openpage/password@myserver.ibm.com:50000/opx 
   @sql-wrapper update-storage 
   output.log myserver.ibm.com 50000 OPX openpage password 
   LFS eng11 eng11  Windows 'C:\IBM\OpenPages\openpages-storage'

• Linux and AIX

clpplus -nw openpage/password@myserver.ibm.com:50000/opx 
   @sql-wrapper update-storage 
   output.log myserver.ibm.com 50000 opx openpage password 
   LFS aix11 aix11 Unix /usr/opdata/openpages-storage

• UNC

Windows

clpplus -nw openpage/password@myserver.ibm.com:50000/opx 
   @sql-wrapper update-storage 
   output.log myserver.ibm.com 50000 OPX openpage password 
   UNC eng11 eng11 Windows openpages-storage
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Updating the location of the openpages-storage directory (Oracle)
In the database, update the location of the openpages-storage directory.

If you are using Microsoft Windows, you can also use this procedure to change the storage type from LFS
to UNC.

Before you begin
Stop the IBM OpenPages GRC Platform services if they are running.

Procedure

1. Log on to the target environment as a user with administrative permissions. You can use any system
with access to SQL*Plus that can connect to the database server.

2. Open a command or shell window.
3. Locate the update-storage.sql script.

The script is stored in the following directories. You can use the script in either location.

• /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/ORACLE/
INSTALL_SCRIPTS directory.

• /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/ORACLE/
UPGRADE_SCRIPTS

4. Run the update-storage.sql script to update the openpages-storage directory location in the
database:

sqlplus /nolog @sql-wrapper.sql update-storage <log_file>
   <oracle_tns_alias> <op_db_user> <op_db_password> 
   <storage_type> <storage_server_name> <host_name> 
   <os_type> <path_or_UNC_name>

Table 38: Parameters in the update-storage.sql script (Oracle)

Parameter Description

<log_file> The name of the log file that the script will create and write
information to.

<oracle_tns_alias> The database alias for the OpenPages database instance, as set
during the Oracle database installation.

<op_db_user> The user name for accessing the OpenPages database.

<op_db_password> The password for accessing the OpenPages database.

<storage_type> The type of file storage to be used. Valid values are:

• LFS (local file system)
• UNC (Universal Naming Convention) - for Windows only

Note: After you move from LFS to UNC, you cannot go back to using
LFS.

<storage_server_name> The name of the storage server.

<host_name> The host name of the machine.

<os_type> The type of operating system. Valid values are:

• Windows
• Unix
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Table 38: Parameters in the update-storage.sql script (Oracle) (continued)

Parameter Description

<path_or_UNC_name> The file path or UNC of the storage location. If the path contains
backslashes, wrap the path in single quotation marks.

Examples

• LFS

Windows

sqlplus /nolog @sql-wrapper.sql 
  update-storage output.log OP 
  openpage password LFS eng11 eng11 
  Windows 'C:\IBM\OpenPages\openpages-storage'

Linux or AIX

sqlplus /nolog @sql-wrapper.sql
 update-storage /home/op/upd-storage-output.log
 op openpages openpages LFS  aix11 aix11
 Unix /usr/opdata/openpages-storage

• UNC

Windows

In the following example, openpages-storage is the UNC share name of the storage location. The
openpages-storage location is accessible to all horizontal cluster members as \
\testserver1\openpages-storage.

sqlplus /nolog @sql-wrapper.sql update-storage 
   c:\temp\update-storage-output.log op openpages openpages 
   UNC eng11 eng11 Windows openpages-storage

Configuring IBM HTTP Server to load balance application servers
In a typical configuration that uses IBM HTTP Server to load balance the OpenPages application servers,
IBM HTTP Server is installed on a separate computer.

Web server plug-ins enable IBM HTTP Server to communicate requests for dynamic content, such as
servlets, to the application server. A configuration file is generated for each plug-in.

Open a port for the load-balancer, for example port 80.

Before you begin

If you are configuring the IBM OpenPages GRC Platform environment for SSL, configure SSL before you
configure the plugin-cfg.xml file. For more information, see the IBM OpenPages GRC Administrator's
Guide.

Procedure

1. Log on to the load-balancing server as a user with administrative privileges.
2. Copy the OP_<version>_Configuration directory from the installation media to your local

system.
3. Create the web server instances for the OpenPages application.

a) Log on to the application server as a non-root user who has administrative privileges.
b) In a web browser, type http://<admin_server_name>:<port>/ibm/console.

For example: http://testserver1.com:9060/ibm/console
c) Enter the WebSphere administrator user name and password.
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d) Click Servers > Server Types > Web Servers.
e) On the Web Servers page, click New.
f) On the Select a node for the Web server page, select the application server from the Select node

list.
g) Enter a name for the server, such as opapp, in the Server name field.
h) From the Type list, select IBM HTTP Server and click Next.
i) On the Confirm new Web server page, review the settings and click Finish.
j) In the messages box, click Save to commit the changes to the master configuration file.

4. Create the plug-in for the OpenPages server instance.
a) Click Generate Plugin.

The plug-in is created and saved to the $IHS_HOME/Plugins/config/<webserver_name>/
directory.

The <webserver_name> is the OpenPages server instance that you created.
5. Open the httpd.conf file, and add or modify the following line to point to the new plug-in file.

WebSpherePluginConfig 
/usr/IBM/HTTPServer/Plugins/config/OP/<plugin_file>.xml 

6. Ensure that the IgnoreAffinityRequests setting in the <ServerCluster> section is set to false:
7. Save and close the file.
8. Restart IBM HTTP Server.
9. Log in to OpenPages as a user with administrative privileges.

10. Click Administration, and then click Settings.
a) Expand Platform > Reporting Schema > Object URL Generator.
b) Type the Host, Port, and Protocol of the load balancer.

If you are using a single server, type the Host, Port, and Protocol of the admin application server.

Adding a load-balancing port to virtual hosts
If the load-balancing port is not 80 or 443, you must set the port in the virtual hosts.

Procedure

1. Log on to the IBM WebSphere Integrated Solutions Console as a server administrator.

http://server_name:port/ibm/console

The default port is 9060.
2. Expand Environment and click Virtual Hosts.
3. In the list on the Virtual Hosts page, click default_host.
4. On the Virtual Hosts > default_host page, under the Additional Properties heading, click Host

Aliases.
5. If the load-balancing port is not present in the table, click New.
6. Leave Host Name as *. Update the port to the load-balancing port.
7. Click Apply.
8. In the Messages box, click Save to commit the changes to the master configuration.
9. Restart all OpenPages servers.
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Configuring the HTTP Server for SAMLV2.0 single sign-on
If you are using SAML V2.0 for single sign-on, extra configuration is required on the IBM HTTP Server
configuration for the SAML V2.0 service provider that you installed on the IBM OpenPages GRC Platform
application server.

Procedure

1. Open the plugin-cfg.xml file in a text editor
2. Update the <UriGroup Name="default_host_OpenPagesCluster_URIs"> section with a new

element.

<Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" Name="/samlsps/*"/>

3. Save and close the file.

What to do next
Ensure that you replace the application server URL with the load balancing URL for the service provider
when you configure SAML V2.0.

Configuring property files for load balancing on Windows, AIX, and Linux operating systems
Some configuration is required when using IBM HTTP Server as a load balancer in a WebSphere
Application Server environment.

Procedure

1. On the load-balancing web server, go to the /usr/IBM/HTTPServer/modules/ directory.

2. Open the plug-in file (plugin-cfg-merged.xml) in a text editor to make the following changes:
a) Change the IgnoreAffinityRequests setting to true.
b) Change the ServerIOTimeout setting for all servers to a value that allows sufficient time for the IBM

OpenPages GRC Platform application to respond to request from a client.
c) Save and close the file.

3. Open the httpd.conf file in a text editor and make the following changes:

The default location of the file is /usr/IBM/HTTPServer/conf/httpd.conf.

a) To load the required modules, add or uncomment the following lines

LoadModule negotiation_module modules/mod_negotiation.so
LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_ajp_module modules/WebSphereCE/mod_proxy_ajp.so
LoadModule proxy_balancer_module modules/WebSphereCE/mod_proxy_balancer.so
LoadModule proxy_connect_module modules/mod_proxy_connect.so
LoadModule proxy_http_module modules/mod_proxy_http.so
LoadModule status_module modules/mod_status.so
LoadModule was_ap22_module modules/mod_was_ap22_http.so

b) Modify the ServerName setting to point to the host name where you installed the IBM HTTP Web
Server.

ServerName=MYSERVERNAME.DOMAIN.COM

c) Modify the ServerRoot setting to point to the installation location of the Apache Web Server. For
example,

ServerRoot=/usr/IBM/HTTPServer/htdocs

d) Add the Allow from all attribute to each Directory element.

<Directory>
Options Indexes FollowSymLinks
AllowOverride None
Order allow,deny
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Allow from all
</Directory>

e) Uncomment the parameter ExtendedStatus setting and set the value to On.
f) Set the location tags for server-status and server-info.

For example,

<Location /server-status>
SetHandler server-status
Order Deny,Allow
Deny from all
Allow from all
</Location>

<Location /server-info>
SetHandler server-info
Order Deny,Allow
Deny from all
Allow from all
</Location>

4. Save and close the file.
5. Restart the IBM HTTP server.

Configuring property files for each OpenPages GRC Platform instance
You must edit the server properties file on each IBM OpenPages GRC Platform application server in the
horizontal cluster to point to the load balancer.

Procedure

1. Log on to the OpenPages application server as a non-root user who has administrative privileges.
2. Go to the <OP_HOME>/aurora/conf directory.
3. Open the aurora.properties file in a text editor.

a) Edit the application.url.path to point to the fully qualified domain name of the load balancer.

application.url.path=http\://op-load-balancer.domain.com\:<port>
/openpages

b) Save and close the file.

4. Open each <OpenPages-node-server-name>Server<#>-server.properties file in a text
editor.
a) Edit the url.path lines to point to the fully qualified domain name of the load balancer.

url.path.openpages=http\://<op-load-balancer.domain.com>\:<port>/openpages

b) Save and close each server.properties file.

5. Open each <OpenPages-node-server-name>Server<#>-sosa.properties file in a text editor.
a) Edit the Application.url.path lines to point to the fully qualified domain name of the load balancer.

application.url.path=https\://<op-load-balancer.domain.com>\:<port>
  /openpages

b) Save and close each sosa.properties file.

6. Restart the web server.

Customizing the load balancer for large data sets
For databases with a large data set, some IBM OpenPages GRC Platform reports might time out before
completion. If you experience problems with reports that are timing out, change configuration settings in
the IBM HTTP Web Server configuration file.

Change the following settings:
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TimeOut
The number of seconds IBM HTTP Web Server waits to receive a GET request between receipt of TCP
packets on a POST or PUT request and between ACKs on transmissions of TCP packets in responses.

KeepAliveTimeout
The number of seconds IBM HTTP Server waits for a subsequent request before closing the
connection.

Note: A high value for the setting can cause performance problems, especially if the higher timeout
causes server processes to wait for idle clients.

Procedure

1. Log on to load balancing web server as a user with administrative privileges.
2. Open httpd.conf in a text editor.
3. Change the KeepAliveTimeout property to a higher value.

KeepAliveTimeout  1800

4. Add and then set the TimeOut property.

Ensure that the setting prevents timeout errors.

For example, TimeOut 1800
5. Save and close the file.
6. Restart IBM HTTP Web Server.

Load balancing the OpenPages GRC Platform reporting server
IBM OpenPages GRC Platform CommandCenter uses Cognos Analytics, which can scale horizontally. To
scale OpenPages CommandCenter vertically within the same environment, increase the number of
processes that are available to handle requests. Depending on the load, you can configure more
dispatchers.

About this task

To scale OpenPages CommandCenter horizontally, install more environments and register the IBM
Cognos dispatchers. Incoming requests are distributed across the multiple environments.

The number of dispatchers you need depends on the operating system, system resources, the number of
users, and other factors.

For more information about configuring dispatchers for your environment, see the IBM Cognos
documentation (http://www.ibm.com/support/knowledgecenter/SSEP7J_11.0.0).

When you design and implement the infrastructure for the IBM Cognos reporting servers, the following
OpenPages components determine how many reporting servers are required for the OpenPages solution:

• The number of computed fields on an object type.
• The complexity of the computed fields on an object type.
• The number of reporting fragments on an object type.
• The complexity of the computed fields on an object type.
• The number of embedded reports on the classic home page.
• Whether reporting fragments and computed fields are set to appear automatically.
• The number of IBM Cognos reports available to users.
• The complexity of IBM Cognos reports available to users.
• The custom components using the OpenPages reporting framework.

You should review the IBM Cognos log files and metrics to determine whether more reporting servers are
required in the environment if timeout errors occur or issues occur as a result of excessive load.
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Procedure

1. On the load-balancer server, stop IBM HTTP Server.
For example, in the IBM/HTTPServer/bin directory, run the following command: httpd -k stop.

2. Open the IBM/HTTPServer/Plugins/config/OP/merged-plugin-cfg.xml file in a text editor.
3. Change the session affinity from JSESSIONID to opsosa.

For example, change the file so that it looks like the following:

<UriGroup Name="default_host_OpenPagesCluster_URIs">
  <Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" Name="/opws/*"/>
  <Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" 
      Name="/opstartup_OPAdmin/*"/>
  <Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" Name="/opx/*"/>
  <Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" Name="/publishweb/*"/>
  <Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" Name="/openpages/*"/>
  <Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" 
      Name="/opwebservices/*"/>
  <Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" Name="/grc/*"/>
 <Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" Name="/samlsps/*"/>
</UriGroup>

4. Save and close the file.
5. Start IBM HTTP Server.

For example, in the IBM/HTTPServer/bin directory, run the following command: httpd -k start.

Adding OpenPages GRC Platform servers to the Cognos Application Firewall safe list
By default, the IBM Cognos Application Firewall is enabled. Cognos Application Firewall validates domain
and host names to protect URLs that are created. Cognos Application Firewall considers domain names
derived from the environment configuration properties as safe domain names. Use Cognos Configuration
to add IBM OpenPages GRC Platform application servers to the list of valid domains and host names.

Procedure

1. Log on to the reporting server as a user with administrative privileges.
2. Start IBM Cognos Configuration.
3. In the Explorer pane, go to Local Configuration > Security > IBM Cognos Application Firewall.
4. In the Properties pane, click the Valid domain names or hosts field and click the pencil icon.
5. In the Valid domain or hosts window, click Add.
6. Enter the names of all OpenPages application servers.
7. Click OK.
8. Save the configuration and restart the Cognos service.

If you use Windows Services to restart the Cognos service, the service is listed as IBM Cognos.

Communication between OpenPages GRC Platform CommandCenter servers
If you install Cognos on more than one computer, you must configure the distributed installations to
communicate with each other

Configure the following communication paths:

• Configure the primary Cognos server as the default active server.
• All Cognos servers must know the location of the content store database.
• All Cognos servers must know the location of the other Cognos servers.
• All Cognos servers must use the same cryptographic settings.
• All Cognos servers must have their system clock synchronized.
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Configuring the active reporting server
In a clustered environment, one reporting server acts as the active server, or default primary server, and
one or more reporting servers act as standby servers.

Procedure

1. Ensure that IBM OpenPages GRC Platform CommandCenter is not running on any server.
2. On the reporting server that is designated as the active server, start IBM Cognos Configuration.

Tip: Use the computer with the highest processor speed for the default active server.
3. In the Explorer pane, click Environment.
4. For the Gateway URI, change the localhost portion of the URL to the name of the primary

reporting server.
5. For the Dispatcher URI for Gateway, click the pencil icon next to the Value box.
6. In the Current Values list, change the localhost portion of the URL to the name of the primary

Cognos computer.
a) For each additional Cognos computer, click Add.
b) Change the localhost portion of the URL to the name of each additional Cognos computer.
c) Click OK.

7. For the Content Manager URIs, click the pencil icon next to the Value box.
a) In the Current Values list, change the localhost portion of the URL to the name of the primary

Cognos computer.
b) For each additional Cognos computer, click Add.
c) Change the localhost portion of the URL to the name of each additional Cognos computer.
d) Click OK.

8. In the Explorer pane, click Security > Cryptography.
9. In the Properties pane, under CSK settings, ensure that Store symmetric key locally? is set to
True.
The key store must be created on the default active Cognos computer

10. Click File > Save.
11. Click Actions > Start.

When the services start, this computer becomes the default active Cognos computer.

Configuring standby reporting servers
In a clustered environment, configure one or more reporting servers to act as standby servers.

Procedure

1. Ensure that Cognos is running on the active Cognos server.
2. On the reporting server that is designated as a standby server, start IBM Cognos Configuration.
3. In the Explorer pane, click Environment.
4. In the Environment - Group Properties pane, click Gateway URI.
5. In the Value field, change the localhost portion of the URL to the name of the primary Cognos

computer.
6. In the Environment - Group Properties pane, click Dispatcher URI for Gateway.

a) Click the pencil icon next to the Value box.
b) In the Current Values list, change the localhost portion of the URL to the name of the primary

Cognos computer.
c) For each additional Cognos computer, click Add.
d) Change the localhost portion of the URL to the name of each additional Cognos computer.
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e) Click OK.

7. In the Environment - Group Properties pane, click Content Manager URIs.
a) Click the pencil icon next to the Value box.
b) In the Current Values list, change the localhost portion of the URL to the name of the primary

Cognos computer.
c) For each additional Cognos computer, click Add.
d) Change the localhost portion of the URL to the name of each additional Cognos computer.
e) Click OK.

8. In the Explorer pane, under Security, click Cryptography.
9. In the Properties pane, under CSK settings, set Store symmetric key locally to False.

Note: The key store is created on the primary Cognos computer. There can be only one key store in a
load balanced Cognos installation.

10. In the Explorer window, under Security, Cryptography, click Cognos.
11. Under the Certificate Authority settings property group, set the Password property to match the

one that you configured on the primary Cognos server.

Ensure that all other cryptographic settings match the settings that you configured on the primary
Cognos computer.

12. In the Explorer pane, under Data Access > Content Manager, click Content Store.
13. Ensure that the values for the content store match the primary Cognos computer
14. Click File > Save.
15. Click Actions > Start.

Configuring an Apache load balancer or proxy server
If you are using an external proxy server for load balancing, you must add a proxy redirection directive to
the httpd.conf file on the proxy server. Requests sent to the proxy server are redirected to the server
specified in the httpd.conf file.

Procedure

1. Log on to the load balancer server as a user who has administrative privileges.
2. Go to the Apache_Home\conf\ directory, and open the httpd.conf file in an editor.
3. Add the following lines:

<Location /ibmcognos/>
ProxyPass http://primary_reporting_server/ibmcognos/
SetEnv force-proxy-request-1.0 1 SetEnv proxy-nokeepalive 1
</Location>

Note: You must include the trailing forward slash in the ProxyPass directive when specifying the
Cognos virtual directory (/ibmcognos/).

4. Save and close the file.

Using a reverse proxy server for load balancing
If you are using a reverse proxy server for load balancing, you must add a
ProxyPassReverseCookieDomain value to the httpd.conf file on the reverse proxy server.

Procedure

1. Log on to the load balancer server as a user who has administrative privileges.
2. Go to the Apache_Home\conf\ directory, and open the httpd.conf file in an editor.
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3. Add a ProxyPassReverseCookieDomain value to the file as follows:

# Proxy
ProxyPass  /openpages http://<hostname>:<port>/openpages
ProxyPassReverse  /openpages http://<hostname>:<port>/openpages

ProxyPass  /ibmcognos http://<hostname>:<port>/ibmcognos
ProxyPassReverse  /ibmcognos http://<hostname>:<port>/ibmcognos

ProxyPassReverseCookieDomain <internal.domain.com> <public.domain.com>

4. Save and close the file.
5. Restart the web server.

Changing the CommandCenter host settings
You must update configuration files to use the IBM OpenPages GRC Platform CommandCenter server
name and port settings.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Stop the OpenPages services.
3. Go to the <OP_HOME>/aurora/conf directory.
4. In the cognos.framework.refresh.servlet=http\://localhost\:8080/crf-refresher

property, replace localhost\:8080 with the reporting server name and port.

Example:

cognos.framework.refresh.servlet=http\://ccserver\:8080/crf-refresher

5. In the cognos.server=http\://localhost:80/ibm/cognos/analytics/cgi-bin/
cognos.cgi property, replace localhost:80 with the reporting server name and port number.

Example: cognos.server=http\://ccserver:80/ibm/cognos/analytics/cgi-bin/
cognos.cgi

6. Add the following value to the logout.url.cognos property:

http\://<CommandCenter_server_name>\<CommandCenter_port>\/
  ibm/cognos/analytics/cgi-bincognos.cgi? b_action\=xts.run&m\=portal/
  logoff.xts&h_CAM_action\=logoff

Example:

logout.url.cognos=http\://ccserver\:8080/ibm/cognos/analytics/
  cgi-bincognos.cgi? b_action\=xts.run&m\=portal/logoff.xts&h_CAM_action\=logoff

7. Save your changes and exit the editor.

Administrative server tuning
You can tune your admin server settings to improve performance.

Preventing concurrency conflicts for installations that use Oracle databases
If two administrators both try to modify settings at the same time, errors might occur. To help avoid
concurrency errors, run the SQL enable-session-sleep.sql script.

A concurrency conflict might result in the following error message:
Operation failed, security settings are being 
concurrently modified by another administrator. 
Please try again later.
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Procedure

1. On a computer that has SQL*Plus and access to the database server, log on as a user with SYSDBA
permissions.

2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

3. Copy the enable-session-sleep.sql script to the local computer.
4. Run the enable-session-sleep.sql script.

sqlplus /nolog @sql-wrapper enable-session-sleep.sql 
   <log_file_name> <connect_identifier> 
   <sysdba_user_name> <sysdba_user_password> 
   <schema_owner_name> 

Example:

sqlplus /nolog @sql-wrapper enable-session-sleep.sql enable-session-sleep.log
 opx10g sys manager openpages 

If the process completes successfully, a message is displayed.

If the script fails, check the log files for error messages.

Optional: Increasing the paging file size on Windows computers
On computers that have 4 GB of RAM, the suggested paging file size is 8 GB.

Procedure

1. Click Start > Run and then type sysdm.cpl, and press Enter.
2. Click the Advanced tab, and then in the Performance section, click Settings.
3. In the Performance Options window, in the Virtual Memory section, click the Advanced tab, and then

click Change.
4. Find the list of drives and select the drive that contains your paging file.

Note: If necessary, clear the Automatically manage page file size for all drives check box.
5. Under Paging File Size, select Custom Size.
6. Reset both the Initial Size and Maximum Size values to higher values.
7. Click Set.
8. Click OK.

Optional: Increasing the paging file size on AIX computers
On computers that have 4 GB of RAM, the suggested paging file size is 8 GB.

Procedure

1. On AIX computers, open a shell as user with administrative privileges.
2. Type the following command to change the attributes of the paging space:

chps -s LogicalPartitions <PagingSpace_Name>

For example, the following command adds four logical partitions to the pgspce paging space:

chps -s 4 pgspce
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Database server tuning for DB2 databases
To improve performance, tune the database. You must change some of the values for database server
parameters. Other changes are suggested in environments where there are heavy user loads.

Changing the DB2 varchar limit for IBM Cognos reports
Conditional statements are used in IBM OpenPages GRC Platform computed fields that reference data
columns with varchar values larger than 4000. By default Cognos Analytics uses a varchar limit of 4000.
You can ensure that errors do not occur in OpenPages reports by removing the varchar limit.

If you do not change the varchar limit, errors like the following can appear in the cogserver.log file.

RQP-DEF-0177 An error occurred while performing operation 'sqlPrepareWithOptions' 
status='-120'
UDA-SQL-0458 PREPARE failed because the query requires local processing of the data. 
The option to allow local processing has not been enabled.
UDA-SQL-0476 A VARCHAR column in a comparison exceeds the maximum length allowed 
by the database. 
This operation requires local processing of the data.

Procedure

1. Log on to the reporting server as a user with administrative privileges.
2. Go to the <Cognos_HOME>/bin directory.

For example, go to the C:\IBM\cognos\analytics\bin directory.
3. Make a backup copy of the cogdmd2.ini file.
4. Open the cogdmd2.ini file in a text editor.
5. Find the following statement:

[Exceptions Operators DATABASE:SQL]
Varchar_Compare_Limit="4000"

6. Comment out the Varchar_Compare_Limit="4000" statement by adding a semicolon (;) in front of
it.
For example,

[Exceptions Operators DATABASE:SQL]
;Varchar_Compare_Limit="4000"

7. Save and close the file.
8. Restart the Cognos Analytics services.

Activate DB2 databases to improve application start-up times
You can use the activate database command to initialize IBM DB2 databases before you start IBM
OpenPages GRC Platform, and to keep the database initialized if the applications are stopped or
disconnected.

The OpenPages database is activated when you create it during the IBM OpenPages GRC Platform
installation process. You might want to activate the database each time that you start IBM OpenPages
GRC Platform to improve application start-up times.

The activate database command explicitly starts a database and makes it ready to accept connections
and process requests. An explicitly activated database remains ready and primed even when there are no
application connections to the database. You can activate a database during routine start-up procedures
to make it ready to immediately accept connections and process requests.

Use the deactivate database command on an explicitly activated database before you stop the instance or
perform an offline backup.

Note: An explicitly activated database cannot be dropped.

For example, the following sequence of commands shows how you can use the activate and deactivate
commands:
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1. Start the database instance:

db2start
2. Start the database:

db2 activate database opx

The database performs consistency checks, recovery tasks, and allocate memory heaps, such as
bufferpools.

3. Start the OpenPages servers:

./startServersAll.sh

The database connections are made immediately.
4. Stop the OpenPages servers:

./stopServers.sh

The database remains activated, ready for connections, and the buffer pools remain primed.
5. Deactivate the database:

db2 deactivate database opx
6. Back up the database:

db2 backup database opx to /backupdir

The database must not be active when you back it up.
7. Start the database:

db2 activate database opx
8. Start the OpenPages servers:

./startServersAll.sh

Database server tuning for Oracle databases
To improve performance, tune the database.

Memory tuning guidelines for Oracle databases
If your application is running in a heavy-load environment, consider allocating as much memory as
possible to the Oracle database instance.

The following table provides general guidelines for memory allocation on a system with 8 GB of RAM or
more.

Table 39: Memory tuning guidelines for computer with 8 GB of RAM

For this... Allocate...

Operating system 2 GB of physical RAM for the Windows OS.

SGA Size 75% of remaining physical RAM to the SGA_TARGET parameter.

Minimum allocation: 4608 MB (or 4.5 GB).

PGA Size 25% of remaining physical RAM to the PGA_AGGREGATE_TARGET
parameter.

Minimum allocation: 1536 MB (or 1.5 GB).
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Computer with multiple database instances

Note: If you are planning to run multiple database instances on the same computer, adjust the memory to
ensure that concurrently running instances fit into the available physical RAM. Using physical memory
avoids swapping to disk.

For example, to run the IBM OpenPages GRC Platform database and Cognos database services on the
same computer with 8 GB of RAM:

• 2 GB of RAM for the OS
• The remaining 6 GB of RAM can be split between the OpenPages GRC Platform database and Cognos

database as follows:

– OpenPages GRC Platform database instance: 2.5 GB SGA + 1 GB PGA
– Cognos database instance: 1.5 GB SGA + 1 GB PGA

Enabling LDAP for the IBM OpenPages GRC Platform application
If you are installing IBM OpenPages GRC Platform into an LDAP environment, you must enable LDAP. The
Openpages module in the LDAP configuration file, aurora_auth.config, determines whether LDAP is
enabled.

Note: The LDAP server for the user provisioning feature is configured separately. See the IBM OpenPages
GRC Administrator's Guide.

For information about how to configure LDAP for the REST API, see Authentication for GRC REST API with
a custom user realm for WebSphere (https://www.ibm.com/developerworks/community/blogs/
d89a3ddf-2acf-4cc8-b11b-14f33b5c653e/entry/
authentication_for_grc_rest_api_with_a_custom_user_realm_for_websphere).

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Use your LDAP Directory Server to add users who require access to the OpenPages application or to

the OpenPages environment to the LDAP authentication server.

For more information about the steps required to add OpenPages users to the LDAP server, see the
documentation for your LDAP Directory Server.

3. Log on to the OpenPages application and create the same users.
4. Stop all OpenPages services.
5. Go to the directory where you copied the aurora_auth.config file.
6. Open the LDAP configuration file, aurora_auth.config, in a text editor.
7. Rename the Openpages module to something different, such as Openpages_default.
8. Depending on your LDAP server, rename the LDAP module to Openpages

• If you are using a Microsoft Active Directory server, change the OpenpagesAD module name to
Openpages.

• If you are using any other LDAP server, change the OpenpagesIP module name to Openpages.
9. Specify the correct values for the following properties in the appropriate module:
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Table 40: LDAP properties

Property Description

provider.url IP address and port number of the LDAP
authentication server, in the <protocol>://
<ip_address>:<port> format.

Note: If you are configuring LDAP over SSL
(LDAPS), the protocol is ldaps and the port is
the LDAPS port.

security.search.user.dn The fully qualified name of an administrative
user on the LDAP server.

security.search.user.credentials The password for the specified user

base.dn The top level of the LDAP directory tree structure
(Domain Name) on the LDAP server.

If the users to be authenticated are in multiple
locations within your Active Directory structure,
list all locations explicitly. Use the distinguished
names of the locations, each separated by a
semi-colon.

user.attr.id The attribute name of the user identifier.

Typically a common name (CN), uid, or
sAMAccountName.

For example

Openpages_default
 {
 com.openpages.aurora.service.security.namespace.AuroraLoginModule required 
   debug=false;
 };

Openpages 
{
com.openpages.aurora.service.security.namespace.LDAPLoginModule required debug=false
provider.url="ldap://10.128.25.150:389"
security.authentication="simple"
security.search.user.dn="CN=Administrator,CN=Users,DC=LDAPTesting,DC=local"
security.search.user.credentials="openpages" 
base.dn="CN=Users,DC=LDAPTesting,DC=local" 
user.attr.id="CN"; 
};

10. Save and close the file.
11. Log on to the OpenPages application and change the OpenPages Administrator password to

openpages.
12. Restart all OpenPages services.
13. Log on to the OpenPages application as one of the users that you created in the LDAP Directory

Server.

Install IBM OpenPages GRC Platform  157



Disabling LDAP for the IBM OpenPages GRC Platform application
If LDAP is enabled on your system, the default Openpages module was renamed. Either the OpenpagesIP
or OpenpagesAD was renamed to Openpages. To disable LDAP, change the name of the current
Openpages module and change the name of the default Openpages module back to Openpages.

Note: The LDAP server for the user provisioning feature is configured separately. See the IBM OpenPages
GRC Administrator's Guide.

Procedure

1. Log on to the application server as a user with administrative privileges.
2. Stop all IBM OpenPages GRC Platform services.
3. Go to the directory where you copied the aurora_auth.config file.

<OP_HOME>/aurora/conf
4. Open the LDAP configuration file, aurora_auth.config, in a text editor.
5. Change the name of the Openpages_default module back to Openpages.
6. Change the name of the current Openpages module to something different.
7. Save and close the file.

Accessing OpenPages GRC Platform
To view the application log in page for your installation, type the IBM OpenPages GRC Platform URL into
your web browser.

For default installations, type the following URL in your web browser:

http://<openpages_server>:<port>/openpages

If you are using an SSL connection to access the OpenPages application, you must have an SSL digital
certificate. After configuration, type the following URL in your web browser:

https://<openpages_server>:<ssl_port>/openpages

Search server post installation tasks
If you installed a search server with IBM OpenPages GRC Platform, ensure that you completed the
following post installation tasks.

• Copy the JDBC driver from the database server to the search server.

For more information, see “Copying database driver files to the search server” on page 159.
• Optional: Set up SSL for the global search service.

For more information, see “Setting up SSL for the global search service” on page 159.
• Configure the location of the openpages-storage directory in the search server properties file.

For more information, see “Updating the search server properties file with the location of the
OpenPages storage directory” on page 162.

• Tune the search server parameter settings.

For more information, see “Search server tuning” on page 163.
• Create the global search index.

For more information, see “Creating the global search index” on page 164.

Note: If you are upgrading from 7.2.x or 7.3.x, skip this task. You will update global search during the
upgrade process.

For more information about the search server, see the IBM OpenPages GRC Administrator's Guide.
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Copying database driver files to the search server
After you install the search server, you must copy the database driver files to the search server.

Procedure

1. Copy the JDBC database drivers from the database server.

• If you are using an Oracle database server:

a. Go to the following directory:

<ORACLE_HOME>\jdbc\lib (on Microsoft Windows operating systems)

<ORACLE_HOME>/jdbc/lib (on UNIX operating systems)
b. Copy the following file:

ojdbc7.jar
• If you are using an IBM DB2 database server:

a. Go to the following directory:

<DB2_HOME>\sqllib\java (on Windows)

<DB2_HOME>/sqllib/java (on UNIX)
b. Copy the following files:

db2jcc4.jar

db2jcc_license_cu.jar
2. Copy the files to the following directory on the search server:

<SEARCH_HOME>\opsearchtools\lib (on Windows)

<SEARCH_HOME>/opsearchtools/lib (on UNIX)
3. Start the global search services. For more information, see “Start or stop the global search services”

on page 257.

Setting up SSL for the global search service
You can configure IBM OpenPages GRC Platform global search service (Apache Solr) to use Secure
Sockets Layer (SSL). SSL ensures that all data that is passed between the application server and the Solr
service remains private.

About this task
If you are setting up the global search component in a test environment, do not enable Secure Sockets
Layer (SSL) until you resolve all installation and configuration issues.

For more information about the commands that are used in this task, see the Apache Solr documentation
https://cwiki.apache.org/confluence/display/solr/Enabling+SSL#EnablingSSL-BasicSSLSetup.

Important: IBM is not responsible for third-party content. At the time of publication, the information is
correct.

Procedure

1. If the global search component is enabled, you must disable it.
a) Log on to OpenPages as a user with administrative privileges.
b) Click Administration > Global Search.
c) Click Disable.

2. Stop the global search services.

For more information, see “Start or stop the global search services” on page 257.
3. Create a certificate for the secure connection.
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a) Go to the <SEARCH_HOME>/solr/server/etc folder and run the following command.

keytool -genkeypair -alias alias -keyalg key_algorithm
  -keysize keysize -keypass key_pass -storepass keystore_passwd
  -validity validity -keystore jks_keystore -ext ip_address
  -dname "CN=localhost, OU=Organizational Unit, O=Organization, L=Location,
   ST=State, C=Country"

In the following example, the command creates a self-signed certificate in a key store named
solr-ssl.keystore.jks. The key store contains a key with an alias of solr-ssl, a key store
password of secret, a trust store password of secret. It specifies Subject Alternative Name
(SAN) values of DNS:host1.companya.com and IP:127.0.0.1,192.168.7.1 to include in
the certificate. (SAN values are not mandatory, and might not be specified in your environment).

keytool -genkeypair -alias solr-ssl -keyalg RSA
  -keysize 2048 -keypass secret -storepass secret
  -validity 9999 -keystore solr-ssl.keystore.jks
  -ext SAN=DNS:host1.companya.com,IP:127.0.0.1,IP:192.168.7.1
  -dname "CN=localhost, OU=Organizational Unit, O=Organization, L=Location,
   ST=State, C=Country"

b) Convert the JKS key store into PKCS12 format.

keytool -importkeystore -srckeystore jks_keystore
 -destkeystore jks_keystore.p12 -srcstoretype source_keystore_type
 -deststoretype destination_keystore_type

When prompted, type a destination key store password, and the source key store password that
you specified in the step 3a.

c) Convert the PKCS12 format key store, including the certificate and the key, into PEM format.

To run this command, openssl must be installed, and added to the PATH environment variable.

openssl pkcs12 -in <jks_keystore.p12> -out <jks_keystore.pem>

When you are prompted for the import password and PEM pass phrase, you can use the same
password that you specified for the <key_pass> value in step 3a.

4. Export the certificate.

keytool -export -keystore <jks_keystore> -alias <alias> -file <solr_certificate> 

When you are prompted for the key store password, type the password that you specified for the
<key_pass> value in step 3a.

5. Update the solr.in file.
a) Edit the following file in a text editor:

<SEARCH_HOME>\solr\bin\solr.in.cmd (on Windows)

<SEARCH_HOME>/solr/bin/solr.in.sh (on UNIX)
b) Uncomment and set the following SSL properties.

SOLR_SSL_KEY_STORE=etc/jks_keystore
SOLR_SSL_KEY_STORE_PASSWORD=keystore_passwd
SOLR_SSL_TRUST_STORE=etc/jks_keystore
SOLR_SSL_TRUST_STORE_PASSWORD=keystore_passwd
SOLR_SSL_NEED_CLIENT_AUTH=false
SOLR_SSL_WANT_CLIENT_AUTH=true

On Windows, you might need to use server/etc as the path name for the
SOLR_SSL_KEY_STORE and SOLR_SSL_TRUST_STORE properties.

6. Log in to the OpenPages application as a user with administrative privileges. Update the following
settings to use https instead of http.

Administration > Settings > Platform > Search > Admin > Search Server Administration URL
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Administration > Settings > Platform > Search > Index > Search Server URL

Administration > Settings > Platform > Search > Request > Search Server URL
7. Copy the certificate file that you exported to the following folder on the application server.

<WAS_HOME>/AppServer/Java/8.0/jre/lib/security
8. Add the certificate to the IBM JRE key store file.

a) Open a Windows command prompt by using the Run as Administrator option, or open a UNIX
shell with administrative privileges.

b) Back up the <WAS_HOME>/WebSphere/AppServer/Java/8.0/jre/lib/security/cacerts
file.

c) Go to <WAS_HOME>/WebSphere/AppServer/Java/8.0/jre/lib/security folder and run
the following command.

keytool -import -alias <alias> -keystore cacerts -file 
   solr_certificate

When prompted, type the key store password of the cacerts key store. The default password is
typically changeit.

d) Confirm that you want to trust the certificate.
e) Restart all OpenPages services.

9. Import the certificate to the IBM WebSphere trust store.
a) Log on to the WebSphere Integrated Solutions Console.

http://<server_name>:<port>/ibm/console

The default port is 9060.
b) Click Security > SSL certificate and key management > Key stores and certificates >

CellDefaultTrustStore > Signer certificates.
c) Click Add.
d) Update the following fields:

• Alias: Type the value that you specified for the alias in step 9.
• File name: Type the full path of the solr_certificate file that you imported into the
cacerts file in step 9.

Ensure that the data type is set to Base64-encoded ASCII data.
e) Click OK.
f) Click Save to update the master configuration.
g) Restart all OpenPages services.

10. Start the global search services.

For more information, see “Start or stop the global search services” on page 257.
11. If the search server is installed on a different computer than the application server, add the certificate

to the IBM JRE key store on the search server.
a) Open a Windows command prompt by using the Run as Administrator option, or open a UNIX

shell with administrative privileges.
b) Go to the <JAVA_HOME>/lib/security directory and run the following command:

keytool -import -alias <alias> -keystore cacerts 
   -file <SEARCH_HOME>/solr/server/etc/solr_certificate

c) When prompted, type the key store password of the cacerts key store. The default password is
typically changeit.

12. Continue with the post installation or post upgrade steps for global search.
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Updating the search server properties file with the location of the OpenPages storage directory
Configure the path to the openpages-storage directory in the search server properties file to enable
the search server to access the directory.

About this task

When you install IBM OpenPages GRC Platform, a pointer to the OpenPages storage location is created.
The storage location is a directory where attached files and forms that are associated with OpenPages
objects are stored. The search server looks in the openpages-storage directory to index file
attachments, when file attachment search is enabled.

To configure the location of the directory, share the openpages-storage directory on the admin
application server, and then modify the search server properties on the search server to point to the
shared network location.

Note: If you are working with a test environment in which the search server is on the same physical
computer as the admin application server, you do not need to do this task.

Attention: By default, file attachment search is enabled. If you enable global search without first
configuring the location of the OpenPages storage directory location, files cannot be searched.

Procedure

1. Share the openpages-storage directory on the admin application server so that it can be reached by
the search server.

For more information, see “Sharing a network OpenPages GRC Platform storage directory on AIX or
Linux operating systems” on page 139 and “Sharing a network OpenPages GRC Platform storage
directory on Windows operating systems” on page 141.

2. Log on to the search server as a user with administrative privileges.
3. Go to <SEARCH_HOME>/opsearchtools/.
4. Open the openpages_search.properties file in a text editor.
5. Modify the OPSearchTool.FileStorageRootPath property to specify the full path to the
openpages-storage directory on the admin application server.

UNIX: /opt/ibm/op/openpages/openpages-storage

Microsoft Windows:

Note: On Windows operating systems, escape the directory separator with a backslash (\).

• If you share is mounted to a driver letter, use the following syntax: C:\\ibm\\op\\openpages\
\openpages-storage

• If your share is a network share, use the following syntax: \\\\op-server\\shared\
\openpages-storage

For more information about the OPSearchTool.FileStorageRootPath property, see the IBM
OpenPages GRC Administrator's Guide.

6. Disable global search and stop the global search services.

For more information, see “Stopping the global search services by using a script” on page 258 or
“Stopping the global search services” on page 259.

7. Start the global search services.

For more information, see one of the following topics:

• “Starting the global search services by using a script” on page 257
• “Starting the global search services on Windows” on page 258
• “Starting the global search services on Linux or AIX” on page 259
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Search server tuning
The standard installation of the IBM OpenPages GRC Platform global search component uses default
parameter settings. You might need to tune some parameter settings depending on your organization's
requirements and data.

There are two settings that you can configure:

• The ports used by the global search component.

For more information, see “Changing port values for the global search component” on page 163.
• The amount of memory used by the search engine service and the indexer service.

For more information, see “Allocating memory for the global search component” on page 163.

Changing port values for the global search component
By default, the IBM OpenPages GRC Platform global search component uses two ports. Port 8983 is used
for indexing and searching IBM OpenPages data. Port 8985 is used to administer global search.

About this task

If you have a firewall, ensure that these ports are enabled. If your organization uses different ports, you
can change the port values.

Procedure

1. If the global search component is enabled, you must disable it.
a) Log on to OpenPages as a user with administrative privileges.
b) Click Administration > Global Search.
c) Click Disable.

2. Stop the global search services.

For more information, see “Start or stop the global search services” on page 257.
3. Log in to the OpenPages application as a user with administrative privileges, and update the following

registry setting values.
a) Click Administration > Settings > Applications > Common > Configuration > Show Hidden

Settings and set the value to true.
b) Click Administration > Settings > Platform > Search > Admin and update the Search Server

Administration URL default port value (8985) to a value of your choice.
c) Click Administration > Settings > Platform > Search > Index and update the Search Server URL

default port value (8983) to a value of your choice.
d) Click Administration > Settings > Platform > Search > Request and update the Search Server

URL default port value (8983) to a value of your choice.

Ensure the port value matches the value you specified in step 3c to avoid issues for users.
4. Start the global search services.

For more information, see “Start or stop the global search services” on page 257.
5. Continue with the post installation or post upgrade steps for global search.

Allocating memory for the global search component
You can change the amount of memory used by the Apache Solr search engine service and the indexer
service for the IBM OpenPages GRC Platform global search component.

Procedure

1. Update the memory allocation on the computer on which you installed the search server.

Ensure you have sufficient free memory on the computer. If you set the memory too high and the
computer does not have enough free memory, you might encounter performance issues.
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a) Edit the <SEARCH_HOME>/opsearchtools/openpages_search.properties file in a text
editor.

b) To update the amount of memory (in megabytes) to allocate to the Apache Solr service, edit the
OPSearchTool.SolrHeapSize value.

c) To update the amount of memory (in megabytes) to allocate to the OpenPages indexer service, edit
the OPSearchTool.IndexerHeapSize value.

2. If the global search component is enabled, you must disable it.
a) Log on to OpenPages as a user with administrative privileges.
b) Click Administration > Global Search.
c) Click Disable.

3. Stop the global search services.

For more information, see “Start or stop the global search services” on page 257.
4. Start the global search services.

For more information, see “Start or stop the global search services” on page 257.
5. Continue with the post installation or post upgrade steps for global search.

Creating the global search index
After you install IBM OpenPages, create the global search index. If you are upgrading, you can skip this
task.

Before you begin

The reporting schema must exist and must be enabled before you create the search index.

Procedure

1. Start the search services, if they are not already started.
2. Log in to OpenPages as a user with administrative privileges.
3. Click Administration > Global Search and click Create.

Creating the index also enables global search.

Click Refresh to update the page.

Results

The Global Search is available next to the Reporting Period box.

If global search does not start, see “Known problems and solutions for global search” on page 345.

For more information about global search, see the IBM OpenPages GRC Administrator's Guide.

Complete the workflow server integration
If you added a IBM Business Process Manager workflow server to your deployment, you need to some
post-installation tasks.

For more information, see the IBM OpenPages GRC - Business Process Manager Installation Guide.
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Modify the SDI/TDI assembly line after fresh installations
If you did a fresh installation and you use the IBM QRadar integration project or IBM OpenPages GRC SDI
Connector for UCF Common Controls Hub, due to a known issue you have to modify the SDI/TDI assembly
line to be able to upload the date values for date fields. Contact Customer Support for more information.

Preventing orphan objects
After you install IBM OpenPages, to prevent orphan objects, you must update the Cascade Delete registry
setting.

Procedure

1. Log in to OpenPages as a user with administrative privileges.
2. Click Administration > Common > Cascade Delete > Include Object Types.
3. Append the registry setting value with the following string:

,ProjectActionItem,QuestionnaireAssessment,QuestionTemplate,
SectionTemplate,SOXBusEntity,SOXDocument,SOXExternalDocument,
SOXIssue,SOXMilestone,SOXSignature,SOXTask,SubSectionTemplate

Verification checklist
After you install the IBM OpenPages GRC Platform application, verify that the installation is working as
expected.

Use the following checklist to verify whether the installation is successful.

Table 41: Post installation verification checklist

Task Guidance

Review all installation logs for errors. For log file locations and names, see “Log files” on
page 341.

Verify that the database parameters are
correct.

Review the database parameters, such as
NLS_LENGTH_SEMANTICS=CHAR, to ensure that they
are correct.

Confirm that the reporting schema and
reporting framework generated successfully.

For more information, see “Creating the reporting
schema and framework” on page 137.

Confirm that base reports are functioning as
expected.

Log on to the OpenPages application and run the All
Documentation Cognos report.

If single sign-on (SSO) is enabled, verify that
user accounts can access the environment.

Log on to the OpenPages application with an SSO user
account.

Confirm that you can upload and download
sample attachments.

Log on to the OpenPages application and upload and
download a file attachment.

Verify that links in reports reference the correct
server address and use the correct web URL
parameters.

Run a report that uses OpenPages links. Select a link
and confirm that the target object is rendered
successfully in the OpenPages interface.

For clustered environments, verify that all
servers can upload and download attachments.

Upload and download files from both the admin and
non-admin application servers.
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Table 41: Post installation verification checklist (continued)

Task Guidance

Test that you can access the Cognos Analytics
portal.

Type the following web URL:

http://server_name/ibmcognos

Confirm that you can log on to the portal.

Confirm that you ran the enable-session-
sleep.sql script.

For more information, see “Preventing concurrency
conflicts for installations that use Oracle databases”
on page 152.

Confirm that object data is created. Do this test
after you back up the database.

Log on to the OpenPages application and create
sample Entity, Process, and Risk objects. Delete these
objects.
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Chapter 7. Upgrade IBM OpenPages GRC Platform
Upgrade your existing version of IBM OpenPages GRC Platform to take advantage of new features,
enhancements, and performance improvements.

You can upgrade from IBM OpenPages GRC Platform version 7.1.x, 7.2.x, or 7.3.x installed on IBM
WebSphere Application Server 8.5.5 or later.

For more information about the supported software versions for OpenPages GRC Platform, see the IBM
Software Product Compatibility Reports (www.ibm.com/support/docview.wss?uid=swg27039467)..

When you upgrade, you do a fresh installation of IBM OpenPages GRC Platform and then migrate your
data. You can install IBM OpenPages GRC Platform in a new environment or in your existing IBM
OpenPages GRC Platform environment.

IBM OpenPages GRC Platform supports upgrades from versions 7.1.x, 7.2.x, and 7.3.x. If your
environment was originally based on a fresh installation of 7.0.x or an earlier version, you might need to
do some remediation steps. For more information, see http://www.ibm.com/support/docview.wss?
uid=swg22014144.

If you have version 7.0.x, 6.x, or 5.x, you must first migrate to version 7.1.x, 7.2.x, or 7.3.x before you can
upgrade. For more information, see the following topics:

• For information about migrating to version 7.1, see the topics about migrating in the OpenPages GRC
Platform version 7.1 installation guide.

• For information about migrating to version 7.2, see the topics about migrating in the OpenPages GRC
Platform version 7.2 installation guide.

• For information about migrating to version 7.3, see the topics about migrating in the OpenPages GRC
Platform version 7.3 installation guide.

Upgrade scenarios
When you upgrade IBM OpenPages GRC Platform, you can follow two main scenarios: using the database
server from your source environment or using new hardware for the database server.

http://www.ibm.com/support/docview.wss?uid=swg27039467
http://www.ibm.com/support/docview.wss?uid=swg27039467
http://www.ibm.com/support/docview.wss?uid=swg22014144
http://www.ibm.com/support/docview.wss?uid=swg22014144
http://public.dhe.ibm.com/software/data/cognos/documentation/openpages/en/7.1.0/op_installation_guide.pdf
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Figure 16: Upgrade scenarios

Upgrade process overview: Using the database server from your source environment
You can upgrade IBM OpenPages GRC Platform and use the existing database server from your 7.1, 7.2,
or 7.3 environment .

Use this option if you do not want to use new hardware for the database server.

Upgrading OpenPages GRC Platform requires the following steps.

1. Ensure that your source database server meets the prerequisites for OpenPages. See “Upgrade
prerequisite software ” on page 173. Also see the following checklists:

• “Checklist for the database server (DB2)” on page 56
• “Checklist for the database server (Oracle)” on page 75

2. Upgrade to Cognos Analytics and upgrade the content store. See “Cognos Analytics upgrade process”
on page 173.

3. If you use global search, prepare the search server for the upgrade. See “Preparing the search server
in the source environment” on page 174.

4. Back up the OpenPages source environment. See “Backing up your source environment” on page
174.

5. Upgrade the OpenPages database in your source environment manually. See “Upgrade the
OpenPages database” on page 175.

6. Install OpenPages. On the Database Server card, point to the database server from your source
environment. Select Already Installed for the Install Database option.

See Chapter 6, “Install IBM OpenPages GRC Platform,” on page 45.
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7. Update the location of the OpenPages storage directory, openpages-storage, in the database. See
one of the following topics:

• “Updating the location of the openpages-storage directory (DB2)” on page 141
• “Updating the location of the openpages-storage directory (Oracle)” on page 143

8. If your deployment includes a search server, update the settings for global search. See “Updating
search server settings” on page 182.

9. Update the URL host pointers for Cognos reports. See “Updating URL host pointers for reports” on
page 182. See “Updating URL host pointers for reports” on page 182.

10. Verify the list of valid OpenPages application server domains and host names for Cognos Analytics.
See “Verify the list of valid domains and host names for Cognos Analytics” on page 183.

11. Open your deployment in the installation app and validate it.
12. Migrate the data from the source environment to your upgraded environment. See “Migrate files” on

page 176.

Use the installation app to back up and restore files and directories, such as JSPs and other customer
deliverables.

If you are upgrading from 7.3.x, you can use the installation app to restore the global search index.
13. Upgrade the application data. See “Upgrading application data” on page 179.
14. Do the post-upgrade tasks. See “Post upgrade tasks” on page 180.
15. If you use IBM OpenPages solutions, do the post upgrade tasks for solutions. See Chapter 10,

“OpenPages solutions post-upgrade tasks,” on page 239.
16. Test the upgraded deployment.
17. Review the new and changed features for this release to check whether there is anything that affects

your installation after upgrading.

Note:

Fujitsu Interstage Business Process Manager is not supported in IBM OpenPages GRC Platform version
7.4 and later. For more information, see the following software announcement.

The database upgrade scripts remove the workflow schema and any references to the workflow schema
that are contained within the OpenPages schema.
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Figure 17: Upgrade process overview: Using the database server from your source environment

Upgrade process overview: Using new hardware for the database server
You can upgrade IBM OpenPages GRC Platform and use new hardware for the database server.

Upgrading OpenPages GRC Platform requires the following steps.

1. Upgrade to Cognos Analytics and upgrade the content store. See “Cognos Analytics upgrade process”
on page 173.

2. If you use global search, prepare the search server for the upgrade. See “Preparing the search server
in the source environment” on page 174.

3. Back up your existing OpenPages environment (the source environment for the upgrade). See
“Backing up your source environment” on page 174.

Note: If you are upgrading from OpenPages version 7.1.x or 7.2.x with IBM DB2 10.5, you might need
to drop and re-create the reporting schema during the upgrade.

4. Install OpenPages. See Chapter 6, “Install IBM OpenPages GRC Platform,” on page 45.

If you use your existing environment, ensure that it meets the software prerequisites. See “Upgrade
prerequisite software ” on page 173.

Note: You must use a new, empty directory for OpenPages.

If you are using IBM DB2, you must use the same database instance name as the database in your
previous version of OpenPages.

If you are using Oracle, you can use different names for the OpenPages schema and Cognos schema.
When you restore the databases from your source environment, you must remap the schema names.
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Note: If you use a different name for the OpenPages schema in your upgraded environment, the
change might impact your reports. You might need to do some remediation steps. If your reports
contain references to the schema, update the reports to use the new schema name. Out-of-the-box
reports are not impacted by this issue because they do not reference the schema name.

Ensure that you complete the database server and OpenPages database setup tasks:

• For IBM DB2, see “Checklist for the database server (DB2)” on page 56.
• For Oracle, see “Checklist for the database server (Oracle)” on page 75.

5. Restore the OpenPages database from your previous version into the upgraded environment. See one
of the following topics:

• “Restore the OpenPages database in your upgraded environment (DB2)” on page 197
• “Restore the OpenPages database in your upgraded environment (Oracle)” on page 217

6. Upgrade the OpenPages database. See “Upgrade the OpenPages database” on page 175.
7. Update the database connection information.

When you restore the database, the connection information from your source environment is
imported. You need to update the connection information to use the new database server.

See one of the following topics:

• “Update the database connection information (DB2)” on page 211
• “Update the database connection information (Oracle)” on page 233

8. Update the URL host pointers for Cognos reports. See “Updating URL host pointers for reports” on
page 182.

9. Migrate the data from the source environment to your upgraded environment. See “Migrate files” on
page 176.

Use the installation app to back up and restore files and directories. For example, if you are upgrading
from 7.3.x, you can restore the global search index.

10. Upgrade the application data. See “Upgrading application data” on page 179.
11. Do the post-upgrade tasks. See “Post upgrade tasks” on page 180.
12. If you use IBM OpenPages solutions, do the post upgrade tasks for solutions. See Chapter 10,

“OpenPages solutions post-upgrade tasks,” on page 239.
13. Test the upgraded deployment.
14. Review the new and changed features for this release to check whether there is anything that affects

your installation after the upgrade.

Note: Fujitsu Interstage Business Process Manager is not supported in IBM OpenPages GRC Platform
version 7.4 and later. For more information, see the following software announcement.

During the upgrade process, you need to back up and then restore both the OpenPages schema and the
workflow schema so that the database upgrade scripts can remove any references to the workflow
schema that are contained within the OpenPages schema. After the OpenPages schema has these
references removed, the workflow schema will then be removed to complete the upgrade.
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Figure 18: Upgrade process overview
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Upgrade prerequisite software
If you want to use your existing IBM OpenPages GRC Platform environment for the upgrade, ensure that it
has the supported versions of the software required by IBM OpenPages GRC Platform

Review the software prerequisites for application servers, reporting servers, the database server, and the
search server. For more information, see “Software prerequisites” on page 25.

For example, if you are upgrading from version 7.2.x, do the following steps:

• If you are using IBM DB2, upgrade to version 11.1 or a later fix pack. See “Upgrade IBM DB2” on page
58.

• If you are using Oracle, upgrade to version 12.1.0.2 or a later fix pack. See “Upgrading the Oracle
database server to 12.1.0.2” on page 76.

• Install IBM WebSphere Application Server version 9.0.0.3 or a later fix pack. See “IBM WebSphere
Application Server installations” on page 53.

Tip: You do not need to uninstall WebSphere 8.5.5. WebSphere supports the installation of multiple
versions on a server. For more information, see the WebSphere documentation.

• Install Cognos Analytics version 11.0.7 or later and migrate your data. See “Cognos Analytics upgrade
process” on page 173.

Tip: You do not need to uninstall Cognos 10.2.x. Cognos Analytics supports the installation of multiple
versions on a server. For more information, see the Cognos documentation.

• Install IBM Runtime Environment for Java 8 on the search server.

Also, ensure that your users have a supported version of Google Chrome or Microsoft Internet Explorer.
See “Prerequisite software for OpenPages GRC Platform client computers” on page 30.

Note:

Fujitsu Interstage Business Process Manager is not supported in IBM OpenPages GRC Platform version
7.4 and later. For more information, see the following software announcement.

If you have Fujitsu Interstage Business Process Manager Studio installed, you can uninstall it.

Cognos Analytics upgrade process
If you are upgrading IBM OpenPages GRC Platform, you need to upgrade Cognos.

To upgrade Cognos, you install Cognos Analytics and then migrate your data. The Cognos Analytics
documentation provides details about how to upgrade. For more information, see Planning your upgrade
to IBM Cognos Analytics.

Tip: You do not need to uninstall Cognos 10.2.x. Cognos Analytics supports the installation of multiple
versions on a server. For more information, see the Cognos documentation.

During the Cognos upgrade process, you move your content store to the new version of Cognos. The
Cognos documentation describes two methods for moving the content store. One of the options is to
move the entire content store by backing up and restoring the database. If you want to use this option,
see the following topics:
IBM DB2

• “Backing up the Cognos database (DB2)” on page 196
• “Restoring the Cognos content store (DB2)” on page 199

Oracle

• “Backing up the Cognos content store (Oracle)” on page 216
• “Restoring the Cognos content store (Oracle)” on page 224
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Preparing the search server in the source environment
Before you upgrade OpenPages, prepare the search server in your source environment .

About this task

The steps that you need to do depend on the version that you are upgrading from.

If you are upgrading from 7.1.x, you do not need to do this task.

Procedure

1. Start the search server in your source environment.

• For 7.3.x, see “Start or stop the global search services” on page 257.
• For 7.2.x, see Starting and stopping the global search services.

2. Log in to OpenPages as a user with administrative privileges.
3. Click Administration > Global Search.
4. If you are upgrading from version 7.2.x, disable global search and drop the global search index.

a) Click Administration > Global Search and click Disable.
b) Click Administration > Global Search and click Drop.

5. If you are upgrading from version 7.3.x, disable global search.
You do not need to drop the global search index.
a) Click Administration > Global Search and click Disable.

6. If the Update button is enabled, click it to update the search index.
7. Stop the search services in your 7.2.x or 7.3.x environment.

• For 7.3.x, see “Start or stop the global search services” on page 257.
• For 7.2.x, see Starting and stopping the global search services.

8. For either Windows or UNIX, verify that global search is fully stopped by doing the following steps:
a) In the directory <SEARCH_HOME>/opsearchtools/, examine the files
opsearchtool_openpages.state and opsearchtool_folderacl.state and verify that the
PID value is -1.

b) From a browser, point to your search server at ports 8983 and 8985 and make sure that the Solr
search platform cannot be reached, for example, https://<search-server>:8983/ and
https://<search-server>:8985/.

If the stop verification fails, repeat the preceding step and then follow the steps in “ Forcing a reset
of global search” on page 346.

Backing up your source environment
Before you upgrade, back up IBM OpenPages GRC Platform in your source environment.

Procedure

1. Stop the application servers (admin and non-admin), reporting servers (active and standby), database
server, and the search server in your source environment.

2. Back up the databases.

• If you are using IBM DB2, see “Back up the database (DB2)” on page 193.

Note: If you are upgrading from OpenPages version 7.1.x or 7.2.x with IBM DB2 10.5, you might
need to drop and re-create the reporting schema during the OpenPages upgrade.

• If you are using Oracle, see “Backing up the OpenPages database (Oracle)” on page 215.
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3. Back up the openpages-storage directory.

The openpages-storage directory can be located on a server in your deployment or it can be on a
separate network share.

The default location is <OP_HOME>/openpages-storage.
4. If you modified the standard reports that are provided with OpenPages, copy them to your personal

folders.

OpenPages standard reports can be overwritten during an upgrade.

After the upgrade, you can change the reports and restrict access to them.
5. On each application server, as the OpenPages installation user (opuser), rename the top level
OpenPages directory to OpenPages-<current-version>. For example, if you are upgrading from
version 7.2.0.4, rename the OpenPages directory to OpenPages-7.2.0.4.

You use this backup directory to restore the current OpenPages version if you need to roll back from
the upgrade.

6. On each reporting server, as the OpenPages installation user (opuser), rename the top level
CommandCenter directory to CommandCenter-<current-version>. For example, if you are
upgrading from version 7.2.0.4, rename the CommandCenter directory to
CommandCenter-7.2.0.4.

You use this backup directory to restore the current <CC_HOME> directory if you need to roll back from
the upgrade.

7. On the search server, as the OpenPages installation user (opuser), rename the top level OpenPages
directory to OpenPages-<current-version>. For example, if you are upgrading from version
7.2.0.4, rename the OpenPages directory to OpenPages-7.2.0.4.

You use this backup directory to restore the current search server version if you need to roll back from
the upgrade.

Note: The search server is an optional component that was first available in OpenPages 7.2.0.0.

Upgrade the OpenPages database
The tasks that you need to do to upgrade the OpenPages database depend on the upgrade scenario that
you are following.
Using the database server from your source environment

• Back up the database.

See one of the following topics:

– “Back up the database (DB2)” on page 193
– “Backing up the OpenPages database (Oracle)” on page 215

• Upgrade the database manually.

See one of the following topics:

– “Upgrade the databases (DB2)” on page 201
– “Upgrade the databases (Oracle)” on page 225

Using new hardware for the database server

• Back up the database in your source environment.

See one of the following topics:

– “Back up the database (DB2)” on page 193
– “Backing up the OpenPages database (Oracle)” on page 215

• Import the OpenPages from your source environment into the database on the new database server.
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See one of the following topics:

– “Restore the OpenPages database in your upgraded environment (DB2)” on page 197
– “Restore the OpenPages database in your upgraded environment (Oracle)” on page 217

• Upgrade the OpenPages database.

See one of the following topics:

– “Upgrade the databases (DB2)” on page 201
– “Upgrade the databases (Oracle)” on page 225

• Update the connection information in the database.

See one of the following topics:

– “Update the database connection information (DB2)” on page 211
– “Update the database connection information (Oracle)” on page 233

Migrate files
You can migrate application files from your previous installation of IBM OpenPages GRC Platform.

For example, your source environment might contain custom reports that you want to use in your
upgraded environment.

You can restore files onto a system that uses a different operating system than the source system. For
example, if the application server in your source environment is running Microsoft Windows, you can
restore the files to a Linux application server.

The topology of your source and target environments can differ. For example, if your source environment
uses clustered application servers, you can migrate files to a target system that uses a single application
server or to a target system that uses a different number of clustered application servers.

This video demonstrates how to migrate files:

https://youtu.be/D_eXA50AkOA

Backing up application files
Use the IBM OpenPages GRC Platform installation app to back up application files.

Before you begin

• Ensure that all of the servers in the source environment are stopped.
• If you use clustered application servers or reporting servers, ensure that all of the nodes are

synchronized.
• Ensure that the installation server computer has sufficient disk space to store the backup files.
• Ensure that the installation server computer can access the servers in the source environment.

About this task

Your source environment might include custom files, reports, services deliverables, and other application
files that you want to use in your target environment. Back up the application files in your source
environment. You can then restore them in your target environment.

If your source environment includes customized JSP files, you must manually incorporate those
customizations into the JSP files in your target environment. If you have already merged the edits into the
JSP files that are deployed by the upgrade, do not include the JSP files in the backup since the restore
process will overwrite your edits to the JSP files in your target environment.
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If you are using clustered application servers or reporting servers, synchronize the nodes, and then back
up the files on the primary server. When you restore the application files, the files are copied to each
server in the cluster automatically.

Keep the following points in mind:

Application server
Do not select the openpages-storage directory for the backup. The directory can be very large.
Instead, copy the directory to your target environment. Or, make the directory available on a network
share.

Search server

• Select the openpages_search.properties file for the backup. During the post upgrade steps,
you can modify the settings in this file, if needed.

• If you are upgrading from 7.3.x, you select the <SEARCH_HOME>/openpages-solr-index
directory for the backup. The directory contains the global search index.

If you are upgrading from 7.2.x, do not include the openpages-solr-index directory in the
backup. You need to re-create the search index during the post upgrade step.

• For the global search server the files are stored on the source server in the OPSearchBackup
directory, for example, /op-search-backup-restore.

Procedure

1. Start the installation app and log in.
2. Open your deployment.
3. Click Current Deployment and select File Backup.

The left pane displays an application server card, a reporting server card, and a search server card.
4. If your source environment does not have a search server, delete the search server card.

Tip: You can add a card that you deleted. Select the server type from the list in the left pane and then

click .
5. Click one of the cards and enter the host name and other details about the server in your source

environment.

On the application server card, if you are using a clustered environment, enter the information for the
admin application server.

On the reporting server card, if you are using a clustered environment, enter the information for the
active reporting server.

If the OpenPages installation server is installed on the same physical computer as the server that you
are backing up, disable the Remote option.

6. Use the toggles to select the directories that you want to migrate.

Click  to view the directory path.
The Files selected for backup field displays the files and directories that you selected.

Note: When you select the Model Query Subjects toggle, the <CC_HOME>/framework/conf
directory is displayed in the Files selected for backup field. However, only the static model query
subjects are backed up and restored. This is intended.

7. If you want to back up and restore more files or directories, enter them in the Additional files to
backup.

Use relative paths to specify files and directories. Paths cannot contain spaces. Separate each item
with a comma. Do not enter spaces.
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• On the application server card, use paths relative to the OP Home Directory. For example, if you
want to migrate the files /opt/IBM/OpenPages/temp/myfile.xml and /opt/IBM/
OpenPages/mydir/otherfile.xml, type:

/temp/myfile.xml,/mydir/otherfile.xml

/temp/myfile.xml,
• On the reporting server card, use paths relative to the Command Center Home Directory. For

example, if you want to migrate the /opt/OpenPages/CommandCenter/temp/myreports/
directory, type /temp/myreports/

• On the search server card, use paths relative to the Search Server Home Directory. For example, if
you want to migrate the file /opt/IBM/OpenPages/Search/temp/data.xml, type /temp/
data.xml

8. Decide whether you want files to be overwritten when you restore them.

If you want the files from your source environment to overwrite the files in your target environment,
enable the Overwrite files during restore option. During the restore process, the files in your target
environment will be backed up before they are overwritten.

If you do not want the files from your source environment to overwrite the files in your target
environment, disable the Overwrite files during restore option. During the restore process, if a file
exists in the target environment, the file is skipped.

9. Click Save.
10. Click Backup.

If an error occurs, a message is displayed on the server card. Click the server card, and then click 
to see the error message.

The backup process creates a .zip file for each server card. The files are saved in the following
locations:

• The files are stored on the installation server computer in: <installation_server_home>/
installer/<deployment_name>/migration/.

The restore process uses the files in this directory.
• For the application server the files are stored on the source server in the OPBackup directory, for

example <OP_HOME>/openpages-backup-restore.
• For the reporting server the files are stored on the source server in the OPCCBackup directory, for

example <OP_HOME>/op-cc-backup-restore.
• The files are stored on the source server in: <OP_HOME>/agent/op-agent/agent/src/
deployment/<deployment_name>/migration/.

The files are named op_<node_name>_<incremental
number>_source_backup_<timestamp>.zip.

Note: The time stamp is based on the time zone of the source server computer.

If a file or directory was not found on the source server, it is skipped. For example, if a file name
contains a typo, the file does not get backed up. The log file includes messages about any files that
were skipped.

11. Download and review the log file.

Restoring application files
Use the IBM OpenPages GRC Platform installation app to restore application files from the source
environment to your target environment.

Before you begin

• Ensure that all of the servers in the environment are stopped.
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About this task

The restore process uses the files in the <installation_server_home>/installer/
<deployment_name>/migration/ directory. The files are called: op_<node_name>_<incremental
number>_source_backup_<timestamp>.zip

Only the files with the most recent timestamps are used.

When the files from the source system are restored, any files on the target system that will be overwritten
are backed up. A zip file that contains all original files that were replaced during the restore process is
created. The backup files are called op_<node_name>_<incremental
number>_target_backup_<timestamp>.zip.

• The application server files are stored in the OP Backup Restore Directory on the target server, for
example, /opt/IBM/OpenPages/openpages-backup-restore.

• The search server files are stored in the OP Backup Restore Directory on the target server.
• The reporting server files are stored in the Command Center Backup Directory on the target server, for

example, /opt/IBM/OpenPages/openpages_cc_backup_restore.

Procedure

1. Start the installation app and log in.
2. Open your target deployment.
3. Click Restore.

Wait for the process to complete.
4. Download the log file and review it. Look for any files or directories that were skipped.

Restore the storage directory in the target environment
You need to make the <OP_HOME>/openpages-storage directory available to the servers in your target
environment.

The <OP_HOME>/openpages-storage directory can be stored on a server in your deployment or it can
be on a separate network share.

• If the directory is on a server in your source environment, restore the backup that you created before
the upgrade. Copy the directory to a server in your target environment. If the <OP_HOME>/openpages-
storage directory exists on the target server, you can overwrite it.

Or, copy the backed up directory to a network share and give the servers in your target environment
access to the network location.

• If your <OP_HOME>/openpages-storage directory is on a network share, ensure that the servers in
your target environment can access the network location.

Note: You can also use OPBackup and OPRestore to move the openpages-storage directory.

If the location of the openpages-storage directory is different than it was in your source environment,
update the OpenPages database with the location of the openpages-storage directory.

Upgrading application data
You must upgrade the application data that is required for the operation of IBM OpenPages GRC Platform.
The application data includes localized text and other miscellaneous settings that are required by
OpenPages.

Before you begin

• If System Admin Mode is enabled in your target environment, disable it.
• If IBM Cognos Configuration is open, close it.
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About this task

This video demonstrates how to upgrade application data:

https://youtu.be/8kLP1Ajr7Xo

Procedure

1. If your source environment includes customized JSP files, you must manually incorporate those
customizations into the JSP files in your target environment. JSP files are located in the following
directories:

<OP_HOME>/profiles/<OpenPages-node-name>/installedApps/
  <OpenPages-cell-name>/op-apps.ear/openpages.war

<OP_HOME>/profiles/<OpenPages-node-name>/installedApps/
  <OpenPages-cell-name>/op-apps.ear/publishweb.war

<OP_HOME>/profiles/<OpenPages-node-name>/installedApps/
  <OpenPages-cell-name>/op-apps.ear/sosa.war

a) Restart the application servers in the target environment to ensure that the servers are
synchronized.

b) For each customized JSP file in your source environment, locate the JSP file in the target
environment. Merge the edits into the JSP file on the administrative application server in your target
environment.

c) After all JSP file edits have been incorporated, restart the application servers.
2. Start the installation app and log in.
3. Open your target deployment.
4. Click Upgrade App Data.

a) If Upgrade App Data is not enabled, click Validate.
If the Upgrade App Data button is still not available, verify that the OpenPages database upgrade
scripts completed successfully. See “Upgrade the databases (DB2)” on page 201 or “Upgrade the
databases (Oracle)” on page 225.

b) Click Upgrade App Data.
c) Wait for the process to complete.

5. Review the log files.
If any issues occurred, look for a log file in the <OP_HOME>/installer/migration/upgrade/
addon_module/loaderdata directory. Typical data loading activity is logged in the
<OP_HOME>/bin/logs directory.

Post upgrade tasks
Complete the following tasks after you upgrade IBM OpenPages GRC Platform.

• Verify the list of valid domain names and host names.

For more information, see “Verify the list of valid domains and host names for Cognos Analytics” on
page 183.

• If your OpenPages GRC Platform environment is using 3DES password encryption, change the
encryption algorithm to AES, which is more secure.

For more information, see “Upgrading the OpenPages password encryption algorithm to AES
encryption” on page 184.

• Determine if you need to update security rules. You might need to update security rules if you use
reporting periods or if you plan to use reporting periods.
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For more information, see “Updating security rules” on page 185.
• If you customized configuration files in your source environment, reapply or merge your changes.

For more information, see “Custom settings in configuration files ” on page 185.
• If you installed a search server, you must complete some post upgrade tasks.

For more information, see “Search server post upgrade tasks” on page 185.
• If you used IBM Business Process Manager in your previous deployment, you must re-establish the

integration of IBM Business Process Manager and IBM OpenPages GRC Platform.

For more information, see “Complete the workflow server integration after an upgrade” on page 186.
• If LDAP was configured in the source system and you did not migrate the aurora_auth.config, you

need to re-enable LDAP in your target environment.

For more information, see “Enable LDAP after upgrading” on page 187.
• If you use the approval app, upgrade the app.

For more information, see “Upgrade the approval app” on page 291.
• If you use IBM OpenPages Loss Event Entry, upgrade it.

For more information, see “Upgrade process overview for Loss Event Entry” on page 299.
• If you want to use Dynamic Query Mode (DQM) for the OpenPages reporting framework, configure a

JDBC connection to the OpenPages database.

For more information, see “Updating the connection to the OpenPages database for Cognos (DB2)” on
page 213 or “Updating the connection to the OpenPages database for Cognos (Oracle)” on page 237.

• Re-create the reporting schema.

If you dropped the reporting schema during the upgrade process, re-create it. For more information, see
“Recreating the reporting schema” on page 188.

• Regenerate the reporting framework.

Depending on your environment, you might need to regenerate the reporting framework. For more
information, see “Regenerating the reporting framework” on page 188.

• If you do not see the OpenPages reports and packages in the Cognos Analytics portal, import the
OpenPages Platform V6 package.

For more information, see “OpenPages reports are not displayed in the Cognos Analytics portal” on
page 368.

• Optional: change the singular and plural labels for the ModelReport object type to "Model Report" and
"Model Reports". Make appropriate changes in other locales.

• Verify the upgrade.

For more information, Upgrade verification tests..
• Test Cognos Analytics.

For more information, see “Testing Cognos Analytics after the upgrade” on page 191.
• Optional: Back up your environment by running OPBackup and OPCCBackup.

Loading the Cognos Analytics dashboard integration after upgrading
After you upgrade OpenPages, you must load a mandatory integration configuration so that you can use
Cognos Analytics dashboards within OpenPages.

Procedure

1. Copy the CommandCenter-integration-op-config.xml and CommandCenter-integration-
op-file-content.zip files from the IBM OpenPages GRC Platform installation media to the
administrative application server.
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The files are located in the /OP_<version>_Non_Embedded/OP_<version>_Configuration/
loader-data/commandcenter directory.

2. Open a command line.

If you are using Microsoft Windows , open a command prompt with the Run as Administrator option.
3. Go to the <OP_HOME>/bin directory.
4. Run the following command to load the files.

Replace <loader-file-path> with the location of the CommandCenter-integration-op-
config.xml and CommandCenter-integration-op-file-content.zip files.

ObjectManager.cmd|sh l c <OpenPages Administrator user> 
   <OpenPages Administrator password> <loader-file-path> 
   CommandCenter-integration

5. If you encounter any errors, review the log file, OP_HOME/bin/logs/ObjectManager.log.

Updating search server settings
Update the search server settings in IBM OpenPages GRC Platform.

You do not need to do this task if you did not install a search server, or if you are upgrading from
OpenPages 7.1.x. You need to perform these steps if you are upgrading from OpenPages 7.2.x or later.

Procedure

1. Update the database connection information for the search server.
See the following topics:

• “Updating the database connection information for the search server (DB2)” on page 212
• “Updating the database connection information for the search server (Oracle)” on page 236

2. If it is not already started, start the global search services.

For more information, see “Start or stop the global search services” on page 257.
3. If the global search component is enabled, you must disable it.

a) Log on to OpenPages as a user with administrative privileges.
b) Click Administration > Global Search.
c) Click Disable.

4. Stop the global search services.

For more information, see “Start or stop the global search services” on page 257.
5. If the global search service (Apache Solr) user name and password are different than in your source

environment, update them.
a) Click Administration > Settings > Applications > Common > Configuration.
b) Click Show Hidden Settings and set the value to true.
c) Click Administration > Settings > Platform > Search.
d) Update the Solr user ID and Solr password settings.

Updating URL host pointers for reports
After you migrate, change port settings in a production environment, or if you want to refresh a test
environment from a production database, you must update the URL host pointers on the application
server so that links in reports work properly.

You can update links in reports by modifying URL host pointer settings, and then propagating these
reporting schema changes to the application server.

To update the reporting schema, you can do either of the following:

• Run an SQL script that incrementally updates the reporting schema with the changes (recommended).
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Note: For SQL tool information, see the topic "Database tool information" in the IBM OpenPages GRC
Administrator's Guide.

• Use the IBM OpenPages GRC Platform application user interface to re-create the entire reporting
schema.

Procedure

1. Start the IBM OpenPages GRC Platform services on the admin application server.
2. Log on to the OpenPages GRC Platform application user interface as a user with administrator

privileges.
3. Change the Object URL Generator settings.

a) From the menu bar, click Administration > Settings.
b) Expand Platform > Reporting Schema > Object URL Generator.
c) Update the Object Generator URL settings, as required, to point to the application server (such as a

test application server). Make sure to click Save after you modify each setting.

Table 42: Object Generator URL settings

Setting Name Description

Host The changed name of the application server.

Example : test-eng1

Port The changed port number of the application server.

Example : 10108 (IBM WebSphere)

Protocol The changed protocol for accessing the application server.

Valid values are either http or https.

4. To update the changed URL setting on the application server, update the reporting schema using one
of the following methods:

• Method 1: Run the following SQL script to incrementally update the reporting schema
(recommended):

a. From a machine with a SQL tool and access to the database server, log on to SQL as the
OpenPages GRC Platform database user (for example, openpages).

b. Run the following SQL statements to update the reporting schema:

begin
OP_RPS_MGR.SET_DETAIL_PAGE_URL_IN_RPS_RT;
end;
/

• Method 2: Re-create the entire reporting schema by using the application user interface. For details,
see the topic "Creating or recreating the reporting schema" in the IBM OpenPages GRC
Administrator's Guide.

Verify the list of valid domains and host names for Cognos Analytics
If you imported the Cognos Analytics content store when you upgraded IBM OpenPages GRC Platform,
verify the list of valid domains and host names. Ensure that all application servers are listed. Also, verify
the public domain that is used for load balanced environments on all reporting servers.
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Procedure

1. Log on to the reporting server as a user with administrative privileges.
2. Start IBM Cognos Configuration.
3. In the Explorer pane, go to Local Configuration > Security > IBM Cognos Application Firewall.
4. In the Properties pane, click the Valid domain names or hosts.
5. Verify that all OpenPages application servers are listed.
6. If any application servers are missing from the list, add them.

a) Click the pencil icon.
b) In the Valid domain or hosts window, click Add.
c) Enter the names of the OpenPages application servers.
d) Click OK.
e) Save the configuration and restart the Cognos service.

If you use Windows Services to restart the Cognos service, the service is listed as IBM Cognos.

Upgrading the OpenPages password encryption algorithm to AES encryption
Determine the password encryption algorithm that your environment is using and upgrade it to AES
encryption, if needed.

About this task

If your OpenPages GRC Platform environment is using the OP-CUSTOM or 3DES encryption algorithm,
change the encryption algorithm to AES, which is more secure.

To determine the encryption algorithm that your environment is using, examine the ALGORITHMNAME
value of the ENCRYPTIONMODULES table entry that has an INACTIVE value of 0.

Procedure

1. Edit the <OP_root>/OpenPages/aurora/conf/aurora.properties file and the <OP_root>/
OpenPages/aurora/bin/op-backup-restore.env file and change any encrypted passwords to
plain text.

• If you are using 3DES, look for lines that contain {3DES}.

For example, suppose the aurora.properties file contains the following line:
database.PASSWORD={3DES}Rj+steg+3eU7kb8O+\=\=. The database password is encrypted
with the 3DES algorithm. Replace the encrypted password with the password in plain text, for
example, database.PASSWORD=db_password.

• If you are using OP-CUSTOM, the lines do not have an algorithm indicator. Look for encrypted
passwords and change each of them to the password in plain text.

The passwords are encrypted with the AES algorithm when you restart the OpenPages GRC Platform
services in step 3.

2. Open a command or shell window on the OpenPages GRC Platform server.

Go to the <OP_HOME>/bin directory.

• For Microsoft Windows operating systems, the default installation directory of OpenPages GRC
Platform is C:\OpenPages.

• For AIX and Linux operating systems, the default installation directory of OpenPages GRC Platform
is /opt/OpenPages.

From the command or shell window, run the following command on a single line:

UpdatePasswordEncryptionAlgorithm.sh|.cmd -Mode CA -Host localhost 
   -Port <port> -AlgorithmName AES -ProviderName CAMCryptoBC
   -ProviderClass org.bouncycastle145.jce.provider.BouncyCastleProvider 
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   -KeySize 128 -Username <OpenPagesAdministrator> 
   -Password <OpenPagesAdministratorPassword>

• <port> is the bootstrap port number. If you do not specify a value, 10101 is used.
• <host> is the host name of the application server. If you do not specify a value, localhost is used.

3. Restart all OpenPages GRC Platform services.
4. If you are using OpenPages to authenticate users, notify all users that their passwords have been reset

to 0p3nP4g3s and that they must change their passwords the next time they log into the system.

Note: If you are using Single Sign-On (SSO), LDAP, or another external system to authenticate users,
passwords are not reset.

Updating security rules
If you use security rules, you might need to update the rules after you upgrade to address an issue with
security rules that were created before version 7.4.

About this task

Do this procedure if you use reporting periods or if you plan to use reporting periods.

Update any security rules that have both of the following properties:

• The rule uses parent-child paths, for example FOR(Primary Parent), FOR(Immediate), and so on
• The rule uses FOR() clauses that have an AND or OR clause before or after the FOR() clause

Procedure

1. Log on to IBM OpenPages GRC Platform as an administrator.
2. Enable System Admin Mode.
3. Go to Administration > Security Rules.
4. For each security rule that needs to be updated, click Edit and then click Save.
5. Disable System Admin Mode.

Results

New SQL is generated for the rules.

Custom settings in configuration files
If you manually edited any configuration files in the previous version, you must merge your changes.

Search server post upgrade tasks
If you backed up and then restored the search server, complete the following post upgrade tasks.

• If the location of the openpages-storage directory has changed, update the search server properties
file.

For more information, see “Updating the search server properties file with the location of the
OpenPages storage directory” on page 162.

• If you upgraded from 7.2.x, create the global search index.

For more information, see “Creating the global search index after upgrading” on page 186.
• If you upgraded from 7.3.x, enable global search.

For more information, see “Enabling global search” on page 186.

You can also do the following optional tasks:

• Set up SSL for the global search service.

For more information, see “Setting up SSL for the global search service” on page 159.
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• Tune the search server memory settings.

For more information, see “Allocating memory for the global search component” on page 163.

For more information about the search server, see the IBM OpenPages GRC Administrator's Guide.

Enabling global search
If you upgraded from 7.3.x and you used global search in 7.3.x, enable the global search feature.

If you upgraded from 7.2.x, create the global search index. For more information, see “Creating the global
search index after upgrading” on page 186.

Procedure

1. Start the search services, if they are not already started.
For more information, see “Start or stop the global search services” on page 257.

2. Log in to OpenPages as a user with administrative privileges.
3. Click Administration > Global Search and click Enable.

Results

The Global Search is available next to the Reporting Period box.

If global search does not start, see “Known problems and solutions for global search” on page 345.

For more information about global search, see the IBM OpenPages GRC Administrator's Guide.

Creating the global search index after upgrading
If you upgraded from 7.2.x, create the global search index.

Before you begin

The reporting schema must exist and must be enabled before you create the search index.

Procedure

1. Start the search services, if they are not already started.
2. Log in to OpenPages as a user with administrative privileges.
3. Click Administration > Global Search and click Create.

Creating the index also enables global search.

Click Refresh to update the page.

Results

The Global Search is available next to the Reporting Period box.

If global search does not start, see “Known problems and solutions for global search” on page 345.

For more information about global search, see the IBM OpenPages GRC Administrator's Guide.

Complete the workflow server integration after an upgrade
If you used IBM Business Process Manager in your previous deployment, you need to some post-upgrade
tasks.

You need to re-establish the integration of IBM Business Process Manager with IBM OpenPages GRC
Platform.

For more information, see "Post upgrade tasks for OpenPages" in the IBM OpenPages GRC - Business
Process Manager Installation Guide.
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Enable LDAP after upgrading
If you used LDAP in your previous version of IBM OpenPages GRC Platform and you did not migrate the
aurora_auth.config, you must re-enable LDAP.

Open the LDAP configuration file, aurora_auth.config, in a text editor.

Check that the provider.url points to your LDAP server. Also verify the other settings.

If the settings are not correct, see “Enabling LDAP for the IBM OpenPages GRC Platform application” on
page 156.

Enabling a JDBC connection for the OpenPages database (DB2)
If you want to use Dynamic Query Mode (DQM) for the OpenPages reporting framework, you need to
configure a JDBC connection to the OpenPages database.

Enable a JDBC connection so that your reports can run on a reporting framework that is published to
Cognos in DQM mode. For more information, see the IBM OpenPages GRC Administrator's Guide.

Procedure

1. Open a browser window and log on to the reporting portal as a user with administrative privileges.

By default, the URL is http://<server_name>/ibmcognos.

Where <server_name> is the host name of the reporting server.
2. Click Manage.
3. Click Administration console.
4. Click the Configuration tab.
5. Click OpenPages DataSource under Data Source Connections.
6. Click Actions > Set Properties - OpenPages DataSource.
7. Update the JDBC connection information.

a) Click the JDBC tab.
b) Check Enable JDBC connection.
c) Enter the OpenPages database information in the Server Name, Port Number, and Database

Name fields.

Enabling a JDBC connection for the OpenPages database (Oracle)
If you want to use Dynamic Query Mode (DQM) for the OpenPages reporting framework, you need to
configure a JDBC connection to the OpenPages database.

Enable a JDBC connection so that your reports can run on a reporting framework that is published to
Cognos in DQM mode. For more information, see the IBM OpenPages GRC Administrator's Guide.

Procedure

1. Open a browser window and log on to the reporting portal as a user with administrative privileges.

By default, the URL is http://<server_name>/ibmcognos.

Where <server_name> is the host name of the reporting server.
2. Click Manage.
3. Click Administration console.
4. Click the Configuration tab.
5. Click OpenPages DataSource under Data Source Connections.
6. Click Actions > More > Set Properties.
7. Update the JDBC connection information.

a) Click the JDBC tab.
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b) Check Enable JDBC connection.
c) Under Connection type, click Service ID.
d) Enter the OpenPages database information in the Server Name, Port Number, and Oracle Service

ID fields.
e) Click OK.

8. Click OK.

Recreating the reporting schema
If you are using IBM DB2 and you dropped the reporting schema during the upgrade process, re-create
the reporting schema.

Procedure

1. Log on to OpenPages as a user with the Reporting Schema application permission set.
2. Click Administration > Reporting Schema.
3. Enable System Administration Mode.
4. Perform one of the following actions:

• If a reporting schema already exists, click Re-Create to drop the existing schema and create a new
schema.

• If no reporting schema exists, click Create.

Note: For more information, see the IBM OpenPages GRC Administrator's Guide.
5. When the creation task (or re-creation task) is complete, update the reporting framework so that the

Cognos reports can access the new schema. For more information, see “Regenerating the reporting
framework” on page 188.

Regenerating the reporting framework
After you upgrade IBM OpenPages GRC Platform you might need to regenerate the reporting framework.

For example, if you re-created the reporting schema during the upgrade process, you need to regenerate
the reporting framework.

About this task

If you plan to install or upgrade other components, such as IBM OpenPages Loss Event Entry, perform this
task after completing all other installation or upgrade tasks.

When you generate the Reporting Framework V6 or the Legacy Reporting Framework, you can choose to
update all or particular components of the reporting framework. For more information, see "Choosing
update options in the reporting framework" in the IBM OpenPages GRC Administrator's Guide.

Procedure

1. Log on to OpenPages as a user with administrative privileges.
2. If System Admin Mode is enabled, disable it.
3. Click Administration > Reporting Framework > Generation.
4. On the Reporting Framework Operations page, click Update.
5. In the Reporting Framework Generation window, complete the following steps:

a) Under Framework Generation, select the Framework Model, Labels, All Models or Selected
Models options and any additional options for generation in the Reporting Framework V6 relational
data model.

Note: For upgraded systems that have the Legacy Reporting Framework setting enabled, if you also
want to generate the Legacy Reporting Framework relational data model, under Legacy Framework
Generation, select the Framework Model and Labels options.
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b) Click Submit.

You are returned to the Reporting Framework Operations page with the new task listed in the
Reporting Framework Operations table.

6. To view the progress of the update, click Refresh.

Regenerating the legacy reporting framework
After you upgrade IBM OpenPages GRC Platform from version 7.1, regenerate the Legacy Reporting
Framework.

Procedure

1. Log into OpenPages application and do the following steps:
a) Navigate to Administration > Settings > Platform > Reporting > Framework > Generation >

Namespaces > OPENPAGES_DEFAULT > Folders > Workflow > Items.
b) Remove the entire value and save it.

2. Log into the reporting server and do the following steps:
a) Navigate to the <CC_HOME>/framework/conf directory.
b) Edit "static-modelquerysubjects_SHARED.xml" and remove all the MODELQUERYSUBJECT

elements which have the folder="/WORKFLOW" attribute. For example:

</MODELQUERYSUBJECT>
        <MODELQUERYSUBJECT name="PROCINSTACCESS" childId="ID" 
parentId="ID" passthrough="true" folder="/WORKFLOW">
<![CDATA[select ID from PROCINSTACCESS]]>
        <COLUMNS>
                <column name="ID"/>
        </COLUMNS>
                <KEYS/>
</MODELQUERYSUBJECT>

3. Log into the reporting server and do the following steps:
a) Navigate to the <CC_HOME>/framework/conf directory.
b) Add the op.user and op.password properties in the framework.properties. For example:

op.user=<OpenPages Administrator user>
op.password=<OpenPages Administrator password>

Deleting workflow reports
After you upgrade IBM OpenPages GRC Platform, you can delete the workflow reports for Fujitsu.

About this task

The workflow reports are no longer needed and can be removed from the system.

Procedure

1. In OpenPages, click Reporting > Cognos Analytics.
2. Click Team content.
3. On the Team content page, navigate through the links as follows:

OpenPages_Platform_V6>Workflow Reports
4. Hover over the Active Tasks report and click the ellipse button.
5. Click Delete.
6. Hover over the Jobs and Tasks report and click the ellipse button.
7. Click Delete.

The workflow reports are deleted.
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Modify the SDI/TDI assembly line after upgrading
If you upgraded OpenPages and you use the IBM QRadar integration project or IBM OpenPages GRC SDI
Connector for UCF Common Controls Hub, due to a known issue you have to modify the SDI/TDI assembly
line to be able to import the release date. Contact Customer Support for more information.

Upgrade verification tests
After you upgrade IBM OpenPages GRC Platform, verify that the upgrade is successful and the product
works as expected.

Use the following checklist to verify the upgrade.

Table 43: Post-installation verification checklist

Task Guidance

Review all installation logs for errors. For more information, see “Log files” on page 341.

Verify that a backup of the system exists If it does not exist, create a backup of your system
by running the OPBackup command from the
<OP_HOME>/aurora/bin directory.

Verify that a compressed file was created with the
correct time stamp. The file is in the OPBackup
directory.

The location of the OPBackup directory is specified
by the OP Backup Restore Directory field on the
Application Server card.

For information about using the backup utility, see
the IBM OpenPages GRC Administrator's Guide.

Confirm that the reporting schema and framework
generated successfully.

For more information, see “Regenerating the
reporting framework” on page 188.

Confirm that base reports are functioning as
expected.

Log on to the OpenPages application and run the
All Documentation Cognos report.

If single sign-on (SSO) is enabled, verify that user
accounts can access the environment.

Log on to the OpenPages application with an SSO
user account.

Confirm that you can upload and download sample
attachments.

Log on to the OpenPages application and upload
and download a file attachment.

Verify that links in reports reference the correct
server address and use the correct web URL
parameters.

Run a report that uses OpenPages links. Select a
link and confirm that the target object is rendered
successfully in the OpenPages interface.

For clustered environments, verify that all servers
can upload and download attachments.

Upload and download files from both the admin
and non-admin application servers.

Validate that you can access the Cognos Analytics
portal.

Type the web URL http://<server_name>/
ibmcognos from a client system. Confirm that you
can log on to the portal.
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Testing Cognos Analytics after the upgrade
Verify that Cognos Analytics works with the IBM OpenPages GRC Platform environment.

Procedure

1. Log on to OpenPages GRC Platform and verify that you can connect to the Cognos Analytics portal.
a) In a web browser, log on to the OpenPages GRC Platform application.
b) To test the connection from OpenPages to the Cognos Analytics portal, click Reporting > Cognos

Analytics.
c) Close the session.

2. From the OpenPages application, click Reporting > All Reports, and run some standard and custom
user reports.

Rolling back an OpenPages upgrade
You can roll back OpenPages to the version from which it was upgraded.

Before you begin

Locate the full server directory backups for each server that were made before the upgrade. For
information, see “Backing up your source environment” on page 174.

About this task

The following steps provide a general overview of how to roll back a 7.4.0.0 upgrade.

Procedure

1. Ensure that the IP/DNS setup of the previous deployment is fully intact and uses the exact same
configuration that was in place before the OpenPages upgrade.

2. For the database server:

If the database server was upgraded in-place from the previous OpenPages version:

a. If the database software was upgraded, reinstate the previous database software version.
b. Restore the database using the database backup created before the upgrade.

If a new database server was introduced for the upgrade:

• Reinstate the former database server into the deployment. You should not have to restore the
OpenPages database from a backup.

3. For all other servers in the previous deployment:
a) If there are any remnants of the OpenPages 7.4 deployment remaining on any of the servers,

rename the top level OpenPages directory to OpenPages-7.4.0.0 on each applicable server.
b) If during the preparation for the upgrade you renamed the OpenPages root folder or if you created

full backup directories or ZIP or tar files of each server, restore them if needed. For more
information about the steps required to prepare for a rollback, see “Backing up your source
environment” on page 174.

After all servers are restored and all third-party products are at the versions required by the previous
OpenPages deployment, the previous OpenPages deployment should work without further actions.
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Chapter 8. Upgrade tasks for DB2 databases
If you are using IBM DB2, refer to the following topics when you upgrade IBM OpenPages GRC Platform.

The tasks that you need to do depend on the upgrade scenario that you are following. Use the following
topics to guide you through the upgrade process:

• “Upgrade process overview: Using the database server from your source environment” on page 168
• “Upgrade process overview: Using new hardware for the database server” on page 170

Back up the database (DB2)
Do the following procedures to back up the IBM DB2 database in your previous deployment of IBM
OpenPages GRC Platform.

• If you use IBM DB2 for your reporting server in the source environment, you might need to drop the
reporting schema before you back up the database. See “Dropping the reporting schema (DB2)” on
page 193.

• If DB2 Text Search is enabled in your source environment, install and enable DB2 Text Search in your
target environment.

• If DB2 Text Search is enabled in your source environment, drop the text search indexes and disable DB2
Text Search.

• Back up the OpenPages database.
• If you created a separate database for Cognos, back up the Cognos database.

You need to back up and then restore both the OpenPages schema and the workflow schema so that the
database upgrade scripts can remove any references to the workflow schema that are contained within
the OpenPages schema. Once the OpenPages schema has these references removed, the workflow
schema will then be removed to complete this step.

Dropping the reporting schema (DB2)
If you use IBM DB2 for your reporting server in the source environment, you might need to drop the
reporting schema before you back up the database.

About this task

The version of IBM OpenPages GRC Platform that you are upgrading from determines whether you need
to drop the reporting schema.

• If you are upgrading from version 7.1.x on IBM DB2, then you must drop the reporting schema.
• If you are upgrading from version 7.2.x on IBM DB2 10.5, you do not need to drop the reporting schema

if you upgrade to IBM DB2 11.1.x before you upgrade IBM OpenPages GRC Platform. Otherwise, you
must drop the reporting schema.

• If you are upgrading from version 7.2.0.3 or later or 7.3.x on IBM DB2 11.1, you do not need to drop the
reporting schema.

Note: Wait until after the upgrade is complete before you run any ObjectManager loads that create or
modify schema objects. You must also wait to install IBM OpenPages Loss Event Entry or the approval
app, since they require schema modifications as part of their installation process.

Procedure

1. Log on to OpenPages GRC Platform application as an administrator.
2. Click System Admin Mode: Disabled.
3. Click OK.



System Admin Mode is enabled.
4. From the menu bar, click Administration and select Reporting Schema.
5. Click Drop.

Wait for the process to complete.
6. Click System Admin Mode: Enabled.
7. Click OK.

System Admin Mode is disabled.

Dropping the DB2 Text Search index and disabling DB2 Text Search
If DB2 Text Search is enabled in your source environment, drop the text search indexes, disable the text
search service, remove the DB2 administrative task to update the indexes, and disable DB2 Text Search.
Do this procedure before you back up the OpenPages database.

Procedure

1. Log on to a system as the OpenPages installation user, for example opuser.

You can use any system with access to CLPPlus that can connect to the OpenPages GRC Platform
database server.

2. Drop the DB2 Text Search index.
a) Go to the <OP_HOME>/aurora/bin/full-text-index directory.
b) Open a command or shell window and run the following command:

clpplus -nw @sql-wrapper CustomIndexing_Step5_IndexDrop.sql 
  <LOG_FILE_NAME> <DB2_SERVER_NAME> <DB2_PORT_NUMBER> <DATABASE_NAME> 
  <OP_DB_USER> <OP_DB_PASSWORD> <FORCE_DROP_INDEX>

For example

clpplus -nw @sql-wrapper CustomIndexing_Step5_IndexDrop.sql 
   CustomIndexing_Step5_IndexDrop.log localhost 50000 OPX OPENPAGE 
   password Y

Note: For more information about the script, see "Drop a long string index" in the IBM OpenPages
GRC Administrator's Guide.

3. Run the following command to determine if DB2 Text Search is enabled.

select * from all_tables where table_schema = 'SYSIBMTS';

If the command returns any data, DB2 Text Search is enabled. Continue with the next step to disable
DB2 Text Search.

4. Log on to the OpenPages database as the db2inst1 user.

db2 connect to opx user opuser using password

5. Run the following command to disable DB2 Text Search.
For more information, see SYSTS_DISABLE procedure - Disable current database for text search.

db2 "call sysproc.systs_disable('','en_US',?)"

Alternatively, use these commands.

db2 GRANT SYSTS_ADM TO db2inst1 
db2 grant SYSTS_MGR to db2inst1
db2 connect reset 
db2ts start for text
export DB2DBDFT=OPX
db2ts DISABLE DATABASE FOR TEXT

6. Remove the DB2 administrative task to update the indexes
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For more information, see the following topic in the DB2 documentation: Removing a task from the
administrative task scheduler (https://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/
com.ibm.db2.luw.admin.gui.doc/doc/t0054384.html).

Backing up the OpenPages database (DB2)
Create a backup of the OpenPages GRC Platform database.

Before you begin
If DB2 Text Search is enabled in your source environment, drop the text search indexes and disable DB2
Text Search before you back up the database.

About this task

Use the utilities that are provided with IBM DB2 to back up the database.

Note: You can back up the database by using other methods. For example, you can use a combination of
full and incremental backups. If you want to use an alternative method, it is critical that you have the
necessary skills available within your organization to complete all aspects of the backup and restore
activity.

For information about developing a database backup and restore strategy, see Backup Overview (http://
www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.admin.ha.doc/doc/
c0006150.html) in the DB2 documentation.

For more information about the commands that are used in this procedure, see the IBM DB2
documentation.

Procedure

1. Make sure that no OpenPages GRC Platform processes are running, such as object reset jobs.
2. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers

(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

3. Open a command or shell window and connect to the OpenPages database as the database instance
owner.

For Windows users only, you must use the db2cmd command in the Command Prompt window to
initialize the DB2 command line processor (CLP).

4. Go to the sqllib directory.
5. Force any applications from the database.

Run the following command:

db2 force application all

6. Deactivate the database.

Run the following command:

db2 deactivate database <db_name>

7. Create a directory in which to store the backup.
8. Do an offline backup by using the db2 backup command.

db2 backup database <db_name> to <backup_directory>

Example:

db2 backup database opx to /home/db2inst1/backup

9. Copy the backup file to the instance owner account on the target OpenPages database server.
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What to do next

If you created a separate database for Cognos, back up the Cognos database.

Backing up the Cognos database (DB2)
Create a backup of the Cognos database. Do this procedure if you use a separate database for Cognos.

About this task

Use the utilities that are provided with IBM DB2 to back up the database.

Note: You can back up the database by using other methods. For example, you can use a combination of
full and incremental backups. If you want to use an alternative method, it is critical that you have the
necessary skills available within your organization to complete all aspects of the backup and restore
activity.

For information about developing a database backup and restore strategy, see Backup Overview (http://
www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.admin.ha.doc/doc/
c0006150.html) in the DB2 documentation.

For more information about the commands that are used in this procedure, see the IBM DB2
documentation.

Procedure

1. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

2. Ensure that all Cognos components are shut down.
3. Open a command or shell window and connect to the Cognos database as the database instance

owner.

For Windows users only, you must use the db2cmd command in the Command Prompt window to
initialize the DB2 command line processor (CLP).

4. Go to the sqllib directory.
5. Force any applications from the database.

Run the following command:

db2 force application all

6. Deactivate the database.

Run the following command:

db2 deactivate database <db_name>

7. If you are migrating from DB2 V10.5.x to DB2 V11.1.x, ensure that the APPLHEAPSZ parameter is set
to a value greater than or equal to 4096 before you back up the database.

To check the value, run the following command:

• Linux or AIX:

db2 get db cfg for cognosdb | grep APPLHEAPSZ

• Windows:

db2 get db cfg for cognosdb | findstr APPLHEAPSZ

To update the value, run the following command:

db2 update db cfg for cognosdb using applheapsz 32768

196   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide

http://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.admin.ha.doc/doc/c0006150.html
http://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.kc.doc/welcome.html
http://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.kc.doc/welcome.html


8. Create a directory in which to store the backup.
9. Do an offline backup by using the db2 backup command.

db2 backup database <db_name> to <backup_directory>

Example:

db2 backup database cognosdb to /home/db2inst2/backup

10. Copy the backup file to the instance owner account on the target Cognos database server.

Restore the OpenPages database in your upgraded environment (DB2)
Restore the OpenPages database from your previous IBM OpenPages GRC Platform environment into your
upgraded environment.

The source and target schema name must be the same.

You cannot use DB2 backup and restore to move a backup to a new operating system. For more
information, see the following topic in the DB2 documentation: Backup and restore operations between
different operating systems and hardware platforms.

Do these tasks to restore the database:

• Restore the OpenPages database. See “Restoring the OpenPages database (DB2)” on page 197.
• If you use DB2 Text Search, reconfigure and enable DB2 Text Search on the target database server. See

“Restore DB2 Text Search ” on page 199.
• If your target environment uses a later 11.x fix pack version of DB2 than your source

environment,update the databases on the target database server. See “Update the databases for a DB2
11.1.x fix pack” on page 199.

Restoring the OpenPages database (DB2)
Restore the OpenPages database in your target environment.

Before you begin
Determine whether you need to do a redirected database restore. You need to do a redirected restore if
the DBPATH/DB_STORAGE_PATH directory in the target environment is different than in the source
environment. You can run a query to check the path.

1. In the source environment, log in as the OpenPages instance owner.
2. Run the following query:

db2 "select DBPARTITIONNUM, substr(TYPE,1,15) as TYPE, 
substr(PATH,1,70) as PATH from sysibmadm.DBPATHS"

3. Log on to the target environment as the OpenPages instance owner and run the query again.

If the directories are the same, restore the database by using the steps in this topic.

If the directories are not the same, do a redirected database restore instead. For more information, see
the DB2 documentation: Performing a redirected restore operation.

Procedure

1. Stop all OpenPages and Cognos services in the target environment.
2. Log on to a server that has access to the target database server and has Command Line Processor Plus

(CLPPlus).
3. Start the IBM DB2 command line processor.
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On Microsoft Windows operating systems, from the command prompt, type db2cmd, or from the Start
menu, click All Programs > DB2COPY1 > Command Window - Administrator.

4. Go to the directory where you copied the database backup file for the OpenPages database.
5. Ensure that there are no connections to the database.

db2 list applications
db2 force applications all

6. Deactivate the database.

db2 deactivate database <db_name>

7. Run the DB2 restore command to restore the OpenPages database.

db2 restore database <source_db_name> from <backup_directory> 
   taken at <timestamp> into <target_db_name>

For example:

db2 restore database opx from /home/db2inst1/backup 
   taken at 20171024165648 into opx

A warning about overwriting data is displayed.
8. Type y to overwrite the data.

If the version of DB2 in your target environment is a later version than in the source environment, a
complete database upgrade takes place automatically during the restore process. At the end of the
restore process, a message is displayed:

SQL2555I The database was restored and then successfully upgraded 
to the current DB2 release where you issued the RESTORE DATABASE command

Note: The automatic upgrade does not update the database when the source and target are at version
11.1 but at different fix pack levels. If your source is 11.1.0 and your target is 11.1.1 or a later fix pack,
see “Update the databases for a DB2 11.1.x fix pack” on page 199.

9. Revalidate objects and rebind packages.
Do these steps as the instance owner for the OpenPages database.
a) Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory.

b) Revalidate the database objects.

clpplus -nw <openpages_db_username>/<openpages_db_password>
@<hostname>:<port_number>/<database_name> 
@sql-wrapper revalidate.sql revalidate.log <openpages_db_username>

For example:

clpplus -nw openpage/passWORD@localhost:50000/opx 
  @sql-wrapper revalidate.sql revalidate.log openpage

c) Rebind the packages.

db2rbind <database_name> -l oprbind.log all 
  -u <openpages_db_username> -p <openpages_db_password> -r any

For example:

db2rbind opx -l opbind.log all 
  -u openpage -p passWORD -r any

198   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide



What to do next

If you use a separate database for the Cognos content store, restore the Cognos database in your target
environment.

Restore DB2 Text Search
If you use DB2 Text Search, reconfigure and enable DB2 Text Search on the target database server.

For more information, see "Utilities for filtering on long string field content in a DB2 database" in the IBM
OpenPages GRC Administrator's Guide

Update the databases for a DB2 11.1.x fix pack
If the version of IBM DB2 in your source environment is at a different fix pack level than the version of
IBM DB2 in your target environment, you need to update the databases.

For example, if your source environment uses IBM DB2 version 11.1.0 and your target environment uses
IBM DB2 11.1.1 or a later fix pack, you need to update the databases in the target environment to update
them to version 11.1.1.

Note: This task applies only when the target environment is using a different fix pack level than the
source. If your source environment is using version 10.5 and your target is using version 11.1.0 or a later
fix pack, you do not need to do this task.

Do this task after you have restored the databases into your target environment.

For information about how to update the databases, see the following topic in the IBM DB2
documentation: db2updv111 - Update database to Version 11.1 fix pack command (https://
www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.admin.cmd.doc/doc/
r0054449.html).

For example:

db2updv111 -d opx -a
db2updv111 completed successfully for database 'opx'

If you are using a separate database instance for the Cognos content store, update the Cognos database
also. For example:

db2updv111 -d cognosdb
db2updv111 completed successfully for database 'cognosdb'

Restoring the Cognos content store (DB2)
If you use a separate database for the Cognos content store, restore the Cognos database in your target
environment.

Before you begin

Determine whether you need to do a redirected database restore. You need to do a redirected restore if
the DBPATH/DB_STORAGE_PATH directory in the target environment is different than in the source
environment. You can run a query to check the path.

1. In the source environment, log in as the Cognos instance owner.
2. Run the following query:

db2 "select DBPARTITIONNUM, substr(TYPE,1,15) as TYPE, 
substr(PATH,1,70) as PATH from sysibmadm.DBPATHS"

3. Log on to the target environment as the Cognos instance owner and run the query again.

If the directories are the same, restore the database by using the steps in this topic.

Upgrade tasks for DB2 databases  199

https://www.ibm.com/support/knowledgecenter/SSEPGG_11.1.0/com.ibm.db2.luw.admin.cmd.doc/doc/r0054449.html


If the directories are not the same, do a redirected database restore instead. For more information, see
the DB2 documentation: Performing a redirected restore operation.

Procedure

1. Stop all Cognos services in the target environment.
2. Log on to a server that has access to the target Cognos database server and has Command Line

Processor Plus (CLPPlus).
3. Start the IBM DB2 command line processor.

On Microsoft Windows operating systems, from the command prompt, type db2cmd, or from the Start
menu, click All Programs > DB2COPY1 > Command Window - Administrator.

4. Go to the directory where you copied the database backup file for the Cognos database.
5. Ensure that there are no connections to the database.

db2 list applications
db2 force applications all

6. Deactivate the database.

db2 deactivate database <db_name>

7. Run the DB2 restore command to restore the Cognos database.

db2 restore database <source_db_name> from <backup_directory> 
   taken at <timestamp> into <target db name>

For example:

db2 restore database cognosdb from /home/db2inst1/backup 
   taken at 20171024174956 into cognosdb

A warning about overwriting data is displayed.
8. Type y to overwrite the data.

If the version of DB2 in your target environment is a later version than in the source environment, a
complete database upgrade takes place automatically during the restore process. At the end of the
restore process, a message is displayed:

SQL2555I The database was restored and then successfully upgraded 
to the current DB2 release where you issued the RESTORE DATABASE command

Note: The automatic upgrade does not update the database when the source and target are at version
11.1 but at different fix pack levels. If your source is 11.1.0 and your target is 11.1.1 or a later fix pack,
see “Update the databases for a DB2 11.1.x fix pack” on page 199.

9. Revalidate objects and rebind packages in the Cognos database.
Do these steps as the instance owner for the Cognos database.
a) Revalidate the database objects.

For example:

db2 connect to cognosdb user db2admin using password123
db2 "call sysproc.admin_revalidate_db_objects()"

b) Rebind packages in the Cognos database.

For example:

db2rbind cognosdb -l cogbind.log -u db2inst2 -p password123
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Upgrade the databases (DB2)
Run scripts to upgrade the OpenPages database objects.

You must run all of the upgrade scripts in sequence to upgrade the database schema.

Two of the scripts require DBA privileges: a pre-upgrade script and a post-upgrade script. If you have DBA
privileges, you can run all of the scripts. If you do not have DBA privileges, contact your database
administrator.

A schema user can run the scripts that do not require DBA privileges.

Pre-upgrade step – DBA tasks
During this step, your database administrator runs a script to prepare the database for the upgrade.

You need both DBADM and SECADM privileges to run this script.

Validate the pre-upgrade step
During this step, you run a script to verify that the pre-upgrade DBA script completed successfully and
that the database schema is ready for the upgrade.

Upgrade step
During this step, you run a script to upgrade the database. The script determines the current version
of the database schema objects, and then runs the upgrade scripts required to upgrade the database.

Post upgrade step – DBA tasks
During this step, your database administrator runs a script to complete the database upgrade and to
set database tuning parameters.

You need both DBADM and SECADM privileges to run this script.

Validate the post-upgrade step
During this step, you run a script to validate the post-upgrade DBA step.

Extending database row sizes for the databases (DB2)
After you restore your IBM OpenPages GRC Platform database to the supported version of IBM DB2 you
must manually enable the EXTENDED_ROW_SZ database configuration parameter.

Procedure

1. Start the IBM DB2 command line processor.

On Microsoft Windows operating systems, from the command prompt, type db2cmd, or from the Start
menu, click All Programs > DB2COPY1 > Command Window - Administrator.

On AIX or Linux operating systems, from the command prompt, type db2cmd.
2. Connect to the OpenPages database.

For example, type

db2 connect to OPX user <userid>

3. Enter the following commands:

db2 update db cfg using EXTENDED_ROW_SZ ENABLE
db2 update db cfg for OPX using APPLHEAPSZ 25600 APPL_MEMORY 320000

Preparing for the database upgrade (DB2)
Prepare for the upgrade of the database objects.

Procedure

1. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
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For more information, see Chapter 11, “Starting and stopping servers,” on page 253.
2. Ensure that the IBM DB2 database server is running.
3. Log on to the DB2 database server computer as a user with administrative privileges.
4. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
UPGRADE_SCRIPTS directory.

5. Verify that you have write permission on the sql-wrapper.sql file. If not, change the permission on
the file by using the chmod command.

6. Edit the sql-wrapper.sql file.

Restriction: Change only the parameters that are described in this step.

Table 44: Parameters in the sql-wrapper.sql file for DB2 databases

Property Description

opx_instance_owner The database instance owner for OpenPages.

The user you specify must have both DBADM and
SECADM privileges

If your database administrator is going to run the
DBA scripts for you, then you can leave this value
empty when you run the non-DBA scripts.

opx_db2_server_name The database server name

opx_db2_port_number The database port number, for example 50000

opx_db2_db_name The name of the OpenPages database.

opx_db_owner The schema owner of the OpenPages database.

opx_dflt_stor_srv_root The path to the OpenPages storage directory.

Example:

define opx_dflt_stor_srv_root='/home/
opuser/OP/OpenPages/openpages-storage'

opx_workflow_user The Fujitsu Interstage BPM workflow database
user name.

You need to provide the workflow user name to
complete the upgrade. The database upgrade
scripts remove any references to the workflow
schema that are contained within the OpenPages
schema, and then the scripts remove the
workflow schema.
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Table 44: Parameters in the sql-wrapper.sql file for DB2 databases (continued)

Property Description

opx_override_ver_check Use the default value, N, unless you are re-
running the database upgrade scripts after a
failure.

If the database upgrade failed in the middle of
the schema upgrade process, set this parameter
to Y. When you re-run the upgrade script, the
upgrade process resumes from the last
successful schema upgrade step.

For example, suppose you are upgrading from 7.2
to 7.4. When you run the upgrade script, it
successfully upgrades the schema from 7.2 to
7.3, but fails during the upgrade from 7.3 to 7.4.
Set this flag to Y and then re-run the script. The
upgrade resumes at the 7.3 to 7.4 upgrade step.

sqllib_dir The path to the DB2 client installation directory
on the admin application server (App Server1)

Example:

• Windows: define sqllib_dir='C:\IBM
\SQLLIB'

• AIX or Linux: define sqllib_dir='/home/
db2inst1/sqllib'

7. If you want to run a custom script during the upgrade process, see “Running a custom script during the
database upgrade (DB2)” on page 203.

Running a custom script during the database upgrade (DB2)
If you want to run custom a script during the database upgrade process, edit the sql-wrapper.sql file
to specify the script to run.

About this task

You can use the custom_data_upgrade_script parameter to configure a custom script.

The script that you specify is run during the database upgrade step. The custom script is called by the op-
database-product-upgrade.sh/bat script after the other upgrade steps, such as DDL changes,
PL/SQL code changes, and database level data changes are complete.

Procedure

1. Open the sql-wrapper.sql file.
2. Verify that the sqllib_dir path is correct. If you are running the custom script from a computer

other than the database server, update the path.
3. Edit the following parameters:

define custom_data_upgrade_script=no-op.sql

Replace no-op.sql with the script that you want to run.
4. Place your custom script in the same directory as the sql-wrapper.sql file.
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Preparing the files for your database administrator (DB2)
If your organization requires the separation of DBA and non-DBA tasks, prepare the files that your
database administrator needs to do the upgrade.

About this task

Note: If you have DBA privileges and you plan to run the DBA scripts, you can skip this procedure.

Procedure

1. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
UPGRADE_SCRIPTS directory.

2. Collect the following files and send them to your DBA.

• sql-wrapper.sql
• op-database-dba-upgrade.sh|.bat
• op-database-dba-pre-upgrade.sql
• op-upgrade-save-original-version.sql
• op-upgrade-save-current-db-version.sql
• op-database-dba-post-upgrade.sql
• no-op.sql
• /UPGRADE_SCRIPTS/OP730X_TO_OP7400/dbu-Fujitsu-IBPM-Removal.sql

3. Send your DBA the instructions to run the DBA scripts.

• “Running the pre-upgrade DBA script (DB2)” on page 204
• “Running the post-upgrade DBA script (DB2)” on page 207

Running the pre-upgrade DBA script (DB2)
Ask your database administrator to run the pre-upgrade script. Or, if you have DBA privileges, you can run
the script.

Before you begin

• The IBM DB2 database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined and points to the IBM Software Development Kit (SDK) for

Java that is installed with DB2. For example:

export JAVA_HOME=/db2/V11.1_01/java/jdk64
export PATH=$JAVA_HOME/bin:$PATH

If you are running the script from another host, ensure that JAVA_HOME is pointing to the IBM Software
Development Kit (SDK) for Java that is installed on the computer.

• apache-ant-1.8.1 is deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/DB2/UPGRADE_SCRIPTS

• The DB2_HOME system variable is defined.

About this task

Run the following script: op-database-dba-upgrade.sh|.bat. The script uses the properties that are
defined in the sql-wrapper.sql file.

The op-database-dba-upgrade.sh|.bat script calls the following scripts:

• op-database-dba-pre-upgrade.sql: This script grants the privileges that are needed to upgrade
the database schema. The script also configures database tuning parameters, such as package cache
size (PCKCACHESZ) and the catalog cache size (CATALOGCACHE_SZ),
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• no-op.sql: This is an empty file. You can use it to run custom scripts.
• op-upgrade-save-original-version.sql: This script writes the version of the pre-upgrade

schema to a log file. The upgrade script uses this information to determine which upgrade scripts to run.
• op-upgrade-save-current-db-version.sql: This script writes the version of the schema to a log
file. The upgrade script uses this information to track which upgrade scripts completed successfully.

Procedure

1. Log on to the DB2 database server computer as a database administrator (DBA).
2. Locate the scripts.

If you are a database administrator, get the scripts from your OpenPages team.

Or, you can get the scripts from the /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/DB2/UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.

a) For the opx_instance_owner parameter, specify a user that has both DBADM and SECADM
privileges.

You can run the following script to get a list of users that have the necessary privileges:

select grantee from syscat.dbauth where dbadmauth = 'Y' and securityadmauth = 'Y';

b) If you customized the table space names, update the define opx_dflt_* parameters with the
custom table space names.

c) If you want to run custom scripts during the upgrade, see “Running a custom script during the
database upgrade (DB2)” on page 203.

5. Run the following command:

Windows:

op-database-dba-upgrade.bat pre <dba_password>

Linux or AIX:

./op-database-dba-upgrade.sh pre <dba_password>

6. Verify that the return code is 0, indicating success.

You can also check the log file, op-database-dba-pre-upgrade.log.

What to do next

Validate the pre-upgrade DBA script.

Validating the pre-upgrade DBA step (DB2)
Run the script to validate the pre-upgrade DBA steps.

Before you begin

• The IBM DB2 database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined and points to the IBM Software Development Kit (SDK) for

Java that is installed with DB2. For example:

export JAVA_HOME=/db2/V11.1_01/java/jdk64
export PATH=$JAVA_HOME/bin:$PATH
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If you are running the script from another host, ensure that JAVA_HOME is pointing to the IBM Software
Development Kit (SDK) for Java that is installed on the computer.

• apache-ant-1.8.1 is deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/DB2/UPGRADE_SCRIPTS

• The DB2_HOME system variable is defined.

Procedure

1. Log on to the IBM DB2 database server computer as the OpenPages application user, opuser.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.
5. Run the following command:

Windows:

op-database-product-upgrade.bat preupgrade <op_password> ""

Linux or AIX:

./op-database-product-upgrade.sh preupgrade <op_password>

6. Verify that the script completed successfully.
Look for the following message: Status:Success or a return code of 0.

You can also check the log file, op-validate-dba-pre-upgrade.log.

What to do next

Run the script to upgrade the database objects.

Upgrading the database (DB2)
Run the script to upgrade the database schema objects and data.

Before you begin

• The IBM DB2 database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined and points to the IBM Software Development Kit (SDK) for

Java that is installed with DB2. For example:

export JAVA_HOME=/db2/V11.1_01/java/jdk64
export PATH=$JAVA_HOME/bin:$PATH

If you are running the script from another host, ensure that JAVA_HOME is pointing to the IBM Software
Development Kit (SDK) for Java that is installed on the computer.

• apache-ant-1.8.1 is deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/DB2/UPGRADE_SCRIPTS

• The DB2_HOME system variable is defined.

Procedure

1. Log on to the IBM DB2 database server computer as the OpenPages application user, opuser.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts in the UPGRADE_SCRIPTS directory and its
subdirectories.
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4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.
5. Run the following command:

Windows:

op-database-product-upgrade.bat upgrade <op_password> <workflow_password>

Linux or AIX:

./op-database-product-upgrade.sh upgrade <op_password> <workflow_password>

Note: You need to provide the workflow user password to complete the upgrade. The database
upgrade scripts remove any references to the workflow schema that are contained within the
OpenPages schema, and then the scripts remove the workflow schema.

6. Verify that the return code is 0, indicating success.

You can also check the log file, op-database-product-upgrade.log.

What to do next

Ask your database administrator to run the post-upgrade DBA script.

Running the post-upgrade DBA script (DB2)
Ask your database administrator to run the post-upgrade script. Or, if you have DBA privileges, you can
run the script.

Before you begin

• The IBM DB2 database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined and points to the IBM Software Development Kit (SDK) for

Java that is installed with DB2. For example:

export JAVA_HOME=/db2/V11.1_01/java/jdk64
export PATH=$JAVA_HOME/bin:$PATH

If you are running the script from another host, ensure that JAVA_HOME is pointing to the IBM Software
Development Kit (SDK) for Java that is installed on the computer.

• apache-ant-1.8.1 is deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/DB2/UPGRADE_SCRIPTS

• The DB2_HOME system variable is defined.
• The op-database-product-upgrade.sh|.bat script completed successfully.

About this task

Run the following script: op-database-dba-upgrade.sh|.bat. The script uses the parameters
defined in the sql-wrapper.sql file.

The op-database-dba-upgrade.sh|.bat script calls the following scripts:

• op-database-dba-post-upgrade.sql: This script verifies that the schema has been upgraded and
is at the correct version.

• no-op.sql: This is an empty file.
• dbu-Fujitsu-IBPM-Removal.sql: This script removes the workflow database objects and the

workflow user. Fujitsu Interstage BPM is not supported in OpenPages 7.4 and later.

Procedure

1. Log on to the IBM DB2 database server computer as a database administrator (DBA).
2. Locate the scripts that are required.
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If you are a database administrator, get the scripts from your OpenPages team.

Or, you can get the scripts from the /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/DB2/UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.

The user that you specify in the opx_instance_owner parameter must have both DBADM and
SECADM privileges

You can run the following script to get a list of users that have the necessary privileges:

select grantee from syscat.dbauth where dbadmauth = 'Y' and securityadmauth = 'Y';

5. Run the following command:

Windows:

op-database-dba-upgrade.bat post <dba_password>

Linux or AIX:

./op-database-dba-upgrade.sh post <dba_password>

6. Verify that the return code is 0, indicating success.

You can also check the log file: op-database-dba-post-upgrade.log.

What to do next

Validate the post-upgrade DBA step.

Validating the post-upgrade DBA step (DB2)
Run the script to validate the post-upgrade DBA steps.

Before you begin

• The IBM DB2 database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined and points to the IBM Software Development Kit (SDK) for

Java that is installed with DB2. For example:

export JAVA_HOME=/db2/V11.1_01/java/jdk64
export PATH=$JAVA_HOME/bin:$PATH

If you are running the script from another host, ensure that JAVA_HOME is pointing to the IBM Software
Development Kit (SDK) for Java that is installed on the computer.

• apache-ant-1.8.1 is deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/DB2/UPGRADE_SCRIPTS

• The DB2_HOME system variable is defined.

Procedure

1. Log on to the IBM DB2 database server computer as the OpenPages application user, opuser.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.
5. Run the following command:
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Windows:

op-database-product-upgrade.bat postdba <op_password> ""

Linux or AIX:

./op-database-product-upgrade.sh postdba <op_password>

6. Verify that the script completed successfully.
Look for the following message: Status:Success or a return code of 0.

You can also check the log file, op-validate-dba-post-upgrade.log.
7. Remove the passwords from the sql-wrapper.sql file for security purposes.

Results

The OpenPages database is upgraded.

What to do next

Migrate the application data from your previous version of OpenPages. See “Migrate files” on page 176.

Updating the location of the openpages-storage directory (DB2)
In the database, update the location of the openpages-storage directory.

If you are using Microsoft Windows, you can also use this procedure to change the storage type from LFS
to UNC.

Before you begin
Stop the IBM OpenPages GRC Platform services if they are running.

Procedure

1. Log on to the target environment as a user with administrative permissions. You can use any system
with access to CLPPlus that can connect to the database server.

2. Open a command or shell window.
3. Locate the update-storage.sql script.

The script is stored in the following directories. You can use the script in either location.

• /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS directory

• /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
UPGRADE_SCRIPTS

4. Run the update-storage.sql script to update the openpages-storage directory location in the
database:

clpplus -nw <op_db_user>/<op_db_password>@<database_host>:
   <database_port>/<database_name> @sql-wrapper update-storage <log_file> 
   <database_host> <database_port> <database_name> <op_db_user> 
   <op_db_password> <storage_type> <storage_server_name> <host_name> 
   <os_type> <path_or_UNC_name>

Table 45: Parameters in the update-storage.sql script (DB2)

Parameter Description

<op_db_user> OpenPages user name for accessing the OpenPages database.

<op_db_password> The OpenPages password for accessing the OpenPages database.
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Table 45: Parameters in the update-storage.sql script (DB2) (continued)

Parameter Description

<database_host> Name of the DB2 server host machine that contains the OpenPages
database.

<database_port> Port number of the DB2 database instance that is installed on the
database server. For DB2, the default port is 50000.

<database_name> Name of the OpenPages database.

<log_file> The name of the log file that the script creates and writes information
to.

<storage_type> The type of file storage to be used. Valid values are as follows:

• LFS (local file system)
• UNC (Universal Naming Convention) - for Windows only.

Note: After you move from LFS to UNC, you cannot go back to using
LFS.

<storage_server_name> The name of the storage server.

<host_name> The host name of the machine.

<os_type> The type of operating system. Valid values are as follows:

• Windows
• Unix

<path_or_UNC_name> The file path or UNC of the storage location. If the path contains
backslashes, wrap the path in single quotation marks.

Examples

• LFS

Windows

clpplus -nw openpage/password@myserver.ibm.com:50000/opx 
   @sql-wrapper update-storage 
   output.log myserver.ibm.com 50000 OPX openpage password 
   LFS eng11 eng11  Windows 'C:\IBM\OpenPages\openpages-storage'

• Linux and AIX

clpplus -nw openpage/password@myserver.ibm.com:50000/opx 
   @sql-wrapper update-storage 
   output.log myserver.ibm.com 50000 opx openpage password 
   LFS aix11 aix11 Unix /usr/opdata/openpages-storage

• UNC

Windows

clpplus -nw openpage/password@myserver.ibm.com:50000/opx 
   @sql-wrapper update-storage 
   output.log myserver.ibm.com 50000 OPX openpage password 
   UNC eng11 eng11 Windows openpages-storage
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Update the database connection information (DB2)
After you restore and upgrade the source database, update the connection information that is stored in
the database.

If you are using the database server from your source environment, you do not need to do these tasks.

• Update the aurora.properties with the URL of the database server. See “Updating the
aurora.properties file (DB2)” on page 211.

• Update the Data Source Connection URL in IBM WebSphere Application Server. See “Updating the Data
Source Connection URL in IBM WebSphere Application Server (DB2)” on page 211.

• Update IBM Cognos Configuration with the connection information for your IBM DB2 database server.
See “Updating the Cognos content store information (DB2)” on page 212

• Update the database connection information for the search server. See “Updating the database
connection information for the search server (Oracle)” on page 236.

• Configure Cognos with the connection information for the OpenPages data source. See “Updating the
connection to the OpenPages database for Cognos (DB2)” on page 213.

Updating the aurora.properties file (DB2)
Update the database server URL in the aurora.properties file.

Procedure

1. Open a command or shell window and go to the <OP_HOME>/aurora/conf directory.
2. Make a backup copy of the aurora.properties file.
3. Open the aurora.properties file in a text editor.
4. Search the file for the string database.URL.
5. Change the value that follows the equal sign to the URL of your database server.

Use the following format:

jdbc\:db2\://<host_name>\:<port>/<db_name>

Where:

• <host_name> is the name of the database server, such as eng11.
• <port> is the database port number, such as 50000.
• <db_name> is the name of the DB2 database, such as OP.

6. Save your changes and close the editor.

Updating the Data Source Connection URL in IBM WebSphere Application Server (DB2)
Update IBM WebSphere Application Server with the database server connection URL.

Procedure

1. Log on to the IBM WebSphere Application Server console.

By default, the URL is http://<host_name>:<port>/ibm/console

Where:

• <host_name> is the name of the application server where IBM WebSphere is installed.
• <port> is the application server port number.

For example: http://myappserver.com:9060/ibm/console
2. Expand Resources > JDBC and click the Data sources link.
3. In the Data sources pane, click CWTxDataSourceXA.

Upgrade tasks for DB2 databases  211



4. Locate the Common and required data source properties heading.
5. Type the database server connection URL in the URL field.

Use the following format:

jdbc:db2://<host_name>:<port>/<db_name>

Where:

• <host_name> is the name of the database server, such as eng11.
• <port> is the database port number, such as 50000.
• <db_name> is the name of the DB2 database, such as OP.

6. Type the name of the OpenPages database in the Database name field.
7. In the Messages box, click Save.
8. Click OK.

Updating the Cognos content store information (DB2)
Update IBM Cognos Configuration with the connection information for your IBM DB2 database server.

Procedure

1. Start the IBM Cognos services and the IBM OpenPages GRC Platform services.
2. Log on to the reporting server as a user with administrator privileges.

Note: For Windows installations, the user must belong to the DB2ADMINS group. For Linux or AIX
installations, the user must belong to the db2iadm group.

3. Start Cognos Configuration.

• On Windows computers, from the Start menu, click All Programs > IBM Cognos Analytics > IBM
Cognos Configuration.

• On Linux or AIX, go to the <COGNOS_HOME>/bin64 directory, type ./cogconfig.sh, and press
Enter.

4. Update the database connection information for the content store.
a) In the Explorer pane, under Data Access > Content Manager, click Content Store.
b) In the Database server and port number field, enter the name of the computer and the port

number on which DB2 is running.
c) Click the Value field next to the User ID and password property, click the edit icon, and type the

appropriate values for the Cognos user that you created for the content store database, and click
OK.

d) In the Properties window, for the Database name property, type the name for your content store
database.

Restriction: Do not use a name longer than eight characters and use only letters, numbers,
underscores, and hyphens in the name.

5. Click File > Save.
6. In the Explorer pane, right-click the content store database connection and click Test.
7. Stop the IBM Cognos services and the IBM OpenPages GRC Platform services.

Updating the database connection information for the search server (DB2)
Update the connection information that the search server uses to access the database server.

Procedure

1. Log on to the search server as a user with administrative privileges.
2. Go to <SEARCH_HOME>/opsearchtools/.
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3. Open the openpages_search.properties file in a text editor.
4. Modify the database connection properties with the values for the production database server.

Use the following examples as a guide.

# Database connectivity information
OPSearchTool.DatabaseType = DB2
OPSearchTool.DatabaseHostName = OP-WIN-DB2
OPSearchTool.DatabasePort = 50000
OPSearchTool.DatabaseName = OPX
OPSearchTool.DatabaseUserID = openpages_db_user_id
OPSearchTool.DatabasePassword = openpages_db_password

Updating the deploy.properties file
Update the database server host name and the database credentials in the deploy.properties file.

Procedure

1. If the installation app is running, log out.
2. Open a command or shell window and go to the <installation_server_home>/src/
deployment/<deployment-name> directory.

3. Make a backup copy of the deploy.properties file.
4. Open the deploy.properties file in a text editor.
5. Go to the database server section.
6. Update the following parameters with the values for your production database server.

• host
• db_port
• dba_username
• dba_password
• op_db_username
• op_db_password

7. Save your changes and close the editor.

Updating the connection to the OpenPages database for Cognos (DB2)
If you are using new hardware for the database server, update Cognos with the database connection
information for the OpenPages database.

Procedure

1. Start the IBM Cognos services.
2. Open a browser window and log on to the reporting portal as a user with administrative privileges.

By default, the URL is http://<server_name>/ibmcognos.

Where <server_name> is the host name of the reporting server.
3. Click Manage.
4. Click Administration console.
5. Click the Configuration tab.
6. Click OpenPages DataSource under Data Source Connections.
7. Click Actions > Set Properties - OpenPages DataSource.
8. Update the database connection string:

a) Click the Connection tab.
b) Click the pencil icon next to the Connection String box to edit the field.

Upgrade tasks for DB2 databases  213



c) On the CLI tab, in the DB2 database name box, change the DB2 database name to the Catalog
Database Name of the OpenPages database in your upgraded environment.
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Chapter 9. Upgrade tasks for Oracle databases
If you are using Oracle, refer to the following topics when you upgrade IBM OpenPages GRC Platform.

The tasks that you need to do depend on the upgrade scenario that you are following. Use the following
topics to guide you through the upgrade process:

• “Upgrade process overview: Using the database server from your source environment” on page 168
• “Upgrade process overview: Using new hardware for the database server” on page 170

Backing up the OpenPages database (Oracle)
Run the OPBackup utility to back up the IBM OpenPages GRC Platform databases in your source
environment.

About this task

You need to back up and then restore both the OpenPages schema and the workflow schema so that the
database upgrade scripts can remove any references to the workflow schema that are contained within
the OpenPages schema. After the OpenPages schema has these references removed, the workflow
schema will then be removed to complete this step.

Run the OPBackup utility with the dbonly parameter.

Note:

You can back up the databases by using other methods. Some examples of alternative methods include:

• Doing a full physical backup by using RMAN
• Doing a combination of full and incremental backup by using RMAN
• Doing an Oracle data pump export.

If you want to use an alternative method, it is critical that you have the necessary skills available within
your organization to complete all aspects of the backup and restore activity.

For more information about backing up your environment, see the IBM OpenPages GRC Administrator's
Guide.

Procedure

1. In your source environment, make sure that no OpenPages GRC Platform processes are running, such
as object reset jobs.

2. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

3. Open a command or shell window on the admin application server in your source environment.
4. Go to the <OP_HOME>/aurora/bin directory.
5. Do a full database backup of the OpenPages schema by using OPBackup.

Windows:

OPBackup.cmd <backup_directory> dbonly

Linux or AIX:

./OPBackup.sh <backup_directory> dbonly



The <backup_directory> is the full path to a directory on the database server. This directory is where
the log files are saved. If the file path is not specified, the OPBackup command uses the location that
is specified by the BACKUP_LOCATION parameter in the <OP_HOME>/aurora/bin/op-backup-
restore.env file.

Two dump files are created in the OP_DATAPUMP_DIRECTORY directory: one for the OpenPages
schema one for the workflow schema.

6. Examine the backup log and make note of the dump file names. The naming convention is
openpage_<timestamp>.dmp and workflow_<timestamp>.dmp.

7. Go to the <OP_HOME>/CommandCenter/tools/bin directory.
8. Copy the two .dmp files to the OP_DATAPUMP_DIRECTORY directory on the database server in your

target environment.
a) Locate the OP_DATAPUMP_DIRECTORY directory on the target database server.

To find the OP_DATAPUMP_DIRECTORY directory, run the following SQL as the system user::

select directory_name, directory_path from dba_directories 
where directory_name = upper ('OP_DATAPUMP_DIRECTORY');

b) Copy the OpenPages and workflow database dump files to the OP_DATAPUMP_DIRECTORY
directory on the target database server.

Copy the following files:

• openpage_<timestamp>.dmp
• workflow_<timestamp>.dmp

Note: Make sure to copy the .dmp files with the time stamp that matches when you ran the
OPBackup command.

Backing up the Cognos content store (Oracle)
You can use OPCCBackup to back up the Cognos content store.

About this task

Run the OPCCBackup utility with the dbonly parameter.

Note: You can back up the content store by using other methods. Some examples of alternative methods
include:

• Doing a full physical backup by using RMAN
• Doing a combination of full and incremental backup by using RMAN
• Doing an Oracle data pump export.

If you want to use an alternative method, it is critical that you have the necessary skills available within
your organization to complete all aspects of the backup and restore activity.

For more information about backing up your environment, see the IBM OpenPages GRC Administrator's
Guide.

Procedure

1. In your source environment, make sure that no OpenPages GRC Platform processes are running, such
as object reset jobs.

2. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

3. Ensure that all Cognos components are shut down.
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4. Open a command or shell window on the admin application server in your source environment.
5. Go to the <OP_HOME>/CommandCenter/tools/bin directory.
6. Do a full database backup of the Cognos schema by using OPCCBackup.

Windows:

OPCCBackup.cmd <backup_directory> dbonly

Linux or AIX:

./OPCCBackup.sh <backup_directory> dbonly

The <backup_directory> is the full path to a directory on the database server. This directory is where
the log files are saved. If the file path is not specified, the OPCCBackup command uses the location
that is specified by the OP_CC_BACKUP_HOME parameter in the <CC_HOME>/tools/bin/op-cc-
backup-restore.env file.

A dump file is created in the OP_DATAPUMP_DIRECTORY directory. The file is called
openpage_cc_<timestamp>.dmp.

7. Copy the .dmp file to the OP_DATAPUMP_DIRECTORY directory on the database server in your target
environment.
a) Locate the OP_DATAPUMP_DIRECTORY directory on the target database server.

Note:

To find the datapump directory for either the source or target database, run the following SQL query
as the system user:

select directory_name, directory_path from dba_directories 
where directory_name = upper ('OP_DATAPUMP_DIRECTORY');

By default, the datapump directory on the database server is <oracle-server-directory>|
admin|<sid>|dpdump

b) Copy the Cognos database dump files to the OP_DATAPUMP_DIRECTORY directory on the target
database server.

Copy the following file: openpage_cc_<timestamp>.dmp

Note: Make sure to copy the .dmp files with the time stamp that matches when you ran the
OPCCBackup command.

Restore the OpenPages database in your upgraded environment (Oracle)
Import the OpenPages database from your source environment to the upgraded environment. Do this
step before you upgrade the database.

Do these tasks to restore the databases:

• Prepare the Oracle database in your upgraded environment.
• Restore the OpenPages and workflow database schemas.

You need to restore the workflow schema so that the database upgrade scripts can remove any
references to the workflow schema that are contained within the OpenPages schema. Once the
OpenPages schema has these references removed, the workflow schema will then be removed to
complete the upgrade.
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Preparing to import the OpenPages database (Oracle)
Prepare the database in your target environment before you restore the database schemas from your
previous installation of OpenPages.

Before you begin
Ensure that you completed the backup of the database schemas. See “Backing up the OpenPages
database (Oracle)” on page 215.

Procedure

1. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

2. Log on to a server that has access to the database server and has SQL*Plus.
3. Drop the OpenPages database schema in your target environment.

a) Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/UPGRADE_SCRIPTS/OP730X_TO_OP7400 directory.

b) Verify that you have execute permission on the files in the UPGRADE_SCRIPTS directory.
c) Log on to SQL*Plus as the OpenPages database user (for example: sqlplus openpages/
openpages@test).

d) Use the spool command to create a log file.

spool <log_file directory>/<log_file name>

Ensure that you have write permission on the <log_file directory>.

Example:

spool /tmp/AuroraDbDelete.log

e) Run the AuroraDbDelete.sql script.

@AuroraDbDelete.sql

f) Log out of SQL*Plus.
4. Completely populate the required entries in the sql-wrapper.sql file. For more information, see

Table 49 on page 226.
5. Create the workflow user on the admin application server in your target environment.

a) Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/UPGRADE_SCRIPTS directory.

b) Log in to SQL*Plus as a DBA user.
c) Run the following script:

@sql-wrapper ibpm-ts-and-schema-owner.sql ibpm-ts-and-schema-owner.log 
   <workflow_password>

What to do next

Restore the database schema from your previous version of OpenPages.
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Restoring the OpenPages database schemas (Oracle)
Restore the database schemas from your previous installation of OpenPages into your target environment.

Before you begin

Ensure that the following tasks are complete:

• You backed up the OpenPages databases in the source environment. See “Backing up the OpenPages
database (Oracle)” on page 215.

• You prepared the database in your target environment for the import. See “Preparing to import the
OpenPages database (Oracle)” on page 218.

• You copied the backup files to the database server in your target environment. Store the files in the
OP_DATAPUMP_DIRECTORY directory.

If the OpenPages and Cognos databases are on different database servers, copy the OpenPages and
workflow dump files to the OpenPages database server.

About this task

Import the databases in the following order:

• OpenPages database
• Workflow database

You need to back up and then restore both the OpenPages schema and the workflow schema so that the
database upgrade scripts can remove any references to the workflow schema that are contained within
the OpenPages schema. After the OpenPages schema has these references removed, the workflow
schema will then be removed to complete this step.

If the schema names or table space names are different in the source and target environments, you must
remap them during the import. See “Remap schema and table space names (Oracle)” on page 221.

Note: When you import the OpenPages or workflow database, you might see an error as a result of the
default data file size. For more information, see “Issues when importing databases” on page 361.

Procedure

1. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

2. Log on to a server that has access to the database server and has SQL*Plus.
3. Set the NLS_LANG environment variable.

Windows

a. Click My Computer > Properties.
b. Click Advanced system settings > Environment Variables.
c. In the System Variables pane, click New.
d. Add the NLS_LANG variable.

For example: NLS_LANG=AMERICAN_AMERICA.AL32UTF8
e. Click OK twice to exit.

Alternatively, you can set the environment variable globally. See Configure an Environment Variable
Item in the Microsoft Windows documentation.
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AIX and Linux

Open a shell window. Open the .profile file that is in the home directory of the user who is
currently logged in. Enter the following line if it is missing from the file:

export NLS_LANG=AMERICAN_AMERICA.AL32UTF8

Save the file, and either execute the .profile in your shell window or log on again.
4. Import the OpenPages GRC Platform database schema.

Note: The Oracle Data Pump command IMPDP is used because the IMP command is not supported.

For more information about Oracle Data Pump, see the IBM OpenPages GRC Administrator's Guide.

Run the following command to import the OpenPages GRC Platform database:

impdp <op_db_user>/<op_db_password>@<SID> 
   DIRECTORY=OP_DATAPUMP_DIRECTORY DUMPFILE=<openpages_dump_file> 
   LOGFILE=openpages_import.log exclude=statistics

Table 46: Parameters and their descriptions: Importing the OpenPages database schema

Parameter Description

<op_db_user> The user name for accessing the OpenPages
database.

<op_db_password> The password for accessing the OpenPages
database.

<SID> The Oracle System Identifier (for example, OP).

<openpages_dump_file> The .dmp file name of the backed-up OpenPages
database schema:
openpage_<timestamp>.dmp.

Important: Do not enter a path. Enter only the
file name.

DIRECTORY Important: Do not enter an explicit path when
you specify the DIRECTORY parameter. Use
OP_DATAPUMP_DIRECTORY only.

If you receive the following error, you can ignore it:

ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'BPMACCNT' does not exist

Example

impdp openpages/openpages@OP 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=openpages_backup_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=openpages_import.log exclude=statistics

5. Import the workflow database schema from the backup files.

From the same command or shell window, run the following command to import the workflow
database:

impdp <workflow_db_user>/<workflow_db_password>@<SID> 
   DIRECTORY=OP_DATAPUMP_DIRECTORY DUMPFILE=<workflow_dump_file> 
   LOGFILE=opworkflow_import.log exclude=statistics
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Table 47: Parameters and their descriptions: Importing the workflow database schema

Parameter Description

<workflow_db_user> The user name for accessing the workflow
database.

<workflow_db_password> The password for accessing the workflow
database.

<SID> The Oracle System Identifier (for example, OP).

<workflow_dump_file> The .dmp file name of the backed-up workflow
database schema:
workflow_<timestamp>.dmp.

Important: Do not enter the path. Enter only the
file name.

DIRECTORY Important: Do not enter an explicit path when
you specify the DIRECTORY parameter. Use
OP_DATAPUMP_DIRECTORY only.

Example

impdp opworkflow/opworkflow@OP 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=opworkflow_backup_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=opworkflow_import.log exclude=statistics

What to do next

If the import fails, review the log files carefully. A failure at the beginning of the process might cause a
number of cascading failures that are a symptom of the root issue.

After the import completes successfully, upgrade the OpenPages database.

Remap schema and table space names (Oracle)
If the schema names or table space names are different in the source and target environments, you must
remap them during the import.

Remap schema names

If the schema names are different in the source and target, you must remap the schema names. You must
also run the import command as a DBA user.

OpenPages schema name is different
If the OpenPages schema name is different, remap it when you import the OpenPages database and
when you import the workflow database.

• Add the following clause to the import command for the OpenPages database:

remap_schema=<op_source>:<op_target>

• Add the following clause to the import command for the workflow database:

remap_schema=<op_source>:<op_target>

Note: If you use a different name for the OpenPages schema in your upgraded environment, the
change might impact your reports. You might need to do some remediation steps. If your reports
contain references to the schema, update the reports to use the new schema name. Out-of-the-box
reports are not impacted by this issue because they do not reference the schema name.
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Workflow schema name is different
If the workflow schema name is different but the OpenPages schema name is the same, remap the
workflow schema when you import the workflow database. Add the following clause to the import
command for the workflow database:

remap_schema=<workflow_source>:<workflow_target>

OpenPages and workflow schema names are different
If both the OpenPages and workflow schema names are different, do the following steps:

• Remap the OpenPages schema when you import the OpenPages database. Add the following
clause:

remap_schema=<op_source>:<op_target>

• Remap both the OpenPages schema and the workflow schema when you import the workflow
database. Add the following clauses:

remap_schema=<workflow_source>:<workflow_target> 
remap_schema=<op_source>:<op_target>

Example : In this example, the OpenPages schema name is different and the workflow schema name is
the same in the source and target.

impdp <dba_user>/<dba_password>@OP 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=openpages_backup_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=openpages_import.log remap_schema=opuser:openpages 
   exclude=statistics

impdp <dba_user>/<dba_password>@OP 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=opworkflow_backup_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=opworkflow_import.log remap_schema=opuser:openpages 
   exclude=statistics

Example : In this example, both the OpenPages and workflow schema names are different.

impdp <dba_user>/<dba_password>@OP 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=openpages_backup_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=openpages_import.log remap_schema=opuser:openpages 
   exclude=statistics

impdp <dba_user>/<dba_password>@OP 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=opworkflow_backup_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=opworkflow_import.log remap_schema=myworkflow:opworkflow
   remap_schema=opuser:openpages exclude=statistics

Example : In this example, the Cognos schema name is different.

impdp <dba_user>/<dba_password>@OPCC 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=openpage_cc_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=opcognos_import.log fromuser=cognos touser=cognos 
   TABLE_EXISTS_ACTION=REPLACE remap_schema=mycc:opcc

Remap table space names

If the source and target databases are using different table space names, include the following clause in
the import command:

remap_tablespace=<source_tablespace_name>:<target_tablespace_name>

222   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide



Example : In this example, the MCRN table space is remapped to the CRN table space in the target
environment.

impdp system/password@OPCC 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=openpage_cc_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=opcognos_import.log fromuser=cognos touser=cognos 
   TABLE_EXISTS_ACTION=REPLACE remap_tablespace=MYCRN:CRN

To determine the table space names that are used, do the following steps:

1. In the source environment, log in to SQL*Plus as the cognos user.
2. Run the following command to get a list of table spaces:

select tablespace_name from user_tablespaces;

3. Run the following command to get a list of table spaces that contain objects:

select distinct tablespace_name from user_segments;

4. Repeat these steps in the target environment and compare the table space names.

If you need to remap the schema and the table spaces, place the remap_schema parameter before the
remap_tablespace parameter. Run the command as a DBA user.

Example : In this example, the Cognos schema name is remapped and the MYCRN table space is also
remapped.

impdp <dba_user>/<dba_password>@OPCC DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=openpage_cc_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=opcognos_import.log fromuser=cognos touser=cognos 
   TABLE_EXISTS_ACTION=REPLACE remap_schema=mycc:opcc 
   remap_tablespace=MYCRN:CRN

Restore the Cognos content store in your upgraded environment (Oracle)
When you upgrade to Cognos Analytics, you can import the content store from your source environment.

Do these tasks to restore the content store:

• Prepare the Oracle database in your upgraded environment.
• Restore the Cognos database schemas.

Preparing to import the Cognos content store (Oracle)
Prepare the database in the target environment before you restore the Cognos content store schema.

Before you begin
Ensure that you completed the backup of the content store. See “Backing up the Cognos content store
(Oracle)” on page 216.

Procedure

1. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

2. Log on to a server that has access to the database server and has SQL*Plus.
3. Drop the Cognos database schema in your target environment.

a) Log on to a server that has access to the database server and has SQL*Plus.
b) Log on to SQL*Plus as the Cognos database user.
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c) Use the spool command to create a log file.

spool <log_file directory>/<log_file name>

Ensure that you have write permission on the <log_file directory>.

Example:

spool /tmp/AuroraDbDelete.log

d) Run the AuroraDbDelete.sql script.

@AuroraDbDelete.sql

e) Log out of SQL*Plus.

Restoring the Cognos content store (Oracle)
Restore the content store from your previous installation of Cognos.

Before you begin

Ensure that the following tasks are complete:

• You backed up the Cognos content store in the source environment. See “Backing up the Cognos
content store (Oracle)” on page 216.

• You prepared your database for the import. See “Preparing to import the Cognos content store (Oracle)”
on page 223.

• You copied the backup files to the database server in your target environment. Store the files in the
OP_DATAPUMP_DIRECTORY directory.

If the OpenPages and Cognos databases are on different database servers, copy the Cognos dump file
to the Cognos database server.

About this task

If the schema names or table space names are different in the source and target environments, you must
remap them during the import. See “Remap schema and table space names (Oracle)” on page 221.

Procedure

1. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

2. Log on to a server that has access to the database server and has SQL*Plus.
3. Import the Cognos content store.

From a command or shell window, run the following command to import the Cognos content store:

impdp system/<system_password>@<SID> 
   DIRECTORY=OP_DATAPUMP_DIRECTORY DUMPFILE=<cognos_dump_file> 
   LOGFILE=opcognos_import.log fromuser=cognos touser=cognos 
   TABLE_EXISTS_ACTION=REPLACE

Table 48: Parameters and their descriptions: Importing the Cognos database schema

Parameter Description

<system_password> The password of the SYSTEM user.

<SID> The Oracle System Identifier (for example, OPCC).

224   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide



Table 48: Parameters and their descriptions: Importing the Cognos database schema (continued)

Parameter Description

<cognos_dump_file> The .dmp file name of the backed-up Cognos
database schema:
openpage_cc_<timestamp>.dmp.

Important: Do not enter the path. Enter only the
file name.

DIRECTORY Important: Do not enter an explicit path when
you specify the DIRECTORY parameter. Use
OP_DATAPUMP_DIRECTORY only.

Example

impdp system/password@OPCC 
   DIRECTORY=OP_DATAPUMP_DIRECTORY 
   DUMPFILE=openpage_cc_YYYY_MM_DD_HH_MI_SS.dmp 
   LOGFILE=opcognos_import.log fromuser=cognos touser=cognos 
   TABLE_EXISTS_ACTION=REPLACE

What to do next

If the import fails, review the log files carefully. A failure at the beginning of the process might cause a
number of cascading failures that are a symptom of the root issue.

Upgrade the databases (Oracle)
Run scripts to upgrade the OpenPages database schema.

This video demonstrates how to upgrade the database schema by using scripts:

https://youtu.be/6uVOdXyCTT8

You must run all of the upgrade scripts in sequence to upgrade the database schema.

Two of the scripts require DBA privileges: a pre-upgrade script and a post-upgrade script. If you have DBA
privileges, you can run all of the scripts. If you do not have DBA privileges, contact your database
administrator.

A schema user can run the scripts that do not require DBA privileges.

Pre-upgrade step – DBA tasks
During this step, your database administrator runs a script to prepare the database for the upgrade.

You need SYSDBA privileges to run this script.

Validate the pre-upgrade step
During this step, you run a script to verify that the pre-upgrade DBA script completed successfully and
that the database schema is ready for the upgrade.

Upgrade step
During this step, you run a script to upgrade the schema. The script determines the current version of
the database schema, and then runs the upgrade scripts required to upgrade the schema.

Post upgrade step – DBA tasks
During this step, your database administrator runs a script to complete the database upgrade and to
set database tuning parameters.

You need SYSDBA privileges to run this script.

Validate the post-upgrade step
During this step, you run a script to validate the post-upgrade DBA step.
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Preparing for the database upgrade (Oracle)
Prepare for the upgrade of the database schema.

Procedure

1. Shut down all OpenPages components: application servers (admin and non-admin), reporting servers
(active and standby), and the search server.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

2. Ensure that the Oracle database server is running.
3. Log on to the Oracle database server computer as a user with administrative privileges.
4. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/UPGRADE_SCRIPTS directory.

5. Verify that you have write permission on the sql-wrapper.sql file.
6. Edit the sql-wrapper.sql file.

Note: Change only the parameters that are described in this step.

Table 49: Parameters in the sql-wrapper.sql file for Oracle databases

Property Description

opx_datafile_storage_dir Defines the physical locations of the datafiles that are associated
with the tablespaces that are created. This should be set to a
value that is appropriate for your environment

opx_dflt_sid The TNS alias of the Oracle database for OpenPages.

opx_db_owner The OpenPages database owner

opx_oracle_dba_user The user name of a DBA user. If your database administrator is
going to run the DBA scripts for you, then you can leave this value
empty when you run the non-DBA scripts.

opx_workflow_user The Fujitsu Interstage BPM workflow database user name.

You need to provide the workflow user name to complete the
upgrade. The database upgrade scripts remove any references to
the workflow schema that are contained within the OpenPages
schema, and then the scripts remove the workflow schema.

opx_override_ver_check Use the default value, N, unless you are re-running the database
upgrade scripts after a failure.

If the database upgrade failed in the middle of the schema
upgrade process, set this parameter to Y. When you re-run the
upgrade script, the upgrade process resumes from the last
successful schema upgrade step.

For example, suppose you are upgrading from 7.2 to 7.4. When
you run the upgrade script, it successfully upgrades the schema
from 7.2 to 7.3, but fails during the upgrade from 7.3 to 7.4. Set
this flag to Y and then re-run the script. The upgrade resumes at
the 7.3 to 7.4 upgrade step.

7. If you want to run a custom script during the upgrade process, see “Running custom scripts during the
database upgrade (Oracle)” on page 227.
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Running custom scripts during the database upgrade (Oracle)
If you want to run custom scripts during the database upgrade process, edit the sql-wrapper.sql file
to specify the scripts to run.

About this task

You can use the custom_data_upgrade_script parameter to configure a custom script.

The script that you specify is run during the database upgrade step. The custom script is called by the op-
database-product-upgrade.sh/bat script after the other upgrade steps, such as DDL changes,
PL/SQL code changes, and database level data changes are complete.

Procedure

1. Open the sql-wrapper.sql file.
2. Edit the following parameters:

define custom_data_upgrade_script=no-op.sql

Replace no-op.sql with the script that you want to run.
3. Place your custom scripts in the same directory as the sql-wrapper.sql file.

Preparing the files for your database administrator (Oracle)
If your organization requires the separation of DBA and non-DBA tasks, prepare the files that your
database administrator needs to do the upgrade.

Note: If you have DBA privileges and you plan to run the DBA scripts, you can skip this procedure.

Procedure

1. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/UPGRADE_SCRIPTS directory.

2. Collect the following files and send them to your DBA.

• sql-wrapper.sql
• op-database-dba-upgrade.sh|.bat
• op-database-dba-pre-upgrade.sql
• op-upgrade-save-original-version.sql
• op-upgrade-save-current-db-version.sql
• op-database-dba-post-upgrade.sql
• /UPGRADE_SCRIPTS/OP730X_TO_OP7400/dbu-Fujitsu-IBPM-Removal.sql
• no-op.sql

3. Send your DBA the instructions to run the DBA scripts.

• “Running the pre-upgrade DBA script (Oracle)” on page 227
• “Running the post-upgrade DBA script (Oracle)” on page 230

Running the pre-upgrade DBA script (Oracle)
Ask your database administrator to run the pre-upgrade script. Or, if you have DBA privileges, you can run
the script.

Before you begin

• The Oracle database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined.
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• apache-ant-1.8.1 is deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/UPGRADE_SCRIPTS

• The ORACLE_HOME system variable is defined.

About this task

Run the following script: op-database-dba-upgrade.sh|.bat. The script uses the parameters
defined in the sql-wrapper.sql file.

The op-database-dba-upgrade.sh|.bat script calls the following scripts:

• op-database-dba-pre-upgrade.sql: This script grants the privileges that are needed to upgrade
the database schema.

• no-op.sql: This is an empty file. You can use it to run custom scripts.
• op-upgrade-save-original-version.sql: This script writes the version of the pre-upgrade

schema to a log file. The upgrade script uses this information to determine which upgrade scripts to run.
• op-upgrade-save-current-db-version.sql: This script writes the version of the schema to a log
file. The upgrade script uses this information to track which upgrade scripts completed successfully.

Procedure

1. Log on to the Oracle database server computer as a database administrator (DBA).
2. Locate the scripts that are required.

If you are a database administrator, get the scripts from your OpenPages team.

Or, you can get the scripts from the /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.

a) For the opx_oracle_dba_user parameter, enter a user that has SYSDBA privileges, for example
SYS.

b) If you customized the table space names, update the define opx_dflt_* parameters with the
custom table space names.

c) If you want to run custom scripts during the upgrade, see “Running custom scripts during the
database upgrade (Oracle)” on page 227.

5. Run the following command:

Windows:

op-database-dba-upgrade.bat pre <sysdba_password>

Linux or AIX:

./op-database-dba-upgrade.sh pre <sysdba_password>

6. Verify that the return code is 0, indicating success.

You can also check the log file, op-database-dba-pre-upgrade.log.

What to do next

Validate the pre-upgrade script.
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Validating the pre-upgrade DBA step (Oracle)
Run the script to validate the pre-upgrade DBA steps.

Before you begin

• The Oracle database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined.
• apache-ant-1.8.1 has been deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/UPGRADE_SCRIPTS

• The ORACLE_HOME system variable is defined.

Procedure

1. Log on to the Oracle database server computer as the OpenPages application user, opuser.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.
5. Run the following command:

Windows:

op-database-product-upgrade.bat preupgrade <op_schema_owner_password> ""

Linux or AIX:

./op-database-product-upgrade.sh preupgrade <op_schema_owner_password>

6. Verify that the script completed successfully.
Look for the following message: Status:Success or a return code of 0.

You can also check the log file, op-validate-dba-pre-upgrade.log.

What to do next

Run the script to upgrade the database schema.

Upgrading the schema (Oracle)
Run the script to upgrade the database schema.

Before you begin

• The Oracle database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined.
• apache-ant-1.8.1 is deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/UPGRADE_SCRIPTS

• The ORACLE_HOME system variable is defined.
• The op-database-product-upgrade.sh|.bat script completed successfully.

Procedure

1. Log on to the Oracle database server computer as the OpenPages application user, opuser.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts in the UPGRADE_SCRIPTS directory and its
subdirectories.
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4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.
5. Run the following command:

Windows:

op-database-product-upgrade.bat upgrade <op_schema_owner_password> 
   <workflow_password>

Linux or AIX:

./op-database-product-upgrade.sh upgrade <op_schema_owner_password> 
   <workflow_password>

Note: You need to provide the workflow user password to complete the upgrade. The database
upgrade scripts remove any references to the workflow schema that are contained within the
OpenPages schema, and then the scripts remove the workflow schema.

6. Verify that the return code is 0, indicating success.

You can also check the log file, op-database-product-upgrade.log.

What to do next

Ask your database administrator to run the post-upgrade DBA script.

Running the post-upgrade DBA script (Oracle)
Ask you database administrator to run the post-upgrade script. Or, if you have DBA privileges, you can run
the script.

Before you begin

• The Oracle database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined.
• apache-ant-1.8.1 is deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/UPGRADE_SCRIPTS

• The ORACLE_HOME system variable is defined.
• The op-database-product-upgrade.sh|.bat script completed successfully.

About this task

Run the following script: op-database-dba-upgrade.sh|.bat. The script uses the parameters
defined in the sql-wrapper.sql file.

The op-database-dba-upgrade.sh|.bat script calls the following scripts:

• op-database-dba-post-upgrade.sql: This script validates database parameters. This script also
sets database tuning parameters.

• no-op.sql: This is an empty file.
• dbu-Fujitsu-IBPM-Removal.sql: This script removes the Fujitsu Interstage BPM workflow schema

and the workflow user. Fujitsu Interstage BPM is not supported in OpenPages 7.4 and later.

Procedure

1. Log on to the Oracle database server computer as a database administrator (DBA).
2. Locate the scripts that are required.

If you are a database administrator, get the scripts from your OpenPages team.

Or, you can get the scripts from the /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
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4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment. In the
opx_oracle_dba_user parameter, enter a user that has SYSDBA privileges, for example SYS.

5. Run the following command:

Windows:

op-database-dba-upgrade.bat post <sysdba_password>

Linux or AIX:

./op-database-dba-upgrade.sh post <sysdba_password>

6. Verify that the return code is 0, indicating success.

You can also check the log file: op-database-dba-post-upgrade.log.

What to do next

Validate the post-upgrade DBA step.

Validating the post-upgrade DBA step (Oracle)
Run the script to validate the post-upgrade DBA steps.

Before you begin

• The Oracle database server is running. All other OpenPages servers are stopped.
• The JAVA_HOME system variable is defined.
• apache-ant-1.8.1 has been deployed to /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/UPGRADE_SCRIPTS

• The ORACLE_HOME system variable is defined.

Procedure

1. Log on to the Oracle database server computer as the OpenPages application user, opuser.
2. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/UPGRADE_SCRIPTS directory.

3. Verify that you have execute permission on the scripts.
4. Open the sql-wrapper.sql file. Verify that the values are suitable for your environment.
5. Run the following command:

Windows:

op-database-product-upgrade.bat postdba <op_schema_owner_password> ""

Linux or AIX:

./op-database-product-upgrade.sh postdba <op_schema_owner_password>

6. Verify that the script completed successfully.
Look for the following message: Status:Success or a return code of 0.

You can also check the log file, op-validate-dba-post-upgrade.log.

Note: If you are upgrading from version 7.1 on Oracle, then the 7.1 to 7.2 portion of the upgrade could
encounter the following warning during the verification step: "PROPERTYDEFS Missing Required
Entries". If you encounter this warning, you can ignore it. For more information, see “Warning when
upgrading OpenPages Version 7.1 (Oracle)” on page 353.

7. Remove the passwords from the sql-wrapper.sql file for security purposes.
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Results
The OpenPages database schema is upgraded.

What to do next

Migrate the application data from your previous version of OpenPages. See “Migrate files” on page 176.

Updating the location of the openpages-storage directory (Oracle)
In the database, update the location of the openpages-storage directory.

If you are using Microsoft Windows, you can also use this procedure to change the storage type from LFS
to UNC.

Before you begin
Stop the IBM OpenPages GRC Platform services if they are running.

Procedure

1. Log on to the target environment as a user with administrative permissions. You can use any system
with access to SQL*Plus that can connect to the database server.

2. Open a command or shell window.
3. Locate the update-storage.sql script.

The script is stored in the following directories. You can use the script in either location.

• /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/ORACLE/
INSTALL_SCRIPTS directory.

• /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/ORACLE/
UPGRADE_SCRIPTS

4. Run the update-storage.sql script to update the openpages-storage directory location in the
database:

sqlplus /nolog @sql-wrapper.sql update-storage <log_file>
   <oracle_tns_alias> <op_db_user> <op_db_password> 
   <storage_type> <storage_server_name> <host_name> 
   <os_type> <path_or_UNC_name>

Table 50: Parameters in the update-storage.sql script (Oracle)

Parameter Description

<log_file> The name of the log file that the script will create and write
information to.

<oracle_tns_alias> The database alias for the OpenPages database instance, as set
during the Oracle database installation.

<op_db_user> The user name for accessing the OpenPages database.

<op_db_password> The password for accessing the OpenPages database.

<storage_type> The type of file storage to be used. Valid values are:

• LFS (local file system)
• UNC (Universal Naming Convention) - for Windows only

Note: After you move from LFS to UNC, you cannot go back to using
LFS.

<storage_server_name> The name of the storage server.
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Table 50: Parameters in the update-storage.sql script (Oracle) (continued)

Parameter Description

<host_name> The host name of the machine.

<os_type> The type of operating system. Valid values are:

• Windows
• Unix

<path_or_UNC_name> The file path or UNC of the storage location. If the path contains
backslashes, wrap the path in single quotation marks.

Examples

• LFS

Windows

sqlplus /nolog @sql-wrapper.sql 
  update-storage output.log OP 
  openpage password LFS eng11 eng11 
  Windows 'C:\IBM\OpenPages\openpages-storage'

Linux or AIX

sqlplus /nolog @sql-wrapper.sql
 update-storage /home/op/upd-storage-output.log
 op openpages openpages LFS  aix11 aix11
 Unix /usr/opdata/openpages-storage

• UNC

Windows

In the following example, openpages-storage is the UNC share name of the storage location. The
openpages-storage location is accessible to all horizontal cluster members as \
\testserver1\openpages-storage.

sqlplus /nolog @sql-wrapper.sql update-storage 
   c:\temp\update-storage-output.log op openpages openpages 
   UNC eng11 eng11 Windows openpages-storage

Update the database connection information (Oracle)
After you restore and upgrade the source database, update the connection information that is stored in
the database.

If you are using the database server from your source environment, you do not need to do these tasks.

• Update the aurora.properties with the URL of the database server. See “Updating the
aurora.properties file (Oracle)” on page 234.

• Update the Data Source Connection URL in IBM WebSphere Application Server. See “Updating the Data
Source Connection URL in IBM WebSphere Application Server (Oracle)” on page 234.

• Update IBM Cognos Configuration with the connection information for your Oracle database server. See
“Updating the Cognos content store information (Oracle)” on page 235.

• Configure Cognos with the connection information for the OpenPages data source. See “Updating the
connection to the OpenPages database for Cognos (Oracle)” on page 237.

• Update the search server settings in OpenPages. See “Updating search server settings” on page 182.
• Update the database connection information for the search server. See “Updating the database

connection information for the search server (Oracle)” on page 236.
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Updating the aurora.properties file (Oracle)
Update the database server URL in the aurora.properties file.

Procedure

1. Open a command or shell window and go to the <OP_HOME>/aurora/conf directory.
2. Make a backup copy of the aurora.properties file.
3. Open the aurora.properties file in a text editor.
4. Search the file for the string database.URL.
5. Change the value that follows the equal sign to the URL of your database server.

Use the following format:

jdbc\:oracle\:thin\:@//<host_name>\:<port>/<SID>

Where:

• <host_name> is the name of the database server, such as eng11.
• <port> is the database port number, such as 1521.
• <SID> is the Oracle System Identifier, such as OP.

6. Save your changes and close the editor.

Updating the Data Source Connection URL in IBM WebSphere Application Server (Oracle)
Update IBM WebSphere Application Server with the database server connection URL.

Procedure

1. Log on to the IBM WebSphere Application Server console.

By default, the URL is http://<host_name>:<port>/ibm/console

Where:

• <host_name> is the name of the application server where IBM WebSphere is installed.
• <port> is the application server port number.

For example: http://myappserver.com:9060/ibm/console
2. Expand Resources > JDBC and click the Data sources link.
3. In the Data sources pane, click CWTxDataSourceXA.
4. Locate the Common and required data source properties heading.
5. Type the database server connection URL in the URL field.

Use the following format:

jdbc:oracle:thin:@//<host_name>:<port>/<SID>

Where:

• <host_name> is the name of the database server, such as eng11.
• <port> is the database port number, such as 1521.
• <SID> is the Oracle System Identifier, such as OP.

6. In the Messages box, click Save.
7. Click OK.
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Updating the Cognos content store information (Oracle)
Update IBM Cognos Configuration with the connection information for your Oracle database server.

Procedure

1. Start the IBM Cognos services and the IBM OpenPages GRC Platform services.
2. Log on to the reporting server as a user with administrator privileges.

Note: For Windows installations, the user must belong to the DB2ADMINS group. For Linux or AIX
installations, the user must belong to the db2iadm group.

3. Start Cognos Configuration.

• On Windows computers, from the Start menu, click All Programs > IBM Cognos Analytics > IBM
Cognos Configuration.

• On Linux or AIX, go to the <COGNOS_HOME>/bin64 directory, type ./cogconfig.sh, and press
Enter.

4. Update the database connection information for the content store.
a) In the Explorer pane, under Data Access > Content Manager, click Content Store.
b) Use the following tables to update the database connection information.

Table 51: Content store property settings for Oracle database

Property name Property value

Database server and port number Type the name of the database server and the
listener port that is used for the database
instance.

User ID and Password Click the value field and then click the pencil
icon.

In the Value - User ID and password field,
enter the appropriate values for the user and
password for the content store database.

Service name Type the SID of the database instance.

Table 52: Content store property settings for Oracle database (Advanced) (Oracle RAC database)

Property name Property value

Database server and port number Type the name of the database server and the
listener port that is used for the database instance.

User ID and Password Click the value field and then click the pencil icon.

In the Value - User ID and password field, enter the
appropriate values for the content store database.
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Table 52: Content store property settings for Oracle database (Advanced) (Oracle RAC database)
(continued)

Property name Property value

Database specifier Type the database specifier string in the following
format with no carriage returns:

(description=(address=
(host=<server_name>)
(protocol=tcp)(port=<port>)
(connect_data(service_name=
<service_name>)))

5. Click File > Save.
6. In the Explorer pane, right-click the content store database connection and click Test.
7. Stop the IBM Cognos services and the IBM OpenPages GRC Platform services.

Updating the database connection information for the search server (Oracle)
Update the connection information that the search server uses to access the database server.

Procedure

1. Log on to the search server as a user with administrative privileges.
2. Go to <SEARCH_HOME>/opsearchtools/.
3. Open the openpages_search.properties file in a text editor.
4. Modify the database connection properties with the values for the database server.

Use the following examples as a guide.

# Database connectivity information
OPSearchTool.DatabaseType = Oracle
OPSearchTool.DatabaseHostName = OP-WIN-ORACLE
OPSearchTool.DatabasePort = 1521
OPSearchTool.DatabaseName = OPX
OPSearchTool.DatabaseUserID = openpages_db_user_id
OPSearchTool.DatabasePassword = openpages_db_password

Updating the deploy.properties file
Update the database server host name and the database credentials in the deploy.properties file.

Procedure

1. If the installation app is running, log out.
2. Open a command or shell window and go to the <installation_server_home>/src/
deployment/<deployment-name> directory.

3. Make a backup copy of the deploy.properties file.
4. Open the deploy.properties file in a text editor.
5. Go to the database server section.
6. Update the following parameters with the values for your production database server.

• host
• db_port
• dba_username
• dba_password
• op_db_username
• op_db_password
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7. Save your changes and close the editor.

Updating the connection to the OpenPages database for Cognos (Oracle)
If you are using new hardware for the database server, update Cognos with the database connection
information for the OpenPages database.

Also, do this procedure if the following conditions apply to you:

• The Oracle database alias that you used when you installed OpenPages in your target environment is
different from the alias that you used in your source environment

• You imported a 7.1.x, 7.2.x, or 7.3.x database

You need to update the connection string to use the Oracle Cognos DB Alias that you configured on the
Database Server card.

Procedure

1. Start the IBM Cognos services.
2. Open a browser window and log on to the reporting portal as a user with administrative privileges.

By default, the URL is http://<server_name>/ibmcognos.

Where <server_name> is the host name of the reporting server.
3. Click Manage.
4. Click Administration console.
5. Click the Configuration tab.
6. Click OpenPages DataSource under Data Source Connections.
7. Click Actions > Set Properties - OpenPages DataSource.
8. Update the database connection string:

a) Click the Connection tab.
b) Click the pencil icon next to the Connection String box to edit the field.
c) Update the SQL*Net connect string. Type the TNS alias or the service name of the OpenPages

database in your upgraded environment.
d) Click Test the connection.
e) Click Test. Verify that the test is successful. Click Close.
f) Click Close.
g) Click OK.

9. Click OK.
10. Click Oracle Native Driver under Data Source Connections.
11. Click Actions > Set Properties - Oracle Native Driver.
12. Update the database connection string:

a) Click the Connection tab.
b) Click the pencil icon next to the Connection String box to edit the field.
c) Update the SQL*Net connect string. Type the TNS alias or the service name of the OpenPages

database in your upgraded environment.
d) Click Test the connection.
e) Click Test. Verify that the test is successful. Click Close.
f) Click Close.
g) Click OK.

13. Click OK.
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Oracle Transparent Data Encryption (TDE) for upgrade customers
You can use Oracle Transparent Data Encryption (TDE) to encrypt the OpenPages and Cognos table
spaces in the OpenPages database.

This task is optional.

For information about how to implement TDE on an existing OpenPages database, see the IBM OpenPages
GRC Administrator's Guide.

For more information about TDE, refer to the Oracle documentation, such as the Oracle Database
Advance Security Guide (https://docs.oracle.com/database/121/ASOAG/toc.htm).
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Chapter 10. OpenPages solutions post-upgrade tasks
If you use IBM OpenPages solutions, complete the following post-upgrade tasks.

• If you are upgrading or migrating from version 7.1.x:

– Remove the obsolete triggers and helpers.
– Load the upgraded solutions trigger files for version 7.2.
– Load the OpenPages solution upgrade loader files.
– Load the object profiles.

For more information, see OpenPages Questionnaire Assessments post upgrade steps for 7.2.x
customers (www.ibm.com/support/docview.wss?uid=swg27047260).

– Update the IBM OpenPages Operational Risk Management reports.
• If you upgraded from 7.1.x or 7.2.x, load the scenario analysis fields for IBM OpenPages Operational

Risk Management.
• If you upgraded from 7.1.x or 7.2.x, update the openpages-solutions.xml file to optimize triggers.
• If you upgraded from 7.2.x, configure lifecycles for IBM OpenPages Vendor Risk Management.
• Update the model query subjects for IBM OpenPages Operational Risk Management.
• Update the RCSA Alignment helper for IBM OpenPages Operational Risk Management.
• Remove any scenario analysis triggers that you do not need.
• If you loaded the Scenario Analysis fields for IBM OpenPages Operational Risk Management, update the
field dependencies.

• If you upgraded from 7.3.x or from a previous version of OpenPages, and you did not previously load the
approval app or Loss Event Entry or RCM schemas, then you can load those schemas now.

• Back up your solutions reports and then import the solutions report package to update them.

For more information, see “Importing the solutions report packages” on page 251.

Removing obsolete solutions triggers
If you are upgrading from IBM OpenPages GRC Platform version 7.1.x to version 7.4 or later, remove the
solutions triggers and helpers from the openpages-ext.jar file.

OpenPages uses versions of these triggers and helpers that are contained in the openpages-
solutions.jar file.

If you are upgrading from OpenPages 7.2.x or 7.3.x, you do not need to perform this task.

Procedure

1. Stop all OpenPages services.
2. Back up the openpages-ext.jar file in the <OP_HOME>/aurora/lib/ directory.
3. Extract openpages-ext.jar from the <OP_HOME>/aurora/lib/ directory to the <OP_HOME>/
openpages-ext/ directory.

4. Delete the <OP_HOME>/openpages-ext/com/openpages/ext/solutions directory and all of the
contents of the directory.

5. Create a JAR file of the <OP_HOME>/openpages-ext directory and name it openpages-ext.jar.
6. Copy the new openpages-ext.jar file to the <OP_HOME>/aurora/lib directory, and overwrite the

existing file.
7. Start all OpenPages services.
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8. Repeat steps 1 - 7 on all non-admin application servers.

Loading the upgraded OpenPages solution trigger files
If you upgraded or migrated IBM OpenPages GRC Platform from version 7.1, you must load the solution
trigger files.

About this task
For example, the following procedure loads the trigger files for the IBM OpenPages IT Governance
solution.

Procedure

1. Run the following command to load the OPLC_Questionnaire-op-config.xml file by using the
ObjectManager command.

On Microsoft Windows operating systems:

ObjectManager.cmd l c <op_user> <op_password>
 <OP_HOME>\installer\migration\upgrade\addon_module\loaderdata\ OPLC_Questionnaire

On UNIX operating systems:

./ObjectManager.sh l c <op_user> <op_password>
 <OP_HOME>/installer/migration/upgrade/addon_module/loaderdata/ OPLC_Questionnaire

2. Click Administration > Settings > Applications > GRCM.
3. Update the value of the Trigger Configuration Files property to
_trigger_config_.xml,openpages-solutions.xml,OPLC-
QuestionnaireAssessment.xml.

4. Restart all OpenPages application servers.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

Loading OpenPages solutions upgrade loader files
If you are upgrading from version 7.1.x, you must load some upgrade files that are used by IBM
OpenPages solutions.

About this task

For example, the following procedure loads files that are used for the IBM OpenPages IT Governance
solution.

Procedure

1. Copy the files in the OP_<version>_Non_Embedded/OP_<version>_Configuration/
Modules/Upgrade/ITG/loader-data directory in the IBM OpenPages GRC Platform installation
media to the following directory:

<OP_HOME>/addon_module/loaderdata

Important: The files that are used to load the schema in Step 7 must be in the same directory as the
schema_loader_properties.bat (Microsoft Windows operating systems) or the
schema_loader_properties.sh file (UNIX operating systems), which is in the <OP_HOME>/
addon_module/loaderdata directory. Ensure that you have copied all the files to the <OP_HOME>/
addon_module/loaderdata directory or the command will fail.

2. Go to the <OP_HOME>/addon_module/loaderdata directory, and edit the following file in a text
editor:
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schema_loader_properties.bat (Microsoft Windows operating systems)

schema_loader_properties.sh (UNIX operating systems)
3. Configure the following values:

On Microsoft Windows operating systems, in the schema_loader_properties.bat file, update
the following lines:

OBJMGR_HOME=<OP_HOME>\bin
PATCH_LOADER_DATA=<OP_HOME>\addon_module\loaderdata
OPXUserName=Super_Administrator_user_name
OPXUserPassword=*****

On UNIX operating systems, in the schema_loader_properties.sh file, update the following
lines:

OBJMGR_HOME=<OP_HOME>/bin
PATCH_LOADER_DATA=<OP_HOME>/addon_module/loaderdata
OPXUserName=Super_Administrator_user_name
OPXUserPassword=*****

The default user name is OpenPagesAdministrator.

The password for OPXUserName is masked by asterisks (***). Replace the mask with clear text. After
the default configuration data is loaded, you can manually mask the password value with asterisks
(***).

Important: You must update these parameters or the command that is run in step 7 will fail.
4. Save and close the file.
5. Edit the <OP_HOME>/bin/ObjectManager.properties file and update the following settings as

shown:

configuration.manager.force.update.object.strings=true
configuration.manager.force.update.application.strings=true

6. Save and close the file.
7. From the <OP_HOME>/addon_module/ directory, run the following command:

openpages-itg-modules-upgrade-loader-data.bat (Windows)

./openpages-itg-modules-upgrade-loader-data.sh (UNIX)
8. If you encounter any errors, review the <OP_HOME>/bin/logs/ObjectManager.log file.
9. Edit the <OP_HOME>/bin/ObjectManager.properties file and update the following settings as

shown:

configuration.manager.force.update.object.strings=false
configuration.manager.force.update.application.strings=false

10. Save and close the file.
11. Configure the menu items for questionnaire assessments.

a) Log in to OpenPages as an administrator.
b) Click Adminstration > Settings.
c) Expand Application > Common > Configuration.
d) Set Show hidden settings to true.
e) Expand Application > GRCM > Navigation Menu > Assessment.
f) Click Object types and append the following text:

,QuestionnaireTemplate,QuestionnaireAssessment,Program
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For example:

RiskAssessment,RAEval,__separator__,SOXControlObjective,SOXRisk,RiskEval,
SOXControl,CtlEval,SOXTest,SOXTestResult,__separator__,ScenarioAnalysis,
ScenarioResult,__separator__,Questionnaire,QuestionnaireTemplate,
QuestionnaireAssessment,Program

g) Log out, and then log in.
Click Assessments. The menu now includes Questionnaire Templates, Questionnaire
Assessments, and Program.

Updating the ORM reports
If you upgraded IBM OpenPages GRC Platform from version 7.1.x, you must update the IBM OpenPages
Operational Risk Management reports.

Before you begin

To perform this procedure, you must have the OpenPages Platform 3 profile associated with your user
name.

Procedure

1. Copy the ORM_JSPReports-resources-op-config.xml and ORM_JSPReports-resources-op-
file-content.zip files from the installation media to the administrative application server.

The files are located in the /OP_<version>_Non_Embedded/OP_<version>_Configuration/
Modules/Upgrade/ORM/loader-data directory.

2. Open a command line.
If you are using Microsoft Windows, open a command prompt with the Run as Administrator option.

3. Go to the <OP_HOME>/bin directory.
4. Run the following command to load the files.

Replace <loader-file-path> with the location of the ORM_JSPReports-resources-op-config.xml
and ORM_JSPReports-resources-op-file-content.zip files.

ObjectManager.cmd|sh l c <OpenPages Administrator user> 
   <OpenPages Administrator password> <loader-file-path> 
   ORM_JSPReports-resources

5. If you encounter any errors, review the log file, OP_HOME/bin/logs/ObjectManager.log.
6. From the menu bar, click Administration > Manage System Files > Report.
7. Click Reports > SOX, and click ORM_Custom_Scope_Wizard.jsp
8. Check the Versions table to verify the update.

Loading the Scenario Analysis fields
If you upgraded IBM OpenPages GRC Platform, you must load the scenario analysis fields for IBM
OpenPages Operational Risk Management.

Procedure

1. Copy the OPSS-ScenAn-bundle-type-op-config.xml file from the installation media to the
administrative application server.

The file is located in the /OP_<version>_Non_Embedded/OP_<version>_Configuration/
Modules/Upgrade/ORM/loader-data directory.

2. Open a command line.
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If you are using Microsoft Windows, open a command prompt with the Run as Administrator option.
3. Go to the <OP_HOME>/bin directory.
4. Run the following command to load the files.

Replace <loader-file-path> with the location of the OPSS-ScenAn-bundle-type-op-config.xml
file.

ObjectManager.cmd|sh l c <OpenPages Administrator user> 
   <OpenPages Administrator password> <loader-file-path> 
   OPSS-ScenAn-bundle-type

5. If you encounter any errors, review the log file, OP_HOME/bin/logs/ObjectManager.log.
6. Restart all OpenPages servers.

For more information, see “Starting application servers” on page 253.
7. Regenerate the reporting framework.

For more information, see “Regenerating the reporting framework” on page 188.

Note: Do this task after completing all other post-upgrade or post-migration tasks.

Update the openpages-solutions.xml file
After you upgrade OpenPages GRC Platform, you need to update the openpages-solutions.xml file.

The steps that you need to do depend on the version you are upgrading from, and on whether you use
lifecycle fields for the SOXControl, SOXIssue, or Loss Event object types.

Update the openpages-solutions.xml file: 7.1.x with lifecycle fields
If you upgraded IBM OpenPages GRC Platform from version 7.1.x and you use lifecycle fields for the
SOXControl, SOXIssue, or Loss Event object types, do these steps to update the openpages-
solutions.xml file.

Before you begin

To perform this procedure, you must have the OpenPages Platform 3 profile associated with your user
name.

Procedure

1. From the menu bar, click Administration > Manage System Files > SysXMLDocument.
2. Click the _trigger_config.xml file, and then click View file.
3. Open the _trigger_config.xml in a text editor.
4. Delete all of the standard OpenPages trigger definitions, and then save the file.

Note: Keep any custom triggers.
5. Check out the _trigger_config.xml file.
6. Upload and check in the _trigger_config.xml file that you edited.
7. Copy the version 7.4 openpages-solutions.xml file from the installation media to the application

server.

The openpages-solutions.xml file is stored in /OP_7.4_Non_Embedded/
OP_7.4_Configuration/Modules/Upgrade/ORM/triggers/7.4_openpages_solutions.

8. Select the TriggerConfigFiles folder and then click Add New.
9. Click Browse and select the openpages-solutions.xml that you copied.

10. Type a description, and then click Create.
11. Restart all OpenPages servers.

For more information, see Chapter 11, “Starting and stopping servers,” on page 253.
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Update the openpages-solutions.xml file: 7.1.x without lifecycle fields
If you upgraded IBM OpenPages GRC Platform from version 7.1.x and you do not use lifecycle fields for
the SOXControl, SOXIssue, or Loss Event object types, do these steps to update the openpages-
solutions.xml file.

Before you begin

To perform this procedure, you must have the OpenPages Platform 3 profile associated with your user
name.

Procedure

1. From the menu bar, click Administration > Manage System Files > SysXMLDocument.
2. Click _trigger_config.xml, and then click View file.
3. Open the _trigger_config.xml in a text editor.
4. Delete all of the standard OpenPages trigger definitions, and then save the file.

Note: Keep any custom triggers.
5. Check out the _trigger_config.xml file.
6. Upload and check in the _trigger_config.xml file that you edited.
7. Copy the version 7.4 openpages-solutions.xml file from the installation media to the application

server.

The openpages-solutions.xml file is stored in /OP_7.4_Non_Embedded/
OP_7.4_Configuration/Modules/Upgrade/ORM/triggers/7.4_openpages_solutions.

8. Select the TriggerConfigFiles folder and then click Add New.
9. Click Browse and select the openpages-solutions.xml that you copied.

10. Type a description, and then click Create.
11. Optional: Edit the openpages-solutions.xml file. Add the objecttype property to the trigger

definitions.

For example:

<trigger name="Valdt and Cls TSheet Trig Create" 
   operation="create.object" type="CUSTOM" 
   classname="com.openpages.ext.solutions.triggers.AuditValidateCloseTrigger"
   position="PRE" objecttype="Timesheet">
   <attribute name="content.type" value="Timesheet" />

Adding the objecttype property to trigger definitions can improve performance.

For information about triggers, see the IBM OpenPages GRC Trigger Developer Guide
12. Restart all OpenPages servers.

For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

Update the openpages-solutions.xml file: 7.2.x with lifecycle fields
If you upgraded IBM OpenPages GRC Platform from version 7.2.x and you use lifecycle fields for the
SOXControl, SOXIssue, or Loss Event object types, do these steps to update the openpages-
solutions.xml.

Before you begin

To perform this procedure, you must have the OpenPages Platform 3 profile associated with your user
name.
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Procedure

1. Copy the version 7.4 openpages-solutions.xml file from the installation media to the application
server.

The openpages-solutions.xml file is stored in /OP_7.4_Non_Embedded
\OP_7.4_Configuration/Modules/Upgrade/ORM/triggers/7.4_openpages_solutions.

2. From the menu bar, click Administration > Manage System Files > SysXMLDocument.
3. Click TriggerConfigFiles, and then click openpages-solutions.xml.
4. Click View file and save the file.
5. From the Actions menu, click Check out this SysXMLDocument.
6. From the Actions menu, click Edit/Upoad this SysXMLDocument.
7. Click Browse and select the openpages-solutions.xml that you copied from the installation

media.
8. Add a comment, and then click Save.
9. From the Actions menu, click Check in this SysXMLDocument.

10. Restart all OpenPages servers.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

Update the openpages-solutions.xml file: 7.2.x without lifecycle fields
If you upgraded IBM OpenPages GRC Platform from version 7.2.x and you do not use lifecycle fields for
the SOXControl, SOXIssue, or Loss Event object types, you can improve performance by adding an object
type attribute to your trigger definitions. This step is optional.

About this task

Adding the ObjectType='' property to trigger definitions can improve performance. For more
information, see the IBM OpenPages GRC Trigger Developer Guide

Procedure

1. From the menu bar, click Administration > Manage System Files > SysXMLDocument.
2. Click TriggerConfigFiles, and then click openpages-solutions.xml.
3. Click View file and save the file.
4. From the Actions menu, click Check out this File.
5. Edit the openpages-solutions.xml file. Add the objecttype property to the trigger definitions.

For example:

<trigger name="Valdt and Cls TSheet Trig Create" 
   operation="create.object" type="CUSTOM" 
   classname="com.openpages.ext.solutions.triggers.AuditValidateCloseTrigger"
   position="PRE" objecttype="Timesheet">
   <attribute name="content.type" value="Timesheet" />

Adding the objecttype property to trigger definitions can improve performance.

For information about triggers, see the IBM OpenPages GRC Trigger Developer Guide
6. From the Actions menu, click Edit/Upoad this SysXMLDocument.
7. Click Browse and select the openpages-solutions.xml that you modified.
8. Add a comment, and then click Save.
9. From the Actions menu, click Check in this SysXMLDocument.

10. Restart all OpenPages servers.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.
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Configuring lifecycles for IBM OpenPages Vendor Risk Management objects
If you upgraded from version 7.2.x and use lifecycle triggers, follow these steps to update the trigger
definitions to include IBM OpenPages Vendor Risk Management objects.

Before you begin

To do this procedure, you must have the OpenPages Platform 3 profile associated with your user name.

Procedure

1. From the menu bar, click Administration > Manage System Files > SysXMLDocument.
2. Click TriggerConfigFiles, and then click OPLC-QuestionnaireAssessment.xml.
3. Click View file and save the file.
4. Open the OPLC-QuestionnaireAssessment.xml file in a text editor.
5. Look for the <!-- defaultsettings used when object is being created --> section.

Add the following lines:

<assigneefield objecttype="Vendor" field="OPSS-VRM:Vendor Owner"/>
<assigneefield objecttype="Engagement" field="OPSS-VRM-E:Enga Owner"/>

6. Update the 3 Stage Lifecycle transitions.
a) Go to the <transition name="3Stage-Info-Submit" nextstage="3Stage-Review">

section and add the following lines.

<assigneefield objecttype="Vendor" field="OPSS-VRM:Business Unit Owner"/>
<assigneefield objecttype="Engagement" field="OPSS-VRM-E:Business Unit Owner"/>

b) Go to the <transition name="3Stage-Review-Reject" nextstage="3Stage-Info">
section and add the following lines.

<assigneefield objecttype="Vendor" field="OPSS-VRM:Vendor Owner"/>
<assigneefield objecttype="Engagement" field="OPSS-VRM-E:Enga Owner"/>

7. Update the 4 Stage Lifecycle transitions.
a) Go to the <transition name="4Stage-Info-Submit" nextstage="4Stage-Review">

section and add the following lines.

<assigneefield objecttype="Vendor" field="OPSS-VRM:Business Unit Owner"/>
<assigneefield objecttype="Engagement" field="OPSS-VRM-E:Business Unit Owner"/>

b) Go to the <transition name="4Stage-Review-Reject" nextstage="4Stage-Info">
section and add the following lines.

<assigneefield objecttype="Vendor" field="OPSS-VRM:Vendor Owner"/>
<assigneefield objecttype="Engagement" field="OPSS-VRM-E:Enga Owner"/>

c) Go to the <transition name="4Stage-Approval-Reject" nextstage="4Stage-
Review"> section and add the following lines.

<assigneefield objecttype="Vendor" field="OPSS-VRM:Business Unit Owner"/>
<assigneefield objecttype="Engagement" field="OPSS-VRM-E:Business Unit Owner"/>

8. Check out the OPLC-QuestionnaireAssessment.xml file.
9. Upload and check in the OPLC-QuestionnaireAssessment.xml file that you edited.

10. Restart all OpenPages servers.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.
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Updating model query subjects for IBM OpenPages Operational Risk
Management

If you have customized the IBM OpenPages GRC Platform application URL and you use IBM OpenPages
Operational Risk Management, update the model query subjects after you upgrade IBM OpenPages GRC
Platform.

Procedure

1. Copy the static-modelquerysubjects_ORM.xml file from the installation media to the
<CC_HOME>/framework/conf/mqs directory in the target environment.

The static-modelquerysubjects_ORM.xml file is located in the
OP_<version>_Non_Embedded/OP_<version>_Configuration/Modules/Upgrade/ORM/
directory.

2. Regenerate the reporting framework.
See “Regenerating the reporting framework” on page 188.

Updating the RCSA Alignment helper for IBM OpenPages Operational Risk
Management

If you use IBM OpenPages Operational Risk Management, update the RCSA Alignment helper. Do this task
to enable users to launch the RCSA Alignment helper from Filtered List Views in addition to Detail views.

Procedure

1. Log on to IBM OpenPages GRC Platform as a user with administrative privileges.
2. Select Administration > Profiles > Profile_name > Risk Assessment > Filtered List from the

navigation bar.
3. Select Assessments > Risk Assessments.
4. In the filtered list view, click RCSA Alignment helper to open the helper.
5. Add the RCSA Alignment Helper field to its filtered list.

Removing the Scenario Analysis triggers
If you upgraded or migrated IBM OpenPages GRC Platform, you might need to remove some Scenario
Analysis triggers that you do not need.

About this task

Do this task if the following statements are true.

• You have not installed the Scenario Analysis with Quantitative Data feature for IBM OpenPages
Operational Risk Management

• You have installed the approval app, or you have set up a new lifecycle that uses the Loss Event, Control,
or Issue object types

If you do not remove the triggers, users might encounter validation errors when they create or update
Scenario Analysis objects.

To perform this procedure, you must have the OpenPages Platform 3 profile associated with your user
name.
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Procedure

1. From the menu bar, click Administration > Manage System Files > SysXMLDocument.
2. Click TriggerConfigFiles, and then click openpages-solutions.xml.
3. Click View file and save the file.
4. Open the openpages-solutions.xml in a text editor.
5. Locate the text <!-- BEGIN: Scenario Completion Triggers -->

6. Delete the following lines, and the save the file.

<!-- BEGIN: Scenario Completion Triggers -->
<trigger name="Scenario Completion Update" operation="update.object"
  type="CUSTOM" 
  classname="com.openpages.ext.solutions.triggers.ScenarioCompletionTrigger"
  position="POST" objecttype="ScenarioAnalysis">
  <attribute name="content.type" value="ScenarioAnalysis" />
  <actions>
    <action type="CUSTOM"
      classname="com.openpages.ext.solutions.triggers.ScenarioCompletionTriggerAction">
    </action>
  </actions>
</trigger>
<trigger name="Scenario Completion Create" operation="create.object"
  type="CUSTOM" 
  classname="com.openpages.ext.solutions.triggers.ScenarioCompletionTrigger"
  position="POST" objecttype="ScenarioAnalysis">
  <attribute name="content.type" value="ScenarioAnalysis" />
  <actions>
    <action type="CUSTOM"
      classname="com.openpages.ext.solutions.triggers.ScenarioCompletionTriggerAction">
    </action>
  </actions>
</trigger>
<!-- END: Scenario Completion Triggers -->

7. Check out the openpages-solutions.xml file.
8. Upload and check in the openpages-solutions.xml file that you edited.
9. Restart all OpenPages servers.

Updating Scenario Analysis field dependencies
If you upgraded to IBM OpenPages GRC Platform version 7.4 or later and you loaded the Scenario
Analysis fields for IBM OpenPages Operational Risk Management, you need to update the field
dependencies.

About this task

If you did not load the Scenario Analysis fields when you upgraded, migrated, or installed a fix pack, do
not do these steps. For information about loading the fields, see “Loading the Scenario Analysis fields” on
page 242.

Procedure

1. Copy the ScenAn-field-dependency-op-config.xml file from the installation media to the
administrative application server.

The file is located in the /OP_<version>_Non_Embedded/OP_<version>_Configuration/
Modules/Upgrade/ORM/loader-data directory.

If the file already exists, overwrite it.
2. Open a command line.

If you are using Microsoft Windows, open a command prompt with the Run as Administrator option.
3. Go to the <OP_HOME>/bin directory.
4. Run the following command to load the files.
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Replace <loader-file-path> with the location of the ScenAn-field-dependency-op-config.xml
file.

ObjectManager.cmd|sh l c <OpenPages Administrator user> 
   <OpenPages Administrator password> <loader-file-path> 
   ScenAn-field-dependency

5. If you encounter any errors, review the log file, <OP_HOME>/bin/logs/ObjectManager.log.
6. Restart all OpenPages servers.

For more information, see “Starting application servers” on page 253.
7. Regenerate the reporting framework.

For more information, see “Regenerating the reporting framework” on page 188.

Note: Do this task after completing all other post-upgrade or post-migration tasks.

Update trigger definitions
Do this procedure if you are upgrading from 7.3.0.0 or if you are upgrading from 7.3.0.1 or later and you
have not already updated the trigger definitions.

Updating trigger definitions when you have custom triggers
If you created custom triggers, follow these steps to update the trigger definitions. To perform this
procedure, you must have the OpenPages Platform 3 profile associated with your user name.

About this task

If you are upgrading from 7.3.0.1 or later and you have already updated the trigger definitions, you do not
need to do this procedure.

Procedure

1. From the menu bar, click Administration > Manage System Files > SysXMLDocument.
2. Click TriggerConfigFiles, and then click openpages-solutions.xml.
3. Click View file and save the file.
4. Open the openpages-solutions.xml file in a text editor.
5. Look for the update.fields.status.2 attribute with the following value:

"OPSS-KRI-Shared.Collection Status=Awaiting Collection,OPSS-KRIVal.Value,
   OPSS-KRIVal.Value Date,OPSS-KRIVal.Approve Reject"

6. Replace the attribute value with the following:

"OPSS-KRI-Shared.Collection Status=Awaiting Collection,
   OPSS-KRIVal.Value,OPSS-KRIVal.Value Date,OPSS-KRIVal.Approve Reject,
   OPSS-KRI.Value,OPSS-KRI.Value Date,OPSS-KRI.Indicator Trend=Not Determined,
   OPSS-KRI-Shared.Breach Status=Not Determined"

7. Look for the update.fields.status.2 attribute with the following value:

"OPSS-KPI-Shared.Collection Status=Awaiting Collection,OPSS-KPIVal.Value,
   OPSS-KPIVal.Value Date,OPSS-KPIVal.Approve Reject"

8. Replace the attribute value with the following:

"OPSS-KPI-Shared.Collection Status=Awaiting Collection,
   OPSS-KPIVal.Value,OPSS-KPIVal.Value Date,OPSS-KPIVal.Approve Reject,
   OPSS-KPI.Value,OPSS-KPI.Value Date,OPSS-KPI.Indicator Trend=Not Determined,
   OPSS-KPI-Shared.Breach Status=Not Determined"

9. Check out the openpages-solutions.xml file.
10. Upload and check in the openpages-solutions.xml file that you edited.
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11. Restart all OpenPages servers.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

Updating trigger definitions when you do not have custom triggers
If you do not have custom triggers, follow these steps to update the trigger definitions. To do this
procedure, you must have the OpenPages Platform 3 profile associated with your user name.

About this task

If you are upgrading from 7.3.0.1 or later and you have already updated the trigger definitions, you do not
need to do this procedure.

Procedure

1. Copy the openpages-solutions.xml file from the installation media to the application server.

The openpages-solutions.xml file is stored in OP_7.4_Non_Embedded/
OP_7.4_Configuration/Modules/Upgrade/ORM/triggers/7.4_openpages_solutions.

2. From the menu bar, click Administration > Manage System Files > SysXMLDocument.
3. Click TriggerConfigFiles, and then click openpages-solutions.xml.
4. From the Actions menu, click Check out this SysXMLDocument.
5. From the Actions menu, click Edit/Upoad this SysXMLDocument.
6. Click Browse select the openpages-solutions.xml file that is in the fix pack installation media
7. Add a comment, and then click Save.
8. From the Actions menu, click Check in this SysXMLDocument.
9. Restart all OpenPages servers.

For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

Configuring email notifications for questionnaire assessment triggers
If you upgraded from version 7.2.x or 7.3.x, follow these steps to update the trigger definitions to send
email notifications when a questionnaire assessment is launched.

Before you begin

To do this procedure, you must have the OpenPages Platform 3 profile associated with your user name.

About this task

The behavior of email notifications for questionnaire assessments has changed.

In IBM OpenPages GRC Platform 7.2.x and 7.3.x, email notifications were sent when a questionnaire
assessment was launched, regardless of the value of the sendemail attribute.

If you want emails to be sent when a questionnaire assessment is launched, update the OPLC-
QuestionnaireAssessment.xml file. Set the sendemail attribute in the default settings section to
true.

Procedure

1. Click Administration > Manage System Files > SysXMLDocument.
2. Click TriggerConfigFiles, and then click OPLC-QuestionnaireAssessment.xml.
3. Click View file and save the file.
4. Open the OPLC-QuestionnaireAssessment.xml file in a text editor.
5. Look for the <!-- defaultsettings used when object is being created --> section.
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6. Look for the following line:

<attribute name="sendemail" value="false"/>

7. Change the value to true.
8. Check out the OPLC-QuestionnaireAssessment.xml file.
9. Upload and check in the OPLC-QuestionnaireAssessment.xml file that you edited.

10. Restart all OpenPages servers.
For more information, see Chapter 11, “Starting and stopping servers,” on page 253.

Importing the solutions report packages
After you upgrade IBM OpenPages GRC Platform, import the solutions reports to update them.

For more information about importing content, see the Cognos Analytics Administration and Security
Guide.

Procedure

1. Back up the following file if it exists: <COGNOS_HOME>/deployment/
OpenPages_Solutions_V6.zip.

2. Get the latest version of the solutions report package.
a) Locate the solutions package file for the database that you are using. The file is located in the

following directory:

• IBM DB2: OP_<version>_Non_Embedded/OP_<version>_Configuration/Modules/
Upgrade/ORM/DB2/OpenPages_Solutions_V6.zip

• Oracle: OP_<version>_Non_Embedded/OP_<version>_Configuration/Modules/
Upgrade/ORM/Oracle/OpenPages_Solutions_V6.zip

b) Copy the OpenPages_Solutions_V6.zip file to the following directory on the Cognos server:
<COGNOS_HOME>/deployment. Overwrite the existing file.

3. From a browser, log on to the Cognos Analytics portal.

By default, the URL is http://<hostname>/ibmcognos/bi

Where <hostname> is the name of the Cognos server.
4. Click Manage > Administration Console to launch the IBM Cognos Administration page.
5. Click the Configuration tab and click Content Administration.

Tip: To access this area in IBM Cognos Administration, you must have the required permissions for
the Administration secured feature.

6. On the toolbar, click New Import.
7. From the Deployment archive list, select OpenPages_Solutions_v6.
8. Click Next.
9. Type a unique name, an optional description, and a screen tip for the deployment archive, select the

folder where you want to save it, and then click Next.
10. In the Public folders content box, select OpenPages_Solutions_v6, and then click Next.
11. On the Specify the general options page, accept the default options and click Next.
12. On the Review the summary page, review the settings and click Next.
13. On the Select an action page, click Finish.
14. On the Run with options page, click Run and then, on the IBM Cognos software page, click OK.
15. To view the imported packages and reports, click the Home icon, and select the folder where you

imported them.
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Results

You can now open the OpenPages reports in Cognos Analytics.
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Chapter 11. Starting and stopping servers
You can start and stop the IBM OpenPages GRC Platform application servers, the database server, the
Cognos server, and the search server.

Starting application servers
You can start IBM OpenPages GRC Platform in Windows, AIX, and Linux environments.

In a Windows environment, the services that are required to start the OpenPages GRC Platform
application servers can be configured to start automatically.

In an AIX and Linux environment, you manually run scripts to start the OpenPages GRC Platform
application servers.

Important:

• Start the deployment manager first:

– On Windows: start the IBMWAS<version>Service - <OpenPagesdmgr-name> service
– On Linux or AIX: run the startManager script

Then run the other services and scripts as described in the following procedures.
• If you are running OpenPages in a load-balanced environment, you must start the server on the cluster

administrator first before starting a cluster member.

Microsoft Windows services
For the IBM OpenPages GRC Platform application to run, all of the required Microsoft Windows services
must be started and the services of supporting applications must be running.

Note: This information applies only to Windows environments.

Table 53: Service descriptions

Service Name Description

IBMWAS<version>Service - <OpenPages-
dmgr-name>

Starts or stops the OpenPages deployment manager service.

Note: In a horizontal-cluster or shared-cell environment,
cluster members might not have an <OpenPages-dmgr-
name> service.

IBMWAS<version>Service - <OpenPages-
node-name>

Starts or stops an OpenPages node service.

IBMWAS<version>Service - <OpenPages-
node-server-name>Server<#>

Starts or stops an OpenPages application server cluster
member.

In a clustered environment, the number for each cluster
member increments by 1.

Microsoft Windows commands
In a Microsoft Windows environment, IBM OpenPages GRC Platform includes a number of commands to
initiate and launch the application environment.

The application runs only if all of the services are started and all of the services for all supporting
applications are running.



Note: These commands can be run individually or you can use wrapper commands to start and stop
OpenPages GRC Platform.

The following table lists the commands required to start and stop the application.

Table 54: OpenPages GRC Platform commands on Windows

Script Name Description

startManager.bat Starts the OpenPages Deployment Manager.

startNode.bat Starts the OpenPages node agent.

startServer.bat Starts the OpenPages application server.

stopManager.bat Stops the OpenPages Deployment Manager.

stopNode.bat Stops the OpenPages node agent.

stopServer.bat Stops the OpenPages application server.

startAllServers.bat Starts all OpenPages services in the correct
sequence.

stopAllServers.bat Stops all OpenPages services in the correct
sequence.

AIX and Linux scripts
In the AIX and Linux environments, IBM OpenPages GRC Platform includes a number of scripts to initiate
and launch the application environment.

The application runs only if all of the services are started and all of the services for all supporting
applications are running.

Note: These scripts can be run individually or you can use wrapper scripts to start and stop OpenPages
GRC Platform.

The following table lists the scripts required to start and stop the application.

Table 55: OpenPages GRC Platform scripts on AIX and Linux

Script Name Description

startManager.sh Starts the OpenPages Deployment Manager.

startNode.sh Starts the OpenPages node agent.

startServer.sh Starts the OpenPages application server.

stopManager.sh Stops the OpenPages Deployment Manager.

stopNode.sh Stops the OpenPages node agent.

stopServer.sh Stops the OpenPages application server.

startAllServers.sh Starts all OpenPages services in the correct
sequence.

stopAllServers.sh Stops all OpenPages services in the correct
sequence.
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Determining application readiness
This procedure lets you determine whether the application is ready to be accessed after starting up
servers.

Procedure

1. Open the log file specified in the following table.

Table 56: Log files and their locations

If this... Navigate to this folder... View this log file...

Windows, AIX, and Linux <OP_HOME>|profiles|
<OpenPages-node-name>|
logs|<OpenPages-node-
server-name>Server<#>

startServer.log

Where

<OP_HOME> represents the installation location of the OpenPages GRC Platform application.

<OpenPages-node-name> is the name of the node in which the servers run.

<OpenPages-node-server-name>Server <#> is the name of the current server within the <OpenPages-
node-name> node that the current server is in, and <#> is the number of the server within that node.

2. Scroll to the end of the log file and search for a message stating that the server is "open for e-business;
process id is <process-id>". If this line appears, the server is running in production mode and the
application is ready to be accessed.

Automatically starting application servers in Windows
By default, all IBM OpenPages GRC Platform services are configured as Manual (they do not start upon
reboot).

You can configure all OpenPages GRC Platform services to Automatic through Windows Services to start
upon booting, or use scripts on each server to start the services upon reboot.

When you reboot the server, all OpenPages GRC Platform services start.

Starting all application services in Windows using a script
The StartAllServers.cmd script included with IBM OpenPages GRC Platform starts all OpenPages
services in the proper sequence.

Note: This information applies only to Microsoft Windows environments.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Open a Command Prompt window (using the Run as Administrator option) and do the following:

a) Navigate to the <OP_HOME>\bin directory.

Where <OP_HOME> is the installation location of the OpenPages GRC Platform application. By
default, this is: c:\OpenPages.

b) Run the following command to start the OpenPages GRC Platform services:

StartAllServers.cmd

When all services have been started, the Command Prompt window closes.
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Starting application services individually using Windows services
In the Windows environment, you start the IBM OpenPages GRC Platform application by starting the
required OpenPages services.

Note: This information applies only to Windows environments.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Click the Windows Start menu and select All Programs.
3. From the Administrative Tools list, click Services.
4. Start the IBMWAS<version>Service - <OpenPages-dmgr-name> service, if present.
5. Start the IBMWAS<version>Service - <OpenPages-node-name> service.
6. Start the IBMWAS<version>Service - <OpenPages-node-server-name>Server<#> services, where <#>

represents the number of the cluster member.

Note: If there is more than one cluster member on the current system, you must start the service
(<OpenPages-node-server-name>Server<#>) for each cluster member in sequence.

When the services are starting, Windows Services may indicate that the services have started, but
background OpenPages processes may still be running. It might take a few minutes for the OpenPages
services to be operational.

Starting all application servers in AIX and Linux using a script
The startAllServers.sh script included with IBM OpenPages GRC Platform will start all OpenPages
services in the proper sequence.

Note: This information applies only to AIX and Linux environments.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Open an AIX or Linux shell window.
3. Go to the <OP_HOME>/bin directory.
4. Run the following script to start OpenPages GRC Platform services:

./startAllServers.sh

Starting application servers in AIX and Linux individually using scripts
Use the following steps to start the IBM OpenPages GRC Platform services manually. In the AIX and Linux
environments, you run a set of scripts to start the OpenPages application.

Note: This information applies only to AIX and Linux environments.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Use an AIX or Linux shell to navigate to the <DMGR profile directory>/<OpenPages-dmgr-
name>/bin directory, where <DMGR profile directory> is the same directory as the one provided
on the installer's Deployment Manager card.
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3. Enter the following command to launch a script that starts the OpenPages GRC Platform Deployment
Manager:

./startManager.sh

4. After the script completes successfully, navigate to <DMGR profile directory>/<OpenPages-
dmgr-name>/bin, where <DMGR profile directory> is the same directory as the one provided on the
installer's Deployment Manager card.

5. Enter the following commands, in the order specified, to launch scripts that start the OpenPages Node
Agent and the OpenPages application server:

./startNode.sh

./startServer.sh <OpenPages-node-server-name>Server<#>

Where <OpenPages-node-server-name> is the name of the current server within the
<OpenPages-node-name> node that the current server is in, and <#> is the number of the server
within that node. For example, OpenPagesNodeServerServer1.

Note: If there is more than one managed server on the current system, you must run the start script
(./startServer.sh <OpenPages-node-server-name>Server<#>) for each managed server in
sequence, starting with server number 1, then server number 2, and so on.

Start or stop the global search services
You can start and stop the global search services by using operating system services or by using scripts.

Note: Do not combine the two methods. If you start global search as a Microsoft Windows service, for
example, stop global search by stopping the Windows service.

Starting the global search services by using a script
You can start the global search services by running a script from a command line.

Before you begin

On the Windows operating system, disable the Microsoft Windows service that is called IBM OpenPages
GRC - Global Search service, if it is enabled. Otherwise, the StartSearchServer.cmd script interferes
with the Windows services.

Make sure that the database server is reachable and is running. Otherwise, the search services will not
connect and will not start.

Procedure

1. Start the search services:

• For Windows, at a command prompt enter the following commands:

cd <SEARCH_HOME>\opsearchtools\
StartSearchServer.cmd

• For UNIX, at a command line, enter the following commands:

cd <SEARCH_HOME>/opsearchtools/
./StartSearchServer.sh

2. Open a browser and point to your search server at ports 8983 and 8985. Make sure that the Solr
search platform can be reached.
For example, http://<search-server>:8983/ and http://<search-server>:8985/.

If the verification fails, repeat the preceding step.
3. Log on to IBM OpenPages GRC Platform as an administrator.
4. Click Administration > Global Search > Enable.
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Stopping the global search services by using a script
You can stop the global search services by running a script from a command line.

Before you begin

On the Windows operating system, disable the Microsoft Windows service called IBM OpenPages GRC -
Global Search service, if it is enabled. Otherwise, the StopSearchServer.cmd script interferes with
the Windows services.

Procedure

1. Log on to IBM OpenPages GRC Platform as an administrator.
2. Click Administration > Global Search > Disable.
3. Stop the search services:

• For Windows, at a command prompt, enter the following commands:

cd <SEARCH_HOME>\opsearchtools\
StopSearchServer.cmd

• For UNIX, at a command line, enter the following commands:

cd <SEARCH_HOME>/opsearchtools/
./StopSearchServer.sh

4. For either Windows or UNIX, verify that global search is fully stopped.
a) In the directory <SEARCH_HOME>/opsearchtools/, examine the files
opsearchtool_openpages.state and opsearchtool_folderacl.state and verify that the
PID value is -1.

b) Open a browser and point to your search server at ports 8983 and 8985. Make sure that the Solr
search platform cannot be reached.
For example, http://<search-server>:8983/ and http://<search-server>:8985/.

If the stop verification fails, repeat the preceding step and then follow the steps in “ Forcing a reset
of global search” on page 346.

Starting the global search services on Windows
You can start global search as a Microsoft Windows service. The service is called IBM OpenPages GRC -
Global Search.

About this task

By default, the service is set to start manually, but you can change the service to start automatically.

Note: Make sure that the database server is reachable and is up and running. Otherwise, the search
services will not connect and will not start.

Procedure

1. Log on to the search server as a user with administrative privileges.
2. Open the Services snap-in (services.msc).
3. Locate the service that is called IBM OpenPages GRC - Global Search.
4. Click Start.
5. If you want the service to start automatically when Windows starts, change the Startup Type to

Automatic.
6. Open a browser and point to your search server at ports 8983 and 8985. Make sure that the Solr

search platform can be reached.
For example, http://<search-server>:8983/ and http://<search-server>:8985/.
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If the verification fails, repeat the preceding step.
7. Log on to IBM OpenPages GRC Platform as an administrator.
8. Click Administration > Global Search > Enable.

Starting the global search services on Linux or AIX
You can start global search as a service.

About this task

Use the steps in this topic as a guide. Depending on your environment and organization policies, you might
decide to use a different method to set up the search service. If you want to use a different method, open
the openpages-search file and check the commands, and the order of the commands. Modify the
commands to meet the needs of your environment.

Note: Make sure that the database server is reachable and is up and running. Otherwise, the search
services will not connect and will not start.

Procedure

1. Log on to the search server.
2. Open a shell as the root user.
3. Copy the <SEARCH_HOME>/opsearchtools/openpages-search file to the /etc/init.d/

directory.
4. Copy the <SEARCH_HOME>/opsearchtools/openpages-searchcfg file to the /etc/
sysconfig/ directory.

5. Set the execution permission on the openpages-search file by running the following command:
chmod +x /etc/init.d/openpages-search

6. If you want the service to start automatically when the system restarts, run the following commands:

chkconfig --add openpages-search
chkconfig openpages-search on
service openpages-search start

7. Start the global search services by running the following command: service openpages-search
start

8. Open a browser and point to your search server at ports 8983 and 8985. Make sure that the Solr
search platform can be reached.
For example, http://<search-server>:8983/ and http://<search-server>:8985/.

If the verification fails, repeat the preceding step.
9. Log on to IBM OpenPages GRC Platform as an administrator.

10. Click Administration > Global Search > Enable.

Stopping the global search services
If global search is running as a service, you can use the operating system to stop the global search
services.

About this task

If you used the StartSearchServer.sh|.cmd script to start the global search services, use the
StopSearchServer.sh|.cmd script to stop the services. For more information, see “Stopping the
global search services by using a script” on page 258.

Procedure

1. Log on to IBM OpenPages GRC Platform as an administrator.
2. Click Administration > Global Search > Disable.
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3. Log on to the search server as a user with administrative privileges.
4. Stop the search services.

On Windows:

a. Open the Services snap-in (services.msc)
b. Locate the service that is called IBM OpenPages GRC - Global Search.
c. Click Stop.

On Linux or AIX, run the following command:

service openpages-search stop

5. Verify that global search is fully stopped.
a) In the directory <SEARCH_HOME>/opsearchtools/, examine the files
opsearchtool_openpages.state and opsearchtool_folderacl.state and verify that the
PID value is -1.

b) Open a browser and point to your search server at ports 8983 and 8985. Make sure that the Solr
search platform cannot be reached.
For example, http://<search-server>:8983/ and http://<search-server>:8985/.

If the stop verification fails, repeat the preceding step and then follow the steps in “ Forcing a reset
of global search” on page 346.

Stopping application servers
You can stop the IBM OpenPages GRC Platform application server in the Windows, AIX and Linux
environments as required.

IBM WebSphere Application Server global security is enabled by default on the application servers. When
stopping an application server, you must provide the WebSphere administrative user name and password
as arguments to all stop scripts on all operating systems.

Stopping the application server prevents IBM OpenPages GRC Platform from being accessed.

Important: If you are running OpenPages GRC Platform in a load-balanced environment, stop the server
on each cluster member first before stopping the cluster administrator.

Stopping application servers in a Windows environment
In a Windows environment, all IBM OpenPages GRC Platform services can be configured to stop
automatically or you can stop the services manually, using one of the following three methods.

Stopping the application server prevents IBM OpenPages GRC Platform from being accessed.

Important: If you are running OpenPages GRC Platform in a load-balanced environment, stop the server
on each cluster member first before stopping the cluster administrator.

Automatically stopping application servers in Windows
Windows automatically and gracefully stops the IBM OpenPages GRC Platform application when a server
shuts down.

Note: This information applies only to Windows environments.

Stopping the application server prevents the OpenPages application from being accessed.

Important: If you are running OpenPages GRC Platform in a load-balanced environment, you must stop
the server on each cluster member first before stopping the cluster administrator.
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Stopping all application services in Windows using a script
The StopAllServers.cmd script included with IBM OpenPages GRC Platform will stop all OpenPages
services in the proper sequence.

Stopping the application server prevents the OpenPages application from being accessed.

Important: If you are running OpenPages in a load-balanced environment, you must stop the server on
each cluster member first before stopping the cluster administrator.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Launch a Command Prompt window (using the Run as Administrator option).
3. Navigate to the <OP_HOME>\bin directory.
4. Enter the following command to launch a script that stops the OpenPages services:

StopAllServers.cmd <username> <password>

Where <username> and <password> are the administrative user name and password for IBM
WebSphere Application Server.

When all services have been stopped, the Command Prompt window closes.

Stopping application services individually using Windows services
You can stop the IBM OpenPages GRC Platform application without shutting down or rebooting the
computer.

Stopping the application server prevents the application from being accessed.

Important: If you are running OpenPages in a load-balanced environment, you must stop the server on
each cluster member first before stopping the cluster administrator.

Use the following steps to stop OpenPages services manually.

Important: Stopping the OpenPages GRC Platform Admin service before you stop each cluster member
causes the OpenPages application to stop on all servers. This could result in the loss of data and other
problems.

In the Windows environment, you stop the OpenPages GRC Platform application by stopping the required
OpenPages services.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Click the Windows Start menu and select All Programs.
3. From the Administrative Tools list, select Services.
4. Stop the IBMWAS<version>Service - <OpenPages-node-server-name>Server<#> services.
5. Stop the IBMWAS<version>Service - <OpenPages-node-name> service.
6. Stop the IBMWAS<version>Service - <OpenPages-dmgr-name> service, if present.

Results

When the services are stopped successfully, the OpenPages application is properly shut down.

Stopping all application servers in AIX and Linux using a script
The stopAllServers.sh script included with IBM OpenPages GRC Platform stops all OpenPages
services in the proper sequence.

Stopping the application server prevents the application from being accessed.
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Important: If you are running OpenPages GRC Platform in a load-balanced environment, you must stop
the server on each cluster member first before stopping the cluster administrator.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Use an AIX or Linux shell to navigate to the <DMGR profile directory>/<OpenPages-dmgr-
name>/bin directory, where <DMGR profile directory> is the same directory as the one provided
on the installer's Deployment Manager card.

3. Enter the following command to launch a script that stops OpenPages GRC Platform services:

./stopAllServers.sh <username> <password>

Where <username> and <password> are the administrative user name and password for the IBM
WebSphere Application Server.

Stopping application servers in AIX and Linux individually using scripts
In the AIX and Linux environments, you run a set of scripts to stop the IBM OpenPages GRC Platform
application.

Stopping the application server prevents the application from being accessed.

Important: If you are running OpenPages in a load-balanced environment, you must stop the server on
each cluster member first before stopping the cluster administrator.

Procedure

1. Log on to the OpenPages GRC Platform application server as a user with administrative privileges.
2. Go to the <OP_HOME>/profiles/<OpenPages-node-name>/bin directory.
3. Enter the following commands, in the order specified, to launch a script that stops the OpenPages

application server and the OpenPages Node Agent.

./stopServer.sh -username <username> -password <password> 
<OpenPages-node-server-name>Server<#>

./stopNode.sh -username <username> -password <password>

Where <OpenPages-node-server-name> is the name of the current server within the
<OpenPages-node-name> node that the current server is in, and <#> is the number of the server
within that node. For example, OpenPagesNodeServerServer1.

Where <username> and <password> are the administrative user name and password for IBM
WebSphere Application Server.

If there is more than one managed server on the current system, you must run the stop server script
(./stopServer.sh <OpenPages-node-server-name>Server<#>) for each managed server
before running the stop node agent script (./stopNode.sh). The managed servers can be stopped in
any order.

4. After the scripts complete successfully, go to the <DMGR profile directory>/<OpenPages-
dmgr-name>/bin directory where <DMGR profile directory> is the same directory as the one provided
on the installer's Deployment Manager card.

5. Enter the following command to launch a script that stops the OpenPages GRC Platform Deployment
Manager:

./stopManager.sh -username <username> -password <password>

Where <username> and <password> are the administrative user name and password for the IBM
WebSphere Application Server.
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When the script completes successfully, the OpenPages application is properly shut down.

Starting and stopping the Oracle database server in a Windows environment
You can start or stop database services using Windows services that are associated with the IBM
OpenPages GRC Platform Oracle database instance.

Note: This information applies only to Windows environments.

Table 57: OpenPages GRC Platform Oracle services on Windows

Service Name Description

OracleOraDB12Home1TNSListener Runs the Oracle Database listener service that
connects the user to the Oracle database instance.

OracleService<SID> Used to start and stop the Oracle database
instance.

Where <SID> represents the database instance
identifier, for example OP.

OracleVssWriter<SID> Where <SID> represents the database instance
identifier, for example OP.

Use the following steps to start or stop database services using Windows Services.

Procedure

1. Log on to the database server as a user with administrative privileges.
2. Click the Windows Start menu and select All Programs.
3. From the Administrative Tools list, select Services.
4. For each database service listed in the previous table, do the following:

• To start the server, right-click the service name and select Start.
• To stop the server, right-click the service name and select Stop.

Starting and stopping the Oracle database server in an AIX and Linux
environment

Use the following steps to start or stop the Oracle database server.

Procedure

1. Log on to the database server as a user with administrative privileges.
2. In a shell window, navigate to the following directory:

<ORACLE_HOME>/bin

For example: /opt/oracle/app/product/12.1/dbhome_1/bin.
3. To start Oracle, do the following steps.

a) Log in to SQL*Plus.

sqlplus / as sysdba
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b) Run the following command to start Oracle.

startup

4. To stop Oracle, do the following steps.
a) Log in to SQL*Plus.

sqlplus / as sysdba

b) Run the following command to start Oracle.

stop immediate

Starting and stopping the Cognos services
There are different procedures to start or stop the Cognos services in the Windows, AIX and Linux
environments. The services are the IBM Cognos service and the OpenPages Framework Model
Generator service

These procedures are:

• “Using the IBM Cognos configuration tool to start and stop the IBM Cognos service” on page 264
• “Using the Windows operating system to start and stop the IBM Cognos service” on page 265
• “Using the AIX or Linux operating system to start and stop IBM Cognos service” on page 265
• “Starting and stopping the OpenPages GRC Platform Framework Model Generator service on Windows”

on page 265
• “ Starting and stopping the OpenPages GRC Platform Framework Model Generator service on AIX or

Linux” on page 265

Using the IBM Cognos configuration tool to start and stop the IBM Cognos service
You can use the IBM Cognos Configuration tool to start or stop the IBM Cognos service.

Note: The IBM Cognos Configuration tool displays the status of the start-up, which can be helpful with
troubleshooting, if necessary.

Procedure

1. Log on to the reporting server as a user with administrative privileges.
2. Start the IBM Cognos Configuration tool as follows:

a) Open a Command Prompt window (using the Run as Administrator option), or AIX or Linux shell,
and navigate to the <COGNOS_HOME>/bin64 directory.

<COGNOS_HOME> represents the installation location of the Cognos application. By default, this is:
Windows

cogconfig.bat
AIX and Linux

./cogconfig.sh
b) Execute one of the following commands to open the tool:

3. Do one of the following:

• To start the server, click Actions | Start. (It may take several minutes for the service to start the
first time.) If the Start option is not available, the service has already started.

• To stop the service, click Actions | Stop.
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Using the Windows operating system to start and stop the IBM Cognos service
Use the following steps to start or stop the IBM Cognos service in a Windows environment using
Windows Services.

Procedure

1. Log on to the reporting server as a user with administrative privileges.
2. Click the Windows Start menu and select All Programs.
3. From the Administrative Tools list, select Services.
4. Do one of the following:

• To start the server, right-click the IBM Cognos service and select Start.
• To stop the server, right-click the IBM Cognos service and select Stop.

Using the AIX or Linux operating system to start and stop IBM Cognos service
Use the following steps to start or stop the IBM Cognos service in an AIX or Linux environment using
command-line scripts.

Procedure

1. Log on to the reporting server as a non-root user with administrative privileges.
2. Launch an AIX or Linux shell and navigate to the bin directory as follows:
<COGNOS_HOME>/bin64

Where
<COGNOS_HOME> is the installation location of the Cognos application.

3. Do one of the following:

• To start the service, enter the following command: ./cogconfig.sh -s
• To stop the service, enter the following command: ./cogconfig.sh -stop

Starting and stopping the OpenPages GRC Platform Framework Model Generator service
on Windows

Use the following steps to start or stop the IBM OpenPages GRC Platform Framework Model Generator
service in a Microsoft Windows environment.

Procedure

1. Log on to the reporting server as a user with administrative privileges.
2. Click the Windows Start menu and select All Programs.
3. From the Administrative Tools list, select Services.
4. Do one of the following:

• To start the server, right-click the IBMOpenPagesFrameworkModelGenerator service and select
Start.

• To stop the server, right-click the IBMOpenPagesFrameworkModelGenerator service and select
Stop.

Starting and stopping the OpenPages GRC Platform Framework Model Generator service
on AIX or Linux

Use the following steps to start or stop the IBMOpenPagesFrameworkModelGenerator service in an
AIX or Linux environment.

Procedure

1. Log on to the reporting server as a non-root user with administrative privileges.
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2. Open an AIX or Linux shell as a user with administrative privileges and navigate to the following
directory:

<CommandCenter_Home>/wlp/bin

Where <CommandCenter_Home> is the installation location ofIBM OpenPages CommandCenter. By
default, this is: /opt/OpenPages/CommandCenter.

3. To start the service, run the following command.

server start IBMOpenPagesFrameworkModelGenerator

4. To stop the service, run the following command.

server stop IBMOpenPagesFrameworkModelGenerator
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Chapter 12. Single sign-on integration for the
OpenPages GRC Platform application server and the
reporting server

IBM OpenPages GRC Platform can integrate into a number of single sign-on solutions, such as IBM Tivoli
Federated Identity Manager (TFIM), CA SiteMinder, and Microsoft Active Directory Federation Services
(ADFS). You can also configure the reporting server for single sign-on.

To integrate single sign-on, configure the settings in the OpenPages GRC Platform application interface.

You can use one of the following options to configure single sign-on:

• Header-based single sign-on

For more information, see “Configuring header-based single sign-on” on page 267.
• SAML V2.0 single sign-on

For more information, see the "Single Sign On (SSO) for OpenPages (on WebSphere) using the Microsoft
Active Directory Federation Server (ADFS) " blog in the GRC Power Plant community.

• SPNEGO single sign-on

For more information, see the "Configuring SPNEGO SSO for IBM OpenPages GRC Platform (on
WebSphere) using the Microsoft Active Directory Federation Server (ADFS) " blog in the GRC Power
Plant community.

Attention: OpenPages user names are case-sensitive. If you are using single sign-on (SSO) or
LDAP authentication, the user name you choose here must match the user name you enter in the
SSO or LDAP system.

Configuring header-based single sign-on
To integrate header-based single sign-on for IBM OpenPages GRC Platform applications, complete the
following steps.

Procedure

1. Start the OpenPages GRC Platform services.
2. Log on to the OpenPages application interface as a user with administrative privileges.
3. Update the Show Hidden Settings setting.

a) Click Administration > Settings > Common > Configuration.
b) Set the value of Show Hidden Settings to true:

4. Update the Class Name, Session Attribute, and Username Attribute settings.
a) Click Platform > Security > Single Sign On > Implementations > Header-based.
b) Set the value of Class Name to com.openpages.singlesignon.HTTPHeaderBasedModule.
c) Update the value of Session Attribute to match the session attribute for your single sign-on

system.

The following examples show values for the Session Attribute parameter.

• Using SiteMinder 6.0, the value of the Session Attribute parameter is SMSERVERSESSIONID
• Using Tivoli® Access Manager 6.1, the value of the Session Attribute parameter is iv_creds

d) Update the value of Username Attribute to match the user name attribute for your single sign-on
system.
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The following examples show values for the Username Attribute parameter.

• Using SiteMinder 6.0, the value of the Username Attribute is SMUSER
• Using Tivoli Access Manager 6.1, the value of the Username Attribute is iv_user

5. Reset the value of Show Hidden Settings to false.
6. Click Save.
7. Update the default file name and redirect to the following path: /home.do (rather than /openpages

or /openpages/log.on.do).

What to do next

You must now enable single sign-on and set the password to never expire.

Configuring the single sign-on logout destination
To securely log out of an IBM OpenPages GRC Platform application session where single sign-on is
enabled, configure the system to redirect the user.

Logging out of the OpenPages GRC Platform application does not automatically log the user out of a single
sign-on system. If you use Back in the web browser to reenter the OpenPages application, your session is
re-created. The session uses the existing, valid third-party credentials.

Procedure

1. Log on to the OpenPages application interface as a user with administrative privileges.
2. Click Administration > Settings.
3. Expand Platform > Security.
4. Click Logout URL to open the detail page.
5. In the Value box, type a fully qualified URL.
6. Click Save.

Enabling single sign-on
After you configure single sign-on, you must enable it and set the password to never expire on the user
profile.

Procedure

1. Complete the following steps to enable single sign-on.
a) Click Administration > Settings.
b) Expand Platform > Security > Single Sign On
c) Click OP and set the value to true.
d) Click Save.
e) Click SOX and set the value to true.
f) Click Save.

2. Set the password to never expire.

You must complete these steps for each user individually.

a) Click Administration > Users.
b) Type a user name in the View, Edit, or Delete User box and select the user that you want to edit.
c) Click Reset Password.
d) Ensure the User must change password at next logon option is not selected.
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e) Select the Password never expires option.
f) Click Save.

Disabling single sign-on for OpenPages GRC Platform
You can disable single sign-on for IBM OpenPages GRC Platform.

Procedure

1. Start the OpenPages GRC Platform services.
2. Log on to the OpenPages application as a user with administrative permissions.
3. Click Administration > Settings.
4. Disable single sign-on.

a) Expand Platform > Security > Single Sign On.
b) Click OP to open its detail page.
c) Set the Value to false.
d) Click Save.
e) Click SOX to open its detail page.
f) Set the Value to false.
g) Click Save.

Configuring single sign-on for a reporting server
If you are using single sign-on (SSO), update the JSP responsible for the single sign-on re-directions by
deploying a new file.

Load the JavaServer Pages (JSPs) through the ObjectManager tool by using the CommandCenter-
integration-op-config.xml file. The file is in the OpenPages installation media.

Procedure

1. Log on to a computer that has SQL*Plus and access to the database server.

Note: For AIX installations, log on as the opuser or a non-root user who has administrative privileges.
2. Copy the OP_<version>_Non_Embedded/OP_<version>_Configuration/loader-data/
commandcenter directory to the local system.

3. Go to the <OP_HOME>/bin directory.
4. Run the following command:

ObjectManager load config OpenPagesAdministrator password 
   path-to-loader-file CommandCenter-integration 
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Chapter 13. QRadar integration
The IBM QRadar integration project is an optional project that you can install to import offenses from
QRadar to IBM OpenPages GRC Platform as incidents.

You must complete the following steps to install and configure the QRadar integration project.

• Ensure IBM QRadar is installed.
• Install IBM Tivoli Directory Integrator 7.1.1 and then install IBM Tivoli Directory Integrator Fix Pack 4

from the OpenPages GRC Platform installation media.
• Configure Tivoli Directory Integrator to connect to QRadar.

For more information, see “Setting up the QRadar SSL certificate” on page 271.
• Import the assembly line.

For more information, see “Importing the assembly line for QRadar” on page 272.
• Configure the property files.

For more information, see “Configuring the QRadar connector properties file” on page 273 and
“Configuring the QRadar connector passwords properties file” on page 273.

Setting up the QRadar SSL certificate
You must specify the SSL certificate that allows IBM Tivoli Directory Integrator (TDI) to connect to the
QRadar server.

Procedure

1. Obtain the QRadar SSL certificate:
a) Log in to the QRadar console.
b) Use the certificate management tool in your browser to export the QRadar certificate to a file on the

system where TDI is installed. For example, in Internet Explorer, click Tools > Internet Options.
Click the Content tab, and then click Certificates.

Alternatively, enter the following command to retrieve the certificate in Base-64 encoded X509
format from the QRadar server.

Attention: The command assumes that the openssl command is in the path. Replace
<host> with the fully qualified host name of your QRadar server, and replace <port> with the
port number being used. If no port number is specified in the URL when logging in to the
QRadar console, specify port 80 for HTTP, or port 443 for HTTPS.

• Windows (You might need to press CONTROL-C to end the command):

openssl s_client -showcerts -connect host:port | openssl 
   x509 -outform PEM > mycertfile.pem

• UNIX:

openssl s_client -showcerts -connect host:port 
   </dev/null 2>/dev/null | openssl x509 -outform PEM > mycertfile.pem

The Base-64 X509 encoded certificate will be in the mycertfile.pem file.
2. From the Tivoli Directory Integrator Configuration Editor, add the certificate to Tivoli Directory

Integrator.
a) Click Key Manager, then click the Open icon.



b) Select JKS from the Key database type list.
c) Click Browse, and locate the <TDI_Solutions_user_home>/Solutions/serverapi/
testadmin.jks file, then click OK.

d) At the password prompt, type administrator.
e) Select Signer Certificates from the Key database content.
f) Click Add and browse to the location of the certificate that you obtained in step 1.
g) Specify the label for the certificate as administrator, then click the Save icon.
h) When you are prompted for the password, type administrator.
i) Close the dialog box.

3. Copy testadmin.jks into the following directories. Some of these directories might not exist,
depending on the options that were chosen when Tivoli Directory Integrator was installed.

If required, back up the existing file in each directory before you copy the updated version.

<TDI_home>/win32_services/serverapi (Windows platforms only)

<TDI_home>/serverapi

<TDI_Solutions_user_home>/serverapi

Importing the assembly line for QRadar
To run the QRadar assembly line, you import the qradar_integration.xml file as a new Tivoli
Directory Integrator project.

About this task
An assembly line is commonly referred to as an AL in the Tivoli Directory Integrator documentation.

Procedure

1. Extract the Tivoli Directory Integrator project file.
a) Open qradar-integration.zip from the following location:

<OP_HOME>/OpenPages/integrations/ITG
b) Extract the files to a temporary directory.

2. Import qradar_integration.xml from the extracted files as a new project in IBM Tivoli Directory
Integrator.
a) Click File > Import > IBM Tivoli Directory Integrator > Configuration.
b) Click Next.
c) Select New Project in the Project list.
d) In the Configuration File field, browse to qradar_integration.xml that you extracted and

select it.
e) Click Finish.
f) In the New Project field, type qradar_integration.

The project is created in your workspace location.
g) Click Finish.

3. Copy the connector.properties and Connector-Passwords.properties files from the files
you extracted in step 1 to the Runtime-qradar_integration folder in your Tivoli Directory
Integrator workspace location.

Note: If the Runtime-qradar_integration folder is not visible in the Tivoli Directory Integrator
Configuration Editor, right-click the qradar_integration.xml project in the TDI Configuration
Editor and click Refresh.
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Configuring the QRadar connector properties file
You must update the connector.properties file with the correct configuration for the connector
components.

About this task

The qradar_integration.zip located in the <OP_ROOT>/integrations/ITG directory contains the
qradar_integration.xml file. This is the project file that is used to import the
qradar_integration project into Tivoli Directory Integrator.

There are also two text properties files that you can use to configure the connector-related properties in
the respective Resources > Properties components of the qradar_integration project. Use the
connector.properties text properties file to set or update the property values in the connector
property store. Use the Connector-Passwords.properties text properties file to set or update the
property values in the Connector-Passwords property store.

The non-encrypted connector properties are maintained in the connector.properties file. This file is
one of the two property files that you manually copy into the Runtime-qradar_integration folder
after you import the qradar_integration project into your Tivoli Directory Integrator deployment. The
properties in this file can be used to set or update the values that are stored in the connector property
store located under the Resources > Properties project folder.

The connector.properties file has three sections: one shared area for email settings; one section
specifically for the QRadar API Connector properties; and one section for the OpenPages Connector
properties. Mandatory fields are marked as REQUIRED in the text properties files, and are marked with an
asterisk (*) when viewed from the TDI Configuration Editor's Connection Editor in the Connection tab for
the connector component. You can use the example values shown for each property for hints on what to
specify for that property.

Procedure

1. From the Tivoli Directory Integrator Configuration Editor, open the qradar_integration project.
2. In the Navigator pane, expand Runtime-qradar_integration.
3. Right-click the connector.properties file and open it using the Text Editor option.
4. Set or change the property values.
5. Save the changes and exit the text editor.
6. In the Navigator pane, expand Resources > properties.
7. Right-click the connector object and click Properties Editor.
8. Click Read properties from Server.
9. Click Send properties to Server.

10. Click the Save icon to save the changes in Tivoli Directory Integrator connector property store.
Close the connector editor. If you are prompted to save the properties again, click Yes.

Configuring the QRadar connector passwords properties file
You must update the Connector-Passwords.properties file with the correct OpenPages password
and QRadar API token values for the connector components.

About this task

The connector components use two encrypted properties: the op_conn_password property and the
qradarToken property. Both properties are maintained in the Connector-Passwords.properties file.
This file is one of the two properties files that you manually copy into the Runtime-
qradar_integration folder after you import the qradar_integration project into your Tivoli
Directory Integrator deployment. You can use the properties in this file to set or update the values that
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are maintained in the Connector-Passwords password property store located under the Resources >
Properties project folder.

Procedure

1. Obtain the QRadar API token value:
a) Log in to the QRadar console.
b) Click Admin > Authorized Services.
c) Copy the Authentication Token value from the REST Service service name line item for use in

step 5.
2. From the Tivoli Directory Integrator Configuration Editor, open the qradar_integration project.
3. In the Navigator pane, expand Runtime-qradar_integration.
4. Right-click the Connector-Passwords.properties file and open it using the Text Editor option.
5. Set or change the password-related property values.

a) Enter a clear-text value for the op_conn_password property after the = character.
b) Enter the value that you obtained from the QRadar server in step 1 after the = character for the

qradarToken property.

Note: Do not remove the {protect}- prefix from any property entry in the file. If you are updating
an already-encrypted value, you can either leave the {encr} prefix after the equal sign (=) character,
or you can remove it. If the {encr} prefix is removed, it is automatically reinserted after the equal
sign (=) character as part of the encryption processing that occurs during step 11.

6. Save the changes and exit the text editor.
7. In the Navigator pane, expand Resources > Properties.
8. Right-click the Connector-Passwords object and click Properties Editor.
9. Click Read properties from Server.

10. Click Send properties to Server.
11. Click the Save icon to save the changes in Tivoli Directory Integrator Connector-Passwords

password property store. Close the Connector-Passwords editor. If you are prompted to save the
properties again, click Yes.

Note: After this step is complete, the values in the Connector-Passwords property store and the
values in the Connector-Passwords.properties text file are automatically encrypted. If needed,
the {encr} tag is automatically inserted before the property value of each property in the
Connector-Properties.properties text file.
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Chapter 14. IBM OpenPages GRC SDI Connector for
UCF Common Controls Hub

IBM OpenPages GRC SDI Connector for UCF Common Controls Hub is an optional connector that you can
install. Use the connector to import data from the Unified Compliance Framework (UCF) Common
Controls Hub into IBM OpenPages GRC Platform.

You must have a UCF Common Controls Hub Basic Subscription with the API Access add-on to use the
connector.

Complete the following steps to install and configure the UCF connector.

• Obtain an API token from UCF. To get your token, log in to UCF Common Controls Hub. Click Settings >
API Manager > API Keys. Click Create Credentials.

• Install IBM Tivoli Directory Integrator 7.1.1 and then install IBM Tivoli Directory Integrator Fix Pack 4
from the OpenPages GRC Platform installation media.

The server where you install IBM Tivoli Directory Integrator must be able to reach UCF Common
Controls Hub and the IBM OpenPages REST API.

Note: IBM Security Directory Integrator is the latest name for IBM Tivoli Directory Integrator. You might
see TDI and SDI used interchangeably in the documentation.

• Install IBM OpenPages GRC SDI Connector for UCF Common Controls Hub. For more information, see
“Installing IBM OpenPages GRC SDI Connector for UCF Common Controls Hub” on page 275.

• Import the assembly lines.

For more information, see “Importing the assembly lines for UCF” on page 276.
• Configure the property files.

For more information, see “Configuring the connection information” on page 277.
• Configure OpenPages GRC Platform.

For more information, see “Configuring OpenPages for UCF integration” on page 278.

For information about how to use the UCF connector, see "IBM OpenPages GRC SDI Connector for UCF
Common Controls Hub integration" in the IBM OpenPages GRC Administrator's Guide.

Installing IBM OpenPages GRC SDI Connector for UCF Common Controls
Hub

You must run the IBM OpenPages GRC SDI Connector for UCF Common Controls Hub installation program
on the OpenPages admin application server.

Procedure

1. Download the installer package from IBM Passport Advantage.
2. Extract the package files.
3. On the admin application server, run IBM Installation Manager.
4. Add the UCF connector repository to IBM Installation Manager.

a) Click File > Preferences.
b) Click Repositories and then click Add Repository.
c) Select the UCF connector installer package.
d) Click the repository.config file.
e) Click OK.

http://www.ibm.com/software/passportadvantage/pao_customer.html


f) Click OK to return to the main IBM Installation Manager page.
5. Click Install.
6. Select IBM OpenPages GRC SDI Connector for UCF Common Controls Hub and Version 7.4, and

click Next.
7. Accept the license agreement and click Next.
8. Type the location of your IBM OpenPages GRC Platform installation directory (OP_HOME).
9. Click Next.

10. Click Next. If any errors appear on the page, follow the instructions to fix them before you continue.
If you see warning messages about the 64-bit version of IIM, you can ignore them.

11. Click Install.

Importing the assembly lines for UCF
To import the UCF assembly lines, you import the ucf_integration.xml file as a new Tivoli Directory
Integrator project.

About this task

The ucf_integration.xml file is located in the <OP_HOME>/integrations/UCF directory. This is the
project file that you use to import the assembly lines and other project files into Tivoli Directory
Integrator.

The UCF connector uses three assembly lines to import objects.

• UCF Authority Documents to OP Mandates
• UCF Citations to OP Submandates
• UCF Controls to OP Requirements

An assembly line is commonly referred to as an AL in the Tivoli Directory Integrator documentation.

Procedure

1. Go to the <OP_HOME>/integrations/UCF directory and locate the ucf_integration.xml file
2. Copy the file to the server where IBM Tivoli Directory Integrator is installed.
3. Import the ucf_integration.xml file as a new project in IBM Tivoli Directory Integrator.

a) Click File > Import > IBM Tivoli Directory Integrator > Configuration.
b) Click Next.
c) Select New Project in the Project list.
d) Click File.
e) Click the browse button next to the Configuration File field. Select the ucf_integration.xml

file.
f) Click Finish.
g) Type a name for the project, such as ucf_integration.
h) Click Finish.

The project is displayed in the TDI Configuration Editor and the project files are created in your
TDI workspace directory.

4. Copy the UCF connector property files into your project runtime Tivoli Directory Integrator workspace
directory.

The workspace directory is where the projects, files, and folders that you create in TDI are stored, for
example C:\Users\<user>\Documents\TDI\workspace\ucf_integration\Runtime-
ucf_integration.

a) Go to the <OP_HOME>/integrations/UCF directory.
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b) Copy the following files to the Runtime-ucf_integration directory.

• passwords.properties
• op_client.properties

5. Right-click the ucf_integration project in the TDI Configuration Editor and click Refresh.

Results
In Tivoli Directory Integrator, the AssemblyLines folder contains the UCF assembly lines. In addition, the
Resources > Properties folder contains the UCF property files.

Configuring the connection information
You must configure the connection information that the UCF connector uses to connect to IBM
OpenPages GRC Platform and to UCF Common Controls Hub. You configure the connection information by
updating property files and by entering passwords in the Tivoli Directory Integrator Configuration Editor.
Do this procedure after you import the assembly lines.

About this task

The UCF connector includes two text files that contain the assembly line properties.

The property files are in the Runtime-ucf_integration folder of the ucf_integration project.

op_client.properties
The op_client.properties file stores the connection information for OpenPages.

passwords.properties
The passwords.properties file contains the OpenPages password and your UCF token. The values
are encrypted.

Note: Do not edit this file. Set the values by using the Tivoli Directory Integrator Configuration Editor.

Procedure

1. From the Tivoli Directory Integrator Configuration Editor, open the ucf_integration project.
2. In the Navigator pane, expand Runtime-ucf_integration.
3. Right-click the op_client.properties file and click Text Editor.
4. Set or change the property values.

Table 58: Properties in the op_client.properties file

Property Description

op_api_root The OpenPages REST API root

The default (typical) value is /grc/api. The
op_api_root is appended to the op_url to form the
full URL to access the OpenPages REST API.

op_url The OpenPages URL

Use the format https://<host>:<port>
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Table 58: Properties in the op_client.properties file (continued)

Property Description

op_user The OpenPages user name that the UCF connector uses
to log in to OpenPages

Use an account with administrative privileges. The user
account must have security permissions to create and
update the mandate, submandate, and requirements
object types.

For example:

op_api_root=/grc/api
op_url=https://op_server:10111
op_user=ucf

5. Save the changes and exit the text editor.
6. Right-click the password.properties file and click Text Editor.
7. Type the password of the OpenPages user that you used in the op_client.properties file.
8. Enter your UCF Common Controls Hub token in the ucf_api_token parameter.

To get your token, log in to UCF Common Controls Hub. Click Settings > API Manager > API Keys.
Click Create Credentials.

If you are unable to create a token, contact UCF Common Controls Hub.
9. Save the changes and exit the text editor.

The values in the password.properties file are automatically encrypted.
10. Refresh the property files and the connectors with the updated connection information.

a) In the Navigator pane, expand Resources > Properties.
b) Right-click op_client, and then click Open.
c) Click Read properties from Server, and then click Send properties to Server.
d) Click Save, and then close the window.
e) Right-click passwords, and then click Open.
f) Click Read properties from Server, and then click Send properties to Server.
g) Click Save, and then close the window.

Configuring OpenPages for UCF integration

Importing business entities
Import the business entities that are used by UCF into OpenPages GRC Platform. When the UCF connector
imports data into OpenPages, the business entities are used for the imported objects.

About this task

The UCF Entities.xlsx file contains the business entity structure for UCF. Import this file by using
FastMap.

Procedure

1. Log in to OpenPages as a user with administrative privileges.
2. Click Reporting > FastMap Import.
3. Click Choose File and select the UCF Entities.xlsx file.
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The file is located in the <OP_HOME>/integrations/UCF directory.
4. Click Import data.
5. Review the verification report, and then click Import data.

The import process begins. The progress of the import is displayed in the FastMap Import Status
window. Click Refresh to update the window.

6. Verify the import.
a) Log in to OpenPages as a user with administrative privileges.
b) Click Organization > Business Entity Overview.
c) Expand Library > UCF.

The business entity UCF is updated. It has two child entities, Authority Documents and Harmonized
Controls.

Note: If UCF Common Controls Hub adds new control impact zones or adds new authority document
guidance areas in future, you need to update OpenPages. For more information, see "Update business
entities, fields, and field groups" in the IBM OpenPages GRC Administrator's Guide.

Updating object type relationships for UCF
The UCF connector requires an additional object type relationship. SOXBusEntity must be a parent of
Requirement. Use ObjectManager to load the object relationship.

Procedure

1. Log on to the OpenPages administrative application server.
2. Copy the req-op-config.xml file to the administrative application server.

The req-op-config.xml is in the <OP_HOME>/integrations/UCF directory.
3. Open a command line. If you are using Microsoft Windows, open a command prompt with the Run as

Administrator option.
4. Go to the <OP-HOME>/bin directory.
5. Run the following command.

Replace <loader-file-path> with the location of the req-op-config.xml file.

ObjectManager.cmd|sh l c <OpenPages Administrator user> 
   <OpenPages Administrator password> 
   <loader-file-path> req

6. If you encounter any errors, review the log file, <OP_HOME>/bin/logs/ObjectManager.log.
7. Verify the update.

a) Log in to OpenPages.
b) Click Administration > Object Types.
c) Click Requirement.
d) Click Parent Associations. Verify that SOXBusEntity is in the list.

Updating UCF field groups
You need to update the UCF field groups and fields.

About this task

You need to update the enumerated string values for the following:

• UCF-Mand field group, UCF Category field
• UCF-SubMand field group, UCF Guidance Area field
• UCF-Req field group, UCF Guidance Area field

IBM OpenPages GRC SDI Connector for UCF Common Controls Hub  279



The changes that you need to make are the same for each field.

Procedure

1. Log in to OpenPages as a user with administrative privileges.
2. Click Administration > Field Groups.
3. Click UCF-Mand, and then click UCF Category.
4. Add the following values:

• Risk Management Organizations
• Banking and Finance Organizations
• Energy Organizations
• Healthcare and Life Science Organizations
• Payment Card Organizations
• Records Management Organizations
• Security and Privacy Organizations
• International
• North America
• Australia-Oceania
• Asia
• Configuration
• South America
• Africa
• Europe

5. Click UCF-SubMand, and then click UCF Guidance Area.
6. Repeat steps 4 and 5 to update the values.
7. Click UCF-Req, and then click UCF Guidance Area.
8. Repeat steps 4 and 5 to update the values.

Results

The field definitions for UCF are updated.

Note: If UCF Common Controls Hub adds new authority document categories or new geographies, update
the UCF field definitions to add the new values.
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Chapter 15. Approval app
The approval app is an optional feature that leverages the power of IBM OpenPages GRC Platform and
provides an easy-to-use interface for quickly taking action on a review, approval, or attestation request
with confidence and full knowledge of the context surrounding the request. The approval app works with
objects that are set up for the configurable lifecycle.

By using the approval app, a casual or infrequent user of IBM OpenPages GRC Platform is able to make
well-informed decisions for GRC tasks guided by information from the system quickly and easily, without
the need for extensive training in OpenPages. If you want to see all of the items sent to you in the
approval app, you can go to your To Do list by clicking the IBM OpenPages GRC Platform logo. You simply
make the decision (or respond to certification language or questions), with your comments if necessary,
and click the relevant button to submit. You can use this feature on tablets and mobile devices as well, for
increased flexibility.

Deployment process overview for the approval app
If you upgraded IBM OpenPages GRC Platform and you previously did not use the approval app, you need
to deploy and configure it.

If you deployed the approval app in version 7.2.0.1 or later, you need to upgrade the approval app. You do
not need to deploy it. For more information, see “Upgrade the approval app” on page 291.

If you did a fresh installation of OpenPages, not an upgrade, you do not need to deploy the approval app.
The app is installed when you install OpenPages. You can configure the approval app. For more
information, see the IBM OpenPages GRC Administrator's Guide.

If you upgraded OpenPages and you are deploying the approval app for the first time, complete these
steps to deploy the approval app:

1. Complete the pre-deployment tasks for the approval app. Check system requirements and back up
your environment. For more information, see “Pre-upgrade tasks for the approval app” on page 282.

2. Make sure that you have all of the object types and field groups - along with the associations - loaded
onto your system. For more information, see “Ensuring that you have the fields and field groups
required for the approval app profile ” on page 283.

3. If you want to configure the approval app profile for selected object types only, exclude the object
types that you don't want. For more information, see “Excluding object types from the approval app
profile ” on page 284.

4. Modify the Trigger Configuration Files registry setting. For more information, see “Updating triggers
for the approval app ” on page 289.

5. Load the approval app profile and enable the app. For more information, see “Loading the approval app
profile ” on page 289.

6. Complete the approval app deployment. For more information, see “Completing the approval app
deployment” on page 291.

Depending on your environment, you might need to do some additional tasks.

1. If you want to report on the fields and field groups for the approval app, regenerate the reporting
framework. For more information, see "Generating the reporting framework V6" in the IBM OpenPages
GRC Administrator's Guide.

2. If you needed to add the object types, fields, and field groups that are required for the approval app
and you use global search, re-create the search index. See “Creating the global search index after
upgrading” on page 186.



Pre-upgrade tasks for the approval app
Before you upgrade the approval app, ensure that your system meets the system requirements, back up
IBM OpenPages GRC Platform files, and gather the information that is required to complete the
installation.

Ensure that you completed the upgrade to version 7.4. The OpenPages database upgrade must be
complete before you upgrade the approval app.

If you want to be able to restore your environment to its current state, back up the OpenPages application
environment, the IBM Cognos environment, and the database.

Gather the following information. You need this information to complete the installation.

• The user name and password of the OpenPages administrator on the admin application server
• The path of the OpenPages home directory, OP_HOME

Preparing for the deployment of the approval app
You must perform some preparation tasks before you deploy the approval app.

Procedure

1. Complete the upgrade to IBM OpenPages GRC Platform version 7.4.
2. Ensure that there are no long running OpenPages processes, such as a FastMap import process or a

global search indexing process.
3. Check the status of the OpenPages servers. Verify that the following servers are running: the

OpenPages application servers (admin and non-admin), reporting servers (active and standby), the
Framework Model Generator, the database server, and the search server (optional).

For information about starting and stopping servers, see Chapter 11, “Starting and stopping servers,”
on page 253.

Supported data types and field types in the approval app
These data types and field types are supported by the approval app.

Note: If a field type is configured but not supported, the field type is ignored, that is, no error is produced.

• Date
• Boolean
• Integer
• Decimal
• Currency. For more information about the currency data type, see Data types.
• The following system fields: Name, Description, Created By, Created On, Modified By, and Modified On.
• All text field types: URL, text box, text area, rich text. Includes support for rendering mathematical

equations in rich text fields.
• All seven actor field display types: User Dropdown, User Selector, User/Group Selector, Multi User

Selector, Multi User Group Selector, and Multi Group Selector.
• Business entity selector
• File attachments, with a link to view each attachment.
• Single-select enumerated fields and multi-select enumerated fields.
• Primary Parent hierarchy fields and Business Entity hierarchy fields.
• Hidden dependent fields.

If you have set up Field Level Security in OpenPages for specific fields, the value of the field in the
approval app is hidden by a black bar with the word Confidential on it. For more information, see Field
Level Security.
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The approval app does not support the following data types and field types:

• Report fragments
• Computed fields
• The following system fields: Folder or Location, Comments, Derived fields, and Orphan fields.

Ensuring that you have the fields and field groups required for the approval app profile
Make sure that you have all of the out-of-the-box fields and field groups required for the approval app
profile loaded onto your system.

About this task

The approval app profile supports four object types (objects in parentheses are the related objects):

• SOXControl (SOXBusEntity, SOXDocument, SOXTest, SOXIssue, SOXRisk, SOXProcess)
• SOXIssue (SOXBusEntity, SOXTask (Action Item), SOXDocument)
• Incident (SOXBusEntity, SOXIssue, SOXDocument)
• LossEvent (SOXBusEntity, LossImpact, LossRecovery, SOXIssue, SOXRisk, SOXDocument, SOXProcess)

These object types use the following field groups, as well as the field groups that are loaded as a part of
approval app installation:
SOXRisk

Uses OPSS-Rsk, OPSS-Risk, OPSS-Risk-Qual, OPSS-Risk-Quant, OPSS-Risk-Accp.
SOXTest

Uses OPSS-Shared-Test, OPSS-Test.
SOXTask

Uses OPSS-AI.
SOXIssue

Uses OPSS-Iss.
SOXControl

Uses OPSS-Ctl, OPSS-Ctl-Fin.
Incident

Uses OPSS-Inc, OPSS-Inc-IT.
LossEvent

Uses OPSS-LossEv, OPSS-Shared-Basel.
LossImpact

Uses OPSS-LossIm.
LossRecovery

Uses OPSS-LossRe.

Click Administration > Object Types. Check that all of the object types, field groups, and fields are listed
in the system.

You can also review the approval app Automated Form Configuration (AFCON) spreadsheet,
Deck_AFCON_<version>.xls, to make sure that you have everything you need in your system. You can
find the AFCON spreadsheet in the OP_<version>_Non_Embedded/
OP_<version>_Configuration/Approval_App/ directory.

If you upgraded from version 7.2.x and you are deploying the approval app for the first time, you might
want to configure the approval app profile only for selected object types. For more information, see
“Excluding object types from the approval app profile ” on page 284. If you performed a new installation,
this step is not required.

Note: This topic lists the objects, field groups, and fields that you need to add if you have the 7.2 solutions
schema. If you do not have the 7.2 solutions schema or if you customized the solutions schema,
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additional changes might be required. For more information, see “Notes for users who do not have the 7.2
or later solutions schema” on page 288.

Excluding object types from the approval app profile
If you upgraded from version 7.2.x and you are deploying the approval app for the first time, you might
want to configure the approval app profile for selected object types only and exclude others. If you
performed a new installation of IBM OpenPages GRC Platform, this step is not required.

About this task

The approval app profile supports four object types. (See “Ensuring that you have the fields and field
groups required for the approval app profile ” on page 283.)

You can choose to exclude any of these object types from the approval app profile. For example:

• You might not need Incidents because you don't use the Incident object type.
• You might have a customized process for an existing Loss Event object type to which you don't want to

make any changes, but you might want to use the other object types for the approval app.

For a specific example of how to remove the LossEvent object type, see “Excluding the Loss Event object
type from the approval app profile ” on page 285.

Important: If you exclude an object type, you must also remove any objects that are associated
exclusively with the object type.

Use the following steps to exclude an object from the four objects that are supported by the approval app
profile. To do this procedure, you must use the OpenPages Platform 3 profile.

Procedure

1. In the Load_End_User_App_Schema.sh|.bat file, comment out the commands that load the files
that are related to the object types from the loader file. Do this step to exclude loading the objects
when you load the approval app profile.

• For a Windows computer: In the Load_End_User_App_Schema.bat file, comment out the block
of code relevant to the object type you want to exclude by adding REM at the beginning of each line.

• For a Linux computer: In the Load_End_User_App_Schema.sh file, comment out the block of
code relevant to the object type you want to exclude by adding # at the beginning of each line.

For an example of the code to be commented out, see step 1 in “Excluding the Loss Event object type
from the approval app profile ” on page 285.

2. Edit the deck_config.json file to exclude the object types.
a) Locate the deck_config.json file.

The approval app working directory is: <OP_HOME>/installer/migration/upgrade/
addon_module/loaderdata/deck.

b) Unzip deck-config-opx-op-file-content.zip.
c) Locate the End User Applications Config folder.
d) Locate the deck_config.json file.
e) Make a backup copy of deck_config.json in case you need to repeat any steps.

For more information, see "Configuring the JSON file for the approval app" in the IBM OpenPages GRC
Administrator's Guide.

After you edit and save the file deck_config.json, you must copy it back to the End User
Applications Config directory and zip it back into deck-config-opx-op-file-content.zip.

3. Edit the Deck_AFCON_<version>.xls spreadsheet to remove the object, the associated objects,
and the related views.
The file is stored in: OP_<version>_Non_Embedded/OP_<version>_Configuration/
Approval_App/.
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Note: Before you start to edit the AFCON spreadsheet, make a backup copy of the AFCON
spreadsheet. If you run into difficulties, you can start again from the backup copy.

4. Follow the steps in the AFCON user manual to generate the .xml file from the updated AFCON
spreadsheet for the approval app profile.
The AFCON user manual is stored on the installation media AFCON-RAFCON/Afcon.zip.
The AFCON tool generates four .xml files:

• IBM_OP_DECK_object-profile-op-config.xml
• IBM_OP_DECK_object-strings-op-config.xml
• IBM_OP_DECK_rule-based-security-op-config.xml
• IBM_OP_DECK_schema-op-config.xml

5. Rename the IBM_OP_DECK_object-profile-op-config.xml file to deck-profile-op-
config.xml and paste it in the approval app working directory. Ignore all of the other files.

The approval app working directory is: <OP_HOME>/installer/migration/upgrade/
addon_module/loaderdata/deck.

Alternatively, you can edit the profile .xml file manually to match your requirements. You must remove
the object type and its associated parent and child object types in the following sections:
objectProfile and ObjectProfileViewSet.

6. Back up the openpages-solutions.xml file.
a) Go to Administration > Manage System Files > SysXMLDocument.
b) Expand the TriggerConfigFiles folder.
c) Download the openpages-solutions.xml and name it openpages-solutions-bk.xml.

If you want to exclude Loss Event but you want to include Issue, you must copy the triggers for Issue
from OpenPages version 7.2.0.1 or later and replace the triggers for Issue in the OpenPages 7.2
version of the file.

Note: You can get a copy of the version 7.2 openpages-solutions.xml file from the installation
media. The file is located in OP_<version>_Non_Embedded/OP_<version>_Configuration/
Modules/Upgrade/ORM/triggers/7.2_openpages_solutions/.

Excluding the Loss Event object type from the approval app profile
If your organization currently uses the Loss Event object type and you don't want to make changes to that
process, but you want to use the approval app for the other object types, this task provides detailed steps
on how to exclude the Loss Event object type from the approval app.

About this task

If you upgraded from version 7.2.x and you are deploying the approval app for the first time, you might
want to configure the approval app profile to exclude the Loss Event object type.

The approval app profile supports four object types. One of these is the Loss Event object type.

You may want to exclude the Loss Event object type for the following reasons:

• You may already be using the Loss Event object type and its triggers.
• You don't have the Loss Event object type deployed in OpenPages.

Important: If you exclude an object type, you must also remove any objects associated exclusively with
the object type. For example, if you want to exclude the Loss Event object type, you must remove the
associated objects LossImpact and LossRecovery. However, note that you must keep the objects
SOXIssue, SOXDocument, SOXRisk, SOXProcess, and SOXBusEntity because they are also associated
with SOXControl, which is still included in the profile.

Use the following steps to exclude the Loss Event object type from the four objects supported by the
approval app profile. To perform this procedure, you must use the OpenPages Platform 3 profile.
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Procedure

1. Edit the openpages-deck-schema-loader-data.txt file by commenting out the lines that are
related to the objects that you want to exclude.

For example, to exclude the Loss Event object type, in the Loading Deck Schema block, comment
out deck-schema-lossevent and, in the Loading Deck Lifecycle block, comment out deck-
lifecycle-lossevent.

# Loading Deck Schema
deck-schema-control
deck-schema-control-questions
deck-schema-issue
# deck-schema-lossevent

# Loading Deck lifecycle
deck-lifecycle-control
deck-lifecycle-incident
deck-lifecycle-issue
# deck-lifecycle-lossevent

# Loading Deck profile
Deck_object-profile

2. Edit the deck_config.json file to exclude the Loss Event object type.
a) Locate the deck_config.json file.

The file is stored in: <OP_HOME>/installer/migration/upgrade/addon_module/
loaderdata/deck.

b) Unzip deck-config-opx-op-file-content.zip.
c) Go to the folder End User Applications Config.
d) Locate the file deck_config.json.
e) Make a backup copy of deck_config.json in case you need to repeat any steps.

For more information, see "Configuring the JSON file for the approval app" in the IBM OpenPages GRC
Administrator's Guide.

To exclude the Loss Event object type, remove "LossEvent" from the objectTypes block:

Before:

"objectTypes" : ["SOXControl","SOXIssue","LossEvent","Incident"], 

After:

"objectTypes" : ["SOXControl","SOXIssue","Incident"],

Also, remove the following code from the objects block:

        {
            "type" : "LossEvent",
            "fieldTitle" : "Name",
            "fieldDesc" : "Description",
            "lifecycle" : {
                "enabled" : true,
                "stageMap" : { 
                    "Awaiting Approval" : {"showInList": true},
                    "Awaiting Approval L1" : {"showInList": true},
                    "Awaiting Approval L2" : {"showInList": true}
                }
            },
            "widgetList" : [
                {
                    "name" : "details",
                    "type" : "activityView",
                    "activityView" : "OP-Deck-LE",
                    "parentViews" : [ 
                        {
                        "type" : "SOXRisk",
                        "activityView" : "OP-Deck-LE-Risk"
                        }                        
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                    ]
                }
            ]                
        },

After you edit and save the deck_config.json file, copy it back to the /End User Applications
Config folder and zip it back into deck-config-opx-op-file-content.zip.

3. Edit the Deck_AFCON_<version>.xls spreadsheet to remove the Loss Event object, the associated
objects, and the related views.
The file is stored in: OP_<version>_Non_Embedded/OP_<version>_Configuration/
Approval_App/.

Note: Before you start to edit the AFCON spreadsheet, make a backup copy of the AFCON
spreadsheet. If you run into difficulties, you can start again from the backup copy.

a) Delete the worksheets Loss Event, Loss Impact, Loss Recovery, AV - OP-Deck-LE, and
AV - OP-Deck-LE-Risk.

b) From the Labels - Object Types worksheet, delete the rows related to Loss Event, Loss
Impact, and Loss Recovery.

c) From the Default Views worksheet, delete the rows related to Loss Event, Loss Impact, and Loss
Recovery.

d) From the Overviews worksheet, delete the rows related to Loss Event, Loss Impact, and Loss
Recovery (Note: No change in the case of Loss Event).

e) From the Date Dimension Associations worksheet, delete the rows related to the field
groups associated to Loss Event, Loss Impact, and Loss Recovery. In this case, delete all rows
related to OPSS-LossEv, OPSS-LossIm, and OPSS-LossRe.

f) From the Navigational Views Order worksheet, delete the rows related to Loss Event, Loss
Impact, and Loss Recovery.

g) From the Object Views Order worksheet, delete the rows related to Loss Event, Loss Impact,
and Loss Recovery.

4. Follow the steps in the AFCON user manual to generate the .xml files from the updated AFCON
spreadsheet for the approval app profile.
The AFCON user manual is stored on the installation media AFCON-RAFCON/Afcon.zip.
The AFCON tool generates four .xml files:

• IBM_OP_DECK_object-profile-op-config.xml
• IBM_OP_DECK_object-strings-op-config.xml
• IBM_OP_DECK_rule-based-security-op-config.xml
• IBM_OP_DECK_schema-op-config.xml

5. Rename the IBM_OP_DECK_object-profile-op-config.xml file to deck-profile-op-
config.xml and paste it in the approval app working directory, <OP_HOME>/installer/
migration/upgrade/addon_module/loaderdata/deck. Ignore all the other files.

Alternatively, you can edit the profile .xml file manually to match your requirements. You must remove
the object type and its associated parent and child object types in the following sections:
objectProfile and ObjectProfileViewSet.

6. Before you proceed to step 7, make sure that you understand the following background information
about copying the SOXIssue trigger content from OpenPages version 7.2.0.1 or later to the
openpages-solutions.xml file from OpenPages version 7.2.

When OpenPages version 7.2 is installed, the openpages-solutions.xml file is stored in the
SysXMLDocument > TriggerConfigFiles folder.

For the present example where Loss Event is excluded from the approval app, you must modify the
openpages-solutions.xml file from OpenPages version 7.2 and replace the trigger content for the
SOXIssue object with the trigger content for the SOXIssue object from the version of openpages-
solutions.xml from OpenPages version 7.2.0.1 or later.
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Because you are excluding the Loss Event object type from the approval app, you want to retain the
OpenPages 7.2 triggers from the OpenPages 7.2 Loss Event triggers, while updating the SOXIssue
triggers with the newer version needed for the approval app.

For the SOXIssue object, the triggers in OpenPages version 7.2.0.1. or later are changed to work with
the approval app. So you must copy the SOXIssue trigger content from the OpenPages version 7.2.0.1
or later openpages-solutions.xml file into the openpages-solutions.xml file in OpenPages
version 7.2 and then save the file.

7. Download the openpages-solutions.xml file.
a) Go to Administration > Manage System Files > SysXMLDocument.
b) Expand the TriggerConfigFiles folder.
c) Download the openpages-solutions.xml and name it openpages-solutions-72.xml.

8. Edit the openpages-solutions.xml file.
The file is stored in: <OP_HOME>/installer/migration/upgrade/addon_module/
loaderdata/deck.
a) Unzip deck-lifecycle-trigger-op-file-content.zip.
b) Make a backup copy of openpages-solutions.xml in case you need to modify it again. Name it
openpages-solutions-backup.xml and save it.

c) Edit openpages-solutions.xml from OpenPages version 7.2.0.1 or later. Locate the following
section and copy it:

<!-- T-009 Issue Life Cycle Status Update Trigger Begin —>
...
</trigger>

d) Edit the openpages-solutions.xml file from OpenPages version 7.2. Using the lines you copied
in step 8c, replace the matching .xml snippet in the existing OpenPages version 7.2 version that
you downloaded. Save the file.

e) Take the openpages-solutions.xml you saved in step 8d and copy it back to the approval app
working directory.

f) Zip the file deck-lifecycle-trigger-op-file-content.zip and be sure that deck-
lifecycle-trigger-op-file-content.zip is under the approval app working directory.

Note: You can get a copy of the version 7.2 openpages-solutions.xml file from the installation
media. The file is located in OP_<version>_Non_Embedded/OP_<version>_Configuration/
Modules/Upgrade/ORM/triggers/7.2_openpages_solutions/.

The approval app working directory is: <OP_HOME>/installer/migration/upgrade/
addon_module/loaderdata/deck.

Now you are ready to load the approval app profile. For more information, see “Loading the approval
app profile ” on page 289.

Notes for users who do not have the 7.2 or later solutions schema
If you do not have the 7.2 or later solutions schema in your environment or if you customized the
solutions schema, you might need to add or modify objects, field groups, and fields before you load the
approval app profile.

For example, if you installed version 7.1 with solutions and then upgraded to 7.4, your environment has
the 7.1 solutions schema. The 7.1 solutions schema might not have all of the objects, field groups, and
fields that you need for the approval app.

Examine the approval app Automated Form Configuration (AFCON) spreadsheet,
Deck_AFCON_<version>.xls. Perform the following checks:

• Make sure that you have the objects, field groups, and fields for the approval app.
• Make sure that the attributes match, for example make sure that the display type of each field is defined

correctly.
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• Make sure that you have any prerequisites for the objects, field groups, and fields.

You can find the Deck_AFCON_<version>.xls spreadsheet in the
OP_<version>_Non_Embedded/OP_<version>_Configuration/Approval_App/ directory.

Updating triggers for the approval app
If you upgraded IBM OpenPages GRC Platform and you are deploying the approval app for the fist time,
you need to modify the Trigger Configuration Files registry setting for the approval app profile.

Before you begin

Upgrade IBM OpenPages GRC Platform.

Make sure your system has the required fields and field groups as described in “Ensuring that you have
the fields and field groups required for the approval app profile ” on page 283.

About this task

The Trigger Configuration Files registry setting defines the trigger files to load when IBM OpenPages
GRC Platform starts. For more information, see the IBM OpenPages GRC Trigger Developer Guide.

The trigger files set the lifecycle for the included object types on the system. Lifecycles define the stages
that an object type can follow. At each stage, the system:

• Identifies a lifecycle assignee
• Defines the actions available to move to a different stage
• Automatically sends an email to the new lifecycle assignee (LCAssignee)
• Defines other attributes that are related to the current stage

Procedure

1. Log on to IBM OpenPages GRC Platform as a user with administrative privileges.
2. Click Administration > Settings > GRCM > Trigger Configuration Files.
3. Update the value for the Trigger Configuration Files setting.

Add the following files, separated by commas.

• OPLC-LossEvent.xml
• OPLC-SOXControl.xml
• OPLC-SOXIssue.xml

For example:

OPLC-LossEvent.xml,OPLC-SOXControl.xml,OPLC-SOXIssue.xml

Note: If you want to exclude an object type from the approval app, do not include the related OPLC-
<object type>.xml file in the Trigger Configuration Files registry setting.

Loading the approval app profile
If you upgraded IBM OpenPages GRC Platform and you are deploying the approval app for the first time in
version 7.4, you need to load the approval app profile and enable the app.

Before you begin
You must install IBM OpenPages GRC Platform before you load the profile and enable the approval app.

Make sure that your system has the required fields and field groups as described in “Ensuring that you
have the fields and field groups required for the approval app profile ” on page 283.
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If you upgraded IBM OpenPages GRC Platform and you are deploying the approval app for the first time,
modify the Trigger Configuration Files registry setting before you load the approval app profile. For more
information, see “Updating triggers for the approval app ” on page 289.

About this task

In addition to the approval app profile, the scripts make the following changes:

• Load schema changes for three object types (SOXControl, SOXIssue, LossEvent)
• Load lifecycle schema changes for 4 object types (Incident, SOXControl, SOXIssue, LossEvent)
• Load Certification Questions (for SOXControl)
• Load deck_config.json
• Load the lifecycle trigger definition XML files (see step 1)
• Enable the approval app

Procedure

1. If you have an existing profile with an LCAssignee field for the object types that are supported by the
lifecycle, perform the following steps to specify the display type of the field as Multi Valued User/
Group Selector.
a) Go to the profile in which you want to make changes: Administrator > Profiles.
b) Click the object type that includes the LCAssignee field.
c) Click LCAssignee.
d) In the Object Field Information section, click Edit.
e) From the Display Type drop-down, click Multi Valued User/Group Selector.
f) Click Save.

This specifies the display type of the LCAssignee field for all the object types that are supported by the
lifecycle to be Multi Valued User/Group Selector. You can now have multiple assignees.

Tip: You can check if you have an existing profile with an LCAssignee field. LCAssignee is a specific
field in a specific field group OPLC-Std. In version 7.2, this field was only in Incident and Questionnaire
Assessment object types. You can look in each object type and see if it includes the OPLC-Std field
group. Then, for each of those object types, look in each profile that object type is included in.

2. Load the approval app profile and enable the app.

• Windows:

a. Go to the approval app working directory: <OP_HOME>/installer/migration/upgrade/
addon_module/loaderdata/deck.

b. Update openpages_domain_folder, login_username, and login_password properties in
Environment_Variables.bat.

c. Run Load_Deck_Schema.bat. Wait for the script to complete before you continue to the next
step.

d. Run Load_End_User_App_Schema.bat.
e. For security purposes, remove the password from the Environment_Variables.bat file.

• Linux:

a. Go to the approval app working directory: <OP_HOME>/installer/migration/upgrade/
addon_module/loaderdata/deck.

b. Update openpages_domain_folder, login_username, and login_password properties in
Environment_Variables.sh.

c. Run Load_Deck_Schema.sh
d. Run Load_End_User_App_Schema.sh. Wait for the script to complete before you continue to

the next step.
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e. For security purposes, remove the password from the Environment_Variables.sh file.

Completing the approval app deployment
Complete the remaining steps to deploy the approval app.

Procedure

1. Restart the OpenPages server on all application servers. For information about starting and stopping
servers, see Chapter 11, “Starting and stopping servers,” on page 253.

2. Perform any conditional tasks required by your environment.
For more information, see “Conditional steps for the approval app” on page 291.

Results
The approval app is deployed.

Conditional steps for the approval app
Depending on your environment, you might need to perform some additional tasks.

Perform these tasks after you complete all other deployment tasks. If you are installing other IBM
OpenPages GRC Platform components, such as a fix pack or IBM OpenPages Loss Event Entry, perform
these steps after all components are installed.

If you want to report on the fields and field groups for the approval app, regenerate the reporting
framework. For more information, see Regenerating the reporting framework.

If you added the objects, fields, and field groups required for the approval app and you use global search,
re-create the global search index. See “Creating the global search index after upgrading” on page 186.

Upgrade the approval app
If you deployed the approval app in version 7.2.0.1 or later and you upgraded IBM OpenPages GRC
Platform to version 7.4, you need to perform some additional steps to upgrade the approval app.

1. Complete the pre-upgrade tasks for the approval app. Check system requirements and back up your
environment. For more information, see “Pre-upgrade tasks for the approval app” on page 282.

2. Update the approval app configuration file. For more information, see “Updating the approval app
configuration file” on page 292.

3. Upgrade the approval app. For more information, see “Upgrading the approval app” on page 292.

Pre-upgrade tasks for the approval app
Before you upgrade the approval app, ensure that your system meets the system requirements, back up
IBM OpenPages GRC Platform files, and gather the information that is required to complete the
installation.

Ensure that you completed the upgrade to version 7.4. The OpenPages database upgrade must be
complete before you upgrade the approval app.

If you want to be able to restore your environment to its current state, back up the OpenPages application
environment, the IBM Cognos environment, and the database.

Gather the following information. You need this information to complete the installation.

• The user name and password of the OpenPages administrator on the admin application server
• The path of the OpenPages home directory, OP_HOME
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Updating the approval app configuration file
When you upgrade the approval app, you need to update the deck_config.json configuration file.

Before you begin

To do this procedure, you must use the OpenPages Platform 3 profile.

Procedure

1. Back up the deck_config.json file.
a) From the menu bar, click Administration > Manage System Files > SysXMLDocument.

b) Click End User Applications Config > deck_config.json.
c) Click View file and save it.

2. Delete the deck_config.json file.
a) Return to the End User Applications Config folder.
b) Click the check box next to deck_config.json, and then click Delete.
c) Click OK.

3. Update the deck-config-opx-op-file-content.zip file.
a) Go to the <OP_HOME>/installer/migration/upgrade/addon_module/loaderdata/deck

directory on the application server.
b) Use a compression utility to open or extract the deck-config-opx-op-file-content.zip file.
c) Replace the deck_config.json file in the .zip file with the deck_config.json that you

backed up.
d) Use a compression utility to recompress the deck-config-opx-op-file-content.zip file.

Note: Make sure that the files are packaged back into the deck-config-opx-op-file-
content.zip file with the same directory structure as in the original .zip file.

4. Load the deck_config.json file.
a) Select the check box next to the End User Applications Config folder.
b) Click Add New.
c) Click Browse and select the deck_config.json file.

Upgrading the approval app
If you deployed the approval app in IBM OpenPages GRC Platform version 7.2.0.1 or later and then
upgraded IBM OpenPages GRC Platform, you need to upgrade the app.

Before you begin
Complete this task after you upgrade IBM OpenPages GRC Platform.

Procedure

1. Log on to the OpenPages admin application server as a user with administrative privileges.
2. Start the IBM OpenPages GRC Platform services on all application servers.

For information, see Chapter 11, “Starting and stopping servers,” on page 253.
3. Open a command prompt by using the Run As Administrator option (Windows) or a command line

(Linux or AIX).
4. Go to the approval app working directory: <OP_HOME>/installer/migration/upgrade/
addon_module/loaderdata/deck.

5. Update openpages_domain_folder, login_username, and login_password properties in the
Environment_Variables.bat|.sh file.

6. Run the upgrade script.
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• Windows: Upgrade_Deck.bat
• Linux or AIX: Upgrade_Deck.sh

7. For security purposes, remove the password from the Environment_Variables.bat|.sh file.
8. Restart the OpenPages services on all application servers. For information about starting and stopping

servers, see Chapter 11, “Starting and stopping servers,” on page 253.
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Chapter 16. Loss Event Entry
Users across an organization can create loss events quickly and easily with IBM OpenPages Loss Event
Entry. It is easy to use and task-focused for users with no experience with IBM OpenPages GRC Platform.

Users can access OpenPages Loss Event Entry without a sign-in account for IBM OpenPages GRC
Platform. You can set up a link to OpenPages Loss Event Entry on your organization's intranet. When users
click the link, they see the user interface in the language of their choice, and dates and numbers are
formatted in ways that are familiar to them. Users can immediately begin entering information. When they
submit a loss event, a confirmation email is sent to them.

OpenPages Loss Event Entry is integrated fully with IBM OpenPages GRC Platform. The following is an
example of the workflow:

• Create a loss event in OpenPages Loss Event Entry.
• Triage, investigate, and enrich the loss event information in IBM OpenPages GRC Platform.
• Review and approve the loss event in the approval app.

For more information, see OpenPages Loss Event Entry.

Installation process overview for Loss Event Entry
If you want to use IBM OpenPages Loss Event Entry, you need to do some tasks to install it.

Do this task if you are doing a fresh installation of OpenPages Loss Event Entry. If you are upgrading, see
“Upgrade process overview for Loss Event Entry” on page 299.

During the installation of IBM OpenPages Loss Event Entry, you can choose to load the default data
required for OpenPages Loss Event Entry automatically or manually. The default data includes the field
groups, fields, users, role templates, profile, and other data needed for OpenPages Loss Event Entry.

If you want to load OpenPages Loss Event Entry data automatically, complete the following steps:

1. Install IBM OpenPages GRC Platform.

If you are upgrading from version 7.1.x and you use IBM DB2, install OpenPages Loss Event Entry
before you re-create the reporting schema and framework. For information, see Chapter 7, “Upgrade
IBM OpenPages GRC Platform,” on page 167.

2. Install OpenPages Loss Event Entry.
3. Modify the web.xml files for OpenPages Loss Event Entry.
4. Change OpenPages Loss Event Entry user passwords.
5. Configure OpenPages Loss Event Entry.

If you want to load OpenPages Loss Event Entry data manually, complete the following steps. Choose this
option if you want to customize the field groups, fields, users, groups, profile, and other data used in
OpenPages Loss Event Entry.

1. Install IBM OpenPages GRC Platform.

If you are upgrading from version 7.1.x and you use IBM DB2, install OpenPages Loss Event Entry
before you re-create the reporting schema and framework. For information, see Chapter 7, “Upgrade
IBM OpenPages GRC Platform,” on page 167.

2. Install OpenPages Loss Event Entry.
3. Modify the web.xml files for OpenPages Loss Event Entry.
4. Load the OpenPages Loss Event Entry data manually.
5. Change OpenPages Loss Event Entry user passwords.
6. Configure OpenPages Loss Event Entry.
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Depending on your environment, you might also need to regenerate the reporting framework. If you
installed OpenPages and then regenerated the reporting framework, you might need to regenerate it
again after you install OpenPages Loss Event Entry.

Pre-installation tasks for Loss Event Entry
Before you install IBM OpenPages Loss Event Entry, ensure that your system meets the system
requirements, back up IBM OpenPages GRC Platform files, and gather information required to complete
the installation.

Ensure that the following software is installed:

• IBM OpenPages GRC Platform
• IBM Installation Manager 1.8.7 or later

If you want to be able to restore your environment to its current state, back up the OpenPages application
environment, the IBM Cognos environment, and the database.

Gather the following information. You need this information to complete the installation.

• The user name and password of the OpenPages administrator on the admin application server
• The path of the OpenPages home directory, OP_HOME

Installation tasks for Loss Event Entry

Preparing for the installation of Loss Event Entry
To ensure that the IBM OpenPages Loss Event Entry Installer is able to perform all necessary steps, you
must perform some preparation tasks.

Procedure

1. Ensure that there are no long running OpenPages processes, such as a FastMap import process or a
global search indexing process.

2. Check the status of IBM OpenPages GRC Platform servers. Verify that the following servers are
running: the application servers (admin and non-admin), reporting servers (active and standby), the
Framework Model Generator, and the database server.

For information about starting and stopping servers, see Chapter 11, “Starting and stopping servers,”
on page 253.

Installing Loss Event Entry
You must run the IBM OpenPages Loss Event Entry installation program on the OpenPages admin
application server.

Procedure

1. Make sure that the OpenPages servers are running. See “Preparing for the installation of Loss Event
Entry” on page 296.

2. Download the OpenPages Loss Event Entry installer package from IBM Passport Advantage (http://
www.ibm.com/software/passportadvantage).

3. Extract the package files.
4. On the admin application server, run IBM Installation Manager.
5. Add the OpenPages Loss Event Entry repository to IBM Installation Manager.

a) Click File > Preferences.
b) Click Repositories and then click Add Repository.
c) Select the OpenPages Loss Event Entry installer package.
d) Click the repository.config file.
e) Click OK.
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f) Click OK to return to the main IBM Installation Manager page.
6. Click Install.
7. Select IBM OpenPages Loss Event Entry and Version 7.4, and click Next.
8. Accept the license agreement and click Next.
9. Click Next.

Note: The installation directory does not impact the installation process. The files are installed to the
same directory as the IBM OpenPages GRC Platform installation (OP_HOME).

10. In the Features list, make sure that IBM OpenPages Loss Event Entry 7.4 is selected and click Next.
11. In the Enter the location of your OpenPages installation field, enter the path to the OpenPages

home directory, OP_HOME. Type the path or click Browse to select the directory. This directory
contains the openpagesregistry.xml file and the bin subdirectory.

12. In the User Name field, enter the user name for the administrator account on the OpenPages admin
application server.

13. In the Password field, enter the password for the administrator account on the OpenPages admin
application server.

14. Click one of the options for loading the default data. The default data includes the default users,
groups, role templates, fields, field groups, profile, and other data used in OpenPages Loss Event
Entry.

• If you choose to load the data automatically, the installation program loads the default data used in
OpenPages Loss Event Entry.

• If you choose not to load the default data automatically, the installation program creates the files
on your system but does not load them. You must load the data files manually before you use
OpenPages Loss Event Entry. Select this option if you want to customize the data before loading it.
For information about loading the data manually, see “Manual data loading for Loss Event Entry” on
page 303.

15. Click Next. If any errors appear on the page, follow the instructions to fix them before you continue.

If you see validation errors during the data load process, see “Data validation errors when installing
Loss Event Entry” on page 363.

16. Click Finish.

What to do next

• If you chose not to load the data automatically, load the data manually before performing the post-
installation tasks. See “Manual data loading for Loss Event Entry” on page 303 .

• If you chose to load the data automatically, continue with “Post-installation tasks for Loss Event Entry”
on page 297.

Log files for Loss Event Entry
If errors occur when you install IBM OpenPages Loss Event Entry, you can review the log files.

The ObjectManager log files generated when loading the default data for OpenPages Loss Event Entry are
located in <OP_HOME>/LossEventEntry/logs/.

If you see validation errors about data that already exists, see “Data validation errors when installing Loss
Event Entry” on page 363.

Post-installation tasks for Loss Event Entry
After you install IBM OpenPages Loss Event Entry, you need to complete some additional tasks.

Certain prerequisites must be met to configure and use OpenPages Loss Event Entry.

• Modifying the web.xml files
• Setting passwords
• Configuring OpenPages Loss Event Entry
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If you chose not to load the OpenPages Loss Event Entry default data automatically during the installation
process, load the data manually before performing the post-installation tasks.

Modifying the web.xml files for Loss Event Entry
After you have installed IBM OpenPages Loss Event Entry, you need to modify the web.xml files for the
application.

Procedure

1. Log on to the OpenPages application server as a user with administrative permissions.
2. Stop all OpenPages services.
3. Go to the <OP_HOME>/profiles/<OpenPages-node-name>/installedApps/<OpenPages-
cell-name>/op-apps.ear/sosa.war/WEB-INF directory.

• <OP_HOME> is the installation location of the OpenPages application. By default, this is
c:\OpenPages on Windows, and /opt/OpenPages on UNIX.

• <server_name> is the name of the application server.
4. In a text editor, open the web.xml file and insert the lines shown in bold, above XSSFilter.

<context-param>         
  <param-name>sm.authentic.key</param-name>
  <param-value>SMSERVERSESSIONID</param-value>     
</context-param>
<context-param>         
  <param-name>sm.username.key</param-name>
  <param-value>SMUSER</param-value>     
</context-param>    

<filter>         
  <filter-name>AppFilter</filter-name>        
    <filter-class>com.ibm.openpages.components.apps.AppFilter
  </filter-class>     
</filter>     

<filter-mapping>         
  <filter-name>AppFilter</filter-name>
  <url-pattern>/*</url-pattern>     
</filter-mapping>     

<filter>         
  <filter-name>XSSFilter</filter-name>
  <filter-class>com.openpages.apps.common.tools.xss.XSSFilter</filter-class>
  <init-param>            
      <param-name>com.openpages.xss.CHECK_POST</param-name>            
      <param-value>true</param-value>
  </init-param>   
  <init-param>            
      <param-name>com.openpages.xss.REDIRECT_URL</param-name>            
      <param-value>/malicious.jsp</param-value>         
  </init-param>     
</filter>

5. Save the file and close the editor.
6. Go to the <OP_HOME>/profiles/<OpenPages-dmgr-name>/config/cells/<OpenPages-
cell-name>/ applications/op-apps.ear/deployments/op-apps/sosa.war/WEB-INF
directory.

7. Repeat steps 4 and 5.
8. If this is a load-balanced environment, repeat steps 1-5 on each application server in the load-

balanced environment.
9. Restart all OpenPages services.
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Setting passwords for Loss Event Entry users
After you have installed IBM OpenPages Loss Event Entry, you need to configure the passwords for the
Loss Event Entry users.

Before you begin

If you chose not to load the default data automatically during the installation process, load the data
manually before setting passwords.

About this task

When you set passwords in the configuration tool and save your changes, the passwords are updated in
IBM OpenPages GRC Platform. Passwords are encrypted.

Procedure

1. Start the configuration tool. Go to http://<server_name>:<port>/openpages/app/jspview/
lossevent#/editconfig

2. Log in with a user account that is a member of the OPAdministrators group.
3. Under the Locales section, expand each locale and enter a password.

Configuration of Loss Event Entry
You can configure IBM OpenPages Loss Event Entry to meet the needs of your organization.

The configuration tool enables you to customize OpenPages Loss Event Entry. See Configuring OpenPages
Loss Event Entry.

Conditional steps for Loss Event Entry
Depending on your environment, you might need to perform some additional tasks.

Perform these tasks after you complete all installation and post-installation tasks. If you are installing
other IBM OpenPages components, such as a fix pack or the approval app, perform these steps after all
components are installed.

If you want to report on the fields and field groups for OpenPages Loss Event Entry, regenerate the
reporting framework. For more information, see Regenerating the reporting framework.

If you needed to add the objects, fields, and field groups required for OpenPages Loss Event Entry and
you use global search, re-create the search index. See “Creating the global search index after upgrading”
on page 186.

Upgrade process overview for Loss Event Entry
If you upgraded IBM OpenPages GRC Platform from 7.2.x or 7.3.x and you previously installed IBM
OpenPages Loss Event Entry, you also need to upgrade OpenPages Loss Event Entry.

Complete the following steps.

1. Complete the pre-installation tasks for OpenPages Loss Event Entry. For more information, see “Pre-
installation tasks for Loss Event Entry” on page 296.

2. Complete the preparation tasks for installing OpenPages Loss Event Entry. For more information, see
“Preparing for the installation of Loss Event Entry” on page 296.

3. Optional: If you customized the OpenPages Loss Event Entry data files, back up the files.
4. Upgrade OpenPages Loss Event Entry.
5. Update the OpenPages Loss Event Entry configuration file.

Depending on your environment, you might also need to regenerate the reporting framework. If you
upgraded OpenPages and then regenerated the reporting framework, you might need to regenerate it
again after you install OpenPages Loss Event Entry.
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Upgrading Loss Event Entry
If you upgraded OpenPages from version 7.2 or 7.3, upgrade IBM OpenPages Loss Event Entry.

Before you begin
Before you upgrade, complete the following tasks:

• “Pre-installation tasks for Loss Event Entry” on page 296
• “Preparing for the installation of Loss Event Entry” on page 296

Procedure

1. Make sure that the OpenPages servers are running. See “Preparing for the installation of Loss Event
Entry” on page 296.

2. Download the IBM OpenPages Loss Event Entry 8.0 installer package from IBM Passport Advantage
(http://www.ibm.com/software/passportadvantage).

3. Extract the package files.
4. On the admin application server, run IBM Installation Manager.
5. Add the OpenPages Loss Event Entry repository to IBM Installation Manager.

a) Click File > Preferences.
b) Click Repositories and then click Add Repository.
c) Select the OpenPages Loss Event Entry installer package.
d) Click the repository.config file.
e) Click OK.
f) Click OK to return to the main IBM Installation Manager page.

6. Click Update.
7. Select IBM OpenPages Loss Event Entry, and click Next.
8. Select Version 7.4, and then click Next.
9. Accept the license agreement and click Next.

10. In the Features list, make sure that IBM OpenPages Loss Event Entry 7.4 is selected and click Next.
11. In the Enter the location of your OpenPages installation field, enter the path to the OpenPages

home directory, OP_HOME. Type the path or click Browse to select the directory. This directory
contains the openpagesregistry.xml file and the bin subdirectory.

12. In the User Name field, enter the user name for the administrator account on the OpenPages admin
application server.

13. In the Password field, enter the password for the administrator account on the OpenPages admin
application server.

14. Click the option to not load the data automatically.
15. Click Next. If any errors appear on the page, follow the instructions to fix them before you continue.
16. Click Update.
17. Click Finish.

What to do next

Update the OpenPages Loss Event Entry configuration file. For more information, see “Updating the Loss
Event Entry configuration file” on page 301.
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Updating the Loss Event Entry configuration file
After you upgrade or migrate IBM OpenPages Loss Event Entry, you need to update the
lossevent_config.json configuration file.

Before you begin

To perform this procedure, you must use the OpenPages Platform 3 profile.

Procedure

1. Back up the lossevent_config.json file.
a) From the menu bar, click Administration > Manage System Files > SysXMLDocument.

b) Click End User Applications Config > lossevent_config.json
c) Click View file and save it.

2. Delete the lossevent_config.json file.
a) Return to the End User Applications Config folder.
b) Click the check box next to lossevent_config.json, and then click Delete.
c) Click OK.

3. Add the Japanese locale to the lossevent_config.json file.
a) Open the lossevent_config.json file that you downloaded.
b) Add the following text at the end of the file, after the zh_CN locale.

"ja_JP":{
         "user":"LEE_JA_JP",
         "password": "",
         "enabled":true
      }

The updated file now includes the Japanese locale:

"zh_CN":{
            "user":"LEE_ZH_CN",
            "password": "",
            "enabled":true
        },
"ja_JP":{
            "user":"LEE_JA_JP",
            "password": "",
            "enabled":true
        }
    }
}

c) Save the file.
4. Update the lossevent-entry-config-opx-op-file-content.zip file.

a) Go to the <OP_HOME>/LossEventEntry directory on the application server.
b) Use a compression utility to open or extract the lossevent-entry-config-opx-op-file-
content.zip file.

c) Replace the lossevent_config.json file in the .zip file with the lossevent_config.json
that you updated.

d) Use a compression utility to recompress the lossevent-entry-config-opx-op-file-
content.zip file.

Note: Make sure that the files are packaged back into the lossevent-entry-config-opx-op-
file-content.zip file with the same directory structure as in the original .zip file

5. Update OpenPages Loss Event Entry.
a) Update the <OP_HOME>/LossEventEntry/Environment_Variables.bat|sh file with the

values for your environment.
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b) Go to <OP_HOME>/LossEventEntry/upgrade.
c) Open a command line and run Upgrade_LossEvent_Entry_App_Schema.bat|sh.
d) Remove the password from the login_password variable in the
Environment_Variables.bat|sh file.

6. Update and review the settings in the OpenPages Loss Event Entry configuration tool.
a) Open the OpenPages Loss Event Entry configuration tool in a browser.

For example, navigate to http://<hostname>:10108/openpages/app/jspview/
lossevent#/editconfig

b) Update the password for the Japanese locale user.
c) Review the other configuration settings.
d) Click Save to load the configuration.

Migration process overview for Loss Event Entry
You can migrate IBM OpenPages Loss Event Entry to a new environment.

Complete the following steps.

1. Install OpenPages Loss Event Entry in the target environment. Choose the option to not load the data
automatically. For more information, see “Installation process overview for Loss Event Entry” on page
295.

2. Optional: If you customized the OpenPages Loss Event Entry data files in the source environment and
you want to keep a copy, back up the data files.

The data files are stored in the OpenPages Loss Event Entry working directory, <OP_HOME>/
LossEventEntry/.

3. Update the OpenPages Loss Even Entry configuration file. For more information, see “Updating the
Loss Event Entry configuration file” on page 301.

Additional tasks for Loss Event Entry

Silent installation for Loss Event Entry
You can run a silent installation by using the Silent mode in IBM Installation Manager.

Before you perform a silent installation, ensure that you have prepared your system for deploying IBM
OpenPages Loss Event Entry.

You can generate a response file by using IBM Installation Manager, or you can create one manually. A
template for creating a response file, called response_template.xml, is stored in the OpenPages Loss
Event Entry installer package in the OP_version_LOS_EV_EN directory. The response file must contain
the following code. Update the variables with the values for your environment:

Profile name
The name of the profile you want to use for OpenPages Loss Event Entry

Install location
The installation directory has no impact on the installation. OpenPages Loss Event Entry is installed to
the same directory as IBM OpenPages GRC Platform, OP_HOME. Specify a directory that does not exist
in your environment.

Path to OpenPages home
The absolute path to the OpenPages home directory, OP_HOME. This directory should contain the file
openpagesregistry.xml and the subdirectory bin.

OpenPages administrator user name
The user name of the administrator account on the OpenPages admin application server.
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OpenPages administrator password
The password for the administrator account on the OpenPages admin application server.

true or false
Choose an option for loading the default data for OpenPages Loss Event Entry. Enter true to load all
default data, or enter false to load data manually later.

If you are upgrading or migrating OpenPages Loss Event Entry, enter false.

<?xml version='1.0' encoding='UTF-8'?>
<agent-input>
  <server>
    <repository location='((Path to repository for OpenPages Loss Event Entry))'/>
  </server>
  <profile id='((Profile name))' installLocation='((Install location))'>
    <data key='user.OPHome,com.ibm.openpages.lossevententry' 
         value='((Path to OpenPages home))'/>
    <data key='user.OPAdminUsername,com.ibm.openpages.lossevententry' 
         value='((OpenPages administrator user name))'/>
    <data key='user.OPAdminPassword,com.ibm.openpages.lossevententry' 
         value='((OpenPages administrator password))'/>
    <data key='user.LoadAll,com.ibm.openpages.lossevententry'          
         value='((true or false))'/>
  </profile>
  <install>
      <offering profile='((Profile Name))' id='com.ibm.openpages.lossevententry'/>
  </install>
</agent-input>

If you are upgrading OpenPages Loss Event Entry, follow these guidelines:

• The repository location must be the same as in the previous installation.
• The Profile name and Install location must be the same in the previous installation.

If you do not know the profile name and install location, check the list of installed packages in IBM
Installation Manager. Run the command imcl listInstalledPackages -verbose. Look for the
package group containing the OpenPages Loss Event Entry package. The name of the package group is
the profile name, and the installation directory is the install location. For more information, see the IBM
Installation Manager documentation (https://www.ibm.com/support/knowledgecenter/SSDV2W_1.8.5/
com.ibm.cic.commandline.doc/topics/t_imcl_viewing_installed_packages.html).

• The value for LoadAll should be false.

For more information about how to generate a response file to run the installer silently, see Response files
(https://www.ibm.com/support/knowledgecenter/SSDV2W_1.8.5/com.ibm.silentinstall12.doc/topics/
c_silent_response_files.html).

Manual data loading for Loss Event Entry
If you did not load the IBM OpenPages Loss Event Entry default data when you installed OpenPages Loss
Event Entry, you can load the data manually. You also need to load the data manually if you have
customized the data files.

Before you load the data, ensure that you have the object types and field groups required by the
OpenPages Loss Event Entry profile.

Objects and field groups required for the Loss Event Entry profile
To load the Loss Event Entry profile successfully, you need to make sure you have all of the required
object types and field groups loaded in your system.

Click Administration > Object Types and check that all of the following object types are listed.

• LossEvent
• LossImpact
• LossRecovery
• SoxBusEntity
• SoxDocument
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• Preference

These object types use the following field groups:

• OPSS-LossEv (LossEvent)
• OPSS-Shared-Basel (LossEvent)
• OPSS-LossIm (LossImpact)
• OPSS-LossRe (LossRecovery)
• OPSS-Pref (Preference)

You can also review the IBM OpenPages Loss Event Entry Automated Form Configuration (AFCON)
spreadsheet to make sure that you have everything you need on your system. You can find the AFCON
spreadsheet in the <OP_Home>/LossEventEntry/ directory, along with the other loader files.

Note: This topic discusses the objects and field groups that you need to add if you have the 7.2 solutions
schema. If you do not have the 7.2 or later solutions schema or if you customized the solutions schema,
additional changes might be required. For more information, see “Notes for users who do not have the 7.2
or later solutions schema” on page 304.

Notes for users who do not have the 7.2 or later solutions schema
If you do not have the 7.2 or later solutions schema in your environment or if you customized the
solutions schema, you might need to add or modify objects, field groups, and fields before you use IBM
OpenPages Loss Event Entry.

For example, if you installed version 7.1 with solutions and then upgraded to 7.2, your environment has
the 7.1 solutions schema. The 7.1 solutions schema might not have all of the objects, field groups, and
fields that you need for OpenPages Loss Event Entry.

Examine the OpenPages Loss Event Entry Automated Form Configuration (AFCON) spreadsheet. Look for
any gaps:

• Are any objects, field groups, or fields for OpenPages Loss Event Entry missing from your schema?
• Do the attributes match? For example, is the display type of each field defined correctly?
• Does your schema have the prerequisites for the objects, field groups, and fields for OpenPages Loss

Event Entry?

You can find the AFCON spreadsheet in the <OP_HOME>/LossEventEntry/ directory.

Address each gap that you identify. For example, if your schema is missing a field, you could add the field
to your schema or you could remove the field from the profile that you use for OpenPages Loss Event
Entry. You can make changes by using the OpenPages application or by using the AFCON tool.

Loading the Loss Event Entry data manually
You can load the data used by IBM OpenPages Loss Event Entry manually. For example, if you have
customized the data, such as the fields or field groups, you need to load the data manually to apply your
changes.

About this task

You can load OpenPages Loss Event Entry data manually by using a script:
Load_LossEvent_Entry_App_Schema.bat (Windows) or
Load_LossEvent_Entry_App_Schema.sh (UNIX).

The script performs the following actions:

• Adds a new user group, called Loss Event Entry
• Adds users, and adds the new users to the Loss Event Entry user group

The user accounts connect OpenPages Loss Event Entry to IBM OpenPages GRC Platform. Each user
account is associated with a specific locale. When a user starts OpenPages Loss Event Entry, the user is
logged in to OpenPages automatically with the user account for their locale.
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– LEE_EN_US
– LEE_EN_GB
– LEE_IT_IT
– LEE_PT_BR
– LEE_FR_FR
– LEE_ES_ES
– LEE_DE_DE
– LEE_ZH_TW
– LEE_ZH_CN
– LEE_JA_JP

• Adds a new role template, called Loss Event Entry

The role template controls access to IBM OpenPages GRC Platform by users of OpenPages Loss Event
Entry.

– The role template includes six object types: LossEvent, LossImpact, LossRecovery, SoxBusEntity,
SoxDocument, and Preference.

– The role template configures the following security permissions:

- Read access to all six object types
- Write access for LossEvent, LossImpact, LossRecovery and SoxDocument only
- Associate access to SoxBusEntity, LossEvent, LossImpact, LossRecovery and SoxDocument only
- Delete access to none of the object types
- No application permissions

• Adds two new field groups and associates them with the LossEvent object.

– OPSS-LE-BE includes fields to identify the entities involved in the loss event being created
– OPSS-LE-Contact includes fields for the submitter of the loss event to provide their identifying

information
• Adds a new profile, Loss Event Entry.

The profile includes creation views for LossEvent, LossImpact, and LossRecovery. This profile drives the
views in OpenPages Loss Event Entry.

• Assigns the Loss Event Entry profile to each of the nine new users
• Assigns the Loss Event Entry role template to each of the nine new users, at the root business entity

security context point.

The XML files are located in the directory <OP_HOME>/LossEventEntry/. The following list describes
the files:

• lossevent-entry-users-op-config.xml (Users and groups)
• lossevent-entry-role-template-op-config.xml (Role templates)
• lossevent-entry-schema-op-config.xml (Schema)
• LEE_object-profile-op-config.xml (Loss Event Entry profile)
• lossevent-entry-config-opx-op-config.xml (JSON configuration file)
• OpenPages-registry-entries-LEE-op-config.xml (Registry setting)
• lossevent-entry-app-string-keys-op-config.xml (Application text)
• lossevent-entry-object-strings-op-config.xml (Object strings)
• locales/<locale>/lossevent-entry-app-strings-<locale>-op-config.xml (Application

text translations for each locale)
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Procedure

1. Load the OpenPages Loss Event Entry data (users, groups, fields, field groups, and so on).

To load the data on a Microsoft Windows computer, perform the following steps:

a) Go to <OP_HOME>\LossEventEntry\.
b) Open the Environment_Variables.bat file and update the openpages_domain_folder,
login_username, and login_password properties.

c) Run Load_LossEvent_Entry_App_Schema.bat.
d) For security purposes, remove the password from the Environment_Variables.bat file.

To load the data on a UNIX computer, perform the following steps:

a) Go to <OP_HOME>/LossEventEntry/.
b) Open the Environment_Variables.sh file and update the openpages_domain_folder,
login_username, and login_password properties.

c) Run Load_LossEvent_Entry_App_Schema.sh.
d) For security purposes, remove the password from the Environment_Variables.sh file.

2. Optional: Add LossEvent to the list of object types that are disabled for the Add New wizard.
OpenPages Loss Event Entry is more full-featured than the Add New wizard for loss events. You might
want all users, including those that have access to IBM OpenPages GRC Platform, to use OpenPages
Loss Event Entry to report loss events.
a) Go to Administrator > Settings > GRCM > Add New Wizard.
b) Expand GRCM > Add New Wizard.
c) Click Object Types Disabled
d) In the Value field, add the LossEvent object to the list.
e) Click Save.

3. Optional: Configure auto-naming for the LossEvent, LossRecovery, and LossImpact object types.
OpenPages Loss Event Entry users are unlikely to know the naming convention for new loss events,
loss impacts, and loss recoveries. To avoid failures caused by duplicate names, enable auto-naming for
these object types.
a) Go to Administrator > Settings.
b) Expand Applications > GRCM > Auto Naming.
c) Expand the object type, and then expand Auto-named. Set New Object to true and Can be Edited

to false.
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Chapter 17. IBM Regulatory Compliance Analytics
You can import data from IBM Regulatory Compliance Analytics, now called IBM Watson Regulatory
Compliance, into IBM OpenPages GRC Platform.

You need the following licenses to use this functionality:

• IBM Regulatory Compliance Analytics
• One or more of the following solutions:

– IBM OpenPages Regulatory Compliance Management
– IBM OpenPages IT Governance
– IBM OpenPages Policy and Compliance Management

These solutions entitle you to the Mandate, Requirement, and SOXControl object types in OpenPages
that store the RCA data.

You need to do some post-installation tasks to set up OpenPages for IBM Regulatory Compliance
Analytics data.

Importing an RCA certificate to the local trust store
You must import a IBM Regulatory Compliance Analytics certificate to the local trust store. It is needed to
build an SSL communication between the OpenPages GRC Platform servers and the RCA server.

Before you begin

• Obtain the host name of the secure target server, in this case the RCA server. Currently, it is
rca.ibmcloud.com. The target secure server is the server that OpenPages GRC Platform connects to
in order to retrieve the certificates.

• The target secure server application from which you are going to retrieve the certificate must be running
and listening on the port.

About this task

Complete this step even if you do not use SSL. You can use the Retrieve from port option in the IBM
WebSphere administrative console to retrieve the certificate. The root certificate contains the public key
and has been verified by the certificate authority (CA).

Procedure

1. Log on to the IBM WebSphere administrative console.
2. Expand Security and click SSL certificate and key management.
3. Under Related Items, click Key stores and certificates and click the CellDefaultTrustStore key store.
4. Under Additional Properties, click Signer certificates and Retrieve from port.
5. Enter the host and port information.

• Host: Enter the host name of the secure target server, for example:

rca.ibmcloud.com

• Port: Enter the port number of the secure target server application, for example, 443.
• Alias: Enter a descriptive name for the certificate, for example, rca.

6. Click Retrieve signer information.
7. Verify that the certificate information is for a certificate that you trust.



8. Click Apply and then click Save.
9. Restart the OpenPages GRC Platform services.

Object types, fields, and field groups for RCA data
If you upgraded and you do not have the 7.3 or later solutions schema, you might need to do some
remediation in your environment to add any missing field groups and fields.

Note: If you are using the 7.3 or later solutions schema and you did not customize it, you have the
required field groups and fields.

If you receive errors about missing field groups and fields when you load the RCA schema file, use the
following list of schema changes to help you to resolve the errors.

The RCA schema file adds the following object types and field groups:
Mandate

Field groups: OPSS-RCA-Base
Requirement

Field groups: OPSS-RCA-Base, OPSS-RCA-Ext, OPSS-RCA-Req
SOXControl

Field groups: OPSS-RCA-Base, OPSS-RCA-Ext, OPSS-RCA-Ctl

The field groups use the following fields:
OPSS-RCA-Base

Uses the following fields:

• RCA Name: The name of the object in RCA
• RCA ID: The ID of the object in RCA
• RCA Owner: The owner of the object in RCA
• RCA Assignees: The assignees of the object in RCA
• IT Process Model: The category tags for IT Process Model in RCA
• Line of Business: The category tags for Line of Business in RCA
• Product: The category tags for Product in RCA

OPSS-RCA-Ext
Uses the following fields:

• Compliance Activity: The category tags for Compliance Activity in RCA
• Compliance Theme: The category tags for Compliance Theme in RCA
• Geography: The category tags for Geography in RCA
• Key Role: The category tags for Key Role in RCA
• Risk Type: The category tags for Risk Type in RCA

OPSS-RCA-Req
Uses the following fields:

• Materiality: The category tags for Materiality in RCA
• Process: The category tags for Process in RCA
• Obligation Status: The status of the obligation in RCA
• Interpretation: The interpretation of the obligation in RCA

OPSS-RCA-Ctl
Uses the following fields:

• Control Type: The category tags for Control Type in RCA
• Policy ID: The policy ID of the control object in RCA
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• External Status: The external status of the control object in RCA
• Next Review Date: The next review date set for the control object in RCA
• Last Review Date: The date that the control object was last reviewed in RCA
• Last Updated Date: The date that the control object was last updated in RCA

The RCA schema file also makes the following changes:
OPSS-Req

Adds a new enumerated value, RCA, to the Content Source field.
OPSS-Mand

Adds new enumerated values to the Type field for the RCA document types.
Auto-naming

Enables auto-naming for the Mandate, Requirement, and SOXControl object types.

Loading the schema changes for RCA
If you upgraded to version 7.4 and you want to import data from IBM Regulatory Compliance Analytics
into OpenPages GRC Platform, you need to update the solutions schema.

If you have a new installation of version 7.4, you do not need to do this procedure. The 7.4 solutions
schema has the changes for RCA.

Before you begin
Upgrade OpenPages GRC Platform before you load the schema changes.

About this task

The script loads schema changes for three object types: Mandate, Requirement, and SOXControl. For
more information, see “Object types, fields, and field groups for RCA data” on page 308.

Procedure

1. Go to the following directory: <OP_HOME>/addon_module/loaderdata/rca
2. Review the loader file, rca-schema-op-config.xml. Make any changes that are needed for your

environment.
3. Update the openpages_domain_folder, login_username, and login_password properties in the
Environment_Variables.cmd|.sh file.

4. Run Load_Rca_Schema.bat|.sh. Wait for the script to complete before you continue to the next
step.

5. For security purposes, remove the password from the Environment_Variables.bat|.sh file.
6. Log in to OpenPages as a user with administrative privileges.
7. Optional: Update the profiles for users that will import data from RCA.

Update the profiles so that users can see the results when they import data.

a) Add the Mandate, Requirement, and SOXControl object types to the profiles.
b) Update the views to include the RCA fields.

For a list of the RCA fields, see “Object types, fields, and field groups for RCA data” on page 308.

What to do next
You can now configure OpenPages to import data from RCA. For more information, see the IBM
OpenPages GRC Administrator's Guide.
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Chapter 18. IBM OpenPages Vendor Risk
Management

IBM OpenPages Vendor Risk Management supports organizations in organizing and centralizing
information about their vendors.

As a solution it provides a configurable and customizable platform, allowing firms to:

• Create, maintain, and document all vendors and engagements
• Classify or "tier" vendors as low, medium, or high criticality
• Use standard risk assessments to identify and mitigate risk in a specific way for individual vendors
• Leverage the questionnaire assessment capability to conduct vendor or engagement tiering using

information that you gather with risk or compliance questionnaire assessments

Installation process overview for IBM OpenPages Vendor Risk Management
If you had a fresh installation of IBM OpenPages GRC Platform version 7.2 with solutions and then
upgraded to version 7.3.0.1 or later, you need to do some steps to install IBM OpenPages Vendor Risk
Management.

Important:

• If you have a fresh installation of 7.4, you do not need to do these steps. IBM OpenPages Vendor Risk
Management is installed when you do a fresh installation of version 7.4 with solutions.

• If you upgraded to version 7.4 from version 7.3.0.1 or later, you do not need to do these steps.
• If you customized the 7.2 or 7.3 solutions schema, you need to analyze your environment. Determine if

any remediation steps are required and complete the remediation work before you install IBM
OpenPages Vendor Risk Management.

• If you upgraded to version 7.2 from 7.0.x or 7.1.x, you need to analyze your environment. Determine if
any remediation steps are required and complete the remediation work before you install IBM
OpenPages Vendor Risk Management.

• If you upgraded to version 7.3 or 7.4 from 7.0.x or 7.1.x, you need to analyze your environment.
Determine if any remediation steps are required and complete the remediation work before you install
IBM OpenPages Vendor Risk Management.

The IBM OpenPages Vendor Risk Management installation process makes the following updates to your
IBM OpenPages GRC Platform environment:

• Registers the VRM solution with the IBM OpenPages GRC Platform application
• Creates VRM objects
• Creates relationships between VRM objects and other objects
• Creates VRM default profiles
• Creates the VRM role templates

Complete these steps to install IBM OpenPages Vendor Risk Management:

1. Upgrade to IBM OpenPages GRC Platform version 7.4.
2. Complete the pre-installation tasks for IBM OpenPages Vendor Risk Management. Check system

requirements and back up your environment. For more information, see “Pre-installation tasks for IBM
OpenPages Vendor Risk Management” on page 312.

3. Complete the preparation tasks for IBM OpenPages Vendor Risk Management. For more information,
see “Preparing for the installation of IBM OpenPages Vendor Risk Management” on page 312.



4. Run the scripts that load VRM into your system. For more information, see “Loading the IBM
OpenPages Vendor Risk Management solution” on page 313.

5. Configure lifecycles for VRM, see “Lifecycle triggers for IBM OpenPages Vendor Risk Management
objects” on page 314.

6. Configure the new menu items. For more information, see “Configuring menu items for IBM
OpenPages Vendor Risk Management” on page 314. This step is optional.

7. Complete the installation. For more information, see “Completing the IBM OpenPages Vendor Risk
Management installation” on page 314.

Pre-installation tasks for IBM OpenPages Vendor Risk Management
Before you install IBM OpenPages Vendor Risk Management, back up IBM OpenPages GRC Platform files,
and gather information required to complete the installation.

Ensure that IBM OpenPages GRC Platform 7.4 or later is installed.

To load the VRM profiles, you need to have the approval app schema. Determine if your environment has
the approval app schema. If you do not have the approval app, do one of the following:

• Deploy the approval app to load the schema. For more information, see Chapter 15, “Approval app,” on
page 281.

• Use the Automated Form Configuration (AFCON) spreadsheets to update the VRM profiles to remove all
references to the fields that are not in your schema. The spreadsheets are in the Profiles
subdirectory in the /OP_<version>_Non_Embedded/OP_<version>_Configuration/
Modules/VRM/OpenPages_VRM.zip file.

If you want to be able to restore your environment to its current state, back up the OpenPages application
environment, the reporting environment, and the database.

Gather the following information. You need this information to complete the installation.

• The user name and password of the OpenPages administrator on the admin application server
• The path of the OpenPages home directory, <OP_HOME>

Preparing for the installation of IBM OpenPages Vendor Risk Management
You must perform some preparation tasks before you install IBM OpenPages Vendor Risk Management.

Procedure

1. Ensure that there are no long running OpenPages processes, such as a FastMap import process or a
global search indexing process.

2. Check the status of the OpenPages servers. Verify that the following servers are running: the
OpenPages application servers (admin and non-admin), reporting servers (active and standby), the
Framework Model Generator, the database server, and the search server (if you use the global search
feature).

3. Locate the VRM installation file, OpenPages_VRM.zip.

The file is in the /OP_<version>_Non_Embedded/OP_<version>_Configuration/
Modules/VRM directory.
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Loading the IBM OpenPages Vendor Risk Management solution
You must load the IBM OpenPages Vendor Risk Management solution to create VRM objects,
relationships, profiles, and role templates.

Before you begin
Complete the tasks that are described in “Preparing for the installation of IBM OpenPages Vendor Risk
Management” on page 312 and “Pre-installation tasks for IBM OpenPages Vendor Risk Management” on
page 312.

About this task
The VRM installation kit contains four folders:
Base

Contains scripts that create VRM objects and relationships. They also register the VRM solution with
the OpenPages application.

Extended
Contains scripts that create relationships between VRM objects and other objects in the 7.2 modules
schema.

Profiles
Contains scripts that create three profiles for VRM: VRM Master Profile, VRM Vendor Profile, VRM
Vendor Manager Profile.

RoleTemplates
Contains scripts that create the VRM role template and the sample VRM user.

Procedure

1. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Modules/VRM
directory on the installation media. Locate the OpenPages_VRM.zip file.

2. Extract the OpenPages_VRM.zip file to a new directory on the admin application server.

You now have the following subdirectories: Base, Extended, Profile, and RoleTemplates.
3. Go to the Base directory.
4. Edit the Environment_Variables.cmd|.sh file.

Set the following parameters for your environment:

• Windows: openpages_domain_folder, administrator_username, and
administrator_password

• Linux and AIX: openpages_domain_folder, login_username, and login_password.
5. If you are using Windows, open a command prompt by using the Run As Administrator option. Go to

the Base directory.
6. Run the loader script.

• On Windows operating systems, run the Start.cmd script.

Start.cmd

• On AIX or Linux operating systems, run the Start.sh script.

./Start.sh

7. Verify that the script ran successfully. Check for the message Done! No errors detected. If it is
not displayed, check the Schema_Load.log file for errors.

8. Repeat these steps for the Extended directory.
9. Repeat these steps for the Profiles directory.

10. Repeat these steps for the RoleTemplates directory.
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11. Remove the administrator password from the Environment_Variables.cmd|.sh file.

Lifecycle triggers for IBM OpenPages Vendor Risk Management objects
If you want to use the VRM objects in lifecycle triggers, ensure that you updated the trigger definitions to
include VRM objects when you upgraded OpenPages.

For more information, see “Configuring lifecycles for IBM OpenPages Vendor Risk Management objects”
on page 246.

Configuring menu items for IBM OpenPages Vendor Risk Management
After you load VRM, for users with access to the Vendor objects, the Vendor menu is displayed at the end
of the menu list. You can move the Vendor menu to a location of your choosing. This step is optional.

For information, see "Menus: Modify the order of menus" in the IBM OpenPages GRC Administrator's
Guide.

Completing the IBM OpenPages Vendor Risk Management installation
Complete the remaining steps to install IBM OpenPages Vendor Risk Management.

Procedure

1. Restart the OpenPages admin application server. For information about starting and stopping servers,
see Chapter 11, “Starting and stopping servers,” on page 253.

2. If you use global search, update the search index.
a) Start the search server if it is not already started.
b) Log in to OpenPages with an administrative account.
c) Click Administration > Global Search and click Update.

3. If you want to report on the fields and field groups for VRM, regenerate the reporting framework. For
more information, see "Generating the reporting framework V6" in the IBM OpenPages GRC
Administrator's Guide.

Do this step after you have completed all other installation tasks. For example, if you want to install
other features or apps, regenerate the reporting framework after all of the features and apps are
installed.

Results
IBM OpenPages Vendor Risk Management is installed.
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Chapter 19. Uninstalling OpenPages GRC Platform
Use the uninstall process to remove the IBM OpenPages GRC Platform software.

When you uninstall OpenPages, the uninstall process takes the following actions.

For standalone deployments:

• Removes the OpenPages application
• Deletes the IBM WebSphere profiles for OpenPages, including the deployment manager
• Deletes the OP_HOME directory structure
• Deletes the CC_HOME directory structure
• Reverts changes to Cognos Analytics that were made for OpenPages
• Deletes the search directory structures
• Deletes the IBM Business Process Manager integration kit directory structures

For shared-cell deployments:

• Removes the OpenPages application
• Deletes the IBM WebSphere profiles that were created for OpenPages
• Reverts any changes to the cell and deployment manager that were made for OpenPages
• Deletes the OP_HOME directory structure
• Deletes the CC_HOME directory structure
• Reverts changes to Cognos Analytics that were made for OpenPages
• Deletes the search directory structures
• Deletes the IBM Business Process Manager integration kit directory structures

For the openpages-storage directory:

• Deletes the openpages-storage directory when Application Server1 is uninstalled, even if it is on a
network share. If it cannot be deleted, you can delete it manually after the uninstall process is finished.

For databases:

• Deletes the OpenPages data sources and reports from the Cognos Analytics content store.

For IBM Business Process Manager:

• No action is taken. The integration with IBM Business Process Manager is not uninstalled.

Uninstalling OpenPages GRC Platform process
Use these steps to uninstall IBM OpenPages GRC Platform.

Before you begin

Decide whether you need to uninstall OpenPages or roll back to a previous version. If you upgraded to
7.4.0.0 and you want to roll back to your previous version, do not do these steps. Instead, see “Rolling
back an OpenPages upgrade” on page 191.

About this task

This video demonstrates how to uninstall IBM OpenPages GRC Platform:

https://youtu.be/-z73voYO7_I

https://youtu.be/-z73voYO7_I


Procedure

1. Stop the OpenPages search server.

You can leave the application servers running or stop them. The reporting server must be running.
2. If you are using Windows, close any command prompts, folders, and files that are accessing the
<OP_HOME>, <CC_HOME>, <SEARCH_HOME>, and IBM Business Process Manager integration kit files
and directories.

3. If the OpenPages storage directory is mounted to an application server (Linux/AIX), unmount it.
4. Uninstall the OpenPages application. You can either follow the steps below or run the silent install with

the task value in the deploy.properties set to uninstall. For more information, see Appendix
A, “Silent installations,” on page 319.
a) Open your deployment in the installation app. For more information, see “Creating a deployment”

on page 121.
b) Click the task list and select Uninstall.
c) Click Validate.
d) Click Uninstall.
e) When the process completes, check the log files for any errors:
<install_server_home>/src/deployment/<deployment name>/logs/nodes/
<Server>/uninstall.log

Where <Server> depends on the server and how it is named in the deploy.properties files. The
error is displayed in the user interface. You can download the log file.

If Uninstall is still enabled in the installation app, the uninstall process did not complete.
5. On each remote server:

a) If it is running, stop the agent. Go to the server card and click  or manually stop the agent with the
npm stop command.

b) Log on to the server and uninstall the agent software.
c) Under the agent directory, go to the /install/<OS type> directory.
d) Run the uninstall script.

• Windows

uninstall.bat

• Linux or AIX:

./uninstall.sh

e) Delete the agent directory.
6. Uninstall the installation server.

a) Log out and close the installation app.
b) Stop the installation server. For more information, see “Stopping the installation server” on page

40.
c) Go to the OP_<version>_Installer/install/<OS type> directory.
d) Run the uninstall script.

• Windows

uninstall.bat

• Linux or AIX:

./uninstall.sh
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e) Delete the <installation_server_home> directory where the installation app was installed, for
example, NewInstaller.

What to do next

1. Drop the OpenPages database schema by using AuroraDBDelete.sql. For more information, see
“Dropping all OpenPages objects in a DB2 database” on page 110 and “Dropping the full schema in an
Oracle database” on page 120.

2. Drop the Cognos Analytics content store database schema by using AuroraDBDelete.sql. For more
information, see “Preparing to import the Cognos content store (Oracle)” on page 223.

3. Check IBM WebSphere for OpenPages profiles. If OpenPages profiles still exist, delete them.

To get a list of profiles:

cd <WAS_HOME>/AppServer/bin
./manageprofiles.sh|.bat -listProfiles

To delete profiles:

./manageprofiles.sh|.bat -delete -profileName <profile-name>

4. Verify that the OP_HOME directory does not exist.
5. Verify that the CC_HOME directory does not exist.
6. Verify that the SEARCH_HOME directory does not exist.
7. Verify that the IBM Business Process Manager integration kit directory does not exist.
8. Verify that the openpages-storage directory does not exist.
9. You can now reinstall OpenPages.
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Appendix A. Silent installations
You run a silent installation from the command line by using inputs that you provide in a deployment
configuration file.

This video demonstrates how to install IBM OpenPages GRC Platform in silent mode:

https://youtu.be/MV8WaNlKIdI

Creating a deployment file by using the installation server
You can use the installation server to save a deployment file that you can use to run a silent installation.

Procedure

1. Open Google Chrome or Internet Explorer.
2. Go to the URL for the installation app.

For example, go to https://<host>:8443

Replace <host> with the name of the computer where you set up the installation server, and ensure
that you use the correct port number. 8443 is the default port number.

For example, https://appserver1.mycompany.com:8443

If you are running the installation server on your local computer, go to https://localhost:8443
3. Enter your credentials, and click Login.
4. Click Create New, enter a name for the deployment in Deployment Name, and click Create.
5. Enter the values for the installation that you want to deploy, and click Save.

If you are going to run the installation on a different computer from where you are running the
installation app, click the gear icon, and then click Download Properties. If you are using Internet
Explorer, click Save or Save As.

The installation server creates a directory for the deployment and a deploy.properties file. The
deployment directory uses the Deployment Name value. The directory is in the
OP_<ver>_Installer/src/deployment directory where you are running the installation server.

Creating a deployment file manually
You can manually create a deployment file for your silent installation by using one of the template files
that are provided with the installation.

Procedure

1. On the computer where you copied the installation files, go the deployment directory.
For example, go to the /home/opuser/OP_<ver>_Installer/src/deployment directory on
Linux operating systems or the C:\OP_<ver>_Installer\src\deployment directory on Microsoft
Windows operating systems.

2. Create a directory for the deployment that you want to run.
For example, create a directory that is named myopinstall. If you used the above path, the full path
would be /home/opuser/OP_<ver>_Installer/src/deployment/myopinstall

Important: Do not use spaces or special characters in the directory name.
3. Copy the deploy-unix.properties or the deploy-win.properties file to the directory that you

created.

https://youtu.be/MV8WaNlKIdI


4. Go to the deployment directory, and open the deploy-unix.properties or deploy-
win.properties file in a text editor.

5. Enter the values to use for your deployment, and save the file.

For more information about the properties, see “Deployment file properties” on page 320.

• On Microsoft Windows operating systems, all path properties must use double backslashes. For
example, C:\\app\\Administrator\\product\\12.1.0\\client

• If you are using the remote deploy option, remote_deploy=true, you must provide values for the
following properties:

– agent_port is the port number for the agent to use
– agent_directory is the folder on the remote server where you want to install the agent
– local_username is the user name on the remote server that you want to use to run the

installation on the remote server. The user must have administrative privileges on the remote
server.

– local_password is the password for the administrative user on the remote server.
– On Linux and AIX operating systems, you must enter the ssh_port value for the port number to

use on the remote server.

If you are not using the remote deploy option, remote_deploy=false, these values are not used.
6. Rename the deploy-unix.properties or deploy-win.properties file to
deploy.properties

Deployment file properties
The deploy.properties file is used by the silent installation command for a new installation, a file
migration, or to upgrade the application data.

You must modify the task value in the deploy.properties file to indicate a new installation, a file
migration, or to upgrade the application data. The rest of the properties in the file stay the same for a new
installation, a file migration, or to upgrade the application data.

Table 59: Deployment file properties

Property Values Description

deploy_type standalone

shared-cell

standalone for a standalone
deployment

shared-cell for a shared cell
deployment

task fresh

file-migration

upgrade-app-data

current-deployment

uninstall

fresh for a new installation

file-migration to migrate
from an existing installation

upgrade-app-data to upgrade
the application data

current-deployment to
modify an existing environment,
such as adding a node

uninstall to uninstall an
environment
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Table 59: Deployment file properties (continued)

Property Values Description

module true

false

The module value indicates
whether to install the IBM
OpenPages solutions.

os windows

linux

aix

The host computer operating
system.

remote_deploy true

false

This value determines whether
the installation is on a different
host than the computer that runs
the installer.

auto_roll_back true

false

This value determines whether
the installation will roll back a
failed operation.

install_db

For more information, see:

• “Configuring the database
server (DB2)” on page 125

• “Configuring the database
server (Oracle)” on page 127

full

nondba

done

full to install the full database.
This option requires DBA
credentials.

nondba if the DBA installation
actions are already complete.
The installer will perform the
non-DBA installation steps.

done if the database installation
is already complete.

db_type Oracle

DB2

Oracle for an Oracle database

DB2 for an IBM DB2 database.
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Table 59: Deployment file properties (continued)

Property Values Description

java_home_directory The absolute path to JAVA_HOME
on the server

For application servers and the
deployment manager, use the
IBM Java JRE that is supplied
with IBM WebSphere Application
Server.

For reporting servers, use the
IBM Java JRE that is supplied
with Cognos or the Java that you
configured for Cognos.

For each server, the path that you
enter must match the path
specified in the JAVA_HOME
system environment variable on
the server.

If the reporting server is
deployed on the same server as
the deployment manager or on
the same server as an application
server, do the following:

• On the server, set JAVA_HOME
to the IBM Java JRE that is
supplied with IBM WebSphere
Application Server.

• For the
java_home_directory
property in the [report
server1] section, use the
same path as you specified for
JAVA_HOME.

Modifying the migration properties file
If you are migrating any files from an existing OpenPages environment, you can do so by using the silent
installation commands. You must edit the migration.properties file that is provided with the
installation files.

Procedure

1. On the computer where you copied the installation files, go the deployment directory.
For example, go to the /home/opuser/OP_<ver>_Installer/src/deployment directory on
Linux operating systems or the C:\OP_<ver>_Installer\src\deployment directory on Microsoft
Windows operating systems.

2. Copy the migration.properties file to the directory where you saved the deploy.properties
file.

For more information about the location, see “Creating a deployment file manually” on page 319.
3. Go to the directory, and open the migration.properties file in a text editor.
4. Edit the values to match your existing OpenPages environment.
5. Save and close the file.
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Running the silent installation commands
After you create the deployment properties file, you can run the silent installation from the command line.

You use the silent installation command for:

• A fresh installation, where task = fresh in the deploy.properties file.
• A back up and restore task to migrate from your existing OpenPages environment to the new

environment. The deploy.properties must have task = file-migration, and you must
configure the migration.properties file. The file-migration task will also perform the
upgrade-app-data task.

• An application data upgrade task, where task = upgrade-app-data in the deploy.properties
file.

If you are migrating from an existing installation, you must follow this process:

1. Run a fresh install of OpenPages.

The task value in the deploy.properties file is set to fresh:

task = fresh
2. Upgrade the database. For more information, see

• Chapter 8, “Upgrade tasks for DB2 databases,” on page 193
• Chapter 9, “Upgrade tasks for Oracle databases,” on page 215

3. Do one of the following:

• Run a file migration to backup and restore any files to the new installation.

The task value in the deploy.properties file is set to file-migration:

task = file-migration

You must also edit the migration.properties file to match your existing environment. (The
OpenPages environment that you are migrating from.)

The file-migration task will also perform the upgrade-app-data task.
• If you do not want to do a backup/restore, you must run the upgrade application data task.

The task value in the deploy.properties file is set to upgrade-app-data:

task = upgrade-app-data

For more information, see .“Upgrading application data” on page 179.

For more information about upgrading, see “Upgrade scenarios” on page 167.

Procedure

1. On the computer where you copied the installation files, go to the OP_<ver>_Installer directory.
2. Ensure you have the correct value for the task that you want to run set in the deploy.properties

file.
3. Run the following command:

npm run silent <deployment_name> acceptLicense

Where <deployment_name> is the name for the deployment that you used in the installation app and
the deployment folder that you created in the OP_<ver>_Installer/src/deployment directory.

Note: Do not close the command prompt or shell window until after the process completes.
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Appendix B. Install OpenPages by using Docker
You can use Docker to install OpenPages. Use Docker to quickly install a small environment for testing or
demonstration purposes.

You can install all of the OpenPages components on one computer, or you can separate the database
components from the application components.

Installing Docker
You must install Docker. If you are installing Docker on an Linux operating system, you must also install
Docker Compose.

Before you begin

Ensure that you have a minimum of 16 GB of RAM and 100 GB of free disk space on the computer on
which you install Docker.

On Linux operating systems, you must also enable the extras repositories. For example,

• On Red Hat Enterprise Linux operating systems, use the following command to enable the extra RHEL
repositories:

sudo yum-config-manager --enable rhel-7-server-extras-rpms
• On CentOS, use the following command:

sudo yum-config-manager --enable extras

If you are going to run OpenPages in a distributed environment, you must install Docker on two
computers.

Procedure

1. Install Docker. For more information about installing Docker, see the product documentation:

• For Linux operating systems, see Get Docker CE for CentOS (https://docs.docker.com/engine/
installation/linux/docker-ce/centos/).

• For Microsoft Windows operating systems, see Install Docker for Windows (https://
docs.docker.com/docker-for-windows/install/).

For some versions of Microsoft Windows, you might have to install Docker Toolbox. For more
information, see Install Docker Toolbox on Windows (https://docs.docker.com/toolbox/
toolbox_install_windows/).

• For macOS operating systems, see Install Docker for Mac (https://docs.docker.com/docker-for-
mac/install/).

2. If you are installing on Linux operating systems, do the following steps:
a) Create a Docker group and add your user name to the group to allow for easier installation. For

more information, see Manage Docker as a non-root user (https://docs.docker.com/engine/
installation/linux/linux-postinstall/).

b) Configure Docker to start when the computer starts up. For more information, see Configure Docker
to start on boot (https://docs.docker.com/engine/installation/linux/linux-postinstall/).

c) Install Docker Compose. For more information, see Install Docker Compose (https://
docs.docker.com/compose/install/).

3. On Microsoft Windows or macOS operating systems, you must configure resource allocations.
a) On Microsoft Windows operating systems, right-click the Docker icon on the Windows Taskbar, and

click Settings.

https://docs.docker.com/engine/installation/linux/docker-ce/centos/
https://docs.docker.com/docker-for-windows/install/
https://docs.docker.com/toolbox/toolbox_install_windows/
https://docs.docker.com/docker-for-mac/install/
https://docs.docker.com/engine/installation/linux/linux-postinstall/#manage-docker-as-a-non-root-user
https://docs.docker.com/engine/installation/linux/linux-postinstall/#configure-docker-to-start-on-boot
https://docs.docker.com/engine/installation/linux/linux-postinstall/#configure-docker-to-start-on-boot
https://docs.docker.com/compose/install/


b) On macOS operating systems, click the Docker icon on the Menu bar, and click Preferences.
c) On the Advanced tab, allocate at least 4 CPUs and 10240 MB for memory.
d) On Microsoft Windows operating systems, click Apply.

4. If you are using Docker Toolbox, you must create the Docker machine that is suitable to install
OpenPages into.
a) Open the Docker Quickstart Terminal.
b) Run the following command to remove the default machine:
docker-machine rm -f default

c) Run the following command to create a machine that is suitable to install OpenPages into:

docker-machine create --driver virtualbox --virtualbox-disk-size "100000" --virtualbox-
cpu-count "4" --virtualbox-memory "10240" default

d) Run the following command and record the machine IP address. You must use the IP address to
access the OpenPages URL.

docker-machine ip
e) Stop the Docker machine:

docker-machine stop
f) Start the Docker machine:

docker-machine start

Installing OpenPages on a single server by using Docker
After you install Docker, you can load and then start the OpenPages application.

About this task

This video demonstrates how to install OpenPages on a single server using Docker:

https://youtu.be/nO6EpCVhkK8

Procedure

1. On the computer where you installed Docker, create a directory for the files.
For example, create a directory that is named OPDocker.

2. If you are installing OpenPages on a single computer, copy the following downloaded files to the
directory:

• op<version>.tar.gz
• .env
• docker-compose.yml

3. In a terminal window, go to the directory where you copied the files, and run the following command to
load the Docker containers:

docker load -i op<version>.tar.gz

The command can take some time to run as it loads all of the software and the database content.
4. On Microsoft Windows operating systems, ensure that the HOSTNAME variable is set.

In a PowerShell terminal, run the following command:

echo $env:HOSTNAME

If the value is not set, you can set it in the terminal window or add it to the .env file that you copied
with the op<version>.tar.gz and docker-compose.yml files.
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5. Open the .env file, and ensure that the OPVER variable value matches the version of OpenPages that
you are installing.

6. On all operating systems, run the following command:

docker-compose up -d

Starting the application can take some time. Wait at least 10 minutes before you can access the
application.

After the application starts, you can access it at https://<hostname>:10111/

For information about the log in credentials, see the cheatsheet_*.txt text files that are provided
with the installation source files.

Installing OpenPages in a distributed environment by using Docker
After you install Docker, you can load and then start the OpenPages application. In a distributed
environment, you use two Docker instances. One instance runs the database container and the other runs
the application containers.

Procedure

1. On the Docker instance where you run the database container, do the following steps:
a) Copy the following downloaded files to the directory:

• op<version>.tar.gz
• db.env
• dc-db-db2.yml

b) In a terminal window, go to the directory where you copied the files, and run the following
command:

docker load -i op<version>.tar.gz

The command can take some time to run as it loads all of the software and the database content.
2. On the Docker instance where you run the application containers, do the following steps:

a) Copy the following downloaded files to the directory:

• op<version>.tar.gz
• app.env
• dc-app-db2.yml

b) In a terminal window, go to the directory where you copied the files, and run the following
command to load the Docker containers:

docker load -i op<version>.tar.gz

The command can take some time to run as it loads all of the software and the database content.
3. On Microsoft Windows operating systems, ensure that the HOSTNAME variable is set on both Docker

instances.

In a PowerShell terminal, run the following command:

echo $env:HOSTNAME

If the value is not set, you can set it in the terminal window or add it to the .env file that you copied
with the op<version>.tar.gz and docker-compose.yml files.

Repeat this step on the second Docker instance.
4. On all operating systems, on the Docker instance where you run the database container, do the

following steps:
a) Rename db.env to .env.
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b) Ensure that the OPVER variable value in the .env file matches the version of OpenPages that you
are installing.

c) Run the following command:

docker-compose -f dc-db-db2.yml up -d
5. On all operating systems, on the Docker instance where you run the application container, do the

following steps:
a) Rename app.env to .env.
b) Open the .env file in a text editor.
c) Change the OPDB_HOST and OPREPORTDB_HOST values to the fully qualified domain name or IP

address of the computer where the database container is running.
d) Ensure that the OPVER variable value in the .env file matches the version of OpenPages that you

are installing.
e) Save and close the file.
f) Run the following command:

docker-compose -f dc-app-db2.yml up -d

Starting the application can take some time. Wait at least 10 minutes before you can access the
application.

After the application starts, you can access it at https://
<hostname_for_application_server>:10111/

<hostname_for_application_server> is the computer where you installed the application
server container.

For information about the log in credentials, see the cheatsheet_*.txt text files that are provided
with the installation source files.

Installing OpenPages with BPM in a distributed environment by using
Docker

After you install Docker, you can load and then start the OpenPages application. In a distributed
environment, you use two Docker instances. One instance runs the database container and the other runs
the application containers.

Procedure

1. On the Docker instance where you run the database container, do the following steps:
a) Copy the following downloaded files to the directory:

• op<version>.tar.gz
• op<version>bpm.tar.gz
• db.env
• dc-bpm-db-db2.yml

b) In a terminal window, go to the directory where you copied the files, and run the following
command to load the Docker containers:

docker load -i op<version>.tar.gz

docker load -i op<version>bpm.tar.gz

The command can take some time to run as it loads all of the software and the database content.
2. On the Docker instance where you run the application containers, do the following steps:

a) Copy the following downloaded files to the directory:
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• op<version>.tar.gz
• op<version>bpm.tar.gz
• app.env
• dc-bpm-app-db2.yml

b) In a terminal window, go to the directory where you copied the files, and run the following
command to load the Docker containers:

docker load -i op<version>.tar.gz

docker load -i op<version>bpm.tar.gz

The command can take some time to run as it loads all of the software and the database content.
3. On Microsoft Windows operating systems, ensure that the HOSTNAME variable is set on both Docker

instances.

In a PowerShell terminal, run the following command:

echo $env:HOSTNAME

If the value is not set, you can set it in the terminal window or add it to the .env file that you copied
with the op<version>.tar.gz, docker load -i op<version>bpm.tar.gz, and docker-
compose.yml files.

Repeat this step on the second Docker instance.
4. On all operating systems, on the Docker instance where you run the database container, do the

following steps:
a) Rename db.env to .env.
b) Run the following command:

docker-compose -f dc-bpm-db-db2.yml up -d
5. On all operating systems, on the Docker instance where you run the application container, do the

following steps:
a) Rename app.env to .env.
b) Open the .env file in a text editor.
c) Change the OPDB_HOST, OPREPORTDB_HOST, and OPBPMDB_HOST values to the fully qualified

domain name or IP address of the computer where the database container is running.
d) Ensure that the OPVER variable value in the .env file matches the version of OpenPages that you

are installing.
e) Save and close the file.
f) Run the following command:

docker-compose -f dc-bpm-app-db2.yml up -d

Starting the application can take some time. Wait at least 10 minutes before you can access the
application.

After the application starts, you can access it at https://
<hostname_for_application_server>:10111/

<hostname_for_application_server> is the computer where you installed the application
server container.

For information about the log in credentials, see the cheatsheet_*.txt text files that are provided
with the installation source files.
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Installing only the OpenPages applications by using Docker
If you already have a DB2 instance, you can restore the OpenPages and Cognos databases to your DB2
instance, and then install the OpenPages applications by using Docker.

Procedure

1. Load the OpenPages Docker containers.
a) On Microsoft Windows operating systems, ensure that the HOSTNAME variable is set on both

Docker instances.

In a PowerShell terminal, run the following command:

echo $env:HOSTNAME

If the value is not set, you can set it in the terminal window or to the .env file that you use in step 4
below.

b) On all operating systems, on the Docker instance where you want to run the application containers,
copy the following downloaded files to the directory:

• op<version>.tar.gz
• app.env
• dc-app-db2.yml

c) On all operating systems, in a terminal window, go to the directory where you copied the files, and
run the following command:

docker load -i op<version>.tar.gz

The command can take some time to run as it loads all of the software and the database content.
2. Create a backup of the OpenPages and the Cognos databases from the Docker container.

a) Run the following command to create a backup of the OpenPages database to a /tmp directory:

docker run --rm -v /tmp:/tmp op-dkreg-kvm01.swg.usma.ibm.com:5000/op/
opdbdata_db2:<opversion> sh -c 'cp /home/db2inst1/backup/*.gz /tmp/'

b) Run the following command to create a backup of the Cognos database to a /tmp directory:

docker run --rm -v /tmp:/tmp op-dkreg-kvm01.swg.usma.ibm.com:5000/op/
opreportdbdata_db2:<opversion> sh -c 'cp /home/db2inst1/backup/*.gz /tmp/'

3. Restore the databases to your DB2 instance.
a) Copy the two *.gz files to the computer where DB2 is installed.
b) Run the following command to restore the databases:

db2 restore database <database alias> from <backup directory>

You must run the command for the OpenPages database and the Cognos database. Ensure that the
DB2 database instance that you restore the OpenPages database to has Oracle compatibility
enabled.

4. Start the OpenPages application servers.
a) On the computer where you copied the downloaded files, rename app.env to .env.
b) Open the .env file in a text editor.
c) Change the OPDB_* values to the database connection parameters for the OpenPages database.
d) Change the OPREPORTDB_* values to the database connection parameters for the Cognos

database.
e) Ensure that the OPVER variable value in the .env file matches the version of OpenPages that you

are installing.
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f) Save and close the file.
g) Run the following command:

docker-compose -f dc-app-db2.yml up -d

Starting the application can take some time. Wait at least 10 minutes before you can access the
application.

After the application starts, you can access it at https://
<hostname_for_application_server>:10111/

<hostname_for_application_server> is the computer where you installed the application
server container.

For information about the log in credentials, see the cheatsheet_*.txt text files that are provided
with the installation source files.

Note: The Cognos data source signon credentials are not updated by the container startup. You must
manually update the signon credentials after the Cognos server starts. For more information, see
Modifying a signon in the Cognos documentation (https://www.ibm.com/support/knowledgecenter/en/
SSEP7J_11.0.0/com.ibm.swg.ba.cognos.ug_cra.doc/
t_asg_stepstomodifyasignon.html#ASG_StepstoModifyaSignon).

Installing only the OpenPages and BPM applications by using Docker
If you already have a DB2 instance, you can restore the OpenPages and Cognos databases to your DB2
instance, and then install the OpenPages applications by using Docker.

Procedure

1. Load the OpenPages Docker containers.
a) On Microsoft Windows operating systems, ensure that the HOSTNAME variable is set on both

Docker instances.

In a PowerShell terminal, run the following command:

echo $env:HOSTNAME

If the value is not set, you can set it in the terminal window or to the .env file that you use in step 4
below.

b) On all operating systems, on the Docker instance where you want to run the application containers,
copy the following downloaded files to the directory:

• op<version>.tar.gz
• op<version>bpm.tar.gz
• app.env
• dc-app-db2.yml

c) On all operating systems, in a terminal window, go to the directory where you copied the files, and
run the following command:

docker load -i op<version>.tar.gz

docker load -i op<version>bpm.tar.gz

The command can take some time to run as it loads all of the software and the database content.
2. Create a backup of the OpenPages, Cognos, and BPM databases from the Docker container.

a) Run the following command to create a backup of the OpenPages database to a /tmp directory:

docker run --rm -v /tmp:/tmp op-dkreg-kvm01.swg.usma.ibm.com:5000/op/
opdbdata_db2:<opversion> sh -c 'cp /home/db2inst1/backup/*.gz /tmp/'
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b) Run the following command to create a backup of the Cognos database to a /tmp directory:

docker run --rm -v /tmp:/tmp op-dkreg-kvm01.swg.usma.ibm.com:5000/op/
opreportdbdata_db2:<opversion> sh -c 'cp /home/db2inst1/backup/*.gz /tmp/'

c) Run the following command to create a backup of the BPM database to a /tmp directory:

docker run --rm -v /tmp:/tmp op-dkreg-kvm01.swg.usma.ibm.com:5000/op/
opbpmdbdata_db2:<opversion> sh -c 'cp /home/db2inst1/backup/*.gz /tmp/'

3. Restore the databases to your DB2 instance.
a) Copy the three *.gz files to the computer where DB2 is installed.
b) Run the following command to restore the databases:

db2 restore database <database alias> from <backup directory>

You must run the command for the OpenPages database, the Cognos database, and the BPM
database. Ensure that the DB2 database instance that you restore the OpenPages database to has
Oracle compatibility enabled.

4. Start the OpenPages application servers.
a) On the computer where you copied the downloaded files, rename app.env to .env.
b) Open the .env file in a text editor.
c) Change the OPDB_* values to the database connection parameters for the OpenPages database.
d) Change the OPREPORTDB_* values to the database connection parameters for the Cognos

database.
e) Change the OPBPMDB_* values to the database connection parameters for the BPM database.
f) Ensure that the OPVER variable value in the .env file matches the version of OpenPages that you

are installing.
g) Save and close the file.
h) Run the following command:

docker-compose -f dc-app-db2.yml up -d

Starting the application can take some time. Wait at least 10 minutes before you can access the
application.

After the application starts, you can access it at https://
<hostname_for_application_server>:10111/

<hostname_for_application_server> is the computer where you installed the application
server container.

For information about the log in credentials, see the cheatsheet_*.txt text files that are provided
with the installation source files.

Note: The Cognos data source signon credentials are not updated by the container startup. You must
manually update the signon credentials after the Cognos server starts. For more information, see
Modifying a signon in the Cognos documentation (https://www.ibm.com/support/knowledgecenter/en/
SSEP7J_11.0.0/com.ibm.swg.ba.cognos.ug_cra.doc/
t_asg_stepstomodifyasignon.html#ASG_StepstoModifyaSignon).

Accessing the OpenPages applications
The application URLs and credential information for OpenPages, Cognos, and IBM BPM installations from
Docker are provided in the cheatsheet_deployment_info.txt file that is provided with the
installation source files.
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Stopping and starting OpenPages services deployed to Docker and other
tasks

You stop and start the OpenPages application services by using docker-compose commands, and you can
perform additional tasks by using Docker commands.

Procedure

1. To stop the OpenPages application, run the following command in a terminal window:

docker-compose stop
2. To start the OpenPages application, run the following command in a terminal window:

docker-compose start
3. You can use the following commands to check the status of the OpenPages containers:

• Use the following command to list all of the active containers, the original images of containers, and
the start-up command configurations:

docker ps
• Use the following command to list all of the active containers and the stopped containers:

docker ps -a
• Use the following command to show the CPU, memory, and I/O usage for the containers:

docker stats
• Use the following command to show the console output for the container:

docker logs <container_name>
• Use the following command to run commands on the container:

docker exec <container_name> <command>

For example, you can access the container by using the following command:

docker exec -it <container_name> /bin/bash
• Use the following command to access the bash terminal for a container:

ssh -l <user> -p <port> <localhost | docker_host_IP>

For the credential and port information, see the cheatsheet_deployment_info.txt file that is
provided with the installation source files.

4. Some additional tasks are documented in the cheatsheet_misc_operations.txt file that is
provided with the installation source files.
For example, migrating data into containers, taking a backup, persisting your customizations as your
own images, and transferring a deployment from one system to another.

Uninstalling OpenPages from Docker
You can uninstall the OpenPages containers and also free up the disk space that is allocated to the
contains by using Docker commands.

Procedure

1. Use the following command to stop and remove the OpenPages containers:

docker-compose down -v
2. Use the following command to remove the images to free up disk space:

docker rmi -f $(docker images -q)
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Appendix C. Adding servers to an OpenPages GRC
Platform deployment

You can add non-admin application servers and standby reporting servers to your IBM OpenPages GRC
Platform deployment.

This video demonstrates how to add servers to a deployment. You can add non-admin application servers
and standby reporting servers to create or expand a horizontal cluster. You can also add vertical cluster
members to an application server:

https://youtu.be/YuuCXuz8FAs

Adding servers to a deployment (horizontal cluster members)
You can add servers to a IBM OpenPages GRC Platform deployment. You can add non-admin application
servers and standby reporting servers to increase the number of horizontal cluster members.

Before you begin

Review the following checklist before you add servers to your installation:

• Ensure that the installation server can communicate with all of the servers in your deployment,
including the servers that you want to add.

• Ensure that the servers you want to add can access the openpages-storage directory.
• Prepare the servers that you want to add to your deployment. For more information, see the following

topics in the IBM OpenPages GRC Installation and Deployment Guide

– “Checklist for Windows servers” on page 47
– “Checklist for Linux and AIX servers” on page 47

On the server that you are adding, configure the same file system user names and passwords that you
are using for the other servers in your deployment. Also, use the same file share permissions on all
servers.

– “Checklist for application servers” on page 52
– “Checklist for reporting servers” on page 88

• Ensure that the same version of IBM Java Software Development Kit (SDK) or IBM WebSphere SDK Java
Technology for WebSphere Application Server is installed.

Attention: If you are using SSL for your application servers, you must ensure that you are not using
the TLSv1.1 or the TLSv1.2 protocols while you add the servers. For more information, see
Verifying the SSL protocol before you deploy a new non-administrative server.

If you want to use TLSv1.1 or the TLSv1.2, you can change the SSL protocol to either of these protocols
after you complete the configuration.

Procedure

1. Verify the status of the servers in your deployment. All servers must be running, except for the search
server, which must be stopped.
See Chapter 11, “Starting and stopping servers,” on page 253.

2. Start the installation app and log in.
3. Open your deployment.
4. Do one of the following steps on the server that you want to add:

• Update the antivirus policy on the remote server to allow Node.js.
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• Disable antivirus software on the remote server. You can re-enable it after you complete the
installation of the new servers.

5. Add a new horizontal cluster member:
a) Click the server list and click the type of server that you want to add.

• Click Application Server to add a non-admin application server horizontal cluster member.
• Click Reporting Server to add a standby reporting server horizontal cluster member.

A new server card is added to your deployment.
b) Enter values for the server.

If you are adding application servers, you must enter unique names in the OP Node Name and OP
Server Name fields.

If you are adding reporting servers, you must configure additional Cognos dispatchers to ensure
that the incoming requests are distributed across the reporting servers.

For more information, see the IBM OpenPages GRC Installation and Deployment Guide.
6. Click Validate to save and validate the deployment.

During the validation process, the installation app installs the agent software on the remote servers,
starts the agents, validates the deployment properties, and verifies that the prerequisites for the
installation are complete.

For example, the following image shows an application server card after validation is complete The
Agent On icon is green, indicating that the agent is installed and running on the remote server.

Figure 19: Agent software is running on Application Server1

You can download a validation report. Click the link at the top of the page.

Figure 20: Click to download a validation report

The validation reports are also stored in the <installation_server_home>/src/deployment/
<deployment-name>/validation directory.

Fix any errors and review the warnings. Click Save, and then click Validate. When the Install button
is available, you can continue. If fixing issues requires an update to the environment variables on any
servers, you must restart the installation server/agent on that server before re-validating.

7. Click Install.
The installation server stages the assets onto the new servers in your deployment.

Tip: You can log out and close the browser window. The Install process continues to run. When you
log in to the installation app again, the app shows the status of your deployment. You can also close
the browser window during the Configure process.
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8. Click Configure.
The installation server sets up and configures the IBM OpenPages GRC Platform components.

9. Start the search server.
The installation server restarts the other servers in your deployment automatically.

10. Do the post installation tasks.

If you added a non-admin application server, do the following tasks:

• If the server is running on Windows, configure the OpenPages services to run under a domain
account. See “Configuring OpenPages GRC Platform applications to use a domain account on
Windows operating systems” on page 139.

• If the server is running on Linux or AIX, configure file share permissions. See “Configuring file share
permissions on AIX or Linux operating systems” on page 139.

• Configure the load balancer. See “Configuring IBM HTTP Server to load balance application
servers ” on page 144.

• Verify that you have shared the openpages-storage directory so that the non-admin application
server can access it. See “Sharing a network OpenPages GRC Platform storage directory on AIX or
Linux operating systems” on page 139 or “Sharing a network OpenPages GRC Platform storage
directory on Windows operating systems” on page 141.

If you added a standby reporting server, do the following tasks:

• Configure the load balancer. See “Load balancing the OpenPages GRC Platform reporting server” on
page 148.

Results

When the installation is complete, ensure that you can log in to OpenPages and complete tasks such as
creating or updating objects, and running reports.

Adding non-admin application servers to a deployment (vertical cluster
members)

You can add non-admin application servers to a IBM OpenPages GRC Platform deployment by increasing
the number of vertical cluster application servers.

Before you begin

Review the following checklist before you add servers to your installation:

• Ensure that the installation server can communicate with all of the servers in your deployment.

Procedure

1. Decide which application server you want to modify. Ensure that the server has sufficient hardware
resources to support vertical cluster members.

Open the Detailed System Requirements report. Click the Hardware tab. Review the detailed system
requirements for application servers.

2. Verify the status of the servers in your deployment. All servers must be running, except for the search
server, which must be stopped.
See Chapter 11, “Starting and stopping servers,” on page 253.

3. Start the installation app and log in.
4. Open your deployment.
5. Click the Application Server card of the server you want to modify.
6. Add vertical cluster members by increasing the value in the OP Vertical Cluster Number field.
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Note: Do not decrease the number of vertical cluster members. A decrease in the value can cause
validation errors.

7. Click Validate to save and validate the deployment.

You can download a validation report. Click the link at the top of the page.

Figure 21: Click to download a validation report

The validation reports are also stored in the <installation_server_home>/src/deployment/
<deployment-name>/validation directory.

Fix any errors and review the warnings. Click Save, and then click Validate. When the Install button
is available, you can continue. If fixing issues requires an update to the environment variables on any
servers, you must restart the installation server/agent on that server before re-validating.

8. Click Install.
The installation server stages the assets onto the new servers in your deployment.

Tip: You can log out and close the browser window. The Install process continues to run. When you
log in to the installation app again, the app shows the status of your deployment. You can also close
the browser window during the Configure process.

9. Click Configure.
The installation server sets up and configures the IBM OpenPages GRC Platform components.

10. Start the search server.
The installation server restarts the other servers in your deployment automatically.

Results

When the installation is complete, ensure that you can log in to OpenPages and complete tasks such as
creating or updating objects, and running reports.

What to do next

Update the load balancer with information for the new non-admin application server. See “Configuring
IBM HTTP Server to load balance application servers ” on page 144.
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Appendix D. Troubleshooting problems
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to
determine why something does not work as expected and how to resolve the problem.

Review the following table to help you or customer support resolve a problem.

Table 60: Troubleshooting actions to prevent problems

Action Description

Apply all known fix packs, service levels, or
program temporary fixes (PTF).

A product fix might be available to fix the problem.

Ensure that the configuration is supported. Review the software and hardware requirements in
the Supported Environments document.

Look up error message codes by selecting the
product from the IBM Support Community and
then typing the error message code into the
Search support box.

Error messages give important information to help you
identify the component that is causing the problem.

Reproduce the problem to ensure that it is not
just a simple error.

If samples are available with the product, you might
try to reproduce the problem by using the sample
data.

Check the installation directory structure and
file permissions.

The installation location must contain the appropriate
file structure and the file permissions.

For example, if the product requires write access to
log files, ensure that the directory has the correct
permission.

Review relevant documentation, such as
release notes, technotes, and proven practices
documentation.

Search the IBM knowledge bases to determine
whether your problem is known, has a workaround, or
if it is already resolved and documented.

Review recent changes in your computing
environment.

Sometimes installing new software might cause
compatibility issues.

If you still need to resolve problems, you must collect diagnostic data. This data is necessary for an IBM
technical-support representative to effectively troubleshoot and assist you in resolving the problem. You
can also collect diagnostic data and analyze it yourself.

Troubleshooting resources
Troubleshooting resources are sources of information that can help you resolve a problem that you have
with a product. Many of the resource links provided can also be viewed in a short video demonstration.

To view the video version, search for "troubleshooting" through either Google search engine or YouTube
video community.

http://www.ibm.com/support/docview.wss?uid=swg27039467
https://www.ibm.com/mysupport


Support Community
The IBM Support Community is a unified, centralized view of all technical support tools and information
for all IBM systems, software, and services.

Use IBM Support Community to access all the IBM support resources from one place. You can adjust the
pages to focus on the information and resources that you need for problem prevention and faster problem
resolution.

Find the IBM OpenPages GRC Platform content that you need by selecting your products from the IBM
Support Community.

Service requests
Service requests are also known as Problem Management Records (PMRs). Several methods exist to
submit diagnostic information to IBM Software Technical Support.

To open a service request, or to exchange information with technical support, view the IBM Software
Support Exchanging information with Technical Support page (www.ibm.com/software/support/
exchangeinfo.html). Service requests can also be submitted directly by using the Service requests (PMRs)
tool (www.ibm.com/support/entry/portal/Open_service_request) or one of the other supported methods
that are detailed on the exchanging information page.

Fix Central
Fix Central provides fixes and updates for your system software, hardware, and operating system.

Use the pull-down menu to go to your product fixes on Fix Central (www.ibm.com/support/fixcentral). You
might also want to view Getting started with Fix Central (www.ibm.com/systems/support/fixes/en/
fixcentral/help/getstarted.html).

Knowledge bases
You can often find solutions to problems by searching IBM knowledge bases. You can optimize your
results by using available resources, support tools, and search methods

You can find useful information by searching the information center for IBM Cognos, but sometimes you
must look beyond the information center to resolve problems.

IBM Support Community

The support community provides tools and information for all IBM systems, software, and services.
The IBM Support Community provides you with access to the IBM electronic support portfolio from
one place. You can customize the pages to focus on the information and resources that you need for
problem prevention and faster problem resolution.

Find the IBM OpenPages GRC Platform content that you need by selecting your products from the IBM
Support Community.

From the IBM Support Community, you can search technotes and APARs (problem reports).

IBM masthead search

Use the IBM masthead search by typing your search string into the Search field at the beginning of
any ibm.com page.

External search engines

Search for content by using any external search engine, such as Google, Yahoo, or Bing. If you use an
external search engine, your results are more likely to include information that is outside the
ibm.com® domain. However, sometimes you can find useful problem-solving information about IBM
products in newsgroups, forums, and blogs that are not on ibm.com.

Tip: Include "IBM" and the name of the product in your search if you are looking for information about
an IBM product.
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Log files
Use the log files to help troubleshoot problems that occur during the installation.

This video discusses errors, warnings, and log files:

https://youtu.be/ljYXq1Cj8gU

Installation log files

Log files for a deployment are stored on the installation server in the
<installation_server_home>/src/deployment/<deployment-name>/logs/nodes directory.

For example, if your deployment is named "CorporateFinance", the log files for each deployed server are
located in: <installation_server_home>/src/deployment/CorporateFinance/logs/nodes

The nodes directory contains a subdirectory for each server in your deployment, for example:

Application Server1
Application Server2
Database Server
Deployment Manager
Global Search Server
Report Server1

As a deployment progresses through the Validate, Install, and Configure phases, the following log files
are created in the subdirectories:

• pre-vali.log
• install.log
• config.log

You might also see a restart.log file in the application server subdirectories.

When a component is installed remotely, the log files are copied from the remote server to the
appropriate subdirectory on the installation server automatically. For example, if Application
Server2 is installed on a remote computer, the files from the remote computer are copied to the
Application Server2 directory on the installation server computer.

The subdirectories also contain JSON files that contain metadata relevant to the deployment of that
server. Do not delete the JSON files.

The base directory, <installation_server_home>/src/deployment/<deployment-name>/
logs/ also contains a log file that is named installer.log that contains logging information about the
installation server.

Most log file entries contain a time stamp followed by the log message's status (error, warn, or info).
Examine the log files for entries that contain error for any issues that might need to be addressed.

The info entries are primarily progress messages.

The warn entries indicate that a non-fatal issue was encountered. Some post-installation action might be
needed.

The error entries indicate that an issue occurred. In most cases, you must take corrective action in order
for the deployment to proceed.

Validation reports

During a deployment, the validation process runs at various points. If you are using the installation app,
for example, the validation process runs each time that you click Validate.

The status of each validation is summarized in a color-coded Validation_Report.pdf file. If you are
using the installation app, you can click a link to download the validation report.
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The validation reports are stored on the installation server in the<installation_server_home>/src/
deployment/<deployment-name>/validation directory.

On the individual servers where the installer agents are running, validation reports for each server are
stored in a validation subdirectory within each server-specific directory. For example:
<agent_install_home>/src/deployment/<deployment-name>/logs/nodes/Database
Server/validation.

New PDF files are generated each time that a validation is run.

Collect log files and diagnostic data
You can use the LogCollector tool to collect log files and diagnostic data from the IBM OpenPages GRC
Platform environment and from OpenPages databases.

The LogCollector tool collects log files and diagnostic data on an application server.

In a horizontal cluster environment, run the tool on each application server in your environment.

In a vertical cluster, with multiple application servers installed on the same machine, the tool gathers logs
from all servers. The tool gathers logs from reporting servers only when they are installed on the same
machine as one of the application servers. If the search server is also installed on the same machine, for
example in a development environment, the tool also collects the search server logs.

The LogCollector tool is in the <OP_HOME>/bin directory.

The tool uses the following command options:

--configuration or -c to specify a configuration file path. If you do not include this option, the default
is LogCollector.xml. Using --configuration or -c is optional.

Note: For all command options, the long name command option uses two hyphens (--), whereas the short
name uses only 1 hyphen (-).

--database or -d to collect log and diagnostic data from only the database.

--file or -f to collect only log and diagnostic files.

--property or -p to set property values. Using --property or -p is optional.

You must include -p for each property that you use. For example, -p DB_OP_USER username -p
DB_OP_PASSWORD password. The properties that you can use are:

Property Description

DB_OP_USER The OpenPages database user name

DB_OP_PASSWORD The OpenPages database user's password

DB_TYPE The database type. This value can be db2 or
oracle.

DB_URL The database JDBC URL.

BPM_HOME The BPM home location.

--target or -t to specify a target package file. If you do not include this option, the default is
LogCollector_<timestamp>.zip. Using --target or -t is optional.

--help or -h to display command help.

This video demonstrates how to collect log files:

https://youtu.be/81X6H0bSlDg

Example: Getting all information

1. Log in as the Super Administrator user.
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2. Open a Command Prompt window.
3. Go to the <OP_HOME>/bin directory. For example, on Microsoft Windows operating systems, go to
C:\OpenPages\bin. On UNIX operating systems, go to /opt/OpenPages/bin.

4. Enter the following command:

On Microsoft Windows operating systems: LogCollector.cmd

On UNIX operating systems: ./LogCollector.sh

The tool generates a package file that is named LogCollector_<timestamp>.zip in the
C:\OpenPages\bin directory or the /opt/OpenPages/bin directory.

Example: Specifying a target package file

1. Log in as the Super Administrator user.
2. Open a Command Prompt window.
3. Go to the <OP_HOME>/bin directory. For example, on Microsoft Windows operating systems, go to
C:\OpenPages\bin. On UNIX operating systems, go to /opt/OpenPages/bin.

4. Enter the following command:

On Microsoft Windows operating systems: LogCollector.cmd -t LogCollector.zip

On UNIX operating systems: ./LogCollector.sh -t LogCollector.zip

The tool generates a package file that is named LogCollector.zip in the C:\OpenPages\bin
directory or the /opt/OpenPages/bin directory.

Example: Getting information from an IBM DB2 database

1. Log in as the Super Administrator user.
2. Open a Command Prompt window.
3. Go to the <OP_HOME>/bin directory. For example, on Microsoft Windows operating systems, go to
C:\OpenPages\bin. On UNIX operating systems, go to /opt/OpenPages/bin.

4. Enter the following command:

On Microsoft Windows operating systems: LogCollector.cmd -d -p DB_TYPE db2 -p DB_URL
jdbc:db2://localhost:50000/OPX -p DB_OP_USER openpage -p DB_OP_PASSWORD
password

On UNIX operating systems: ./LogCollector.sh -d -p DB_TYPE db2 -p DB_URL
jdbc:db2://localhost:50000/OPX -p DB_OP_USER openpage -p DB_OP_PASSWORD
password

The tool generates a package file that is named LogCollector_<timestamp>.zip in the
C:\OpenPages\bin directory or the /opt/OpenPages/bin directory.

Order of starting and stopping services
To restart the servers in an IBM OpenPages GRC Platform environment, you must stop and start them in
sequence. Restarting the servers in order ensures that the OpenPages application server and Cognos
Analytics can connect to the database server.

Use the following sequence to stop the servers:

1. Stop the services on the IBM BPM server.
2. Stop the services on the Search server.
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3. Stop the services on the Cognos Analytics reporting server(s).
4. Stop the services on the OpenPages application server(s).
5. Stop the services on the database server.

Use the following sequence to start the servers:

1. Start the services on the database server.
2. Start the services on the OpenPages application server(s).
3. Start the services on the Cognos Analytics reporting server(s).
4. Start the services on the Search server.
5. Start the services on the IBM BPM server.

Manually creating the reporting table space and user for Oracle databases
After you create the Cognos content store, you can manually create the content store user and the
content store table space. This user must be able to create, alter, and drop tables, triggers, views,
procedures, and sequences, and have the CONNECT and RESOURCE roles.

Procedure

1. Log on to the reporting server as a user with administrative privileges.

Note: For Linux operating systems, log in as a non-root user.
2. Copy the OP_<version>_Configuration/Database/ORACLE/COGNOS directory to the local

system.

3. Log on to SQL*Plus by using the following command:

sqlplus system/<system_password>@<oracle_tns_alias>

To create the table space in the OpenPages database instance, enter the oracle_tns_alias of the
OpenPages database. The database alias for the OpenPages database instance, as set during the
Oracle database installation, is oracle_tns_alias. If necessary, you can retrieve this alias from the
tnsnames.ora file.

If you created a separate database instance for the content store, create the table space in the content
store database instance. Enter the oracle_tns_alias of the content store database.

4. At the SQL prompt, type the following command:

@cognosdbcreate.sql <cognos_user> <cognos_password>
     <oracle_data_home> <tablespace_name> <log_file>

Table 61: Parameter descriptions for the cognosdbcreate.sql script for Oracle databases

Script parameters Description

cognos_user Specifies the new user name for the content store database

cognos_password Specifies the password for the cognos_user

oracle_data_home Specifies the location of the Oracle data home directory for the
content store database instance.

On Windows operating systems: <ORACLE_BASE>\oradata\<SID>

tablespace_name Specifies the name of the exported table space.

log_file Specifies the file name and location of the log file to create.
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Known problems and solutions for global search
Issues that are related to the IBM OpenPages GRC Platform global search component are most commonly
encountered when you are setting it up or when it is updated to synchronize the search index for changes
that are made to the OpenPages GRC Platform schema (such as adding or removing object types or
fields).

When an administrative operation fails, you can normally resolve these issues by clicking View Log to see
the log message for the failed global search operation.

The most common failure is that the search service is not started, for which you see this error:

"Could not establish connection to the search engine. Please contact your system administrator."

Ensure that the search service is started or restart to try to resolve the issue.

Global search start fails
If you configured the global search services to start and stop by using a script and you forgot to stop
global search before rebooting the system, when you attempt to start the global search services, the
services will fail to start. To fix this issue complete the following steps.

Procedure

1. Log on to the search server as a user with administrative privileges.
2. Open a command line on the search server.
3. Go to the <SEARCH_HOME>/opsearchtools/ directory and run the following commands.

On Microsoft Windows operating systems, run:

opsearchtool.cmd clearState -indexname openpages
opsearchtool.cmd clearState -indexname folderacl

On UNIX operating systems, run:

./opsearchtool.sh clearState -indexname openpages

./opsearchtool.sh clearState -indexname folderacl

Global search setup fails
In some rare cases, the global search component might encounter a failure during the creation of the
search index, before the operation completes. The failure might be caused by hardware issues, database
issues, or a power outage, for example. When this happens, the state of the global search setup is in an
undefined state and the Enable button might become available, giving the misleading impression that
global search was set up successfully. To recover from this state, investigate the root cause, resolve it, and
then set up global search again.

Procedure

1. Investigate and resolve the root cause of the failure.
2. Log on to OpenPages as a user with administrative privileges.
3. Click Administration > Global Search.
4. Click Drop to drop the search index.
5. Wait for the drop process to complete.

If the Drop button is not available or if the drop process fails, see “ Forcing a reset of global search” on
page 346.

6. Click Create to re-create the search index.
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Forcing a reset of global search
In some rare cases, it might be necessary to reset the IBM OpenPages GRC Platform global search
component if you cannot restore it from the global search administration page. These issues might
prevent you from successfully completing tasks in the global search administration page. To resolve these
issues, complete the following steps.

Procedure

1. Log on to the search server as a user with administrative privileges.
2. Open a command line on the search server.
3. Go to the <SEARCH_HOME>/opsearchtools/ directory to run the commands in the following steps.

Attention: At the successful completion of each command, the statement "Normal
completion of command" should appear. If it does not, contact Customer Support to diagnose
the issue.

4. Ensure that Solr is running and is reachable on port 8983. If Solr is not running, then run the following
command to start it.

Microsoft Windows:

opsearchtool.cmd startSolr

UNIX:

./opsearchtool.sh startSolr

5. Run the following commands to stop indexing.

Microsoft Windows:

opsearchtool.cmd stopIndexing -indexname openpages
opsearchtool.cmd stopIndexing -indexname folderacl

UNIX:

./opsearchtool.sh stopIndexing -indexname openpages

./opsearchtool.sh stopIndexing -indexname folderacl

6. Verify that no opsearchtool.jar processes are running.

On Microsoft Windows operating systems, use the task manager to see whether any
opsearchtool.jar processes are running. If there are, terminate them.

On UNIX operating systems, use the ps command to see whether any opsearchtool.jar
processes are running. If there are, terminate them.

7. Run the following commands to clear any PID states that might still be set if the opsearchtool.jar
processes did not end successfully.

Microsoft Windows:

opsearchtool.cmd clearState -indexname openpages
opsearchtool.cmd clearState -indexname folderacl

UNIX:

./opsearchtool.sh clearState -indexname openpages

./opsearchtool.sh clearState -indexname folderacl

8. Run the following commands to reset global search.
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Microsoft Windows:

opsearchtool.cmd resetSolr -indexname openpages
opsearchtool.cmd resetSolr -indexname folderacl
opsearchtool.cmd resetDb
opsearchtool.cmd stopSolr
opsearchtool.cmd startSolr

UNIX:

./opsearchtool.sh resetSolr -indexname openpages

./opsearchtool.sh resetSolr -indexname folderacl

./opsearchtool.sh resetDb

./opsearchtool.sh stopSolr

./opsearchtool.sh startSolr

9. Log on to OpenPages as a user with administrative privileges.
10. Click Administration > Global Search.
11. Click Create to re-create the search index.

What to do next

Resetting the global search component does not change your global search settings, such as object types,
fields that are enabled for search, registry settings, or property settings. The reset disables the global
search component. You must enable it again to make it available to users.

Checking for global search setup issues and periodic monitoring
When the incremental indexer is running during global search setup or after setup, some records might
not get indexed due to issues with the record, other system errors, or application errors.

About this task

If the issues are not unrecoverable, they do not impede the setup process or the incremental indexer.
However, the records that do not get indexed are logged in an error-log file, with an error message that
explains the issue so you can take appropriate action. The error-log files are never rotated. Periodically
examine this directory for new error files.

Procedure

1. Log on to OpenPages as a user with administrative privileges.
2. Go to the directory <SEARCH_HOME>/opsearchtools/logs_error/ .
3. Examine this directory for new error files.

Encryption of long strings in OpenPages running on Oracle 12.1
Before encrypting long strings in OpenPages running on Oracle 12.1, refer to the following Technote:
http://www.ibm.com/support/docview.wss?uid=swg22010106. The Technote describes a potential issue
and how to resolve it by obtaining the appropriate patch from Oracle support and applying it to your
environment.

Before you contact IBM OpenPages Support
When you contact IBM OpenPages Support, you need to collect diagnostic data and provide a detailed use
case of the issue.

About this task

Before you contact IBM OpenPages Support to help with resolving global search issues, follow these
steps to collect diagnostic data.

Note: You do not need to stop global search, the OpenPages application server, the database server, or
any other application when you run the collectDiagData command.
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Procedure

1. Log in to the OpenPages global search server as a user with administrative privileges.
2. Start a command prompt.
3. Go to the <SEARCH_HOME>/opsearchtools/ folder and run the following commands:

• Microsoft Windows:

mkdir diag
opsearchtool.cmd collectDiagData -diagpath diag

• UNIX:

mkdir diag
./opsearchtool.sh collectDiagData -diagpath diag

Attention: The collectDiagData command might report warning messages that look as if
the command failed. This warning can happen due to a number of reasons, such as the data
that is being collected cannot be accessed or is not yet available. If you see any such warnings,
capture them and include them as part of the diagnostic data to IBM OpenPages Support.

4. Add the contents of the new folder that is created under the diag folder to a compressed file.
5. Send the compressed file and complete details about your issue to IBM OpenPages Support.

Installation issues and solutions
Error messages and log files provide you with information about errors that occur during the installation
process. Use the error messages and log files to determine which part of the process failed.

Review common problem scenarios, recovery methods, and ways to get help if you encounter a problem
during software installation. You can diagnose problems when the installation and configuration is
unsuccessful.

Version is 7.4 when you use the 8.0 package
When you install IBM OpenPages GRC Platform, you see 7.4 in the installation media directories, in the
installation app, and in OpenPages.

This is not an error. The 7.4 and 8.0 packages for OpenPages are the same.

After you install OpenPages, apply fix pack 8.0.0.1 to get the latest features and fixes.

Error starting the installation app
If you try to start the installation app on Linux or AIX operating systems but enter the command
incorrectly, and you try to start it again, you can receive an error.

For example, you can receive an error such as:

********************************************************
ERROR: Error occurred during OpenPages Installer startup.
Although, OpenPages Installer was successfully installed.
Try starting OpenPages Installer using startup.sh script.
Location: /home/opuser/OP_7.4_Installer/startup.sh
********************************************************

This error can occur due to time out settings. You can check the log to verify whether the installation app
started.
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Silent installation hangs
During a silent installation of IBM OpenPages GRC Platform, the installation process appears to hang. For
example, the process is taking a very long time and there are a couple of components that are not finished
and do not appear to be progressing.

Additionally, the installation logs contain the following messages:

[31merror[39m:  Error: read ECONNRESET
    at exports._errnoException (util.js:1022:11)
    at TLSWrap.onread (net.js:610:25)

To resolve this problem:

1. Stop the installation server. For more information see, “Stopping the installation server” on page 40.
2. Restart the installation server. For more information, see “Starting the installation server” on page 40.
3. Run the installation again.

Global search fails to validate during upgrade
If the global search server fails to validate when you upgrade OpenPages, it can be because the host
name in the URL points to the source server rather than the new target server.

About this task

Modify and run the following SQL statement to update the registry settings that define the admin and
index/request URLs for global search on the target server.

Procedure

1. Modify the lines in bold in the following SQL statement.
For example:

vcSearchAdminURL REGISTRYENTRIES.DESCRIPTION%Type := 'http://search.example.com:8985';
  vcSearchURL      REGISTRYENTRIES.DESCRIPTION%Type := 'http://search.example.com:8983';

Oracle:

Declare
 vcSearchAdminURL REGISTRYENTRIES.DESCRIPTION%Type := '{full admin URL}';
  vcSearchURL      REGISTRYENTRIES.DESCRIPTION%Type := '{full request/index URL}';
  recActor         ACTORINFO%Rowtype;
Begin
  -- get the system user
  op_actor_mgr.get_actorinfo(OP_Actor_Mgr.gc_System_User, recActor);
  -- set registry values
  op_registry_mgr.set_registry_entry
  (
   p_parent_path            => '/OpenPages/Platform/Search/Admin',
   p_name                   => 'Search Server Administration URL',
   p_description            => 'URL for Search Server Administration',
   p_value                  => vcSearchAdminURL,
   p_is_hidden              => 'Y',
   p_is_encrypted           => 'N',
   p_is_protected           => 'Y',
   p_actor_id               => recActor.actorid,
   p_is_done_by_vendor      => OP_Globals.sc_true,
   p_behavior               => OP_Registry_Mgr.OPT_RE_Set_Defaults
  );
  op_registry_mgr.set_registry_entry
  (
   p_parent_path            => '/OpenPages/Platform/Search/Index',
   p_name                   => 'Search Server URL',
   p_description            => 'URL for Search Server Index',
   p_value                  => vcSearchURL,
   p_is_hidden              => 'Y',
   p_is_encrypted           => 'N',
   p_is_protected           => 'Y',
   p_actor_id               => recActor.actorid,
   p_is_done_by_vendor      => OP_Globals.sc_true,
   p_behavior               => OP_Registry_Mgr.OPT_RE_Set_Defaults
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  );
  op_registry_mgr.set_registry_entry
  (
   p_parent_path            => '/OpenPages/Platform/Search/Request',
   p_name                   => 'Search Server URL',
   p_description            => 'URL for Search Request',
   p_value                  => vcSearchURL,
   p_is_hidden              => 'Y',
   p_is_encrypted           => 'N',
   p_is_protected           => 'Y',
   p_actor_id               => recActor.actorid,
   p_is_done_by_vendor      => OP_Globals.sc_true,
   p_behavior               => OP_Registry_Mgr.OPT_RE_Set_Defaults
  );
  Commit;
End;
/

DB2:

Declare
  vcSearchAdminURL REGISTRYENTRIES.DESCRIPTION%Type := '{full admin URL}';
  vcSearchURL      REGISTRYENTRIES.DESCRIPTION%Type := '{full request/index URL}';
  recActor         ACTORINFO%Rowtype;
Begin
  -- get the system user
  op_actor_mgr.get_actorinfo_by_actor_name(OP_Actor_Mgr.gc_System_User, recActor);
  -- set registry values
  op_registry_mgr.set_registry_entry_with_behavior
  (
   p_parent_path            => '/OpenPages/Platform/Search/Admin',
   p_name                   => 'Search Server Administration URL',
   p_description            => 'URL for Search Server Administration',
   p_value                  => vcSearchAdminURL,
   p_is_hidden              => 'Y',
   p_is_encrypted           => 'N',
   p_is_protected           => 'Y',
   p_actor_id               => recActor.actorid,
   p_is_done_by_vendor      => OP_Globals.sc_true,
   p_behavior               => OP_Registry_Mgr.OPT_RE_Set_Defaults
  );
  op_registry_mgr.set_registry_entry_with_behavior
  (
   p_parent_path            => '/OpenPages/Platform/Search/Index',
   p_name                   => 'Search Server URL',
   p_description            => 'URL for Search Server Index',
   p_value                  => vcSearchURL,
   p_is_hidden              => 'Y',
   p_is_encrypted           => 'N',
   p_is_protected           => 'Y',
   p_actor_id               => recActor.actorid,
   p_is_done_by_vendor      => OP_Globals.sc_true,
   p_behavior               => OP_Registry_Mgr.OPT_RE_Set_Defaults
  );
  op_registry_mgr.set_registry_entry_with_behavior
  (
   p_parent_path            => '/OpenPages/Platform/Search/Request',
   p_name                   => 'Search Server URL',
   p_description            => 'URL for Search Request',
   p_value                  => vcSearchURL,
   p_is_hidden              => 'Y',
   p_is_encrypted           => 'N',
   p_is_protected           => 'Y',
   p_actor_id               => recActor.actorid,
   p_is_done_by_vendor      => OP_Globals.sc_true,
   p_behavior               => OP_Registry_Mgr.OPT_RE_Set_Defaults
  );
  Commit;
End;
/

2. Run the SQL statement in SQL*Plus (Oracle) or CLPPLUS (DB2) as the OpenPages database user.
3. Rerun the upgrade validation and verify that global search can now validate.
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Docker containers not starting
After installing OpenPages by using Docker, not all of the containers have started and you cannot access
the OpenPages application URL.

To resolve this, you can start the containers again by using the following command:

docker-compose [-f <yml file>] start

Application URL is missing the domain of the host after a Docker deployment
After you install IBM OpenPages GRC Platform by using Docker, the application URL contains only the host
name rather than the fully qualified domain name. Additionally, you cannot access to the JSP helper
pages, the Cognos Analytics page, or IBM Business Process Manager from the OpenPages application.

The application URL is set when the Docker container starts and it is based on the HOSTNAME
environment variable of the computer where you run the docker-compose -f <yml_file> up
command. The container startup finds the fully qualified domain name automatically. However, you can
set the host of the application URL explicitly by updating the HOSTNAME variable on the computer. For
example, you can set the host of the application URL to myhost.mydomain.com and redeploy OpenPages
on Docker by using the following commands:

export HOSTNAME=myhost.mydomain.com
docker-compose -f <yml_file> down
docker-compose -f <yml_file> up -d

The docker-compose -f <yml_file> down command is needed only if you have already deployed
OpenPages on Docker.

If you deploy OpenPages on Docker in a distributed environment (for example, one database server host
and another application server host), the HOSTNAME environment variable is looked up only by the
containers on the application server host. You do not need to redeploy the containers on the database
server host if you change the application URL.

Blank pages after you log in to IBM BPM or OpenPages application
You have OpenPages and IBM BPM installed on the same server and you see blank pages after you log in
to OpenPages.

Some web browser cookie names are common between OpenPages and IBM BPM. When both application
servers are deployed to single host (with different port numbers), the web browser can confuse the cookie
values for the different application servers.

For more information, see Hosting the OpenPages application server and IBM Business Process Manager
on the same computer.

Errors while loading data after you upgrade
After you upgrade, you see errors such as the following while you load data:

Caused by: java.lang.ClassNotFoundException: org.springframework.context.ApplicationContextAware
    at java.net.URLClassLoader.findClass(URLClassLoader.java:609)
    at com.ibm.ws.bootstrap.ExtClassLoader.findClass(ExtClassLoader.java:243)
    at java.lang.ClassLoader.loadClassHelper(ClassLoader.java:850)
    at java.lang.ClassLoader.loadClass(ClassLoader.java:829)
    at com.ibm.ws.bootstrap.ExtClassLoader.loadClass(ExtClassLoader.java:134)
    at java.lang.ClassLoader.loadClass(ClassLoader.java:809)
...
2018-03-02 09:08:08
CODE       : OP-00550
LEVEL      : 4
NAME       : com.openpages.sdk.trigger.grc.GRCTriggerCacheException
ERROR #    : TOKAUSA9HXAY
TOKEN ID   : 465433
USER       : OpenPagesAdministrator
MESSAGE    : Cache may not be setup correctly.
    at com.openpages.sdk.trigger.grc.GRCTriggerRuleDefinition.getInstance
(GRCTriggerRuleDefinition.java:111)
    at com.ibm.openpages.api.service.local.trigger.GRCTriggerManager.
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processTriggerRule(GRCTriggerManager.java:237)
    ... 62 more

...
02 Mar 2018 09:08:08,849
ERROR ConfigurationManager on OPServer1
Loader EXCEPTION (Line: 88 Column: 53): Unable to create a new folder resource.
[P=630037:O=0:CT](ConfigurationManager.java:8112)

These errors can occur if triggers are still enabled during the data load. You can resolve this problem by
disabling the triggers, and then reload the data. After you successfully load the data, ensure that you re-
enable the triggers.

For more information about disabling triggers, see Disabling triggers when migrating environments in the
IBM OpenPages GRC Administrator's Guide.

Password confirmation field is empty after importing deployment properties
After you import a deploy.properties file, the confirmation field for the Local User Password for a server is
empty.

This issue can occur when the following conditions are true:

• The deploy.properties file has a value for local_password for the server.
• The deploy.properties file has remote_deploy set to false for the server.
• After you import the file, you enable Remote Deploy in the installation app for the server.

To resolve the issue, do one of the following steps:

• Set remote_deploy to true for the server and then reimport the file, or
• In the installation app, clear the Local User Password field on the server card and then reenter the value

for both this field and the confirmation field.

Update to IBM Installation Manager 1.8 is blocked when the data location is the same as
the installation location

Starting with IBM Installation Manager version 1.8, you are blocked from using a data location that is
within the IBM Installation Manager installation location.

About this task

In older IBM Installation Manager versions, you are not blocked from using a data location within the IBM
Installation Manager installation location. When you try to update an older version that was installed by
using a data location within the IBM Installation Manager installation location, you receive an error
message.

For example, if the older Installation Manager version was installed in the /opt/IBM/IM directory by
using the /opt/IBM/IM/dataLocation directory as the data location, the following error message is
displayed when you update to IBM Installation Manager version 1.8:

CRIMA1261E ERROR: The installation directory ("/opt/IBM/IM") must not be the
same directory, a parent directory, or sub-directory of the Installation
Manager data directory ("/opt/IBM/IM/dataLocation")

This issue occurs when one of the following scenarios occur:

1. Using an IBM Installation Manager version earlier than 1.8 (for example, 1.7.3), you install the
Installation Manager that uses a data location within the installation location. For example:

installc -acceptLicense -dataLocation /opt/IBM/IM/dataLocation -
installationDirectory /opt/IBM/IM

2. Using an IBM Installation Manager version 1.8 or higher installer, you update the installed IBM
Installation Manager. For example:

Installc -acceptLicense -dataLocation /opt/IBM/IM/dataLocation

352   IBM OpenPages GRC Version 7.4.0 : Installation and Deployment Guide

https://www.ibm.com/support/knowledgecenter/SSFUEU_7.4.0/op_grc_admin/t_adm_objmgr_disablingtriggers.html


Putting the data location within the installation location violates basic assumptions about the separation
of the installation artifacts and the runtime data of IBM Installation Manager, which can lead to errors.
IBM Installation Manager 1.8 was intentionally changed to no longer allow this situation. When the
software detects this situation, it displays the preceding error message.

To resolve this issue, you must reinstall IBM Installation Manager in a new location that does not collide
with the data location.

Unfortunately, the -reinstallim option does not work in this particular case because the data location
is incorrectly located in the IBM Installation Manager installation location. You must manually reinstall
IBM Installation Manager as follows:

Procedure

1. Delete the IBM Installation Manager installation location.

Normally, this means deleting the entire /opt/IBM/IM directory (the installation location in the
preceding example), but because the data location was incorrectly put within the installation location,
delete only the subdirectories of the /opt/IBM/IM directory, excluding the data location directory.
Delete eclipse, license, and properties. The /opt/IBM/IM/dataLocation directory must
remain.

2. Run IBM Installation Manager version 1.8 or higher installer to reinstall Installation Manager. Specify
an installation location that does not collide with the data location. For example:

installc -acceptLicense -dataLocation /opt/IBM/IM/dataLocation -
installationDirectory /opt/IBM/IM/installLocation

3. To confirm that all previously installed products are still available, start the installed Installation
Manager and click File > View Installed Packages to see the list of installed products.

Note: The instructions for manually reinstalling Installation Manager are derived from Manually
reinstalling Installation Manager, except that in this case, care must be taken not to delete the data
location that was incorrectly put in the IBM Installation Manager installation location.

Warning when upgrading OpenPages Version 7.1 (Oracle)
If you are upgraded from IBM OpenPages version 7.1.x deployed on Oracle, then the 7.1 to 7.2 portion of
the upgrade could encounter the following warning during the verification step: "PROPERTYDEFS Missing
Required Entries". If you encounter this warning, you can ignore it.

You could encounter the following warning during the verification step of the upgrade process:

****************************************
* The script will verify the upgrade. * 
****************************************

Connected. 

PL/SQL procedure successfully completed. 

PROPERTYDEFS Missing Required Entries 

*****************************************
WARNING
WARNING - Problems found during verification - Upgraded database missing required items 
WARNING 
******************************************

If you see this warning message, you can ignore it as the issue is with the script checking for a field in
PROPERTYDEFS that was removed in version 7.2. There is no problem with the database.
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SSL handshake error when the SOAP port on non-administrative application servers is
validated

During the installation of IBM OpenPages GRC Platform in a clustered environment, you might receive an
SSL handshake error. The error is displayed in the installation logs.

For information about installation log files, see “Log files” on page 341.

An SSL handshake error can occur when the SOAP port for each non-admin application server is being
validated. The SOAP port validation process can fail with an SSL handshake error if an IBM WebSphere
Application Server profile that is not owned by OpenPages exists in the OpenPages cell.

To correct the error so that the installer can continue, complete the following steps:

1. Get a list of the IBM WebSphere profiles that are being used on the OpenPages cell.

Run the following commands:

• UNIX

cd <WAS_HOME>/AppServer/bin
./manageprofiles.sh -listProfiles

• Microsoft Windows

cd <WAS_HOME>\AppServer\bin
manageprofiles.bat -listProfiles

2. Stop any services that are using profiles that do not belong to IBM OpenPages GRC Platform.
3. Delete any profiles that do not belong to OpenPages.

Run the following command:

• UNIX

./manageprofiles.sh -delete -profileName <profile-name>

• Microsoft Windows

manageprofiles.bat -delete -profileName <profile-name>

For example, on Windows, to delete a profile that is called Profile1, run the following command:

manageprofiles.bat -delete -profileName Profile1

Install the 32-bit Oracle 12.1.0.2 client and 64-bit Oracle 12.1.0.2 database server on the
same computer

If the 64-bit Oracle 12.1.0.2 database server is installed, and you want to install the 32-bit Oracle
12.1.0.2 client on the same computer, where no previous version of the Oracle client exists, you must
complete the following configuration steps:

1. Manually set the following registry key to the location of the Oracle Inventory directory of the
computer on which you are performing the upgrade:

HKEY_LOCAL_MACHINE\SOFTWARE\Oracle\inst_loc

For example:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ORACLE]
"inst_loc"="D:\app\OPDB\product\12.1.0\dbhome_1\inventory"

2. Edit the following file:

<inst_loc>\ORA 12.1.0.2\win64\Client\client32\install\oraparam
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Update the MSVCREDIST_LOC parameter:

MSVCREDIST_LOC=vcredist_x86.exe

If the 32-bit Oracle 11.2.0.4 client is already installed on the computer, you can upgrade to the 32-bit
Oracle 12.1.0.2 client without any issues.

Issues with importing data to Oracle 12.1.0.2 using Oracle data pump
When you import data from an Oracle 11.2.0.4 source into an Oracle 12.1.0.2 target, you might encounter
a data pump import error.

Processing object type SCHEMA_EXPORT/TABLE/INDEX/STATISTICS/INDEX_STATISTICS
ORA-39083: Object type INDEX_STATISTICS failed to create with error:
ORA-01403: no data found
ORA-01403: no data found

To import the data successfully, use the following solution. It is assumed that you are using a clean target
database as the import destination.

Import the data using the exclude=statistics command.

For example:

impdp <user>/<password>@<db> full=Y
 DIRECTORY=<dp dir> DUMPFILE=<dp file>
 logfile=<log file> exclude=statistics

When the import is complete, you must gather table statistics for all objects manually.

SQL0569N Authorization ID user_name does not uniquely identify a user, a group or a role
in the system error

The IBM OpenPages GRC Platform installation app might indicate that the installation is successful.
However, you might see a message similar to the following text in the log file:
SQL0569N Authorization ID "user_name" does not uniquely identify a user, 
a group or a role in the system error

Ensure that on Linux and AIX operating systems, the user name for the OpenPages database user account
is not the same as the group name. For example, opuser:opuser is not allowed.

Tip: When you deploy OpenPages applications to WebSphere, ensure that you review the session.log
file for errors.

For information about installation log files, see “Log files” on page 341.

OpenPages GRC Platform and software that is installed in a directory that contains
spaces

If you installed software that IBM OpenPages GRC Platform uses into a directory with spaces, you must
use the Windows short file name convention for the directory location.

For example, in the IBM OpenPages GRC Platform installation app, when you configure the home
directory for IBM WebSphere Application Server, instead of entering the C:\Program Files\IBM
\WebSphere\AppServer directory, enter C:\PROGRA~1\IBM\WebSphere\AppServer.

Garbled characters are displayed on the OpenPages GRC Platform home page when you
log in for the first time

You might see garbled characters on the IBM OpenPages GRC Platform home page (http://
server_name:port/openpages) if the DB2 database does not have sufficient memory.

The following SQL errors are in the OP_Home\aurora\log files or the OP_Home\bin\logs
\ObjectManager.log file:
com.ibm.db2.jcc.am.SqlException: DB2 SQL Error: 
SQLCODE=-20442, SQLSTATE=57011, SQLERRMC=null, DRIVER=3.64.104
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To resolve the problem, increase the memory that is available to DB2 database by running the following
commands, one by one, as the database instance owner:

db2 connect to <database_name> user <DB2_instance_owner> using <password>
db2 update db cfg for <database_name> using APPLHEAPSZ 512 APPL_MEMORY 80000
db2 terminate
db2start

Reload the configuration data. For more information, see “Manually loading the configuration data after a
new installation” on page 356.

If the problem still exists, keep doubling the sizes for the APPLHEAPSZ and APPL_MEMORY settings, up
to 2048,000 or acquire more memory (RAM).

Example: APPLHEAPSZ 1024 APPL_MEMORY 160000

db2 connect to <database_name> user <DB2_instance_owner> using <password>
db2 update db cfg for <database_name> using APPLHEAPSZ 1024 APPL_MEMORY 160000
db2 terminate
db2start

Example: APPLHEAPSZ 2048 APPL_MEMORY 320000

db2 connect to <database_name> user <DB2_instance_owner> using <password>
db2 update db cfg for <database_name> using APPLHEAPSZ 2048 APPL_MEMORY 320000
db2 terminate
db2start

Manually loading the configuration data after a new installation
The installation program for IBM OpenPages GRC Platform automatically loads the application data and
enables user access to the standard Cognos Analytics reports. In limited situations, you can manually
load the level-0 schema.

Before you begin

IBM OpenPages GRC Platform must be installed.

The OpenPages services must be running.

About this task

If the loader file execution that occurs during the fresh installation has errors, you can correct the issues
that caused the errors and then manually execute the fresh installation loader file.

Procedure

To manually load the level-0 schema, use the following steps:
1. Log on to the OpenPages admin application server as a user with administrative privileges.
2. Go to the <OP_HOME>/addon_module/loaderdata directory.
3. Make a backup copy of the schema_loader_properties.sh|.bat file.
4. Open the original schema_loader_properties file in a text editor.
5. In the following line, update the password for the OpenPages Super Administrator.

SET OPXUserName=<Super_Administrator_user_name>
SET OPXUserPassword=********

The default user name is OpenPagesAdministrator.

The password for the OPXUserName user is masked by asterisks (***). Replace the mask with clear
text. After the default configuration data is loaded, you can manually mask the password value with
asterisks (***).

6. Save and close the file.
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7. To load the default configuration, run the openpages-level0-loader-data.sh|.bat script.

Tip:

Redirect the output to a log file so that you can conveniently track the progress:

• Windows: openpages-level0-loader-data.bat > openpages-level0-loader-data.log
• AIX or Linux : ./openpages-level0-loader-data.sh > openpages-level0-loader-
data.log

The script takes some time to finish loading the data. For example, the data might take two hours to
load.

8. Restart the OpenPages services.

Manually loading the configuration data after an upgrade
When you upgrade IBM OpenPages GRC Platform to version 7.4, IBM OpenPages GRC Platform
automatically loads the application data and enables user access to the standard Cognos Analytics
reports. In limited situations, you can manually load the level-0 schema.

Before you begin

IBM OpenPages GRC Platform must be installed.

The OpenPages services must be running.

About this task

If the upgrade loader files that are executed during the upgrade action have errors, you can correct the
issues that caused the errors and then manually execute the upgrade loader files.

Procedure

1. Log on to the OpenPages admin application server as a user with administrative privileges.
2. Go to the <OP_HOME>/installer/migration/upgrade/addon_module/loaderdata directory.
3. Make a backup copy of the schema_loader_properties.sh|.bat file.
4. Open the original schema_loader_properties file in a text editor.
5. In the following line, update the password for the OpenPages Super Administrator.

SET OPXUserName=<Super_Administrator_user_name>
SET OPXUserPassword=********

The default user name is OpenPagesAdministrator.

The password for the OPXUserName user is masked by asterisks (***). Replace the mask with clear
text. After the default configuration data is loaded, you can manually mask the password value with
asterisks (***).

6. Save and close the file.
7. Depending on your upgrade path, run the scripts in the order that is listed:

Upgrade path Windows files to run

7.1.x to 7.4 a. openpages-op720x-loader-data.bat
b. openpages-op730x-loader-data.bat
c. openpages-upgrade-loader-data.bat

7.2.x to 7.4 a. openpages-op730x-loader-data.bat
b. openpages-upgrade-loader-data.bat

7.3 to 7.4 openpages-upgrade-loader-data.bat
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Upgrade path AIX/Linux files to run

7.1.x to 7.4 a. ./openpages-op720x-loader-data.sh
b. ./openpages-op730x-loader-data.sh
c. ./openpages-upgrade-loader-data.sh

7.2.x to 7.4 a. ./openpages-op730x-loader-data.sh
b. ./openpages-upgrade-loader-data.sh

7.3 to 7.4 ./openpages-upgrade-loader-data.sh

8. Restart the OpenPages services.

Dropping the IBM DB2 database for OpenPages GRC Platform
If you encounter problems when you try to create the database for IBM OpenPages GRC Platform, you can
run clean up scripts. Use the scripts to drop the database and uncatalog the node.

About this task
In most cases, you do not need to drop the database. Try dropping and recreating the database objects
first. See “Troubleshooting DB2 database object creation” on page 109.

Procedure

1. Log on to the OpenPages GRC Platform application server.
2. Go to the location where you extracted the installation files.

• On Windows operating systems, go to the following directory:

\OP_<version>_Non_Embedded\OP_<version>_Configuration\Database
\DB2\INSTALL_SCRIPTS

• On Linux or AIX operating systems, go to the following directory:

/OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/DB2/
INSTALL_SCRIPTS

3. On Windows operating systems, start the DB2 command line processor by typing db2cmd.

4. To drop the database, run the drop-opx-db-clt script.

drop-opx-db-clt.bat|.sh <database-name> 
   <node-name> <instance.owner.username> 
   <instance.owner.password>

5. To uncatalog the node, run the db2-uncatalog-node.bat|.sh script.

Note: In most situations, uncataloging the node is unnecessary.

db2-uncatalog-node.bat|.sh <node-name>

Updating the services for multiple DB2 instances
DB2 database instances must be able to communicate through the network. If you have multiple DB2
instances on the same computer, ensure that the SVCENAME and listener port are configured. Otherwise,
connection errors might occur.

To verify that the DB2 database instances are configured for network communication:

• DB2SET must show TCPIP for the DB2COMM setting.
• The SVCENAME in the DBM configuration must show a valid TCP service name and TCP port number.

If you changed either the DB2 registry (DBSET) or the Database Manager configuration, ensure that you
stop and restart DB2.
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Procedure

1. Log on to the database server as the DB2 instance owner.
2. To reserve a TCP port for the service, append the information to the services file.

On Windows, edit the %systemroot%\system32\drivers\etc\services file

On AIX or Linux, edit the /etc/services file.

To reserve TCP port 5500 for the service named db2c_opdb, append the following line to the end of
the services file:

db2c_opdb 5500/tcp

3. Update the database manager configuration.

db2 update database manager configuration using svcename 55000
4. Ensure that TCP communication is set for the database instance.

db2cmd -i -w
db2set DB2COMM=npipe,tcpip
db2stop
db2start

5. Stop and then restart the DB2 server.

db2stop
db2start

OP-03620: The Reporting Schema has not been instantiated error
You log on to the IBM OpenPages GRC Platform home page, and the following error message is displayed.
The Home Page cannot be viewed without a valid Reporting Schema. 
Please contact your System Administrator. OP-03620: 
The Reporting Schema has not been instantiated. Please instantiate it 
before executing this operation.

This error occurs if the reporting schema has not yet been created.

To resolve the problem, enable System Admin Mode, and generate the reporting schema.

Procedure

1. In a web browser, open the OpenPages GRC Platform application:

http://openpages_server:port/openpages
2. Log on to the application as a user with administrative privileges.
3. For System Admin Mode, switch from Disabled to Enabled.

4. From the menu bar, click Administration and select Reporting Schema.
5. Click Create.
6. After the create operation finishes, click System Admin Mode to switch from Enabled to Disabled.
7. From the menu bar, click Administration > Reporting Framework > Generation.
8. On the Reporting Framework Operations page, click Update.
9. In the Reporting Framework Generation window, under Framework Generation, select the

Framework Model and Labels and other options you want for the relational data model.

10. Click Submit.
11. To view the progress of the update, click Refresh.

The Percent Complete column on the Reporting Framework Operations table updates the
percentage of completion.
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Uninstalling OpenPages GRC Platform with an Oracle database before you reinstall
In test or development environments, you might be required to uninstall IBM OpenPages GRC Platform or
remove the OpenPages database from the Oracle database server before you reinstall. You must
completely uninstall before you reinstall.

Procedure

1. On a computer that has SQL*Plus, log on as a user, such as SYSTEM, who has database administration
permissions.

2. Run the following SQL statements:

drop user <openpages_user> CASCADE;
drop user <cognos_user> CASCADE;

Note: Drop the cognos_user if the OpenPages database and the Cognos content store schemas are in
the same Oracle database. If you use a separate database for the Cognos content store, dropping the
cognos_user is not required.

3. Run the following SQL statements to drop the default table spaces and data files:

drop tablespace AURORA including contents and datafiles;
drop tablespace INDX including contents and datafiles;
drop tablespace AURORA_SNP including contents and datafiles;
drop tablespace AURORA_TEMP including contents and datafiles;
drop tablespace AURORA_NL including contents and datafiles;
drop tablespace AURORA_NLI including contents and datafiles;
drop tablespace AURORA_CLOB_DATA including contents and datafiles;
drop tablespace AURORA_DOMAIN_INDX including contents and datafiles;
drop tablespace COGNOS including contents and datafiles;

4. Run the following script to drop the Oracle data pump storage directory.

drop directory <OP_DATAPUMP_DIRECTORY>;

5. Uninstall OpenPages GRC Platform.
6. If required, remove environment variables that reference OpenPages GRC Platform, or Cognos

Analytics, or both products.
7. Restart the servers.
8. Remove the existing OpenPages GRC Platform application or Cognos Analytics installation directories.

The following table lists examples of the installation directories for OpenPages and Cognos Analytics
components.

Table 62: Example directory locations for OpenPages and Cognos Analytics components

Installation directory Location on Windows operating system

OpenPages

(OP_HOME)

C:\OpenPages

OpenPages CommandCenter

(CC_HOME)

C:\OpenPages\CommandCenter

Cognos Analytics

(Cognos_HOME)

C:\IBM\cognos\analytics

9. Review the TEMP or TMP directories for temporary installation files that might exist.

The location of temporary directories varies. The location depends on the environmental variables that
are set during the installation process.
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For Windows operating systems, common temporary directory locations include

• C:\temp
• C:\Users\<user_name>\AppData\Local\Temp

Issues when importing databases
When you import the IBM OpenPages GRC Platform database during an upgrade or migration, you might
see an error as a result of the default data file size.

If an error occurs, increase the default data file size as follows.

1. On a computer that has SQL*Plus, log on as a user, such as SYSTEM, who has database administration
permissions.

2. Run the following SQL statements:

ALTER TABLESPACE INDX ADD DATAFILE
        'C:\app\Administrator\oradata\OP\INDX02.DBF'
                SIZE 128 M AUTOEXTEND ON     NEXT 128 M MAXSIZE 34359721984;

    Alter database datafile 'C:\app\Administrator\oradata\OP\AURORA.DBF'
  resize     2000m;

Logging in to Cognos Analytics fails
If you cannot log in to Cognos Analytics after you add a reporting server to an OpenPages deployment,
you might need to check that the application URL is set correctly.

About this task

Follow these steps if you cannot log in to Cognos Analytics and the following error is issued:

java.net.MalformedURLException: For input string: "undefined"

Procedure

1. Go to the <COGNOS_HOME>/configuration directory.
2. Open the OpenPagesSecurityProvider_OpenPagesSecurityRealm.properties file in a text

editor.
3. Ensure that the value for the openpages.application.url property matches the OpenPages

application URL on the admin application server. Make the necessary change and save the file.
4. Restart Cognos Analytics.

Cognos content store import fails
If you use the database export and import option to restore the IBM Cognos content store, the import
might fail if the table space name differs in the target environment.

To resolve this issue, you must update the table space name in the target environment:

1. Check the table space name in the target environment.

a. Log on as an OpenPages user.
b. Run the following command:

select tablespace_name from user_tablespaces;

2. Update the table space name.

a. Log on as SYSTEM using SQL*Plus.
b. Run the following scripts:

alter tablespace crn RENAME TO cognos;
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3. Drop the Cognos database schema.

a. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/INSTALL_SCRIPTS directory.

b. Log on to SQL*Plus as the Cognos database user.
c. Use the spool command to create a log file.

spool <log_file directory>/<log_file name>

Ensure that you have write permission on the <log_file directory>.

Example:

spool /tmp/AuroraDbDelete.log

d. Run the AuroraDbDelete.sql script.

@AuroraDbDelete.sql

e. Log out of SQL*Plus.
4. Go the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/ORACLE/
INSTALL_SCRIPTS directory, and run the following script:

impdp <system_user>/<system_password>@<alias>
full=Y file=<filename.dmp> log=<filename.log>
directory=<OP_DATAPUMP_DIRECTORY>
fromuser=<cognos_user> touser=<cognos_user> EXCLUDE=INDEX

High CPU use with Windows 2012 R2 servers
You might experience high CPU use if the User Access Logging service is set to automatic in Windows
Server 2012 or if you enabled the ProgramData Updater that is used by Microsoft Customer Experience
Improvement Program.

To change the User Access Logging service to manual, follow these steps:

• Log in to Windows 2012 Server.
• In the services console, stop the User Access Logging Service.
• Change the Startup Type to Manual.

To disable the ProgramData Updater, follow these steps:

• Open Administrative Tools.
• Expand Computer Management.
• Select Application Experience and ProgramData Updater.
• Right-click, then click Disable.

Updating the Oracle client path on the reporting server
On a Linux or AIX OS that uses an Oracle database, if you change the Oracle client location after you
install Cognos Analytics and IBM OpenPages GRC Platform, then you must update the Oracle client path
on the reporting server. To update the Oracle client path, edit the PATH and LD_LIBRARY_PATH or
LIBPATH environment variables in the BMTScriptPlayer.sh file.

Procedure

1. On the reporting server, navigate to the <COGNOS_HOME>/bin directory, and open the
BMTScriptPlayer.sh file.

2. Update the Oracle client path in the environment variables:

• For Linux, update the PATH and LD_LIBRARY_PATH variables.
• For AIX, update the PATH and LIBPATH variables.
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3. After you update the BMTScriptPlayer.sh file, verify that you can generate the OpenPages
framework.

Issues when you use IBM Installation Manager on Linux
When you use the IBM Installation Manager on the Linux operating system to install IBM OpenPages GRC
Platform, then an error message might be displayed.

Add the following line to the IBMIM.ini file, which you can find in <installation location>/
eclipse: -Dorg.eclipse.swt.internal.gtk.cairoGraphics=false. Save the file and restart
IBM Installation Manager.

Issues with IBM DB2 and Oracle after upgrading to RHEL 7.2
When you are using Red Hat Enterprise Linux 7.2, you might encounter issues with IBM DB2 and Oracle
due to a known issue in RHEL 7.2.

For example, the OpenPages database instance on DB2 might crash with the following error displayed by
the db2diag tool:

CALLED  : OS, -, unspecified_system_function      OSERR: EIDRM (43)

2016-09-29-11.18.10.184984-240 I2604417E2069         LEVEL: Severe (OS)
PID     : 27510                TID : 140561960920832 PROC : db2sysc 0
INSTANCE: db2inst1             NODE : 000            DB   : OPX
HOSTNAME: op-host-01
EDUID   : 197                  EDUNAME: db2agntdp (OPX     ) 0
FUNCTION: DB2 UDB, oper system services, sqloWaitEDUWaitPost, probe:100
MESSAGE : ZRC=0x8300002B=-2097151957

To fix the issue, edit the /etc/systemd/logind.conf file, set RemoveIPC=no, and then restart the
corresponding service or reboot.

For more information, see https://access.redhat.com/solutions/2062273.

libdb2.so cannot be loaded
When you are using Linux for the reporting server, you might get an error that libdb2.so cannot be
loaded.

UDA-SQL-0569 library to control program function (libdb2.so) 
can not be loaded
UDA-SQL-0571 The operating system returned an error message (libpam.so.0: 
can not open shared object file: No such file or directory).

To fix the issue, update pam.x86_64 and then install pam.i686. For example, run yum install
pam.x86_64 and then run yum install pam.i686.

Data validation errors when installing Loss Event Entry
If data validation errors about existing data occur when you installIBM OpenPages Loss Event Entry,
review the log files.

The log files for OpenPages Loss Event Entry are located in <OP_HOME>/LossEventEntry/logs/.

Validation errors can occur when OpenPages Loss Event Entry data exists in the OpenPages database.

If you chose to load the data automatically, run the OpenPages Loss Event Entry installer again and use
the option to manually load the data. When the installation completes, load the data manually. You might
see errors about existing data, but you can ignore them.

If you chose to load the data manually and you see errors about existing data, you can ignore them.

For information about installing OpenPages Loss Event Entry, see Chapter 16, “Loss Event Entry,” on page
295.
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Memory validation step fails for an Oracle database
When you install OpenPages with an Oracle database, you get an error that the memory validation step
failed.

OpenPages uses Automatic Shared Memory Management (ASMM) and requires the following
configuration:

• SGA Size: 1024
• PGA Size: 768
• Block Size: 8192
• Processes : 250

Review these requirements with your database administrator. If your environment meets these
requirements, for example if you are using an alternative method for managing memory, you can override
the memory check and complete the installation.

1. Open the sql-wrapper.sql file in the /OP_<version>_Non_Embedded/
OP_<version>_Configuration/Database/ORACLE/INSTALL_SCRIPTS directory.

2. Change the dba_override_asmm_check property to Y.

define dba_override_asmm_check='Y'

3. Run the op-validate-dba-install.sh|.bat script.
4. Resume the installation of OpenPages.

Configuring the Oracle data pump directory
For an Oracle deployment, if the backup process is not successful, configure the Oracle data pump
storage directory, then run OPCCBackup again.

Procedure

1. Go to the <WAS_HOME>/Java/8.0/lib directory and copy the tools.jar file to the
<COGNOS_HOME>/jre/lib directory.

2. Log on to a computer that has the SQL*Plus utility and a connection to the OpenPages
CommandCenter database instance.

3. Go to the /OP_<version>_Non_Embedded/OP_<version>_Configuration/Database/
ORACLE/UPGRADE_SCRIPTS directory.

4. From the command line, run the update-datapump-directory.sql script.

sqlplus /nolog @sql-wrapper update-datapump-directory <log_file_name>
<tns_name_alias> SYSTEM <password> create 
<directory_location> <user_name>

The following table describes the variables in the script.

Table 63: Descriptions for variables in the update-datapump-directory.sql file

Variable Description

<log_file_name> The user-defined name of the log file that the
script creates to store information.

<tns_name_alias> The database Oracle TNS entry that is used by
the OpenPages CommandCenter database
instance on the reporting server computer.
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Table 63: Descriptions for variables in the update-datapump-directory.sql file (continued)

Variable Description

<password> The password for the Oracle SYSTEM user
account.

<directory_location> The full directory path to the location on the
database server where the backup files are
stored.

<user_name> The user name of the Cognos account for the
OpenPages CommandCenter database schema
(content store).

Example:

sqlplus /nolog @sql-wrapper update-datapump-directory 
C:\temp\update-datapump.log OP SYSTEM sys2Password create 
d:\cc_backup cognos 

Verifying the default SDK for WebSphere Application Server profiles
If you migrated from IBM WebSphere Application Server version 8.5.5.x to 9.x, verify that the default SDK
is set to IBM SDK, Java Technology Edition, Version 8. Do this check after you migrate to version 9.x and
before you upgrade OpenPages GRC Platform.

About this task

IBM SDK, Java Technology Edition, Version 8 is the default SDK that is delivered with IBM WebSphere
Application Server 9.x.

If WebSphere Application Server global security is enabled, you are prompted to enter the WebSphere
administrator user name and password when you run commands that access the application server.

Procedure

1. Log on to the IBM OpenPages GRC Platform admin application server. Log in as a user with
administrative privileges.

2. Check that IBM WebSphere Application Server is using the correct SDK.
a) Open a shell (Linux or AIX) or a command window as an administrator (Windows).
b) Go to the <WAS_HOME>/bin directory.
c) Run the following command:

• Linux or AIX:

./managesdk.sh -getNewProfileDefault

• Windows:

managesdk -getNewProfileDefault

The result is displayed. If you see 8.0_64, the default SDK is set correctly.

CWSDK1007I: New profile creation SDK name: 8.0_64
CWSDK1001I: Successfully performed the requested managesdk task.

3. If you do not see 8.0_64, change the default SDK.

a) Open a shell (Linux or AIX) or a command window as an administrator (Windows).
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b) Go to the <WAS_HOME>/bin directory.
c) Change the default SDK by running the following command:

• Linux or AIX:

./managesdk.sh -setNewProfileDefault -sdkname 8.0_64

• Windows:

managesdk -setNewProfileDefault -sdkname 8.0_64

The following message is displayed.

CWSDK1022I: New profile creation will now use SDK name 8.0_64.
CWSDK1001I: Successfully performed the requested managesdk task.

4. Verify that the default SDK is now set to 8.0_64.
Run the following command:

• Linux or AIX:

./managesdk.sh -getNewProfileDefault

• Windows:

managesdk -getNewProfileDefault

The result is displayed. If you see 8.0_64, the default SDK is set correctly.

CWSDK1007I: New profile creation SDK name: 8.0_64
CWSDK1001I: Successfully performed the requested managesdk task.

5. Repeat these steps on each OpenPages application server in your environment.

CM-CFG-5114: The Cognos service does not start
When you start Cognos Analytics, it fails to start and you see a message that the content store is locked.

CM-CFG-5114 An error occurred while locking the content store database.

For example:

CM-CFG-5063 A Content Manager configuration error was detected 
while connecting to the content store.
CM-CFG-5114 An error occurred while locking the content store database.

This error is a known issue in Cognos Analytics. For information about how to resolve the issue, see
Problems With Starting the Cognos Service After Running the OpenPages OPCCBackup Utility (Error: CM-
CFG-5114) (http://www-01.ibm.com/support/docview.wss?uid=swg21633776).

CM-CAM-4005 Unable to authenticate
You might see a CM-CAM-4005 Unable to authenticate error in the reporting server log during the
Import Solutions Reports phase of the installation.

This error can happen when the reporting server is installed on the same computer as an IBM OpenPages
application server or the Deployment Manager and the computer is running Linux or AIX.

The error occurs because the Cognos startup script (cogconfig.sh) uses the Java that is specified by
$JAVA_HOME. When the reporting server is installed on the same computer as another OpenPages
component, $JAVA_HOME might not point to the Java that is needed by Cognos Analytics.

You can resolve the problem by modifying the startup script.

1. Open the <COGNOS_HOME>/bin64/cogconfig.sh script in a text editor.
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2. Comment out the first, second, and fourth lines. Leave the third line unchanged.

#if [ "$JAVA_HOME" = "" ]
#then
    JAVA_HOME=../jre
#fi

3. Save the file.
4. Resume the installation.

Agent does not exist on remote server
When you click  in a server card of the installation app, the server card might display the following
message: Agent does not exist at <directory> on <remote-server-name>.

This issue occurs if the Agent Directory field was changed on the remote server's card after Validate was
clicked and the original agent on the remote server was not stopped before the Agent Directory field was
changed. If Validate is clicked again, the installation proceeds using the original agent. The error displays
if you click  in that server's card because no agent exists at the specified location.

To fix the issue, complete the following steps:

1. Log on to the remote server as the installation user and manually stop the original agent:

# cd <original-agent-directory>
# npm stop

2. Go to the installation directory:

# cd <original-agent-directory>/install/<platform>  

Where <platform> is one of: AIX | Linux | Windows.
3. Run the uninstall script:

• Windows

uninstall.bat

• Linux or AIX:

./uninstall.sh

4. Delete the original agent directory.
5. Return to the installation app and click Validate.

The agent software is installed in the new directory location and the agent software starts.

Errors during database server validation (DB2)
If you have insufficient memory available on your IBM DB2 server you might encounter a functional issue
during the installation of IBM OpenPages GRC Platform. You might see errors during the database server
validation process.

The functional issue can be resolved by applying the workaround that is described in the following
technote: IT19442: A DB2 FENCED ROUTINE MAY FAIL WITH ERROR SQL1646N DUE TO SHARED
MEMORY PERMISSION PROBLEMS (http://www.ibm.com/support/docview.wss?uid=swg1IT19442).

However, insufficient memory allocation on your DB2 server can also lead to significant performance
problems. Allocate more memory to the DB2 server before you continue with the installation of IBM
OpenPages GRC Platform.
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Warning: Run sysdba-xa-views-wrapper.sql
In the validation report, you see a message about the sysdba-xa-views-wrapper.sql script.

Warning: If you have not already done so, manually run 
sysdba-xa-views-wrapper.sql after configuration.

You can ignore this warning. In IBM OpenPages GRC Platform version 7.4.0.0 and later, you do not need
to run the sysdba-xa-views-wrapper.sql script.

Known issue: Incorrect notices file
The correct version of the notices file can be found in the installation media in the root folder.

If you want to replace the incorrect notices file with the correct version, follow these steps:

1. Copy the notices file (no extension) from /OP_<version>_Non_Embedded to the OpenPages
Application Server under <OP_HOME>/license, and overwrite the existing notices file. Repeat this step
on all non-admin application servers.

2. Copy the notices file (no extension) from /OP_<version>_Non_Embedded to the reporting servers
(active and standby) under <CC_HOME>/license, and overwrite the existing notices file.

OpenPages reports are not displayed in the Cognos Analytics portal
After you install or upgrade IBM OpenPages GRC Platform, if you do not see the OpenPages reports and
packages in the Cognos Analytics portal, you can import them manually.

For more information about importing content, see the Cognos Analytics Administration and Security
Guide.

Procedure

1. If you use solutions, get the latest version of the solutions report package.
a) Back up the following file if it exists: <COGNOS_HOME>/deployment/
OpenPages_Solutions_V6.zip.

b) Locate the solutions package file for the database that you are using. The file is located in the
following directory:

• IBM DB2: OP_<version>_Non_Embedded/OP_<version>_Configuration/Modules/
Upgrade/ORM/DB2/OpenPages_Solutions_V6.zip

• Oracle: OP_<version>_Non_Embedded/OP_<version>_Configuration/Modules/
Upgrade/ORM/Oracle/OpenPages_Solutions_V6.zip

c) Copy the OpenPages_Solutions_V6.zip file to the following directory on the Cognos server:
<COGNOS_HOME>/deployment. Overwrite the existing file.

Note: You do not need to copy the platform reports package from the installation media. The package
is placed on the Cognos server automatically when you install OpenPages.

2. From a browser, log on to the Cognos Analytics portal.

By default, the URL is http://<hostname>/ibmcognos/bi

Where <hostname> is the name of the Cognos server.
3. Click Manage > Administration Console to launch the IBM Cognos Administration page.
4. Click the Configuration tab and click Content Administration.

Tip: To access this area in IBM Cognos Administration, you must have the required permissions for
the Administration secured feature.

5. On the toolbar, click New Import.
6. From the Deployment archive list, select the package that you want to import.

• To import the platform reports, select the OpenPages Platform v6 package.
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• To import the solutions reports, select the OpenPages_Solutions_v6 package.
7. Click Next.
8. Type a unique name, an optional description, and a screen tip for the deployment archive, select the

folder where you want to save it, and then click Next.
9. In the Public folders content box, select the package that you are importing, and then click Next.

• If you are importing the platform reports, select OpenPages Platform v6.
• If you are importing the solutions reports, select OpenPages_Solutions_v6.

10. On the Specify the general options page, accept the default options and click Next.
11. On the Review the summary page, review the settings and click Next.
12. On the Select an action page, click Finish.
13. On the Run with options page, click Run and then, on the IBM Cognos software page, click OK.
14. To view the imported packages and reports, click the Home icon, and select the folder where you

imported them.

Results

You can now open the OpenPages reports in Cognos Analytics.

Troubleshooting IBM OpenPages GRC Platform solutions
Solve common problems that might occur when you install or remove the IBM OpenPages GRC Platform
solutions.

ObjectManager fails to initialize
Object Manager might fail to initialize and generate the following error WSCL0912E component failed
to initialize.

To resolve the issue, verify that the environment variable <WAS_HOME> is defined in the profile of the user
account that you specified in the <user> parameter. Verify that <WAS_HOME> is set to the directory where
IBM WebSphere Application Server is installed.

For example:

• on Windows, C:\IBM\WebSphere\AppServer
• on AIX and Linux, /opt/IBM/WebSphere/AppServer

If <WAS_HOME> is defined correctly but the error is not resolved, see the following additional information
http://www.ibm.com/support/docview.wss?uid=swg1PI26313.

Reporting Framework generation fails with CAMCryptoBC error
During installation, Reporting Framework generation might fail with a CAMCryptoBC error.

About this task

A CAMCryptoBC error occurs if the bcprov-jdk14-145.jar file that is provided with IBM OpenPages
GRC Platform is missing from the Java location that is used by the IBM Cognos server or if the
BouncyCastleProvider is not registered in the JRE master security provider file, java.security.

The following circumstances can cause the error:

• During the OpenPages upgrade process, the Java that is used for the Cognos server was changed to
version 1.8.

• During the Cognos fix pack installation process, the Java that is used for the Cognos server was updated
or overwritten.

• The Java used for the Cognos server was updated.
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To resolve the issue, check each reporting server in your environment. Verify that the JRE that is used to
run the Cognos software contains the bcprov-jdk14-145.jar file that is supplied with OpenPages. If
the JRE does not have a copy of the bcprov-jdk14-145.jar file, you can get a copy of the file from the
OpenPages application server in the directory: <OP-HOME>/profiles/<OpenPages-node-name>/
installedApps/<OpenPages-cell-name>/op-apps.ear

Procedure

1. If the Cognos software is using the JRE that is installed with Cognos, do the following steps:
a) Ensure that the bcprov-jdk14-145.jar is in the <COGNOS_HOME>/
analytics/jre/8.0/lib/ext directory.

b) Register the BouncyCastleProvider in the JRE master security provider file, if it is not already
registered.

To register the provider, add the following line to the java.security file that is stored in the
<COGNOS_HOME>/analytics/jre/8.0/lib/security directory. Replace <sequence number>
with the next number after the other security.provider sequence numbers that are in the file:

security.provider.<sequence number>=
    org.bouncycastle145.jce.provider.BouncyCastleProvider

2. If the Cognos software is using the JRE that is installed with WebSphere, do the following steps:
a) Ensure that the bcprov-jdk14-145.jar is in the <WAS_HOME>/java_8.0_64/jre/lib/ext

directory.
b) Register the BouncyCastleProvider in the JRE master security provider file, if it is not already

registered.

To register the provider, add the following line to the java.security file that is stored in the
<WAS_HOME>/java_8.0_64/jre/lib/security directory. Replace <sequence number> with
the next number after the other security.provider sequence numbers that are in the file:

security.provider.<sequence number>=
    org.bouncycastle145.jce.provider.BouncyCastleProvider

3. If the Cognos software is using a JRE that is installed in another location on the reporting server, do the
following steps:

Replace <JAVA_LOCATION> with the directory where the JRE is installed.

a) Ensure that the bcprov-jdk14-145.jar is in the <JAVA_LOCATION>/lib/ext directory.
b) Register the BouncyCastleProvider in the JRE master security provider file, if it is not already

registered.

To register the provider, add the following line to the java.security file that is stored in the
<JAVA_LOCATION>/lib/security directory. Replace <sequence number> with the next number
after the other security.provider sequence numbers that are in the file:

security.provider.<sequence number>=
    org.bouncycastle145.jce.provider.BouncyCastleProvider
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
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